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About This Guide

This preface defines the following:
e Objective, page xv
e Related Documentation, page xv
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Objective

This guide provides details about the WatchDog commands and the Graphical User Interface (GUI) for
the Cisco IP Solution Center (ISC) product. Detailed explanations are given for common components
across all applications.

Related Documentation

The entire documentation set for Cisco IP Solution Center, 4.2 can be accessed at:

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/
tsd_products_support_series_home.html

Tip To cut and paste a two-line URL into the address field of your browser, you must cut and paste each line
separately to get the entire URL without a break.

The following documents comprise the ISC 4.2 documentation set.

Cisco IP Solution Center Infrastructure Reference, 4.2
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I Related Documentation

General documentation (in suggested reading order)

Cisco IP Solution Center Getting Started and Documentation Guide, 4.2.

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/
products_documentation_roadmap09186a008069c214.html

Release Notes for Cisco IP Solution Center, 4.2.

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/
prod_release_note09186a008069¢20c.html

Cisco IP Solution Center Installation Guide, 4.2.

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/
products_installation_guide_book09186a00806923f0.html

Cisco IP Solution Center Infrastructure Reference, 4.2.

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/
products_technical_reference_book09186a00806923f6.html

Cisco IP Solution Center System Error Messages, 4.2.

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/
products_system_message_guide_book(09186a008069240e.html

Application and technology documentation (listed alphabetically)

AP

Cisco IP Solution Center Metro Ethernet and L2VPN User Guide, 4.2.

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/
products_user_guide_book(09186a0080692411.html

Cisco IP Solution Center MPLS VPN User Guide, 4.2.

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/
products_user_guide_book09186a00806907¢5.html

Cisco IP Solution Center Quality of Service User Guide, 4.2.

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/
products_user_guide_book09186a0080692413.html

Cisco IP Solution Center Traffic Engineering Management User Guide, 4.2.

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/
products_user_guide_book(09186a0080692414.html

Cisco MPLS Diagnostics Expert 2.0 User Guide on ISC 4.2.

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/
products_user_guide_book(09186a0080692425.html

Documentation
Cisco IP Solution Center API Programmer Guide, 4.2.

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/
products_programming_usage_guide_book(09186a0080692428.html

Cisco IP Solution Center API Programmer Reference, 4.2.

http://www.cisco.com/application/x-zip-compressed/en/us/guest/products/
ps6910/c1667/ccmigration_09186a008072368f.zip

] Cisco IP Solution Center Infrastructure Reference, 4.2

0L-10727-01 |


http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_documentation_roadmap09186a008069c214.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_documentation_roadmap09186a008069c214.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/prod_release_note09186a008069c20c.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/prod_release_note09186a008069c20c.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_installation_guide_book09186a00806923f0.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_installation_guide_book09186a00806923f0.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_technical_reference_book09186a00806923f6.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_technical_reference_book09186a00806923f6.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_system_message_guide_book09186a008069240e.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_system_message_guide_book09186a008069240e.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_user_guide_book09186a0080692411.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_user_guide_book09186a0080692411.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_user_guide_book09186a00806907c5.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_user_guide_book09186a00806907c5.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_user_guide_book09186a0080692413.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_user_guide_book09186a0080692413.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_user_guide_book09186a0080692414.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_user_guide_book09186a0080692414.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_user_guide_book09186a0080692425.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_user_guide_book09186a0080692425.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_programming_usage_guide_book09186a0080692428.html
http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_programming_usage_guide_book09186a0080692428.html
http://www.cisco.com/application/x-zip-compressed/en/us/guest/products/ps6910/c1667/ccmigration_09186a008072368f.zip
http://www.cisco.com/application/x-zip-compressed/en/us/guest/products/ps6910/c1667/ccmigration_09186a008072368f.zip

| About This Guide

)

Note

Audience

Audience W

All documentation might be upgraded over time. All upgraded documentation will be available at the
same URLs specified in this document.

This guide is written as a resource for experienced users and administrators who use ISC. It provides
details about how to implement the infrastructure functionality of ISC that is common to all applications.

It is assumed that you have a basic understanding of network design, operation, and terminology, and
that you are familiar with your own network configurations.

How This Book Is Organized

This guide is organized as follows:

Chapter 1, “Getting Started,” provides a reference to the system recommendations, provides an
overview of the ISC product, provides an overview of the GUI structure, and explains the common
GUI components.

Chapter 2, “WatchDog Commands,” provides the description, syntax, and arguments for the
commands for WatchDog, a background daemon process that is automatically installed as part of
the installation procedure for ISC.

Chapter 3, “Service Inventory — Inventory and Connection Manager,” explains the navigation path
from the Service Inventory tab to Inventory and Connection Manager and how to use the topics
found there.

Chapter 4, “Service Inventory—Discovery,” explains the navigation path from the Service
Inventory tab to Discovery and how to discover devices, connections, and services.

Chapter 5, “Service Inventory—Device Console,” explains the navigation path from the Service
Inventory tab to Device Console and how to use the topics found there.

Chapter 6, “Service Design,” explains the Service Design tab and how to use the topics found there.
Chapter 7, “Monitoring,” explains the Monitoring tab and how to use the topics found there.

Chapter 8, “Diagnostics,” explains the Diagnostics tab and where to navigate for a full explanation.
Chapter 9, “Administration,” explains the Administration tab and how to use the topics found there.

Appendix A, “Cisco CNS IE2100 Appliances,” explains how to use the Cisco CNS IE2100
functionality on ISC.

Appendix B, “ISC XML Reference,” explains XML files for Discovery.

Appendix C, “Property Settings,” explains the Dynamic Component Properties Library (DCPL)
properties, their defaults, and ranges and rules.

Glossary explains terminology used in the ISC product.

[ oL-10727-01
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Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. This section explains the
product documentation resources that Cisco offers.

Cisco.com

You can access the most current Cisco documentation at this URL:
http://www.cisco.com/techsupport

You can access the Cisco website at this URL:
http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD

The Product Documentation DVD is a library of technical product documentation on a portable medium.
The DVD enables you to access installation, configuration, and command guides for Cisco hardware and
software products. With the DVD, you have access to the HTML documentation and some of the

PDF files found on the Cisco website at this URL:

http://www.cisco.com/univercd/home/home.htm

The Product Documentation DVD is created and released regularly. DVDs are available singly or by
subscription. Registered Cisco.com users can order a Product Documentation DVD (product number
DOC-DOCDVD= or DOC-DOCDVD=SUB) from Cisco Marketplace at the Product Documentation
Store at this URL:

http://www.cisco.com/go/marketplace/docstore

Ordering Documentation

You must be a registered Cisco.com user to access Cisco Marketplace. Registered users may order
Cisco documentation at the Product Documentation Store at this URL:

http://www.cisco.com/go/marketplace/docstore
If you do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Documentation Feedback

You can provide feedback about Cisco technical documentation on the Cisco Technical Support &
Documentation site area by entering your comments in the feedback form available in every online
document.
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Cisco Product Security Overview

Cisco provides a free online Security Vulnerability Policy portal at this URL:
http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html
From this site, you will find information about how to do the following:

e Report security vulnerabilities in Cisco products

¢ Obtain assistance with security incidents that involve Cisco products

e Register to receive security information from Cisco

A current list of security advisories, security notices, and security responses for Cisco products is
available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are updated in real time, you
can subscribe to the Product Security Incident Response Team Really Simple Syndication (PSIRT RSS)
feed. Information about how to subscribe to the PSIRT RSS feed is found at this URL.:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products

o

Cisco is committed to delivering secure products. We test our products internally before we release them,
and we strive to correct all vulnerabilities quickly. If you think that you have identified a vulnerability
in a Cisco product, contact PSIRT:

¢ For emergencies only—security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or a condition for which
a severe and urgent security vulnerability should be reported. All other conditions are considered
nonemergencies.

e For nonemergencies—psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:
e 1877 228-7302
e 1408 525-6532

We encourage you to use Pretty Good Privacy (PGP) or a compatible product (for example, GnuPG) to
encrypt any sensitive information that you send to Cisco. PSIRT can work with information that has been
encrypted with PGP versions 2.x through 9.x.

Never use a revoked encryption key or an expired encryption key. The correct public key to use in your
correspondence with PSIRT is the one linked in the Contact Summary section of the Security
Vulnerability Policy page at this URL:
http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

The link on this page has the current PGP key ID in use.

If you do not have or use PGP, contact PSIRT to find other means of encrypting the data before sending
any sensitive material.
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Product Alerts and Field Notices

Modifications to or updates about Cisco products are announced in Cisco Product Alerts and Cisco Field
Notices. You can receive Cisco Product Alerts and Cisco Field Notices by using the Product Alert Tool
on Cisco.com. This tool enables you to create a profile and choose those products for which you want to
receive information.

To access the Product Alert Tool, you must be a registered Cisco.com user. (To register as a Cisco.com
user, go to this URL: http://tools.cisco.com/RPF/register/register.do) Registered users can access the
tool at this URL: http://tools.cisco.com/Support/PAT/do/ViewMyProfiles.do?local=en

Obtaining Technical Assistance

Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The

Cisco Technical Support & Documentation website on Cisco.com features extensive online support
resources. In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Center
(TAC) engineers provide telephone support. If you do not have a valid Cisco service contract, contact
your reseller.

Cisco Technical Support & Documentation Website

The Cisco Technical Support & Documentation website provides online documents and tools for
troubleshooting and resolving technical issues with Cisco products and technologies. The website is
available 24 hours a day at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires a Cisco.com
user ID and password. If you have a valid service contract but do not have a user ID or password, you
can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note  Use the Cisco Product Identification Tool to locate your product serial number before submitting a
request for service online or by phone. You can access this tool from the Cisco Technical Support &
Documentation website by clicking the Tools & Resources link, clicking the All Tools (A-Z) tab, and
then choosing Cisco Product Identification Tool from the alphabetical list. This tool offers three search
options: by product ID or model name; by tree view; or, for certain products, by copying and pasting
show command output. Search results show an illustration of your product with the serial number label
location highlighted. Locate the serial number label on your product and record the information before
placing a service call.

Tip Displaying and Searching on Cisco.com

If you suspect that the browser is not refreshing a web page, force the browser to update the web page
by holding down the Ctrl key while pressing F5.

To find technical information, narrow your search to look in technical documentation, not the entire
Cisco.com website. On the Cisco.com home page, click the Advanced Search link under the Search box
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Obtaining Technical Assistance

and then click the Technical Support & Documentation radio button.

To provide feedback about the Cisco.com website or a particular technical document, click Contacts &
Feedback at the top of any Cisco.com web page.

Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 and
S4 service requests are those in which your network is minimally impaired or for which you require
product information.) After you describe your situation, the TAC Service Request Tool provides
recommended solutions. If your issue is not resolved using the recommended resources, your service
request is assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco TAC by telephone.
(ST or S2 service requests are those in which your production network is down or severely degraded.)
Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411
Australia: 1 800 805 227
EMEA: +32 2 704 55 55
USA: 1800 553 2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has established severity
definitions.

Severity 1 (S1)—An existing network is “down” or there is a critical impact to your business operations.
You and Cisco will commit all necessary resources around the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your
business operations are negatively affected by inadequate performance of Cisco products. You and
Cisco will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of the network is impaired while most business operations
remain functional. You and Cisco will commit resources during normal business hours to restore service
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or
configuration. There is little or no effect on your business operations.
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Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is available from various online
and printed sources.

The Cisco Online Subscription Center is the website where you can sign up for a variety of
Cisco e-mail newsletters and other communications. Create a profile and then select the
subscriptions that you would like to receive. To visit the Cisco Online Subscription Center,
go to this URL:

http://www.cisco.com/offer/subscribe

The Cisco Product Quick Reference Guide is a handy, compact reference tool that includes brief
product overviews, key features, sample part numbers, and abbreviated technical specifications for
many Cisco products that are sold through channel partners. It is updated twice a year and includes
the latest Cisco channel product offerings. To order and find out more about the Cisco Product Quick
Reference Guide, go to this URL:

http://www.cisco.com/go/guide

Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo
merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

Cisco Press publishes a wide range of general networking, training, and certification titles. Both new
and experienced users will benefit from these publications. For current Cisco Press titles and other
information, go to Cisco Press at this URL:

http://www.ciscopress.com

Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering
professionals involved in designing, developing, and operating public and private internets and
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

Networking products offered by Cisco Systems, as well as customer support services, can be
obtained at this URL:

http://www.cisco.com/en/US/products/index.html

Networking Professionals Connection is an interactive website where networking professionals
share questions, suggestions, and information about networking products and technologies with
Cisco experts and other networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

“What’s New in Cisco Documentation” is an online publication that provides information about the
latest documentation releases for Cisco products. Updated monthly, this online publication is
organized by product category to direct you quickly to the documentation for your products. You
can view the latest release of “What’s New in Cisco Documentation” at this URL:

http://www.cisco.com/univercd/cc/td/doc/abtunicd/136957.htm

World-class networking training is available from Cisco. You can view current offerings at
this URL:

http://www.cisco.com/en/US/learning/index.html
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CHAPTER 1

Getting Started

This chapter provides information about how to get started to use Cisco IP Solution Center (ISC) and
gives a structural overview of this manual. It contains the following sections:

e System Recommendations, page 1-1
e Introduction, page 1-1

e Structural Overview, page 1-2

e Service Inventory, page 1-10

e Service Design, page 1-12

e Monitoring, page 1-13

e Diagnostics, page 1-14

¢ Administration, page 1-15

System Recommendations

Note

The system recommendations and requirements are listed in Chapter 1, “System Recommendations” of
the Cisco IP Solution Center Installation Guide, 4.2. The recommendation is to thoroughly review this
list before even planning your installation, to be sure that you have all the hardware and software you
must successfully install.

There is no direct way to upgrade from ISC 3.0 or ISC 3.1 to ISC 4.2. To upgrade from ISC 3.0 or ISC
3.1 to ISC 4.2, you must contact ISC Marketing, e-mail: isc-mktg @cisco.com.

Introduction

Cisco IP Solution Center, 4.2 (ISC 4.2) is a follow-on release to Cisco IP Solution Center, 4.1 (ISC 4.1),
with the changes listed in the Release Notes for Cisco IP Solution Center, 4.2.

This manual lists many features that are common among multiple applications, which are sold and
licensed separately. The applications and their respective User Guides reference this document for setup
steps necessary before creating a policy and then a service request specific to the application and for
other common features.
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Before explaining the tabs in the Graphical User Interface (GUI), see the “Structural Overview” section
on page 1-2. It explains elements common to many windows in ISC.

The GUI is separated into the following large sections (tabs):
e “Service Inventory” section on page 1-10
e “Service Design” section on page 1-12
e “Monitoring” section on page 1-13
e “Diagnostics” section on page 1-14
e “Administration” section on page 1-15

The remaining sections in this chapter explain the sections and subsections of this manual that explain
the functionality available from these tabs.

Structural Overview

After you log in to Cisco IP Solution Center (ISC), the first window to appear is the Home window, as
shown in Figure 1-1, “Home Window.”

Figure 1-1 Home Window

Cisco SYSTEMS Home | Shortcuts | Accourt | Index | Help | 2bout | Logout

IP Solution Center

=er: admin

Wou Are Here: + Customer: Mone
‘Welcorne to IP Solution Center {ISC).

=3 Service Inventony
n"a Tools to manage inventory elements, service requests, and devices.
&N

Service Design
n Tools to create and manage policies, templates, protocols, and network objects.

—— Menitoring
i Tools to manage tasks, ping parameters, and generate Service Level Agreement (SLA) probes
and reports.

Diagnostics
E& Tools for autornsted troubleshooting and diagnostics

Administration
K4 /5% Tools to manage users and 1S configuration, servers, remote installation, and licensing.

128045

HOTE: Use the Index link in the top-right corner at any time to view an indexed list of all 1SC areas.

Note  The tabs and the choices navigating within the tabs that appear depend on the user permission, explained
in Chapter 9, “Administration”(Administration > Security > User Roles). The choices shown in this
manual are for all permissions (admin).

This overview includes the following sections:
e Product Category Tabs, page 1-3
e Links, page 1-3
¢ Common GUI Components, page 1-6
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Product Category Tabs

Links

The organization of this manual is based on the tabs shown in Figure 1-1, “Home Window.” Click either
the specific tab or the name in the data pane:

Service Inventory An overview is given in the “Service Inventory” section on page 1-10 and
detailed information is given in Chapter 3, “Service Inventory — Inventory and Connection
Manager,” Chapter 4, “Service Inventory—Discovery,” and Chapter 5, “Service Inventory—Device
Console.”

Service Design An overview is given in the “Service Design” section on page 1-12 and detailed
information is given in Chapter 6, “Service Design.”

Monitoring An overview is given in the “Monitoring” section on page 1-13 and detailed
information is given in Chapter 7, “Monitoring.”

Diagnostics An overview is given in the “Diagnostics” section on page 1-14 and a pointer to
detailed information is given in Chapter 8, “Diagnostics.”

Administration An overview is given in the “Administration” section on page 1-15 and detailed
information is given in Chapter 9, “Administration.”

In the upper right-hand corner of the Home window (Figure 1-1), additional links appear that function
as follows:

Home, page 1-3
Shortcuts, page 1-3
Account, page 1-5
Index, page 1-5
Help, page 1-5
About, page 1-6
Logout, page 1-6

On the far right of the You are Here: line on the Home window (Figure 1-1), is the name of a Customer
Context, which is explained in the “Customer” section on page 1-6.

Home
When you click Home, you always return to the first window to appear, as shown in Figure 1-1, “Home
Window.”
Shortcuts
When you click Shortcuts, you can define shortcuts to help quickly choose day to day operations. In
addition, by grouping these shortcuts together into folders, you can create work flows specific to your
operating environment. To get more information about shortcuts, follow these steps:
Step1  After you click Shortcuts, you receive a window as shown in Figure 1-2, “ISC Shortcuts.”
Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 1-2 ISC Shortcuts

Shiowe Shortcuts with | Folder Hame | Matching | ALL -

#

1.

2.

3.

4. |« testfoldert
3. testfolder

Rows per page:

&l

Showing 1 - 5 of 3 records

test
test2
test3
testfl
testd

| €] <] Goto page: 1 oi1 (Ga) [ [

116251

Step2  To create a shortcut, click the Create button in Figure 1-2 and you receive a window as shown in
Figure 1-3, “New ISC Shortcut.”

Figure 1-3 New ISC Shortcut

«
Marme :

B

UEL :

Cescription:

Faolder:

Faolder Shortcut Crdering:

Type or paste the desired URL into the field ahove. Ifthe URL is external to 15C | i must
Regin with "hitp: . Or, =elect an internal URL from the list belowand click "Set™

Choose.. -
test1 B
testz
tests
+
+
/

116232

Step3  Fill in the required Name and URL (you can type in the URL, in which case if it is external to ISC, you
must start the URL name with http://, or you can click the drop-down list and choose a path internal to

ISC and then click the Set button) and optionally the Description, Folder, and Folder Shortcut
Ordering. Then click Save.
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Account

Index

Help

Step 4

Step 5

Structural Overview

You return to Figure 1-2 and can repeat Step 2 and Step 3 to Create more shortcuts or you can select a
shortcut to proceed to Go, select a shortcut to Edit, select one or more shortcuts to Delete, or select

Close.

Any time you want to go directly to a URL, you can click Shortcuts on the Home page and from
Figure 1-2 select the shortcut of your choice and click Go.

When you click Account, you can change your password without the SysAdmin or UserAdmin
privileges. This allows you to edit the user profile, including changing the password.

When you click Index, you receive an overall picture of all choices from which you can click and jump
to, as shown in Figure 1-4, “Index of all Choices.”

Figure 1-4 Index of all Choices
Index
Service Inventony Service Design Monitorning Diagncstics Administration
Inverntory and Cormection Policies Task VBrager MPLS Diagrostics Expert Security
Ninager Templates Task Logs MPLS WP Connectivity Users
Service Reqguests Link QoS Ping “erification User Groups
Trafiic Engineering Managerm ent srA User Fles
Irvertory Manager P Object Graups
Taopol Taoal
LR Tt Fepaorts Controfl Center

Devices
Cevice Groups
Customers
Customer Sites
GPE Devices
Providers
Provider Regions
PE Devices
Access Domaing
Resource Pools
GE Routing Communities
WRMNE
Mamed Physical Circuits
MPC Rings
Discovery
Davice Corsoke

TE Performance Report
Reporls

Collection Zones

Licensing
Active tsers
tser Access Log

158139

When you click Help, you receive a pointer to the documentation set:

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/tsd_products_support_series_home.html

From that location, you can choose the type of ISC document you want to see.
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About

Logout

Customer

Step 1

Step 2
Step 3
Step 4

Step 5

Step 6

When you click About, you receive the product name and version.

When you click Logout, you log out of the product.

On the far right of the You are Here line of the Home page is Customer: followed by None (default) or
a customer name. This is referred to as Customer Context. The advantage of Customer Context is to
focus only on information for a specified customer. To set the Customer Context, follow these steps:

Click on the name after Customer: on the far right of the line that starts with You are Here. The default
is None. The window shown in Figure 1-5, “Customer Context,” appears.

Figure 1-5 Customer Context

Customer Context

Custormer:

116234

Click the Select button and you receive a list of all the currently created customers.
Click the radio button for the customer for which you want information and click Select.

Figure 1-5, “Customer Context,” reappears with the name of the selected customer. Click Save or
highlight the customer name and click Clear to reset the customer for which you want information.

The customer you chose now appears after Customer: on the Home window and it is the only customer
for which information appears.

You can reset the Customer Context by clearing and reselecting.

Common GUI Components

GUI components that are common on many windows are as follows:
e Filters, page 1-7
e Header Row Check Box, page 1-7
e Rows per Page, page 1-7

Go To Page, page 1-7

Auto Refresh, page 1-8
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¢ Color Coding, page 1-8
e Icons, page 1-10

At the top of many windows you can filter information that appears in the window. As shown in
Figure 1-6, “Example of Filtering, Header Row Check Box, Rows per Page, and Changing Pages,” you
can click the drop-down list for categories, then in the matching field enter the search criteria, using *
if you want to indicate anything is a match (you can enter only * or you can place * before other
characters, in the middle of other characters, at the end of other characters, or in multiple locations), and
click Find. In some cases you might also have a field after the matching field from which you can select
or enter more specifics for your Find.

Header Row Check Box

Rows per Page

Go To Page

Many windows have a check box in the header row, where the column names exist, as shown in
Figure 1-6, Example of Filtering, Header Row Check Box, Rows per Page, and Changing Pages. If you
check this check box, then all check boxes in the window are chosen.

In the bottom left corner of many windows, as shown in Figure 1-6, “Example of Filtering, Header Row
Check Box, Rows per Page, and Changing Pages,” you can change the number of rows shown on this
window in Rows per page. Click the drop-down list and you can select 5, 10, 20, 30, 40, 50, 100, 500,
1000, or 2500.

Near the bottom in the right corner of many windows, as shown in Figure 1-6, “Example of Filtering,
Header Row Check Box, Rows per Page, and Changing Pages,” there is Go to page field of y. In the field,
you can enter the page you want to choose and then click the Go button to get there. The y indicates the
last page for this topic. Another way to choose a specific page is to use the arrows. You can click the >
arrow to choose the next page or the furthest arrow to the right >I to choose the last page. You can click
the < arrow to choose the previous page or the furthest arrow to the left I< to choose the first page.
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Figure 1-6 Example of Filtering, Header Row Check Box, Rows per Page, and Changing Pages
Devices
ShowDevices with I Davice Mame | matching Ix | Find |
Showing 1 - § of 3 records
# Device Hame Management IP Address Type Parent Device Hame
1.7 & r=t Cisco 10S Device
2 & pen Cisco [0S Device
3. & = Cisco 103 Device
. & = Cisco 10 Davice
s & = Cisco 105 Device
B & c=3 Cisco 10S Device
. & cen Cisco |08 Device
8. & cels Cisco 103 Device
Rows perpage: | 10 7| [4] ] Goto page: ll_nﬂ b= 0
g
Create o || Edit || Delete | | Config || E-rnzil || Copy | §

Auto Refresh
At the bottom left corner of several windows, there is a check box used to enable or disable the Auto
Refresh feature, as shown in Figure 1-7, “Example of Auto Refresh.” Checking this check box causes
the window and its data to refresh every n milliseconds. The amount of time between refresh cycles can
be set in the DCPL property: GUIL.srRefreshRate. By default, the Auto Refresh feature is enabled to
30000 milliseconds.
Figure 1-7 Example of Auto Refresh
Services
ShowServices with I Joh D | matching I" of Type | MPLS WFN =] | Find
Showing 1 - 2 of 2 recards
# |_ Job 1D State Type Operation Type  Creator  Customer Hanne Paolicy Mame Last Modified Descrption
1.1 REQUESTED MPLS 2DD admin Customerd MPLSPolicy_PECE 10/27/05 5:25 PM
22 REQUESTED MPLS 2DD admin Customerd MPLEP olicylO_GE 10/27/05 5:25 PM
Rows per page: | 10 | N] ﬁ] Goto page: |1 of1 bbl
3
Auto Refresh: F | Corfigure Ping Parameters | =
o~
Color Coding

In the Service Request table, the Task table, and the Device table, the colors you see indicate the state
of the items, as shown in Figure 1-8, “Colors as Identifiers.”

In the Service Request table, the states have the following colors:

¢ BROKEN is bright yellow

Cisco IP Solution Center Infrastructure Reference, 4.2
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e CLOSED is no color
e DEPLOYED is bright green
e FAILED AUDIT is bright yellow
e FAILED DEPLOY is bright red
e FUNCTIONAL is bright green
e INVALID is bright red
e LOST is bright yellow
e PENDING is bright green
e REQUESTED is cream
e WAIT DEPLOYED is cream
In the Task table, the states have the following colors:
e ABORTED is orange
e RUNNING is bright green
e WAITING_TO_RUN is cream
e errors is bright red
e successfully is bright green
e warnings is cyan
In the devices table, the states have the following colors:
e device returns anything else is bright red
e device returns success is bright green

e no result from device is dark blue

Figure 1-8 Colors as Identifiers

Service Reguests

Showe Services with | Jok 1D j matching |* aof Type | All j Find

Showing 1 - 10 of 11 recaords
Operation Customer

& [ J;;']h State Type o Creator Hame Policy Mame  Last Modified Desgcription
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Icons

Note

In some windows with tables of information, icons appear to show the type of device, as shown in
Figure 1-9, “Devices—Icons.”

A list of possible icons can be found in Table 3-2 in the Topology Tool section of Chapter 3, “Service
Inventory — Inventory and Connection Manager.”

Figure 1-9 Devices—Icons
Devices
ShowDevices with | Device MName | mateing | | Find |
Showing 1 - & of & records
# I_ D evice Hame Management IP Address Type Parent Device Hame
1. & pet Cisco |08 Device
2 & pe3 Cisco |08 Device
i & = Cisco 10T Davice
. & =wa Cisco 105 Device
s & = Cisco 103 Device
6. & cea Cisco [0S Device
. & cen Cisco |08 Device
g [ & c=13 Cisco 10 Davice
Rows perpage: | 10 7| [4] ] Goto page: ll_nﬂ b= 0
g
Create ,|| Edit || Delete | | Corfig || E-nail || Copy | §

Service Inventory

Service Inventory contains tools to manage inventory elements, service requests, and devices. This is
explained in Chapter 3, “Service Inventory — Inventory and Connection Manager,” Chapter 4, “Service
Inventory—Discovery,”and Chapter 5, “Service Inventory—Device Console.”

From the Home window you receive upon logging in, click the Service Inventory tab and you receive a
window as shown in Figure 1-10, “Service Inventory Selections.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 1-10 Service Inventory Selections
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The selections are as follows:

Inventory and Connection Manager (explained in detail in Chapter 3, “Service Inventory —
Inventory and Connection Manager”)

The functions within Inventory and Connection Manager are shown in Figure 1-11, “Inventory
and Connection Manager Selections,” and are as follows:

— Service Requests Create, deploy, and manage service requests (SRs). Details are explained in
User Guides.

— Traffic Engineering Management Create, deploy, and manage elements of Traffic Engineering
Management (explained in detail in the Cisco IP Solution Center Traffic Engineering
Management User Guide, 4.2).

— Inventory Manager Bulk-manage inventory elements.
— Topology Tool View topology maps.

— Devices Create and manage devices.

— Device Groups Create and manage device groups.

— Customers Create and manage customers.

— Providers Create and manage Providers.

— Resource Pools Create and manage pools for IP address, multicast address, route distinguisher,
route target, site of origin, VC ID, and VLAN.

— CE Routing Communities Create and manage CE Routing Communities.
— VPNs Create and manage VPNs.
— Named Physical Circuits Create and manage Named Physical Circuits (NPCs).

[ oL-10727-01
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Figure 1-11
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Discovery Discover devices, connections, and services (explained in detail in Chapter 4, “Service
Inventory—Discovery”).

Device Console Download commands and configlets to devices and view device configuration

(explained in detail in Chapter 5, “Service Inventory—Device Console”).

The functions with Device Console are as follows:

— Download Commands

— Download Template

— Device Configuration Manager

- EXEC Commands

— Reload

Service Design

Service Design contains management tools for creating and managing policies, templates, and Link

QoS. This is explained in Chapter 6, “Service Design.”

From the Home window you receive upon logging in, click the Service Design tab and you receive a
window as shown in Figure 1-12, “Service Design Selections.”
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Figure 1-12 Service Design Selections
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The selections are as follows:
¢ Policies Create and manage policies for licensed services. Details are explained in User Guides.

¢ Templates Create and manage templates and associated data. The available choices are shown in the
left column of Figure 1-13, “Templates Selections.”

Figure 1-13 Templates Selections
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]

¢ Link QoS Create and manage IP Link QoS and Ethernet Link QoS settings. Details are explained
in the Cisco IP Solution Center Quality of Service User Guide, 4.2.

Monitoring

Monitoring contains tools to manage tasks, ping parameters, Service Level Agreement (SLA) probes,
Traffic Engineering performance reports, and other reports. This is explained in Chapter 7,
“Monitoring.”

From the Home window you receive upon logging in, click the Monitoring tab and you receive a
window as shown in Figure 1-14, “Monitoring Selections.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 1-14 Monitoring Selections
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The selections are as follows:
e Task Manager Create and schedule tasks and monitor task run details.
e Ping Perform Ping connectivity tests.
e SLA Manage probes and view reports.
¢ TE Performance Report TE Performance report.

¢ Reports Create and schedule reports.

Diagnostics

Diagnostics contains automated troubleshooting and diagnostics for MPLS VPNs. This is explained in
the Cisco MPLS Diagnostics Expert 2.0 User Guide on ISC 4.2.

From the Home window you receive upon logging in, click the Diagnostics tab and you receive a
window as shown in Figure 1-15, “Diagnostics Selections.”

Figure 1-15 Diagnostics Selections
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Administration

Administration contains tools to manage users, ISC configuration, servers, remote installation, and
licensing, to view users and the user access log, and to specify attributes for some messages. This is
explained in detail in Chapter 9, “Administration.”

From the Home window you receive upon logging in, click the Administration tab and you receive a
window as shown in Figure 1-16, “Administration Selections.”

Figure 1-16 Administration Selections
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The selections are as follows:

e Security Create and manage Users, User Groups, User Roles, and Object Groups. The following
choices are shown in Figure 1-17, “Security Selections™:

— Users Create and manage Users to also access Inventory Manager, Topology, and Northbound
APL.

— User Groups Create and manage User Groups. A Group is used to combine the privileges of all
the roles contained within it.

— User Roles Create and manage User Roles, which define a set of permissions.

— Object Groups Create and manage a group of objects, such as devices, interfaces, and named
physical circuits.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 1-17 Security Selections
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¢ Control Center Manage ISC configuration, servers, remote installation, and licensing. The
following choices are shown in the left column of Figure 1-18, “Control Center Selections”:

— Hosts

Note  From Hosts, you can choose Install. You can remotely install a Processing Server, Collection Server, or
Interface Server. In this Remote Install, you must accept the default values, similar to the express install.
If you want to do a custom install, this is only available through the Installation procedure explained in
the Cisco IP Solution Center Installation Guide, 4.2.

— Collection Zones

— Licensing
Figure 1-18 Control Center Selections
Hosts
el
nHosts _Refresh |
« Gollection Zones Showing 1 - 1 of 1 record
- Licensing # | Mame Role Start Time Stop Time Running
1. [ efgh-utra.cisco.com Master Oct 27 04:19:56 PM PDT LIMKM OV es
Rows per page: [ 10 x| <] <] Zoto page: Il of 1 Bl
i
| Details || Config || Servers || Watchdog || || Unirstall || Logs | §
—

e Active Users View users currently connected to ISC. Disconnect users.
e User Access Log View the user access log.

¢ Manage TIBCO Rendezvous Specify attributes for proper messaging among all Java™ Web Start
distributed applications.
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CHAPTER

WatchDog Commands

The WatchDog is responsible for bootstrapping Cisco IP Solution Center (ISC) and starting the
necessary set of server processes. In addition, the WatchDog monitors the health and performance of
each server to ensure it is functioning properly. In the event of a software error that causes a server to
fail, the WatchDog automatically restarts the errant server.

The WatchDog is a background daemon process that is automatically installed as part of the installation
procedure for ISC. After the installation procedure has completed, WatchDog is started automatically.
You can execute the startwd command to run the WatchDog after the installation. The WatchDog can
be configured to automatically start any time the machine is rebooted.

In addition to the commands that are specified in this chapter, in the product you can choose
Admin > Control Center > Servers and from there you can start, stop, restart, and view log files for
the individual ISC servers.

This chapter provides the description, syntax, and arguments (listed alphabetically) for the following
WatchDog commands:

e startdb Command, page 2-1
e startns Command, page 2-2
e startwd Command, page 2-2
e stopall Command, page 2-3
e stopdb Command, page 2-3
e stopns Command, page 2-4
e stopwd Command, page 2-4

e wdclient Command, page 2-5

startdb Command

This section provides the description and syntax for the startdb command.

Description

The startdb command starts the database.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Syntax

startdb
The startdb command has no arguments and starts the database.

The location of startdb is: <ISC Directory>/bin.

~

Note Do not run startdb in the background. Do not enter startdb &.

startns Command

This section provides the description and syntax for the startns command.

Description

The startns command starts the name server. The orbd process provides the name server functionality.
orbd (from JDK) is required, but startwd starts it if it is not already running. The startns and stopns

commands deal with orbd.

Syntax

startns
The startns command has no arguments and starts the name server.

The location of startns is: <ISC Directory>/bin.

startwd Command

This section provides the description and syntax for the startwd command.

Description

The startwd command starts the WatchDog and all ISC processes. The startwd command includes the
functionality of startdb (see the “startdb Command” section on page 2-1) and startns (see the “startns
Command” section on page 2-2). Executing this command is a necessary procedure and occurs

automatically as part of the installation. Use this startwd command after issuing a stopwd command to
restart the WatchDog. The master ISC host must be started first. Other ISC hosts can be started any time

after the master ISC host, but all hosts must be started before starting to use ISC.

If for some reason the master ISC host is stopped, either inadvertently or by issuing the stopwd

command, this master ISC host can be restarted by using the startwd command.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Syntax

S

Note

stopall Command

startwd

The startwd command has no arguments and starts the WatchDog only for the machine where it is
executed.

The location of startwd is: <ISC Directory>/bin.

Do not run startwd in the background. Do not enter startwd &.

stopall Command

Description

Syntax

A

This section provides the description and syntax for the stopall command.

The stopall command stops the database, name server, and WatchDog on the machine on which it is run.
The stopall command includes the functionality of stopdb -y (see the “stopdb Command” section on

page 2-3), stopns -y (see the “stopns Command” section on page 2-4), and stopwd -y (see the “stopwd
Command” section on page 2-4). Normally this is only necessary before installing a new version of ISC.

stopall

Caution

There is no -y parameter. Therefore, everything stops without the ability to cancel.

The location of stopall is: <ISC Directory>/bin.

stopdb Command

Description

This section provides the description and syntax for the stopdb command.

The stopdb command stops the database.

[ oL-10727-01
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M stopns Command

Syntax

stopdb [-y]
where:

-y indicates not to prompt before shutdown. If -y is not specified, you are prompted with the following
message: “Are you absolutely sure you want to stop the database?” You are then prompted to reply yes
or no.

The location of stopdb is: <ISC Directory>/bin.

stopns Command

Description

Syntax

This section provides the description and syntax for the stopns command.

The stopns command stops the name server.The startns and stopns commands deal with orbd.

stopns [-y]
where:

-y indicates not to prompt before shutdown. If -y is not specified, you are prompted with the following
message: “Are you absolutely sure you want to stop the nameserver?” You are then prompted to reply
yes or no.

The location of stopns is: <ISC Directory>/bin.

stopwd Command

Description

This section provides the description and syntax for the stopwd command.

The stopwd command stops the WatchDog and all ISC processes other than the name server and the
database.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Syntax

stopwd [-y] [-all]

where:

wdclient Command

-y indicates not to prompt before shutdown. If -y is not specified, you are prompted with the following
message: “Are you absolutely sure you want to stop the watchdog and all of its servers? Other users may
be using this system as well. No activity (for example: collections, performance monitoring,
provisioning) occurs until the system is restarted.” You are then prompted to reply yes or no.

-all indicates to stop all the hosts. This argument is only available to the master host.

The location of stopwd is: <ISC Directory>/bin.

wdclient Command

This section provides the description, syntax, and options (listed alphabetically) for the wdclient
subcommands. These subcommands are diagnostic tools. This section also describes the column format
of the output of each of the subcommands.

Note

~

Note

The location of wdclient is: </SC Directory>/bin.

The following are the wdclient subcommands:

e wdclient disk Subcommand, page 2-6

e wdclient group <group_name> Subcommand, page 2-6

e wdclient groups Subcommand, page 2-6

e wdclient health Subcommand, page 2-7

e wdclient hosts Subcommand, page 2-7

e wdclient restart Subcommand, page 2-8

e wdclient start Subcommand, page 2-8

e wdclient status Subcommand, page 2-9

Information Produced

Information Produced:
Information Produced:
Information Produced:
Information Produced:
Information Produced:

Information Produced:

: Name Column, page 2-9

State Column, page 2-10

Gen Column, page 2-11

Exec Time Column, page 2-11
PID Column, page 2-11
Success Column, page 2-11

Missed Column, page 2-11

e wdclient stop Subcommand, page 2-11

e wdclient syshealth Subcommand, page 2-12

If you enter wdclient -help, you receive a listing of all the wdclient subcommands.
If you enter wdclient -master -help, you receive a listing of all the wdclient -master subcommands.

[ oL-10727-01
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wdclient disk Subcommand

Description

Syntax

This section provides the description and syntax for the wdclient disk subcommand.

The wdclient disk subcommand gives the disk space statistics for the directories where ISC is installed.

wdclient [-master [-host <hostname>]] disk
where:

-master is an optional parameter that indicates to give the WatchDog information for the master ISC
host. If -master is not specified, only local information about the current host is given.

-host <hostname> is an optional parameter. <hostname> is the fully-qualified name of the remote host
on which the WatchDog is running. If this optional parameter is not specified, information from all the
hosts is returned.

wdclient group <group_name> Subcommand

Description

Syntax

This section provides the description and syntax for the wdclient group <group_name> subcommand.

The wdclient group <group_name> subcommand lists the servers in the specified server group. Server
groups provide a convenient way to start or stop a group of servers with a single command.

wdclient [-master [-host <hostname>]] group <group_name>
where:

-master is an optional parameter that indicates to give the WatchDog information for the master ISC
host. If -master is not specified, only local information about the current host is given.

-host <hostname> is an optional parameter. <hostname> is the fully-qualified name of the remote host
on which the WatchDog is running. If this optional parameter is not specified, information from all the
hosts is returned.

<group_name> is the name of a server group chosen from the list displayed by the wdclient groups
command.

wdclient groups Subcommand

This section provides the description and syntax for the wdclient groups subcommand.

Cisco IP Solution Center Infrastructure Reference, 4.2
m. oL-10727-01 |



| Chapter2 WatchDog Commands

Description

Syntax

wdclient Command

The wdclient groups subcommand lists all the active server groups.

wdclient [-master [-host <hostname>]] groups
where:

-master is an optional parameter that indicates to give the information for the master ISC host. If
-master is not specified, only local information about the current host is given.

-host <hostname> is an optional parameter. <hostname> is the fully-qualified name of the remote host
on which the WatchDog is running. If this optional parameter is not specified, information from all the
hosts is returned.

wdclient health Subcommand

Description

Syntax

This section provides the description and syntax for the wdclient health subcommand.

The wdclient health subcommand indicates whether all the servers are stable on the master ISC host.

wdclient health

wdclient hosts Subcommand

Description

Syntax

This section provides the description and syntax for the wdclient hosts subcommand.

The wdclient hosts subcommand returns the status of all the hosts including the master.

wdclient -master [-poll <seconds>] hosts
where:
-master is a required parameter that indicates to get the information from the master ISC host.

-poll <seconds> is an optional parameter. <seconds> is the number of seconds. A number other than
zero indicates that when new status data is available it is displayed every <seconds> seconds, where
<seconds> is the specified number of seconds. The default -poll value is zero (0), which shows the status
just once.

[ oL-10727-01
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wdclient restart Subcommand

This section provides the description and syntax for the wdclient restart subcommand.

Description

The wdclient restart subcommand restarts one or more servers. Any dependent servers are also
restarted.

)

Note It is not necessary to restart servers in a properly functioning system. The wdclient restart command
should only be run under the direction of Cisco Support.

Syntax

wdclient [-master [-host <hostname>]] restart [all | <server_name> | group <group_name>]
where:

-master is an optional parameter that indicates the restart operation should be performed on the master
ISC host. If -master is not specified, the restart operation is performed only on the local machine.

-host <hostname> is an optional parameter. <hostname> is the fully-qualified name of the remote host
on which the WatchDog is running. If this optional parameter is not specified, information from all the
hosts is returned.

You can choose one of the following arguments. If none are chosen, the default is all:
all is all servers. This is the default if no argument is specified.

<server_name> is the name of a server chosen from the list displayed by the wdclient status command.
See Table 2-1, “Servers and Their Functions,” for server descriptions.

group <group_name> is the term group followed by the name of a server group chosen from the list
displayed by the wdclient groups command.

wdclient start Subcommand

This section provides the description and syntax for the wdclient start subcommand.

Description

The wdclient start subcommand starts one or more servers. Other servers that depend on the specified
server(s) might also start.

~

Note It is not necessary to stop and start servers in a properly functioning system. The wdclient start
command should only be run under the direction of Cisco Support.
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Syntax

wdclient Command

wdclient [-master [-host <hostname>]] start [all | <server_name> | group <group_name>]
where:

-master is an optional parameter that indicates the start operation should be performed on the master
ISC host. If -master is not specified, the start operation is performed only on the local machine.

-host <hostname> is an optional parameter. <hostname> is the fully-qualified name of the remote host
on which the WatchDog is running. If this optional parameter is not specified, information from all the
hosts is returned.

You can choose one of the following arguments. If none are chosen, the default is all:
all is all servers. This is the default if no argument is specified.

<server_name> is the name of a server chosen from the list displayed by the wdclient status command.
See Table 2-1, “Servers and Their Functions,” for server descriptions.

group <group_name> is the name of a server group chosen from the list displayed by the wdclient
groups command.

wdclient status Subcommand

Description

Syntax

This section provides the description, syntax, and information produced for the wdclient status
subcommand.

The wdclient status subcommand lists all the servers and their states. See Table 2-1 on page 2-10,
“Servers and Their Functions,” for server descriptions. See Table 2-2 on page 2-10, “Valid States,” for
the list of all the states.

wdclient [-master [-host <hostname>] [-poll <seconds>]] status
where:

-master is an optional parameter that indicates to give the information for the master ISC host. If
-master is not specified, only local information about the current host is given.

-host <hostname> is an optional parameter. <hostname> is the fully-qualified name of the remote host
on which the WatchDog is running. If this optional parameter is not specified, information from all the
hosts is returned.

-poll <seconds> is an optional parameter. <seconds> is the number of seconds. A number other than
zero indicates that when new status data is available it is displayed every <seconds> seconds, where
<seconds> is the specified number of seconds. The default -poll value is zero (0), which shows the status
just once.

Information Produced: Name Column

The Name column provides the name of each of the servers. Table 2-1 provides a list of the servers and
a description of the function that each server provides.

[ oL-10727-01
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Table 2-1 Servers and Their Functions

Server Function

cnsserver Handles TIBCO messages from Cisco CNS IE2100 appliances and
takes appropriate actions.

cornerstonebridge Used for peer-to-peer communication with client applications
invoking auto-discovery commands.

dbpoller Monitors database server.

dispatcher Manages workers. Distributes work to other hosts (if any).

httpd Web server.

lockmanager Handles device locking so a router’s configuration is not modified
by multiple service requests at the same time.

nspoller Monitors name service.

scheduler Enables you to schedule tasks immediately or later in time, for
one-time or repeated execution.

worker Executes various ISC tasks/jobs such as Provisioning.

Information Produced: State Column

The State column provides the current state of the server. Table 2-2 provides a description of each of the
states in normal progression order.

Table 2-2

Valid States

State

Description

start_depends

This server has been asked to start, but is waiting for servers it
depends on to start. After all dependent servers have started,
this server transitions to the state of starting.

starting This server is currently starting. After a successful heartbeat
occurs, this server transitions to the state of started.
started This server is currently started and running.

stop_depends

This server is supposed to be stopped, but it is waiting for
servers it depends on to be stopped first.

stopping_gently

This server is in the process of stopping in a gentle fashion.
That is, it was notified that it is to stop.

stopping_hard

This server is in the process of being killed because either it did
not have a way to stop gently or because the gentle stop took too
long.

stopped

This server is stopped. The WatchDog either starts it again or
disables it if it has been frequently dying.

disabled_dependent

This server is disabled because one or more servers it depends
on are disabled. If all servers it depends on are started, this
server automatically starts.

] Cisco IP Solution Center Infrastructure Reference, 4.2

0L-10727-01 |



| Chapter2 WatchDog Commands

wdclient Command

Table 2-2 Valid States (continued)

State Description

disabled This server is disabled and must be manually restarted.

restart_delay This server is delaying before restarting. There is a short delay
after a server stops and before it is restarted again.

Information Produced: Gen Column

The Gen column provides the generation of the server. Each time the server is started, the generation is
incremented by 1.

Information Produced: Exec Time Column

The Exec Time column provides the date and time the server was last started.

Information Produced: PID Column

The PID column provides the UNIX process identifier for each server, except for dbpoller and nspoller.

Information Produced: Success Column

The Success column provides the number of successful heartbeats since the server was last started.
Heartbeats are used to verify that servers are functioning correctly.

Information Produced: Missed Column

The Missed column provides the number of missed heartbeats since the server was last started.

A few missed heartbeats could simply indicate the system was busy. However, more than a couple of
missed heartbeats per day could indicate a problem. See the logs to diagnose the reason.

Three missed heartbeats in a row is the default for restarting the server.

wdclient stop Subcommand

This section provides the description and syntax for the wdclient stop subcommand.

Description

The wdclient stop subcommand stops one or more servers. Other servers that depend on the specified
servers also stop.

)

Note It is not necessary to stop servers in a properly functioning system. The wdclient stop command should
only be run under the direction of Cisco Support.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Syntax

wdclient [-master [-host <hostname>]] stop [all | <server_name> | group <group_name>]
where:
-master is an optional parameter that indicates to perform the operation on the master ISC host.

-host <hostname> is an optional parameter. <hostname> is the fully-qualified name of the remote host
on which the WatchDog is running. If this optional parameter is not specified, information from all the
hosts is returned.

You can choose one of the following arguments. If none are chosen, the default is all.
all is all servers. This is the default if no argument is specified.

<server_name> is the name of a server chosen from the list displayed by the wdclient status command.
See Table 2-1, “Servers and Their Functions,” for server descriptions.

group <group_name> is the name of a server group chosen from the list displayed by the wdclient
groups command.

wdclient syshealth Subcommand

This section provides the description and syntax for the wdclient syshealth subcommand.

Description
The wdclient syshealth subcommand gives the system health information about the entire system,
including the master and the hosts. Their health is listed either as good, which means, running, or not
good, which means, not running.

Syntax

wdclient -master [-host <hostname>] syshealth
where:
-master is a required parameter that indicates to get the information from the master ISC host.

-host <hostname> is an optional parameter. <hostname> is the fully-qualified name of the remote host
on which the WatchDog is running If this optional parameter is not specified, information from all the
hosts is returned.

Cisco IP Solution Center Infrastructure Reference, 4.2
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From the Home window of Cisco IP Solution Center (ISC), which appears upon logging in, click the

Service Inventory tab and a window as shown in Figure 3-1, “Service Inventory Selections Window,’

appears.

bl

Figure 3-1 Service Inventory Selections Window
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Click on Inventory and Connection Manager and a window as shown in Figure 3-2, “Inventory and
Connection Manager Selections Window,” appears.

[ oL-10727-01
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Figure 3-2 Inventory and Connection Manager Selections Window
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From the Inventory and Connection Manager window, you can choose any of the following functions:

¢ Service Requests, page 3-2 Create, deploy, and manage Service Requests (SRs).

e Traffic Engineering Management, page 3-5 Create, deploy, and manage elements of Traffic
Engineering Management.

¢ Inventory Manager, page 3-5 Bulk-manage inventory elements.
¢ Topology Tool, page 3-37 View topology maps.

¢ Devices, page 3-70 Create and manage Devices.

e Device Groups, page 3-101 Create and manage Device Groups.
¢ Customers, page 3-107 Create and manage Customers.

e Providers, page 3-115 Create and manage Providers.

¢ Resource Pools, page 3-122 Create and manage pools for IP address, Multicast address, Route
Distinguisher, Route Target, Site of Origin, VC ID, and VLAN.

¢ CE Routing Communities, page 3-132 Create and manage CE Routing Communities.
e VPNs, page 3-136 Create and manage VPNs.
e Named Physical Circuits, page 3-140 Create and manage Named Physical Circuits (NPCs).

Service Requests

Service Requests are explained in each of the User Guides for each of the applicable licensed services.

Table 3-1, “Summary of Cisco IP Solution Center Service Request States,” describes each ISC service
request state. The states are listed in alphabetical order.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-3, “Service Request States Transition Diagram,” shows the transitions of states.

Table 3-1

Summary of Cisco IP Solution Center Service Request States

Service Request State

Description

Broken

(valid only for L2TPv3
and MPLS services)

The router is correctly configured but the service is unavailable (due to a
broken cable or Layer 2 problem, for example).

An MPLS service request moves to Broken if the auditor finds the routing
and forwarding tables for this service, but they do not match the service
intent.

Closed

A service request moves to Closed if the service request should no longer be
used during the provisioning or auditing process. A service request moves to
the Closed state only upon successful audit of a decommission service
request. ISC does not remove a service request from the database to allow
for extended auditing. Only a specific administrator purge action results in
service requests being removed.

Deployed

A service request moves to Deployed if the intention of the service request
is found in the router configuration file. Deployed indicates that the
configuration file has been downloaded to the router, and the intent of the
request has been verified at the configuration level. That is, ISC downloaded

the configlets to the routers and the service request passed the audit process.

Failed Audit

This state indicates that ISC downloaded the configlet to the router
successfully, but the service request did not pass the audit. Therefore, the
service did not move to the Deployed state. The Failed Audit state is
initiated from the Pending state. After a service request is deployed
successfully, it cannot re-enter the Failed Audit state (except if the service
request is redeployed).

Failed Deploy

The cause for a Failed Deploy status is that DCS reports that either the
upload of the initial configuration file from the routers failed or the
download of the configuration update to the routers failed (due to lost
connection, faulty password, and so on).

Functional

(valid only for L2TPv3
and MPLS services)

An MPLS service request moves to Functional when the auditor finds the
VPN routing and forwarding tables (VRF) for this service and they match
with the service intent. This state requires that both the configuration file

audit and the routing audit are successful.

Invalid

Invalid indicates that the service request information is incorrect in some
way. A service request moves to Invalid if the request was either internally
inconsistent or not consistent with the rest of the existing network/router
configurations (for example, no more interfaces were available on the
router). The Provisioning Driver cannot generate configuration updates to
service this request.

Lost

A service request moves to Lost when the Auditor cannot find a
configuration-level verification of intent in the router configuration files.
The service request was in the Deployed state, but now some or all router
configuration information is missing. A service request can move to the Lost
state only when the service request had been Deployed.

[ oL-10727-01
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Table 3-1 Summary of Cisco IP Solution Center Service Request States (continued)

Service Request State | Description

Pending A service request moves to Pending when the Provisioning Driver
determines that the request looks consistent and was able to generate the
required configuration updates for this request. Pending indicates that the
service request has generated the configuration updates and the
configuration updates are successfully downloaded to the routers.

The Auditor regards pending service requests as new requests and begins the
audit. If the service has been freshly provisioned and not yet audited, it is not
an error (pending audit). However, if an audit is performed and the service is
still pending, it is in an error state.

Requested If the service is newly entered and not yet deployed, it is not an error.
However, if a Deploy is done and it remains Requested, the service is in an
error state.

Wait Deploy This service request state pertains only when downloading configlets to a
Cisco CNS-CE server, such as a Cisco CNS IE2100 appliance. Wait Deploy
indicates that the configlet has been generated, but it has not been
downloaded to the Cisco CNS-CE server because the device is not currently
online. The configlet is staged in the repository until such time as the Cisco
CNS-CE server notifies ISC that it is up. Configlets in the Wait Deploy state
are then downloaded to the Cisco CNS-CE server.

Figure 3-3 Service Request States Transition Diagram
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Traffic Engineering Management

Traffic Engineering Management allows you to create, deploy, and manage elements of Traffic
Engineering Management. This is explained in detail in the Cisco IP Solution Center Traffic Engineering
Management User Guide, 4.2.

Inventory Manager

Inventory Manager provides a method of managing mass changes to inventory and service model data in
the ISC provisioning process. In this process, Inventory Manager enables an operator to import
network-specific data into the ISC Repository (Repository) in bulk mode.

Inventory Manager performs three primary functions:

¢ Imports devices from configuration files and configures CPEs and PEs by associating devices with
a Customer or Provider.

e Edits devices, CPEs or PEs stored in the ISC repository.

e Assigns a device to a provider or customer.

Accessing the Inventory Manager Window

To access the Inventory Manager, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Inventory Manager to access the
Inventory Manager window shown in Figure 3-4.

Figure 3-4 Inventory Manager Window
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From the Inventory Manager window you can import devices or open a list of devices, providers or
customers.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Importing Devices

To import a device, it must be in an existing directory on the same server that is running ISC. After a
device is imported into the ISC repository, you can assign it to a customer or provider, if desired.

To import devices with configuration files, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Inventory Manager.
Step2  Click the Import Devices button.

The Import Devices from Configuration Files window appears, as shown in Figure 3-5.

Figure 3-5 Import Devices from Configuration Files Window
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Step3  Click the Select button.

The Select Device Configuration File dialog box appears, as shown in Figure 3-6.

Figure 3-6  Select Device Configuration File Dialog
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Directonys

| OK | | Cancel
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Step4 At the Select Device Configuration File dialog box, enter the directory on the ISC server where the
configuration files reside.

Step5  The Import Devices from Configuration Files window appears.

Step6  Select as many of the configuration files as you want to import by checking the box to the left of the
Configuration File name.

Step7  If you want to import devices from more than one directory, you can repeat Steps 3 through 6.
Step8  Click Import.
The General Attributes window appears with the added information.

Step9  Click Save.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Opening and Editing Devices

Step 1
Step 2

Step 3

Step 4

Step 5

Inventory Manager W

To open device configuration files to bulk edit, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Inventory Manager.

Click the Open button.

The Open drop-down list appears. The Open options include the following:

¢ Devices—Every network element that ISC manages.

~

Note To edit a PE, Open Provider, not Open Devices.

¢ Provider—PEs belonging to a specific provider.
e Customer—CEs belonging to a specific customer.

Select Devices.

The Select Device window appears, as shown in Figure 3-7.

Figure 3-7 Select Devices Window
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Select a device to open by checking the check box to the left of the Device Name. You can select more

than one device to open.

Click the Select button.

The General Attributes window appears containing information on the selected devices, as shown in

Figure 3-8.

[ oL-10727-01
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Figure 3-8 General Attributes Devices Window
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Step6  To view specific attributes click the Attributes button.

The Attributes options appear, as shown in Figure 3-9.

Figure 3-9 Attributes Options Window
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Step7  Select the type of attribute to display.
See the following sections for descriptions of these attribute fields.
e General Attributes Devices, page 3-9
e Password Attributes Devices, page 3-10
e SNMP Attributes Devices, page 3-11
e (NS Attributes Devices, page 3-12

Cisco IP Solution Center Infrastructure Reference, 4.2
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e Platform Attributes Devices, page 3-13
e Interfaces Devices, page 3-13
Step8  To bulk edit an attribute, do the following:
a. Check the one or more boxes to the left of the Device Name.
b. Check the check box above the attribute name column.
c. Click the Edit button.
Step9  Enter the changes you want to make.
Step10  Click Save.

The changes are saved.

General Attributes Devices

The General Attributes Devices window appears, as shown in Figure 3-10.

Figure 3-10 General Attributes Devices Window
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The General Attributes Devices window contains the following:

¢ Host —Must begin with a letter, digit, or underscore followed by letters, digits, underscores, spaces,
hyphens, or dots ending with a letter, digit, or underscore. This field is required and must match the
name configured on the target router device. Limited to 256 characters.

e Device Type—The device type includes the following devices:

Cisco Router

Catalyst OS device
Terminal server

IE2100 (Cisco CNS appliance)

Cisco IP Solution Center Infrastructure Reference, 4.2
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¢ Description—Can contain any pertinent information about the device, such as the type of device,
its location, or other information that might be helpful to service provider operators. Limited to 80
characters.

e Management IP Address—Valid IP address of the device that ISC uses to configure the target
router device. This IP address must be reachable from the ISC host.

e Device Domain Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. The name must
match the domain name on the target router device.

¢ Terminal Session Protocol—Configures the method of communication between ISC and the
device. Choices include: Telnet, Secure Shell (SSH), CNS, and RSH. Default: Telnet.

¢ Config Access Protocol—Administers the access protocol for config upload and download.
Choices include: Terminal, TFTP, FTP, and RCP. Default: Terminal

¢ Device Groups—Lists the names of the Device Groups. You can add and modify Device Groups in
this column.

Password Attributes Devices

The Password Attributes Devices window appears, as shown in Figure 3-11.

Figure 3-11 Password Attributes Devices Window
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The Password Attributes Devices window contains the following:

¢ Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

¢ Login User—Not required by ISC. However, collection and upload/download will not function
without the Login User and Login Password, as ISC will not be able to access the device. Should
match what is configured on the target router device. Limited to 80 characters.

¢ Login Password—Displayed as stars (*). Not required by ISC. However, collection and
upload/download will not function without the Login User and Login Password, as ISC will not be
able to access the device. Should match what is configured on the target router device. Limited to
80 characters.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Enable User—Not required by ISC. However, collection and upload/download only function if the
Login User has sufficient privileges to configure the router in EXEC mode. Should match what is
configured on the target router device. Limited to 80 characters.

Enable Password—Displayed as stars (*). Not required by ISC. However, collection and
upload/download only function if the Login User has sufficient privileges to configure the router in
EXEC mode. Should match what is configured on the target router device. Limited to 80 characters.

Community String RO —Many tasks use SNMP to access the device. This field must match what
is configured on the target router device. Limited to 80 characters.

Community String RW— Many tasks use SNMP to access the device. This field must match what
is configured on the target router device. Limited to 80 characters.

SNMP Attributes Devices

The SNMP Attributes Devices window appears, as shown in Figure 3-12.

Figure 3-12 SNMP Attributes Devices Window
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The SNMP Attributes Devices window contains the following:

Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

SNMP Version—Choices include: SNMP v1/v2c, and SNMP v3. The default value is determined
by the setting in the DCPL property SnmpService\default SNMPVersion. (See Appendix C,
“Property Settings” for more details.)

Security Level—Choices include: No Authentication/No Encryption, Authentication/No
Encryption, and Authentication/Encryption. Default: No Authentication/No Encryption.

Authentication User Name—User name configured on the specified device router. User must have
permission to the object identification numbers (OIDs) specified in the security request (that is,
write permission for a set request, and read permission for a get request). Should match what is
configured on the target router device. Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Limited to 80 characters.

[ oL-10727-01
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Authentication Password—Displayed as stars (*). Should be provisioned if the SNMP Security
Level is Authentication/No Encryption or Authentication/Encryption. Should match what is
configured on the target router device. Limited to 80 characters.

Authentication Algorithm—Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Choices include: None, MDS5, and
SHA. Default: None.

Encryption Password—Displayed as stars (¥). In previous versions, this field was called Privacy
Password. Should match what is configured on the target router device. Should be provisioned if the
SNMP Security Level is Authentication/Encryption. Limited to 80 characters.

Encryption Algorithm—In previous versions, this field was called Privacy Protocol. Should be
provisioned if the SNMP Security Level is Authentication/Encryption. Choices include: None and
DES 56. Default: None.

CNS Attributes Devices

The CNS Attributes Devices window appears, as shown in Figure 3-13.

Figure 3-13 CNS Attributes Devices Window

CHS Attributes

CHS Attributes - Devices

Show entries with Host matching I* |M
Showing 1 - 3 of 3 records
# I_ Device Name IE21 UIU-N i I- I- i I- i
ame Device State Event Identification ZME Identification

1. pet Maone Active Host Mame
2. pe3 MHaone Active Host Mame
3. swi Maone Active Host Mame

Rows perpage:lm | 14 Goto page:|1—uf1 [ [0

| Attributes | | Assign CEPE | | | | Save |

149440

The CNS Attributes Devices window contains the following:

Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

IE2100 Name—Disabled unless the Device-State field is Inactive or the Terminal Session Protocol
field is CNS. A valid Cisco CNS IE2100 appliance must be selected if the Terminal Session
Protocol is CNS. Choices include: None and the list of existing Cisco CNS IE2100 appliance names.
Default: None.

Device State—Choices include: Active and Inactive. Active indicates that the router has been
plugged on the network and can be part of ISC tasks such as collect config and provisioning. Inactive
indicates the router has not been plugged-in. Default: Active.

Event Identification—Indicates whether the CNS Identification field contains a HOST NAME or
CNS ID. Default: HOST NAME.

CNS Identification—Required if the Event Identification field is set to CNS ID. Can contain letters,
numbers, and these punctuation characters: period, underscore, and dash.
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Platform Attributes Devices

The Platform Attributes Devices window appears, as shown in Figure 3-14.

Figure 3-14 Platform Attributes Devices Window

Platform Attributes

Platform Attributes - Devices

Shaws entries with Host matching I* | Find |
Showing 1- 3 of 3 records
_ || u u
# | Device  piatfigrm Software Image Name Serial Number
ame
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Rows perpage:l 10 = 1] Goto page:|1 of 1 B 0
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The Platform Attributes Devices window contains the following:

¢ Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

¢ Platform—Should match what is configured on the target router device. Limited to 80 characters.

¢ Software Version—Should match what is configured on the target router device. Limited to 80
characters.

¢ Image Name—Should match what is configured on the target router device. Limited to 80
characters.

e Serial Number—Should match what is configured on the target router device. Limited to 80
characters.

Interfaces Devices

The Interfaces Devices window appears, as shown in Figure 3-15.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-15 Interfaces Devices Window

Interface Attributes

Interfaces - Devices

Show entries with Host matching I Find |

Showing 1 - 10 of 39 records

i v " I [ I
ost Interface Mame Interface Type Interface Description Interface IP Address Encapsulation  Port Type
1. [ pel ATM2I0 atrm Mone
2. pel Ethernet4/0 ethernet 172.29.146.21/26 Mone
3. [ pel Ethernetdi1 ethernet Mone
4. [ pel Ethernetdr2 ethernet Mone
5 [ pel Ethernetdr3 ethernet Mone
6. [ pel FastEthernetfd  fastethernet L4: Link To sw3 Mone
7. pel FastEtherneton fastethernet Mone
B nel LoopbackD loopback For BGP neighbor, do not 10.8.0.101732 Mone
rermaove
9. [ pel Serial3i0 serial 10.8.0.2130 Mone
100 [ pel Serialan serial Mone
Rows perpage:lﬂ 144 Goto page:|1_0f4 ([0
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The Interfaces Devices window contains the following:

e Host —Must begin with a letter, digit, or underscore followed by letters, digits, underscores, spaces,
hyphens, or dots ending with a letter, digit, or underscore. This field is required and must match the
name configured on the target router device. Limited to 256 characters.

¢ Interface Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required.
Limited to 256 characters.

e Interface Type—Specifies the type of interface. It is a display-only field.

¢ Interface Description—Description of the interface. This field is display-only. Field is populated
by importing a configuration file.

e Interface IP Address—IP address associated with this interface.

¢ Encapsulation—The Layer 2 Encapsulation for this device. It is a display-only field. Choices
include:

- DEFAULT
- DOTIQ

- ETHERNET

- ISL

- FRAME_RELAY

- FRAME_RELAY_IETF
- HDLC

- PPP

- ATM

- AALS5SNAP
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AALO
AALS
AALSMUX
AALSNLPID
AAL2
ENCAP_QinQ
GRE

Inventory Manager W

e Port Type—Choices include: Access, Trunk, Routed, and None.

Opening and Editing PEs

Step 1
Step 2

Step 3

Step 4
Step 5

To open PE files to bulk edit, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Inventory Manager.

Click the Open button.

The Open drop-down list appears. The Open options include the following:

e Devices—Every network element that ISC manages.

¢ Provider—PEs belonging to a specific provider.

e Customer—CEs belonging to a specific customer.

Select Provider.

The Select Provider window appears, as shown in Figure 3-16.

Figure 3-16 Select Provider Window

I'.EJ Select Provider - Cisco Systems, Inc.

=101 %]

Show Providers with Provider Name matching Ibk

#

Provider Hame

| Find

Showing 1- 1 of 1 record

1. & Provideri

Rows per page: I 10 j 14 Goto page:l1 of 1 [ [0

| Select || Cancel |
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Select a provider by clicking the radio button to the left of the Provider Name.
Click the Select button.

The General Attributes window appears showing the PEs assigned to the selected provider, as shown in
Figure 3-17.

[ oL-10727-01
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Figure 3-17 General Attributes Provider Window

Inventory Manager

. pel Cisco 105 Default Default Device-Group-1
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Device
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Step6  To view specific attributes click the Attributes button.

The Attributes options appear, as shown in Figure 3-18.

Figure 3-18 Attributes Options Window

Inventory Manager [}

1 |:| e Cisco 05 Defautt Default groupd
: Device
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Device
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Step 7

Step 8

Step 9
Step 10

Inventory Manager

Select the type of attribute to display.
See the following sections for descriptions of these attribute fields.
e General Attributes Provider, page 3-17
e Password Attributes Provider, page 3-18
e SNMP Attributes Provider, page 3-20
e (NS Attributes Provider, page 3-21
e Platform Attributes Provider, page 3-22
e PE Attributes Provider, page 3-23
¢ Interfaces Provider, page 3-24
To bulk edit an attribute, do the following:
a. Check the one or more boxes to the left of the Host or Device Name.
b. Check the check box above the attribute name column.
c. Click the Edit button.
Enter the changes you want to make.
Click Save.

The changes are saved.

General Attributes Provider

The General Attributes Provider window appears, as shown in Figure 3-19.

Figure 3-19 General Attributes Provider Window

Inventory Manager

General Attributes - PEs for Provider Provider1

Show entries with Host matehing I’" | Find |
Showing 1 - 5 of 5 records
, | I I I | I
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IF Address Mame Session ACCESS
Fratacal Pratacal
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' Device
2| m pe3 Cisco 105 Cefault Default Cevice-Group-2
' Device
S Cisco 105 Default Default
a Device
1 3 Cigca 105 Default Default Device-Graup-1
' Device
5 Swrd Cisco 105 Default Default Device-Group-2
’ Device
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Attributes v || || Save |
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The General Attributes Provider window contains the following:

Host —Must begin with a letter, digit, or underscore followed by letters, digits, underscores, spaces,
hyphens, or dots ending with a letter, digit, or underscore. This field is required and must match the
name configured on the target router device. Limited to 256 characters.

Device Type—The device type includes the following devices:
- Cisco Router
— Catalyst OS device
— Terminal server
- IE2100 (Cisco CNS appliance)

Description—Can contain any pertinent information about the device, such as the type of device,
its location, or other information that might be helpful to service provider operators. Limited to 80
characters.

Management IP Address—Valid IP address of the device that ISC uses to configure the target
router device. This IP address must be reachable from the ISC host.

Device Domain Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. The name must
match the domain name on the target router device.

Terminal Session Protocol—Configures the method of communication between ISC and the
device. Choices include: Telnet, Secure Shell (SSH), CNS, and RSH. Default: Telnet.

Config Access Protocol—Administers the access protocol for config upload and download.
Choices include: Terminal, TFTP, FTP, and RCP. Default: Terminal

Device Groups—Lists the names of the Device Groups. You can add and modify Device Groups in
this column.

Password Attributes Provider

The Password Attributes Provider window appears, as shown in Figure 3-20.
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Figure 3-20 Password Attributes Provider Window

Password Attributes

Password Attributes - PES for Provider Provider 1
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The Password Attributes Provider window contains the following:

Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

Login User—Not required by ISC. However, collection and upload/download will not function
without the Login User and Login Password, as ISC will not be able to access the device. Should
match what is configured on the target router device. Limited to 80 characters.

Login Password—Displayed as stars (*). Not required by ISC. However, collection and
upload/download will not function without the Login User and Login Password, as ISC will not be
able to access the device. Should match what is configured on the target router device. Limited to
80 characters.

Enable User—Not required by ISC. However, collection and upload/download only function if the
Login User has sufficient privileges to configure the router in EXEC mode. Should match what is
configured on the target router device. Limited to 80 characters.

Enable Password—Displayed as stars (*). Not required by ISC. However, collection and
upload/download only function if the Login User has sufficient privileges to configure the router in
EXEC mode. Should match what is configured on the target router device. Limited to 80 characters.

Community String RO —Many tasks use SNMP to access the device. This field must match what
is configured on the target router device. Limited to 80 characters.

Community String RW— Many tasks use SNMP to access the device. This field must match what
is configured on the target router device. Limited to 80 characters.

[ oL-10727-01
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SNMP Attributes Provider

The SNMP Attributes Provider window appears, as shown in Figure 3-21.

Figure 3-21 SNMP Attributes Provider Window

SNMP Attributes

SHMP Attributes - PEs for Provider Provider1

Show entries with Host matching I’" |M
Showing 1 -5 of 9 records
| I u u | I u
# [ Device Name sump version Security Level  Authentication  Authentication  Authentication  Encryption Encryption
User Mame Password Algorithm FPassyard Algarithm
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4. [ =w3 Default Default Mane Mane
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| Attributes ¥ | | | | Save |
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The SNMP Attributes Provider window contains the following:

e Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

e SNMP Version—Choices include: SNMP v1/v2c, and SNMP v3. The default value is determined
by the setting in the DCPL property SnmpService\default SNMPVersion. (See Appendix C,
“Property Settings” for more details.)

¢ Security Level—Choices include: No Authentication/No Encryption, Authentication/No
Encryption, and Authentication/Encryption. Default: No Authentication/No Encryption.

¢ Authentication User Name—User name configured on the specified device router. User must have
permission to the object identification numbers (OIDs) specified in the security request (that is,
write permission for a set request, and read permission for a get request). Should match what is
configured on the target router device. Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Limited to 80 characters.

e Authentication Password—Displayed as stars (¥*). Should be provisioned if the SNMP Security
Level is Authentication/No Encryption or Authentication/Encryption. Should match what is
configured on the target router device. Limited to 80 characters.

e Authentication Algorithm—Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Choices include: None, MDS5, and
SHA. Default: None.

¢ Encryption Password—Displayed as stars (*). In previous versions, this field was called Privacy
Password. Should match what is configured on the target router device. Should be provisioned if the
SNMP Security Level is Authentication/Encryption. Limited to 80 characters.

¢ Encryption Algorithm—In previous versions, this field was called Privacy Protocol. Should be
provisioned if the SNMP Security Level is Authentication/Encryption. Choices include: None and
DES 56. Default: None.

Cisco IP Solution Center Infrastructure Reference, 4.2
m. oL-10727-01 |




| Chapter3

Service Inventory — Inventory and Connection Manager

Inventory Manager W

CNS Attributes Provider

The CNS Attributes Provider window appears, as shown in Figure 3-22.

Figure 3-22 CNS Attributes Provider Window

CHS Attributes

CHNS Attributes - PEs for Provider Provider 1

Show entries with Host matching r‘ |M
Showing 1- 9 of 4 recards
il Device Name |E21D|D-N -I- I-- i I-- i
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The CNS Attributes Provider window contains the following:

Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

IE2100 Name—Disabled unless the Device-State field is Inactive or the Terminal Session Protocol
field is CNS. A valid Cisco CNS IE2100 appliance must be selected if the Terminal Session
Protocol is CNS. Choices include: None and the list of existing Cisco CNS IE2100 appliance names.
Default: None.

Device State—Choices include: Active and Inactive. Active indicates that the router has been
plugged on the network and can be part of ISC tasks such as collect config and provisioning. Inactive
indicates the router has not been plugged-in. Default: Active.

Event Identification—Indicates whether the CNS Identification field contains a HOST NAME or
CNS ID. Default: HOST NAME.

CNS Identification—Required if the Event Identification field is set to CNS ID. Can contain letters,
numbers, and these punctuation characters: period, underscore, and dash.

[ oL-10727-01
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Platform Attributes Provider

The Platform Attributes Provider window appears, as shown in Figure 3-23.

Figure 3-23 Platform Attributes Provider Window

Platform Attributes
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The Platform Provider window contains the following:

e Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

¢ Platform—Should match what is configured on the target router device. Limited to 80 characters.

¢ Software Version—Should match what is configured on the target router device. Limited to 80
characters.

¢ Image Name—Should match what is configured on the target router device. Limited to 80
characters.

e Serial Number—Should match what is configured on the target router device. Limited to 80
characters.
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PE Attributes Provider

The PE Attributes Provider window appears, as shown in Figure 3-24.

Figure 3-24 PE Attributes Provider Window
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The PE Attributes Provider window contains the following:

Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

Provider—Lists the names of providers. Must begin with a letter. Can contain letters, numbers, and
these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can sort
the list by provider name.

Region—Lists the names of regions. Must begin with a letter. Can contain letters, numbers, and
these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can sort
the list by region name.

Role—Choices include: N-PE, U-PE, P, PE_AGG.

Loopback Interface—Loopback address is the IP address of any loopback interface on the device.
You can select one of the loopback interfaces for this field and use the IP address on that loopback
interface.

Managed—Provisioned by ISC. Check the check box for yes. Default is no.

[ oL-10727-01
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Interfaces Provider

The Interfaces Provider window appears, as shown in Figure 3-25.

Figure 3-25 Interfaces Provider Window
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The Interfaces Provider window contains the following:

Host —Must begin with a letter, digit, or underscore followed by letters, digits, underscores, spaces,
hyphens, or dots ending with a letter, digit, or underscore. This field is required and must match the
name configured on the target router device. Limited to 256 characters.

Interface Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required.

Limited to 256 characters.

Interface Type—Specifies the type of interface. It is a display-only field.

Interface Description—Description of the interface. This field is display-only. Field is populated
by importing a configuration file.

Interface IP Address—IP address associated with this interface.

Encapsulation—The Layer 2 Encapsulation for this device. It is a display-only field. Choices

include:

- DEFAULT

- DOTI1Q

- ETHERNET

- ISL

- FRAME_RELAY
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- FRAME_RELAY_IETF
- HDLC
- PPP
- ATM
— AALSSNAP
- AALO
- AALS
- AALSMUX
- AALSNLPID
- AAL2
- ENCAP_QinQ
- GRE
e Port Type—Choices include: Access, Trunk, Routed, and None.

Opening and Editing CEs

Step 1
Step 2

Step 3

To open CE files to bulk edit, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Inventory Manager.

Click the Open button.

The Open drop-down list appears. The Open options include the following:
¢ Devices—Every network element that ISC manages.
¢ Provider—PEs belonging to a specific provider.
e Customer—CEs belonging to a specific customer.

Select Customer.

The Select Customer window appears, as shown in Figure 3-26.
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Figure 3-26 Select Customer Window
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Step4d  Select a customer by clicking the radio button to the left of the Customer Name.
Step5  Click the Select button.
The General Attributes window appears showing the CEs assigned to the selected customer, as shown in
Figure 3-27.
Figure 3-27 General Attributes Customer Window
Inventory Manager
General Attributes - CEs for Customer Customer1
Show entries with Host matching I | Find |
Showing 1 - 3 of 3 records
: u u u u u u
A Host Device Type Description Management  Device Domain Terminal  Config Access Device Groups
IP Address MName Session Frotocol
Frotocol
cel Cisco 105 Default Default
.| Device
2| ced Cisco 105 Default Default Device-Group-1
: Device
Al celd Cisco 105 Default Default Device-Group-2
’ Device
Rows perpage:lm | 144 Goto page:|1 of 1 [ B0
| atributes o || Eat || sawe | 8
S
Step6  To view specific attributes click the Attributes button.

The Attributes options appear, as shown in Figure 3-28.
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Step 7

Step 8

Step 9
Step 10

Inventory Manager W

Figure 3-28 Attributes Options Window
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Select the type of attribute to display.

See the following sections for descriptions of these attribute fields.

General Attributes Customer, page 3-28
Password Attributes Customer, page 3-29
SNMP Attributes Customer, page 3-30
CNS Attributes Customer, page 3-31
Platform Attributes Customer, page 3-32
CPE Attributes Customer, page 3-33

Interfaces Customer, page 3-34

To bulk edit an attribute, do the following:

a.
b.

C.

Check the one or more boxes to the left of the Host or Device Name.
Check the check box above the attribute name column.

Click the Edit button.

Enter the changes you want to make.
Click Save.

The changes are saved.

[ oL-10727-01

Cisco IP Solution Center Infrastructure Reference, 4.2 B



Chapter3  Service Inventory — Inventory and Connection Manager |

M Inventory Manager

General Attributes Customer

The General Attributes Customer window appears, as shown in Figure 3-29.

Figure 3-29 General Attributes Customer Window
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The General Attributes Customer window contains the following:

Host —Must begin with a letter, digit, or underscore followed by letters, digits, underscores, spaces,
hyphens, or dots ending with a letter, digit, or underscore. This field is required and must match the
name configured on the target router device. Limited to 256 characters.

Device Type—The device type includes the following devices:
- Cisco Router
— Catalyst OS device
— Terminal server
- IE2100 (Cisco CNS appliance)

Description—Can contain any pertinent information about the device, such as the type of device,
its location, or other information that might be helpful to service provider operators. Limited to 80
characters.

Management IP Address—Valid IP address of the device that ISC uses to configure the target
router device. This IP address must be reachable from the ISC host.

Device Domain Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. The name must
match the domain name on the target router device.

Terminal Session Protocol—Configures the method of communication between ISC and the
device. Choices include: Telnet, Secure Shell (SSH), CNS, and RSH. Default: Telnet.

Config Access Protocol—Administers the access protocol for config upload and download.
Choices include: Terminal, TFTP, FTP, and RCP. Default: Terminal

Device Groups—Lists the names of the Device Groups. You can add and modify Device Groups in
this column.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Password Attributes Customer

The Password Attributes Customer window appears, as shown in Figure 3-30.

Figure 3-30 Password Attributes Provider Window

Password Attributes

Password Attributes - CEs for Customer Customer1

Show entries with Host matching I | Find |

Showing 1 - 3 of 3 records

: u u u u u u
# [ Device Login User Login Password Enahle User Enahle Passward — Community String  Community String
Mame RO =]
1. ce3 RIS [T public private
2. [ ced [ [ public private
3. cel3 RIS [T public private
Rows perpage:lm | 1<) Gota page:|1 of 1 [0
| Attributes ¥ | | | | Save |
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The Password Attributes Customer window contains the following:

Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

Login User—Not required by ISC. However, collection and upload/download will not function
without the Login User and Login Password, as ISC will not be able to access the device. Should
match what is configured on the target router device. Limited to 80 characters.

Login Password—Displayed as stars (*). Not required by ISC. However, collection and
upload/download will not function without the Login User and Login Password, as ISC will not be
able to access the device. Should match what is configured on the target router device. Limited to
80 characters.

Enable User—Not required by ISC. However, collection and upload/download only function if the
Login User has sufficient privileges to configure the router in EXEC mode. Should match what is
configured on the target router device. Limited to 80 characters.

Enable Password—Displayed as stars (*). Not required by ISC. However, collection and
upload/download only function if the Login User has sufficient privileges to configure the router in
EXEC mode. Should match what is configured on the target router device. Limited to 80 characters.

Community String RO —Many tasks use SNMP to access the device. This field must match what
is configured on the target router device. Limited to 80 characters.

Community String RW— Many tasks use SNMP to access the device. This field must match what
is configured on the target router device. Limited to 80 characters.

[ oL-10727-01
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SNMP Attributes Customer

The SNMP Attributes Customer window appears, as shown in Figure 3-31.

Figure 3-31 SNMP Attributes Customer Window

SHMP Attributes

SHMP Attributes - CEs for Customer Customer1

Show entries with Host matching I | Find |

Showing 1 - 3 of 3 records

_ I I I I I I I
# [ Device Mame  cymPversion  Security Level  Authentication  Authentication  Authentication Encryptian Encryptian
User Mame Fassword Algorithm Fassword Algorithm
1. ce3 Default Default Maone Maone
2. [ ced Default Default Mone Mone
3. cel3 Default Default Maone Maone

1<) Gota page:|1 of 1 [0

Rowg perpage:l 0

| Attributes || || Save |
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The SNMP Attributes Customer window contains the following:

e Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

e SNMP Version—Choices include: SNMP v1/v2c, and SNMP v3. The default value is determined
by the setting in the DCPL property SnmpService\default SNMPVersion. (See Appendix C,
“Property Settings” for more details.)

¢ Security Level—Choices include: No Authentication/No Encryption, Authentication/No
Encryption, and Authentication/Encryption. Default: No Authentication/No Encryption.

¢ Authentication User Name—User name configured on the specified device router. User must have
permission to the object identification numbers (OIDs) specified in the security request (that is,
write permission for a set request, and read permission for a get request). Should match what is
configured on the target router device. Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Limited to 80 characters.

¢ Authentication Password—Displayed as stars (*). Should be provisioned if the SNMP Security
Level is Authentication/No Encryption or Authentication/Encryption. Should match what is
configured on the target router device. Limited to 80 characters.

e Authentication Algorithm—Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Choices include: None, MDS5, and
SHA. Default: None.

¢ Encryption Password—Displayed as stars (*). In previous versions, this field was called Privacy
Password. Should match what is configured on the target router device. Should be provisioned if the
SNMP Security Level is Authentication/Encryption. Limited to 80 characters.

e Encryption Algorithm—In previous versions, this field was called Privacy Protocol. Should be
provisioned if the SNMP Security Level is Authentication/Encryption. Choices include: None and
DES 56. Default: None.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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The CNS Attributes Customer window appears, as shown in Figure 3-32.

Figure 3-32 CNS Attributes Customer Window

CHS Attributes

CNS attributes - CEs for Customer Customer1

Show entries with Host matching I | Find |

Showing 1 - 3 of 3 records

- _ I I I I
Device Name IE2100 Mame Dievice State Ewant Identification CHE Identification
1. ce3 Maone Active Host Mame
2. [ ced Mone Active Host Mame
3. cel3 Maone Active Host Mame
Rows perpage:lm | 1<) Gota page:|1 of 1 [0
| Attributes ¥ || || Save |
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The CNS Attributes Customer window contains the following:

¢ Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

¢ JE2100 Name—Disabled unless the Device-State field is Inactive or the Terminal Session Protocol
field is CNS. A valid Cisco CNS IE2100 appliance must be selected if the Terminal Session
Protocol is CNS. Choices include: None and the list of existing Cisco CNS IE2100 appliance names.
Default: None.

¢ Device State—Choices include: Active and Inactive. Active indicates that the router has been
plugged on the network and can be part of ISC tasks such as collect config and provisioning. Inactive
indicates the router has not been plugged-in. Default: Active.

e Event Identification—Indicates whether the CNS Identification field contains a HOST NAME or
CNS ID. Default: HOST NAME.

¢ CNS Identification—Required if the Event Identification field is set to CNS ID. Can contain letters,
numbers, and these punctuation characters: period, underscore, and dash.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Platform Attributes Customer

The Platform Attributes Customer window appears, as shown in Figure 3-33.

Figure 3-33 Platform Attributes Customer Window

Platform Attributes

Platform Attributes - CEs for Customer Customer1

Show entries with Host matching I | Find |

Showing 1 - 3 of 3 records

- : u u u u
Device Name Platfarm Software Yersion Image Name Serial Mumber
1. ce3 2621 12.2{5d}) C2600-J8-Mc2600-j5-mz.122-16.6
2. [ ced 2621 12.2{5d}) C2600-J5-Mc2600-j5-mz.122-16.6
3. cel3 2621 12.2{5d}) C2600-J8-Mc2600-j5-mz.122-16.6
Rows perpage:lm | 1<) Gota page:|1 of 1 [0
| Attributes ¥ || || Save |
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The Platform Customer window contains the following:

e Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

e Platform—Should match what is configured on the target router device. Limited to 80 characters.

¢ Software Version—Should match what is configured on the target router device. Limited to 80
characters.

¢ Image Name—Should match what is configured on the target router device. Limited to 80
characters.

¢ Serial Number—Should match what is configured on the target router device. Limited to 80
characters.

Cisco IP Solution Center Infrastructure Reference, 4.2
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CPE Attributes Customer

The CPE Attributes Customer window appears, as shown in Figure 3-34.

Figure 3-34 CPE Attributes Customer Window

CPE Attributes

CPE Attributes for Customer Customer1

Show entries with Host matching I | Find |

Showing 1 - 3 of 3 records

r _ I I
Dewice Name Custamer s Management Type
1. [~ ce3d Custameri east Managed
2. [ ced Custamert east Managed
3 [ cel3 Custameri east Managed
Rows perpage:lm | 1<) Gota page:|1 of 1 [0
| Attributes ¥ | | | | Save |

Mote: * - Required Field
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The CPE Attributes Customer window contains the following:

¢ Device Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

¢ Customer—Lists the names of customers. Must begin with a letter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can
sort the list by customer name.

e Site—Lists the names of sites. Must begin with a letter. Can contain letters, numbers, and these
punctuation characters: period, underscore, and dash. Limited to 80 characters. You can sort the list
by site name.

e Management Type—Choices include: Managed, Unmanaged, Managed - Management LAN,
Unmanaged - Management LAN, Directly Connected, Directly Connected Management Host,
Multi-VRF, and Unmanaged Multi-VRFE.

Cisco IP Solution Center Infrastructure Reference, 4.2
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The Interfaces Customer window appears, as shown in Figure 3-35.

Figure 3-35 Interfaces Customer Window

Interface Attributes

Interfaces - CEs for Customer Customer1

Show entries with Host matching I | Find |

Showing 1-10 of 12 recards

i " I I I
Host Interface Narme Interface Type Interface Description Interface IP Address Encapsulation  Port Type
1. ce3 Ethernetlin ethernet 17229146 26026 Maone
2. [ ce3 Ethernet0i1 ethernet Mone
3. ce3 Ethernetliz ethernet Maone
4. [ ce3 Ethernetli3 ethernet Mone
5 [ ce3 Serial1f0 searial Maone
6. [ ce3 Serialli searial Mone
7. ce3 Serial1s2 searial Maone
8. [ ce3 Serial1f3 searial Mone
g [ cesd FastEthernetdill  fastethernet 1722914631026 Maone
10. [ cesd FastEthernetdil  fastethernet L7: Link To sw3 Mone
Rows perpage:lﬂ 144 Goto page:|1—0f2 BRI
| Attributes ¥ | | | | Save |
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The Interfaces Customer window contains the following:

Host —Must begin with a letter, digit, or underscore followed by letters, digits, underscores, spaces,
hyphens, or dots ending with a letter, digit, or underscore. This field is required and must match the
name configured on the target router device. Limited to 256 characters.

Interface Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required.
Limited to 256 characters.

Interface Type—Specifies the type of interface. It is a display-only field.

Interface Description—Description of the interface. This field is display-only. Field is populated
by importing a configuration file.

Interface IP Address—IP address associated with this interface.

Encapsulation—The Layer 2 Encapsulation for this device. It is a display-only field. Choices
include:

- DEFAULT
- DOTIQ

- ETHERNET

- ISL

- FRAME_RELAY

- FRAME_RELAY_IETF
- HDLC

- PPP

Cisco IP Solution Center Infrastructure Reference, 4.2
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- ATM
- AALS5SSNAP
- AALO
- AALS
- AALSMUX
- AALSNLPID
- AAL2
- ENCAP_QinQ
- GRE
e Port Type—Choices include: Access, Trunk, Routed, and None.

Assigning Devices

To assign a device to a provider or customer, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Inventory Manager.
Step2  Click the Open button.
The Open drop-down list appears, as shown in Figure 3-37.

Figure 3-36 Open Options Window

Inventory Manager

| Fnd |

Import Devices m

Devices

Provider

Customer

158146

Step3  Select Devices.

The Select Device window appears, as shown in Figure 3-37.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-37 Select Devices Window

I'.EJ Select Device(s) - Cisco Systems, Inc. — IEllil
Show Devices with I Device MName | rnatching r‘ | Find |
Showing 1 - 8 of 8 records
_ Management IP Parent Device
# [ Device Name . Type i
1. I~ pet Cisco 105 Device
2. [ ped Cisco 105 Device
3. I~ Sw2 Cisco 105 Device
4, [ Sw3 Cisco 108 Device
a. I~ Sy Cisco 1035 Device
G. [ ce3 Cisco 108 Device
7. I~ cef Cisco 105 Device
a. [ cel3 Cisco 108 Device
Rows per page:| 10 ~| 1] <] Goto page: |1 of 1 B =0
| Select || Cancel |
h
&
=

Step4  Select a device to open by checking the box to the left of the Device Name. You can select more than
one device to open.

Step5  Click the Select button.

The General Attributes window appears containing information on the selected devices, as shown in
Figure 3-38.

Figure 3-38 General Attributes Devices Window

Inventory Manager

General Attributes - Devices

Show entries with Host matching Iw | Find |
Showing 1- 3 of 3 records
_ | | | || || I
% Host Device Type Description Management  Device Domain Terminal Caonfiy  Device Groups
IP Address Mame Session Access
Frotacol Protacol
pel Cisco 108 Diefault Diefault Device-Group-1
1. :
Device
pe3 Cisco 108 Diefault Default Device-Group-2
2 [ .
Device
A w2 Cisco 1085 Default Default
’ Device
0w's per page: - oto page: i
R 10 144 Got 1 71 () [ 21
Attributes v | | Assign CEPE '| | Edit | | Save |
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Step6  Click the Assign CE/PE button.
Step7  Select Customer or Provider.

The corresponding Select Customer or Select Provider window appears, as shown in Figure 3-39.
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Figure 3-39 Select Provider Window

() select Provider - Cisco Systems, Inc. 1Ol x|
Show Providers with Provider Mame matching Ibk | Find |
Showing 1- 1 of 1 record
# Provider Name

1. & Provideri
Rows per page: I 10 j 14 Goto page:l1 of 1 [ [0

| Select || Cancel |
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Step8  Select the customer or provider to which you want to assign the device by checking the box to the left
of the Customer or Provider Name.

Step9  Click the Select button.

If you assigned the device to a provider, the PE Attributes window appears. If you assigned the device
to a customer, the CPE Attributes window appears.

Step10 In order to save the assigned devices to the ISC repository, you must specify the Site in the CPE
Attributes window or the Region in the PE Attributes window. Do the following:

a. Check the one or more boxes to the left of the Device Name.
b. Check the check box above the Site or Region column.
c. Click the Edit button. The Edit Attributes window appears.
d. Click Select. The Select Site or Select Region window appears.
e. Select a site or region by checking the box to the left of the Site Name or Region Name.
f. Click Save.
Step11  You can choose to edit attributes as desired. Enter any changes you want to make.
Step12  Click Save.
The PE or CPE is saved to the ISC repository.

Topology Tool

The topology tool provides a graphical view of networks set up through the ISC web client. It gives a
graphical representation of the various physical and logical parts of the network, both devices and links.

¢ Introduction, page 3-38
¢ Launching Topology Tool, page 3-38
e Conventions, page 3-40
e Accessing the Topology Tool for ISC-VPN Topology, page 3-43
e Types of Views, page 3-45
— VPN View, page 3-46

Cisco IP Solution Center Infrastructure Reference, 4.2
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Introduction

- Logical View, page 3-51
- Physical View, page 3-54
e Viewing Device and Link Properties, page 3-55
e Filtering and Searching, page 3-62
- Filtering, page 3-62
— Searching, page 3-65
e Using Maps, page 3-66
- Loading a map, page 3-67
- Layers, page 3-68
— Map data, page 3-69
— Node locations, page 3-69
— Adding new maps, page 3-70

The topology tool includes three types of views:

e VPN view—shows connectivity between customer devices. The VPN view also gives an aggregate
view of all services and individual logical and physical views of each of the services.

e Logical view—shows logical connections set up in a selected provider region
¢ Physical view—displays connectivity of named physical circuits in a provider region.
In addition, this chapter describes the following features:

e Filtering and Searching—filter out unnecessary detail in large graphs or jump straight to a particular
device using the search tool

e Using Maps—associate maps with the individual views.

Please note that some details, such as window decorations, are system specific and might appear
differently in different environments. However, the functionality should remain consistent.

Launching Topology Tool

Step 1
Step 2

To launch the Topology Tool, follow these steps:

Log in to ISC.

Choose Service Inventory > Inventory and Connection Manager > Topology Tool and a window
appears, as shown in Figure 3-40, “Topology Launch Window.” If you do not have the proper Java
Runtime Environment (JRE) as specified at the bottom of the window, click the corresponding link for
your system, follow that path, then quit the browser, log in again, and go back to the Topology Tool page.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Note

Step 4

Step 5

Topology Tool ||

Figure 3-40 Topology Launch Window

Topology Tool

“iewy topology maps.

=p#_ ISC-VPH Topology
‘_;H:T: Launches a Java™ Weh Start application that presents graphical views of ¥PNz, Regions, and Access

=  Domainz.
«3:”“ ISC-TEM Topology Interface Applet
‘_;H:T: Launches the ISC-TEWM Topalogy Interface Applet.

Java Runtime Enviranment (JRE) and Java Yebstart must be installed to run Inventary Manager. If you are having trouble
getting them to function properly or need to updste your local JRE please download and install one appropriate for your
operating system.

JRE Description Platform Version Supported
Windoves (all languages, including English) Windows 1.42_04 Yes
Solariz SPARC 32-hit zelf-extracting file Solariz SPARC 1.42 04 Yes
Linux self-extracting file Lz 1.42_04 [

101966

Click ISC-VPN Topology in Figure 3-40, “Topology Launch Window” to launch the Topology Tool
application on the web client. This starts up the Java Web Start application.

Name resolution is required. The ISC HTTP server host must be in the Domain Name System (DNS)
that the web client is using or the name and address of the ISC server must be in the client host file.

The first time Inventory Manager is activated, the Security Warning window in Figure 3-41 appears.
Click Start to proceed or Details to verify the security certificate.

Figure 3-41 Security Warning Window

Security Warning E

(( Do you weant to trust the signed application distributed by: WPNSC
<> Engineering
—

Warning: Failed to verify the authenticity of this cerdificate. Mo assertions
can be made ofthe origin or validity of the code.

Itis highly recommended nat to install and run this code,

| start || petais || Exit |
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The Desktop Integration window in Figure 3-42 appears. Click Yes to integrate into your desktop
environment, click No to decline, click Ask Later to be prompted the next time VPN Topology is
invoked, or click Configure ... to customize the desktop integration.

[ oL-10727-01
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Figure 3-42 Topology Desktop Integration Window

ISC 4.1 - Topology - Desktop Integration E|

( Desktop Intearation provides a quick and easy

‘-_ir) weay o Access your application.

S WWOUIG yoOU like to have "ISC 4.1 - Topaology”
integrated into your desktop enviornment ?

| Yes || No || Ask Later || Configure ...
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The Login window in Figure 3-43, “Log In to ISC Window.” appears whether or not a selection has been
made in the Desktop Integration window.

Figure 3-43 Log In to ISC Window

Please log in. ..
User Name: | |
Password: | |

| Ok || Cancel | %

Step6  Enter your User Name and Password and click OK. The Topology Tool launches and connects to the
Master ISC server.

Conventions

Topology software uses several conventions to visually communicate information about displayed
objects. The shape and color of a node representing a device depends on the role of the device, as shown
in Table 3-2.
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Table 3-2

Topology Tool

Device Role Shapes

Shape

Description

g device-b.domamn.com

Customer Name
Site B Mame
LEG.0.0.1

Green icon for a CAT OS customer device followed by the
following information:

- Device name
- Customer Name

Description of device-h - - Site Name
2 - Management IP Address
SPOKE Z |- Description
- Role (SPOKE or HUB of a VPN)
Green icon for a router customer device followed by the
5 dewice-adoman.com following information:
Customer Hame - Device name
St o ane - Customer Name
Description of device-a . - Site Name
-~ % - Management IP Address
- - - Description
- Role (SPOKE or HUB of a VPN)
Green icon for an interface followed by the following
e Ethernet0;1 information:
1;2% 'u3l't4 - Interface name
Paclat Cver S0 HET E - Management IP Address
o - Encapsulation Type
- Interface Type
Blue icon for a CAT OS provider device followed by the
3 device-Ldomian.com following information:
Frovider Mame - Device name
Re %i?::'?!‘é EJT'"E - Provider Name
Dﬁscl'iptinﬁ of device-1 - Region Name
M-PE %’ - Management IP Address
b - Description
- Role
Blue icon for a router provider device followed by the
& device-0.domain.com following information:
F'I'D'-:-'iIIF!I' Mame - Device name
P‘E%';' ;!-1[{ _ES'"E - Provider Name
Description of device-0 - Region Name
M-PE % - Management IP Address
b - Description
- Role

Cisco IP Solution Center Infrastructure Reference, 4.2




Chapter3  Service Inventory — Inventory and Connection Manager |

| Topology Tool

Table 3-2 Device Role Shapes (continued)

Shape Description

Blue icon for a region followed by the following

i information:
5 Region 1 MName
- Region name

o
o

Frovider Hame A - Provider Name
-

Green icon for a site followed by the following

By Site € Name information:

- Site name

- Customer Name

- Role in which Site’s device joined VPN (HUB, SPOKE,
or combination of HUB and SPOKE)

Customer Name
HUE

111690

Green icon for a site followed by the following
34 Site A Name information:

- Site name

- Customer Name

- Role in which Site’s device joined VPN (HUB, SPOKE,
or combination of HUB and SPOKE)

Customer Name
SPOKE

111691

A distinct color scheme is used to highlight the link type as shown in Table 3-3:

Table 3-3 Link Type Color Scheme

Color Connection Type

End-to-end wire

(green)

Attachment circuit

(purple)

MPLS VPN link

(brown)
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Finally, the four patterns shown in Table 3-4 are used to indicate the service request state:

Table 3-4 Link State Pattern Scheme

Pattern Service Request State

Deployed, functional, pending

Failed audit, invalid, broken, lost

Wait deploy, requested, failed deploy

Closed

Accessing the Topology Tool for ISC-VPN Topology

Launch the Topology Tool as explained in Figure 3-40, “Topology Launch Window,” in the “Launching

Topology Tool” section on page 3-38 and then use the following steps to access the ISC-VPN Topology
tool.

Step1  Choose Service Inventory > Inventory and Connection Manager > Topology Tool > ISC-VPN
Topology.

The Topology window shown in Figure 3-44 appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-44 Topology Application Window
IP Solution Center - Topology Viewer [connected to wxyz-ul0.cisco.com as admin
File Edit ¥iew Map Help
= A EYENEN
: Name contains: | 4 Advanced...
1
[y Unnarmed 1
3
2
DN
l Innamed o
| | |
The application window is divided into four areas, as shown in Figure 3-44:

N

Note

area (1)—The top left corner shows the Overview area. The colored rectangular panel, called the
panner, corresponds to the area currently visible in the main area. Moving the panner around
changes the part of the graph showing in the main area. This is particularly useful for large graphs.

area (2)—The bottom left area shows the Tree View of the graph. When no graph is shown, a single
node called Unnamed is displayed. When a graph is shown, a tree depicting devices and their
possible interfaces and connections is displayed. The tree can be used to quickly locate a device or
a connection.

area (3)—The main area (Main View) of the window shows a graph representing connections
between devices. The name of the displayed network is shown at the bottom. When no view is
present, the name defaults to Unnamed.

area (4)—Above the main window is the Filter area. It allows you to filter nodes by entering a
pattern. Nodes whose name contains the entered pattern maintain the normal level of brightness. All
other nodes and edges become dimmed, as shown in Figure 3-66 and the “Filtering” section on
page 3-62.

The bottom bar below all the areas, is a Status bar.

Views are loaded, saved, and closed using the File menu, as shown in Figure 3-45.
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Figure 3-45 The File Menu
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The File menu contains the following menu items:
e Open—Opens a view.
e Save—Saves the open and active view with the existing file name, if any.

¢ Export...—Exports the active view in either Scalable Vector Graphics (SVG), Joint Photographics
Expert Group (JPG), or Portable Network Graphics (PNG) format.

e Save All—Saves all open views.

¢ Close—Closes the open and active view.
¢ Close All—Closes all open views.

e Print...—Prints the open and active view.

¢ Exit— Exits the Topology tool.

Types of Views

There are three view panes in the topology application and they are described in the following sections:
e VPN View, page 3-46, shows connectivity between devices in a VPN
e Logical View, page 3-51, shows connectivity between PEs and CPEs in a region
e Physical View, page 3-54, shows physical devices and links for PEs in a region.

The view attributes can be changed using the View menu, as shown in Figure 3-46.
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VPN View

Step 1

Figure 3-46 The View Menu
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The View menu contains the following menu items:

¢ Anti-Aliasing—When drawing a view, this creates smoother lines and a more pleasant appearance
at the expense of performance.

¢ Grid—Activates a magnetic grid. The grid has a 10 by 10 spacing and can be used to help align
nodes in a view.

¢ Auto-Layout—Generates an automatic layout of nodes in a view. If selected, the program tries to
find the most presentable arrangement of nodes.

e Zoom—Opens a dialog where the desired magnification level can be specified.
e Zoom In— Increases the magnification level.
e Zoom Out—Decreases the magnification level.

¢ Refresh—Regenerates the view. This is especially useful if the data in the repository changes. To
see an updated view, select Refresh or click the Refresh toolbar button.

The VPN view shows connectivity between devices forming a given VPN. To activate the VPN view,
follow these steps:

In the menu bar, select File > Open.
or
click the Open button in the tool bar.

The Folder View window in Figure 3-47 appears displaying a directory tree with available VPNs.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Aggregate View

Figure 3-47
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Topology Tool ||

Choose the desired VPN’s folder, select the folder, and click Open. This opens the desired folder to
display any logical and physical views associated with that VPN.

Click a logical or a physical view item in the folder tree. The logical view minimizes the amount of detail
and shows connectivity between customer devices. The physical view reveals more about the physical
structure of the VPN. For example, for MPLS it shows connectivity between customer and provider

devices and the core of the provider.

The Aggregate View, as shown in Figure 3-48, “Aggregate View,” shows connectivity between all
customer devices, regardless of the type of technology used to connect them.

A single view might show a combination of MPLS, Layer 2, and VPLS. For MPLS, only the Customer

Premises Equipment devices (CPEs) are shown.

[ oL-10727-01
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Figure 3-48 Aggregate View
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The Layer 2 VPN might in addition to CPEs show connectivity between Customer Location Edge
devices (CLEs) or Provider Edge devices (PE). For VPLS, you see connectivity between CPEs. For

missing CPEs, you see connectivity to PEs.

In MPLS Layer 2 VPN, the topology displays Virtual Circuit (VC) with MPLS core (as MPLS string)
but with L2TPv3, the topology will display Virtual Circuit (VC) with IP core (as IP string) as shown in

Figure 3-49.
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Figure 3-49 Virtual Circuit with IP Core
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In the case of a VPLS topology, you can access an Attachment Circuit View or an Emulated Circuit View.
The Attachment Circuit View corresponds to a logical view in other types of VPNs. It shows customer
devices connected to a virtual private LAN, as shown in Figure 3-50, “Attachment Circuit View.”

[ oL-10727-01
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Figure 3-50 Attachment Circuit View
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The Emulated Circuit View shows the physical connectivity details omitted in the Attachment Circuit

View. Connectivity between provider devices and customer devices connected to provider devices, as
shown in Figure 3-51, “Emulated Circuit View.”
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Figure 3-51
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The logical view shows connectivity, created through service requests, between PEs and CPEs of a given

region.

To activate the logical view, follow these steps:

In the menu bar, choose File > Open.

or

click the Open button in

the tool bar.

The Folder View window, as shown in Figure 3-47, appears.

Choose the desired VPN’s folder and double-click on the desired folder. Any logical and physical views
associated with that VPN are displayed.

To open the logical view for the selected VPN, do one of the following:

Single-click the Logical View icon and click Open

or

Double-click the Logical View icon.

This creates a logical view for the chosen VPN, as shown in Figure 3-52.

[ oL-10727-01
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Figure 3-52
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In a created view, the node, usually located in the center of the graph, is the node representing a given

region of a provider. The node is annotated with the name of the

region and the name of the provider.

Each node directly connected to the regional node represents a PE. The icon of a node depends on the
type and the role of the device it represents (see the “Conventions” section on page 3-40).

Each PE is annotated with the fully-qualified device name, provider name, region name, management [P
address, description, and role. A right-click on a node displays the details of the logical and physical
device, interfaces, and service requests (SR) associated with the node, as shown in Figure 3-53. For the

regional node, details are shown in a tabulated form.

Figure 3-53 Device Properties
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Service Requests...
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The various node and link properties are described in detail in Viewing Device and Link Properties, page

3-55.

Likewise, you can right-click on a link to learn about its link properties. For example, when selecting
Interfaces... for a sample serial link, a Properties window like the one in Figure 3-54 appears.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-54 Interface Properties Window
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Each PE can be logically connected to one or more CPEs. Such connections are created by either MPLS
VPN links or Layer 2 Logical Links. Each such connection is represented by an edge linking the given
PE to a CPE. If there are more connections between a particular PE and CPE, all of them are shown.
Depending on the state of a connection, the edge is drawn using a solid line (for functioning
connections), dotted line (for broken connections), or dashed line (for connections yet to be established).

Depending on the connection type, the connection is drawn as described in Table 3-3 and Table 3-4.

Each connection is annotated with the PE Interface Name (IP address), VLAN ID number, CPE Interface
Name (IP address).

In the Overview area, a direct connection is drawn between a CPE and a PE, even if a number of devices
are forming such a connection.

For more about viewing device properties, see Viewing Device and Link Properties, page 3-55.

To view the details of a connection, right-click on it and select the Expand option from a pop-up menu.

The expanded view, displayed in a new tab, shows all devices and interfaces making a given PE to CPE
connection, as shown in Figure 3-55.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-55 Detailed Connection View
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Physical View

A physical view shows all named physical circuits defined for PEs in a given region. Each named
physical circuit is represented as a sequence of connections leading from a PE through its interfaces to
interfaces of CLEs or CPEs. All physical links between PEs of a given region and their CLEs or CPEs

are shown. Since physical links are assumed to be in a perfect operational order, edges are always drawn
with solid lines.

To activate the physical view, follow these steps:

Step 1 In the menu bar, choose File > Open.
or
click the Open button in the tool bar.
The Folder View window, as shown in Figure 3-47, appears.

Step2  Choose the desired VPN’s folder and double-click on the desired folder. Any logical and physical views
associated with that VPN are displayed.

Cisco IP Solution Center Infrastructure Reference, 4.2
m. oL-10727-01 |



| Chapter3 Service Inventory — Inventory and Connection Manager

Topology Tool

Step3  To open the physical view for the selected VPN, do one of the following:
Single-click the Physical View icon and click Open

or
Double-click the Physical View icon.

This creates a physical view for the chosen VPN, as shown in Figure 3-56.

Figure 3-56 Physical View
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In this view, each device is connected with a thin line to the interfaces it owns. Interfaces are connected

to other interfaces with thick lines. If there is more than one connection between two interfaces, they are
spaced to show all of them.

The tree shows devices and connections. Each device can be a folder, holding all interfaces connected
to it.

Viewing Device and Link Properties

In the logical view, you can view the properties of both devices and links. In the physical view, only
properties of physical devices are accessible.

Thus, device properties can be viewed in both the logical and physical views.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Device Properties

To view the properties of a device, right-click the device. The Device Properties menu in Figure 3-57
appears.

Figure 3-57 Device Properties
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The following properties are available:

Logical Device...—View the logical properties of the device.
Physical Device...—View the physical properties of the device.
Interfaces...—View interface properties of the device.

Service Requests...—View service request properties associated with the device.
Logical Device

When right-clicking a device and selecting Logical Device..., the logical device properties window in
Figure 3-58 appears.

Figure 3-58 Logical Device Properties Window
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The logical properties window displays the following information:
Device Name—Name of the device.

Provider Name—Name of the provider whom the device is serving.
Region Name—Name of the provider region.

Loopback Address—IP address of the loopback address.

Role Type—Role assigned to the device.

Cisco IP Solution Center Infrastructure Reference, 4.2
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When right-clicking a device and selecting Physical Device..., the physical device properties window in
Figure 3-59 appears.

Figure 3-59 Physical Device Properties Window
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The physical properties window displays the following information:

Name—Name of the device.

Description—User-defined description of the device.

Collection Zone—Collection zone for device data.

IP Address—IP address of the interface used in the topology.

User ID—User ID for the interface.

Enable User—Password for the interface.

Device Access Protocol—Protocol used to communicate with the device.

Config Upload/Download—Upload/download method for the configuration file.
SNMP Version—Simple Network Management Protocol (SNMP) version on the device.
Community String RO—public or private

Community String RW—public or private

SNMP Security Level—Simple Network Management Protocol (SNMP) security level.
Authentication User Name—User name for performing authentication on the device.
Authentication Algorithm—Algorithm used to perform authentication.

Encryption Algorithm—Encryption algorithm used for secure communication.

[ oL-10727-01
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Terminal Server—Name of the terminal server.

Terminal Server Port—Port number used by the terminal server.
Platform—Hardware platform.

Software—IOS version or other management software on the device.
Image Name—Boot image for device initialization.

Serial Number—Serial number of the device.
Interfaces

When right-clicking a device and selecting Interfaces..., the interface properties window in Figure 3-60

appears.
Figure 3-60 Device Interface Properties Window
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The interface properties window displays the following information:

Name—Name of the device.

IP Address—IP address of the device.

IP Address Type—STATIC or DYNAMIC.

Encapsulation—Encapsulation used on the interface traffic.

Description—Description assigned to the interface, if any.

Select (link)—If a connection is attached to the interface, a drop-down list at the bottom of the window
allows you to choose between the interfaces available on the device.

Service Requests

When right-clicking a device and selecting Service Requests..., the service request (SR) properties
window in Figure 3-61 appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-61 Service Request Properties Window
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The service request properties window displays the following information:
Job ID—SR identifier.

Type—Protocol type used in the SR.

State—SR state.

Operation Type—Encapsulation used on the interface traffic.
Creator—Description assigned to the interface, if any.

Creation Time—Date and time when the SR was created.

Customer Name—Name of customer associated with the SR.

Last Modified—Date and time when the SR was last modified.
Description—User-defined description of the SR.

Select (SR)—If more than one SR is associated with the interface, the drop-down list at the bottom of
the window allows you to choose between these SRs.

Link Properties

To view the properties of a given link, right-click the link. The Link Properties menu in Figure 3-62
appears.

Figure 3-62 Link Properties
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The following options are available:
Expand...—View link details, including devices local to the link not shown in the general topology.
Service Request...—View service request properties associated with the link.

MPLS VPN...—View the MPLS VPN properties of the link. Other link protocol properties than MPLS
VPN are currently not available.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Expand

When right-clicking a link and selecting Expand..., the Topology Display will display any devices and
connections local to that link. An Expand Link window similar to the one in Figure 3-63 will appear.

Figure 3-63 Expand Link Window
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Properties information for devices and links can only be obtained in the master view as described earlier
in this section.

Service Request

When right-clicking a link and selecting Service Requests..., the service request (SR) properties
window in Figure 3-64 appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-64 Link Service Request Properties Window
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The service request properties window displays the following information:
Job ID—SR identifier.

Type—Protocol type used in the SR.

State—SR state.

Operation Type—Encapsulation used on the interface traffic.

Creator—Description assigned to the interface, if any.

Creation Time—Date and time when the SR was created.

Customer Name—Name of customer associated with the SR.

Last Modified—Date and time when the SR was last modified.

Description—User-defined description of the SR.

Select (SR)—If more than one SR is associated with the interface, the drop-down list at the bottom of
the window allows you to choose between these SRs.

MPLS VPN

When right-clicking a link that is configured for MPLS VPN and selecting MPLS VPN..., the MPLS
VPN properties window in Figure 3-65 appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-65 Link MPLS VPN Properties Window
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The service request properties window displays the following information:
Status—Status of the MPLS VPN link.

Status Message—Displays any error or warning messages.

Operation Type—MPLS operation type.

Policy Type—The policy type applied to the link.

Data MTD Threshold—Memory Technology Driver (MTD) data threshold.
Default MTD Address—Default MTD IP address.

Data MTD Subnet—Data MTD subnet.

Data MTD Size—Data MTD size.

SOO Enabled—Yes or No.

Manual Config—Yes or No.

Filtering and Searching

On large graphs, the amount of detail can be overwhelming. In such cases, filtering might help eliminate

unnecessary details, while searching can lead to a prompt location of a device you want to examine
further.

Both advanced filtering and searching use the same dialog to enter conditions on nodes to be either
filtered or located. The filtering area also allows you to quickly filter viewed objects by name.

Filtering
The topology view can be filtered in two ways, simple and advanced.
Simple Filtering

To perform simple filtering of the view, follow these steps:

Step 1 Enter a string in area (4) of the main window, as shown in Figure 3-44 on page 3-44.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 2

Advanced Filtering

Step 1

Topology Tool W

Press Enter to dim all objects whose name does not contain the specified string.

For example, to locate nodes that contain string router in their name you would enter router in area (4)
and click Enter. All objects whose name does not contain the entered string are dimmed, as shown in
Figure 3-66.

Figure 3-66 Physical View with Dimmed Nodes
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Note  Regular expressions are supported but only in the advanced dialog (click Advanced... button).
For example, by entering ~foo.*a, you only request nodes that have names starting with "foo"
followed by arbitrary characters and containing the letter 'a' somewhere in the name. The regular
expressions must follow the rules defined for Java regular expressions.

To perform advanced filtering, follow these steps:

Open the advanced filtering dialog by clicking the Advanced... button. The Advanced Filter dialog
appears, as shown in Figure 3-67.

[ oL-10727-01
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Step 2

Make the desired filtering elections.

The dialog allows you to enter one or more conditions on filtered nodes. The first drop-down list allows
you to specify the attribute by which the filtering is performed. The second allows you to decide how the
matching between the value of the attribute and text entered in the third column is performed.

The following matching modes are supported from the drop-down list:

¢ contains—The attribute value is fetched from the device and it is selected if it contains the string
given by you. The string can be located at the start, end, or middle of the attribute for the match to
succeed. For example, if the pattern is cle the following values match it in the contains mode: clean,
nucleus, circle.

e starts with—The value of the attribute must start with the string given by you. For example, if the
pattern is foot, footwork matches, but afoot does not.

¢ ends with—This is the reverse of the starts with case, when a given attribute matches only if the
specified pattern is at the end of the attribute value. In this mode, for example, the pattern foot
matches afoot but not footwork.

¢ doesn't contain—In this mode, only those strings that do not contain the given pattern match. The
results are opposite to that of the contains mode. For example, if you specify cle in this mode, clean,
nucleus, and circle are rejected, but foot is deemed to match, because it does not contain cle.

e matches—This is the most generic mode, in which you can specify a full or partial expression that
defines which nodes you are interested in.

Figure 3-67 Advanced Filter Dialog
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By clicking one of the two radio buttons, Match any conditions or Match all conditions, you can
request that any or all of the conditions are matched. In the first case, you can look for devices where,
for example, the name contains cisco and the management IP address ends with 204. When all conditions
must be met, it is possible to look for devices that, for example, have a given name and platform.

Click More or Fewer to add more rows of conditions or remove existing rows of conditions.

By default, all matches are performed without regard for upper or lower case. However, in some cases it
is beneficial to have a more exact matching that takes the case into account. To do so, check the Match
case check box.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 3

Searching

Step 1

Step 2

Step 3

Step 4

Topology Tool ||

Click OK to start the filtering process. Click Cancel to hide the dialog without any changes to the state
of the filters.

The Clear button allows you to clear all conditions. Clicking Clear followed by OK effectively removes
all filtering, restoring all nodes to their default brightness level. If filtering is active, the same can be
achieved by clicking Clear in area (4) of the main window, as shown in Figure 3-44 on page 3-44.

Searching can be conducted by using the menus or the tool bar. To perform a search, follow these steps:

Select Find in the Edit menu

or

Click the Find icon in the main toolbar.

Both approaches bring up the same dialog box, as shown in Figure 3-68.

Again, you can enter one or more conditions to locate the node.

Figure 3-68 Find Dialog Box
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Make the desired filtering selections. Match modes, case check box, and the radio button are used as
described under Advanced Filtering, page 3-63, as shown in Figure 3-67.

Click OK to start searching for the first node that matches the given criteria. If found, the node is
highlighted and the view is shifted to make it appear in the currently viewed area of the main window.

After the first search, press F3 or click the Find Again button to repeat the search. If more than one node
matches the condition the Find Again function highlights each one of them. If no nodes match the
entered criteria, the Object Not Found dialog box appears.

[ oL-10727-01
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Using Maps

You can associate a map with each view. Currently, the topology viewer only supports maps in the
Environmental Systems Research Institute, Inc. (ESRI) shape format. The following sections describe
how to load maps and selectively view map layers and data associated with each map.

The map features are accessed from the Map menu shown in Figure 3-69.

Figure 3-69 The Map Menu
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The Map menu contains the following menu items:
e Open Map... Loads a map into the application
¢ Clear Map Clears the active map from the current view

¢ View Allows you to select which layers in the map should be displayed (for example, country, state,
city).

Cisco IP Solution Center Infrastructure Reference, 4.2
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Loading a map

Topology Tool ||

You might want to set a background map showing the physical locations of the displayed devices. To
load a map, follow these steps:

Step 1 In the menu bar, select Map > Open Map....
or
Press Ctrl-M
Providing the web map server is running and operational, the Load Map window appears, as shown in
Figure 3-70.
Figure 3-70 Load Map Window
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[=] [=]
| soH| o
File Name: || |
Files of Type: | All Files v|
Open | | Cancel | 0
Step2  Make your selections in the Load Map window.
The right-hand side of the window contains a small control panel, which allows you to select the
projection in which a map is shown. A map projection is a projection that maps a sphere onto a plane.
Typical projections are Mercator, Lambert, and Stereographic.
For more information on projections, consult the Map Projections section of Eric Weisstein's World of
Mathematics at:
http://mathworld.wolfram.com/topics/MapProjections.html
For each projection, you can also select the region of the map to be shown. In most cases, the predefined
values should be sufficient. The top level the file hierarchy should contain folders for all major regions,
such as Europe, North America, Oceania, and so on.
If desired, make changes to the settings in the Longitude Range and Latitude Range fields.
Step3  Choose the desired folder.
Each folder can contain either complete maps or folders for countries. Each map is clearly distinguished
with the Map icon.
Cisco IP Solution Center Infrastructure Reference, 4.2
[ oL-10727-01 .m



Chapter3  Service Inventory — Inventory and Connection Manager |

| Topology Tool

Step4  Select a map file and click Open to load the map.

Selecting the map file and clicking the Open button starts loading it. Maps can consist of several
components and thus a progress dialog is shown informing you which part of the map file is loaded.

Layers

Each map can contain several layers. For example most country maps have country, region, and city
layers, as shown in Figure 3-71.

Figure 3-71 Map Layers
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After a map is loaded, the View submenu of the Map menu is automatically populated for you. A name
of each available layer is shown together with the check box indicating visibility of the layer. If a given
map shows too many details, you can turn off some or all layers by unchecking the corresponding check
box(es). The same submenu can be used to restore visibility of layers.

If an incorrect map is loaded or the performance of the topology tool is unsatisfactory with the map
loaded, you can clear the map entirely. To do this, select Clear Map from the Map menu. Maps are
automatically cleared if another map is loaded.

Consequently if you want just to load another map, there is no need to clear the existing map. The act of
loading a new map does this.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Map data

Topology Tool

If map data files are successfully loaded with the map, the right field of the Status bar shows the
longitude and latitude location of the cursor on the map. If map objects, such as cities, lakes, and so on,
have data associated with them, their names are displayed after the longitude and latitude coordinates.

Node locations

After a map is successfully loaded, the view area is adjusted to fully accommodate it, as shown in
Figure 3-72. If nodes shown on the window had longitude and latitude information associated with them,
they are moved to locations on the map corresponding to their geographical location. If not, their

positions remain unchanged.

However, you can manually move

them to the desired location and save the positions for future

reference. The next time the image of a given network is loaded, node positions are restored and the map

file is loaded.

Figure 3-72
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Adding new maps

You might want to add your own maps to the selection of maps available to the topology application.
This is done by placing a map file in the desired directory within the ISC installation. To make this
example more accessible, assume that you want to add a map of Toowong, a suburb of Brisbane, the
capital of Queensland. The first step to do so is to obtain maps from a map vendor. All maps must be in
the ESRI shape file format (as explained at the web site: http://www.esri.com). In addition, a data file
might accompany each shape file. Data files contain information about objects whose shapes are
contained within the shape file. Let us assume that the vendor provided four files:

e toowong_city.shp
e toowong_city.dbf
e toowong_street.shp
e toowong_street.dbf

We must create a map file that informs the topology application about layers of the map. In this case we
have two layers: a city and a street layer. The map file, say, Toowong.map, would thus have the following
contents:

toowong_city
toowong_street

It lists all layers that create a map of Toowong. The order is important, as the first file forms the
background layer, with other layers placed on top of the preceding layers.

Having obtained shape and data files and having written the map file, decide on its location. As
mentioned, Toowong is a suburb of Brisbane, located in Queensland, Australia. All map files must be
located in or under the $ISC_HOME/resources/webserver/tomcat/webapps/ipsc-maps/data
directory. Since by default this directory contains a directory called Oceania intended for all maps from
that region, simply create a path Australia/Queensland/Brisbane under the directory Oceania. Next,
place all five files in this location. After this is done, the map is automatically accessible to the topology
viewer.

Devices

Every network element that ISC manages must be defined as a device in the system. An element is any
device from which ISC can collect information. In most cases, devices are Cisco IOS routers that
function as Provider Edge Routers (PEs) or Customer Edge Routers (CEs) in the MPLS VPN.

Note  To provision services with ISC, you must have IPv4 connectivity.

This section describes how to configure SSH, set up SNMP, manually enable an RTR responder, and
create, edit, delete, and configure various types of supported devices. This section includes the
following:

e Configuring SSH, page 3-71

e Setting Up SNMP, page 3-72

e Manually Enabling RTR Responder on Cisco IOS Routers, page 3-74
e Accessing the Devices Window, page 3-74

e (Creating a Device, page 3-76

Cisco IP Solution Center Infrastructure Reference, 4.2
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e Editing a Device, page 3-93

e Deleting Devices, page 3-96

e Editing a Device Configuration, page 3-97
e E-mailing a Device’s Owner, page 3-99

¢ Copying a Device, page 3-100

Configuring SSH

Devices

ISC needs a mechanism to securely access and deploy configuration files on devices, which include
routers and switches. And, to securely download a configlet and upload a configuration file from a

device, SSH must be enabled.

The following sections describe how to configure SSH on a device.

Configuring SSH on Cisco 10S Routers

Step 1
Step 2

Step 3

Step 4
Step 5

Step 6
Step 7

Step 8

Step 9
Step 10

This Cisco IOS router configuration procedure assumes that the router’s authentication database is stored
locally on the router and not on a TACACS or RADIUS server.

The procedure for configuring SSH on a Cisco IOS router is as follows:.

Command

Description

Router# configure terminal

Enters global configuration mode.

Router (config)# ip domain-name
<domain_name>

Specifies the IP domain name.

Router (config)# username <username>
password <password>

Configures the user ID and password. Enter your
ISC username and password. For example:

username admin password iscpwd

Router (config)# crypto key generate rsa

Generates keys for the SSH session.

You will see the following prompt:

Choose the size of the key modulus in the
range of 360 to 2048 for your general
purpose keys. How many bits in the modulus
(nnn) :

Press Enter to accept the default number of bits.

Sets the number of bits.

Router (config)# line vty 0 4

Enables SSH as part of the vty login transport.

Router (config-line)# login local

The login local command indicates that the router
stores the authentication information locally.

Router (config-line)# transport input
telnet ssh

Enables SSH transport.

Router (config-line)# Ctrl+z

Returns to Privileged Exec mode.

Router# copy running startup

Saves the configuration changes to NVRAM.

[ oL-10727-01
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Setting Up SNMP

To work with ISC, SNMP must be configured on each CPE device in the customer network. In ISC,
SNMP is used to:

e collect from the Interface MIB
e provision and collect SLA data.

Two security models are available: SNMPv1/v2c and SNMPv3. Table 3-5 identifies the combinations of
security models and levels.

Table 3-5 SNMP Security Models and Levels
Model Level Authentication |Encryption Description
vl/v2c No Authentication/ |Community No Uses a community string match
No Encryption String for authentication.
v3 No Authentication/ |Username No Uses a username match for
No Encryption authentication.
v3 Authentication/ MDS5 or SHA |No Provides authentication based on
No Encryption the HMAC-MD?5 or
HMAC-SHA algorithms.
v3 Authentication/ MDS5 or SHA |DES Provides authentication based on
Encryption the HMAC-MD?5 or
HMAC-SHA algorithms, and
provides DES 56-bit encryption
in addition to authentication
based on the CBC-DES
(DES-56) standard.

SNMPv3 provides for both security models and security levels. A security model is an authentication
strategy that is set up for a user and the group in which the user resides. A security level is the permitted
level of security within a security model. A combination of a security model and a security level
determines which security mechanism is employed when handling an SNMP packet.

The security features provided in SNMPv3 are as follows:
e Message integrity—Ensures that a packet has not been tampered with in-transit.
e Authentication—Determines the message is from a valid source.

¢ Encryption—Encoding the contents of a packet to prevent it from being read by an unauthorized
source.

SNMPv3 objects have the following characteristics:
e Each user belongs to a group.

e The group defines the access policy for a set of users and determines the list of notifications its users
can receive. The group also defines the security model and security level for its users.

e The access policy defines which SNMP objects can be accessed for reading, writing, or creation.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Setting Up SNMPv1/v2c on Cisco 10S Routers

To determine whether SNMP is enabled, and to set the SNMP community strings on a Cisco IOS router,
perform the following steps for each router:

Command Description

Step 1 Router> enable Enters enable mode, and then enters the enable
Router> <enable password> password.

Step2 Router# show snmp Check the output of the show snmp command

to see whether the following statement is
present: “SNMP agent not enabled.” If SNMP
is not enabled, complete the steps in this

procedure.

Step3  Router# configure terminal Enters global configuration mode.

Step4  Router (config)# snmp-server community Sets the community read-only string.
<userstring> RO

Step5  Router(config)# snmp-server community Sets the community read-write string.
<userstring> RW

Step6 Router(config)# Ctrl+z Returns to Privileged Exec mode.

Step7 Router# copy running startup Saves the configuration changes to NVRAM.

je)

ﬁ The SNMP community strings defined in ISC for each target device must be identical to those configured

on the device.

Setting SNMPv3 Parameters on Cisco 10S Routers

This section describes how to set the SNMPv3 parameters on Cisco IOS routers. SNMPv3 is only
supported on IOS crypto images. For Authentication/Encryption, the IOS image must have DES56.

Tip The SNMP users defined in ISC for each target device must be identical to those configured on the
device.

To check the existing SNMP configuration, use these commands in the router terminal session:

® show snmp group

®¢ show snmp user

To set the SNMPv3 server group and user parameters on a Cisco IOS router, perform the following steps.

Note  The group must be created first and then the user.

Command Description

Step 1 Router> enable Enters enable mode, then enter the enable
Router> <enable password> password.

Step2  Router# configure terminal Enters global configuration mode.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 3

Step 4

Step 5
Step 6

Command

Description

Router (config) # snmp-server group
[<groupname> {vl | v2e¢ | v3 {auth | noauth |
priv}}] [read <readview>] [write
<writeview>] [notify <notifyview>]

[access <access-list>]

The snmp-server group command configures a
new SNMP group or a table that maps SNMP
users to SNMP views. Each group belongs to a
specific security level.

Exanqﬂe:snmp-server group v3auth v3 auth
read vldefault write vildefault

Router (config) # snmp-server user <username>
[<groupname> remote <ip-address>

[udp-port <port>] {vl | v2e | v3 [encrypted]
[auth {md5 | sha} <auth-password> [priv
des56 <priv-password>]]

[access <access-1list>]

The snmp-server user command configures a
new user to an SNMP group.

Example: snmp-server user userl v3auth v3
auth md5 userlPass

Router (config)# Ctrl+z

Returns to Privileged Exec mode.

Router# copy running startup

Saves the configuration changes to NVRAM.

Manually Enabling RTR Responder on Cisco 10S Routers

~

Note

Step 1

Step 2
Step 3

Step 4
Step 5

SNMP must be configured on the router.

To manually enable an RTR Responder on a Cisco 10S router, execute the following steps:

Command

Description

Router> enable
Router> <enable password>

Enters enable mode, and then enters the enable
password.

Router# configure terminal

Enters the global configuration mode.

Router (config)# rtr responder

Enables the SA responder on the target router of
SA Agent operations.

Router (config)# Ctrl+z

Returns to Privileged Exec mode.

Router# copy running startup

Saves the configuration changes to NVRAM.

Accessing the Devices Window

Step 1

The Devices feature is used to create, edit, delete, and configure devices, and e-mail the device owner.

To access the Devices window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Devices to access the Devices

window shown in Figure 3-73.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-73 Deviices List Window
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The Devices window contains the following:
e Device Name Lists the fully qualified host and domain name of the device. You can sort the list of
devices by device name.
e Management IP Address Lists the management IP address or the IE2100 address. You can sort the
list of devices by this field.
e Type Lists the type of the device. Types include: Cisco IOS Device, CatOs Device, Terminal Server,
and IE2100.
e Parent Device Name
In the Devices window, you can create, edit, delete, or configure devices, e-mail the device owner, or
copy using the following buttons:
¢ Create Click to create new devices. Enabled only if no devices are selected.
¢ Edit Click to edit selected device (select device by checking the corresponding box). Enabled only
if a single device is selected.
¢ Delete Click to delete selected device (select device by checking the corresponding box). Enabled
only if one or more devices are selected.
¢ Config Click to change the selected device configuration (select device by checking the
corresponding box). Enabled only if a single device is selected.
¢ E-mail Click to send e-mail to the owner of the selected device(s) (select device(s) by checking the
corresponding box(es)). Enabled only if one or more devices are selected.
¢ Copy Click to copy selected device (select device by checking the corresponding box). Enabled only
if a single device is selected.
Cisco IP Solution Center Infrastructure Reference, 4.2
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Creating a Device

From the Create window, you can define different types of devices.

To create a device, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Devices.

Step2  Click the Create button.

The Create options window appears, as shown in Figure 3-74.

Figure 3-74
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The Create options include the following:

e Catalyst Switch A Catalyst device running the Catalyst Operating System.

¢ Cisco Device Any router that runs the Cisco IOS. This includes Catalyst devices running Cisco 10S.

¢ Terminal Server A device that represents the workstation that can be used to provision edge routers.

e JE2100 Any Cisco Intelligence Engine (IE) 2100 series network device.

Step3  See the following sections for instructions on creating each type of device.

e Creating a Catalyst Switch, page 3-77

e Creating a Cisco Device, page 3-81

e Creating a Terminal Server, page 3-87

¢ Creating a Cisco CNS IE2100, page 3-92
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Creating a Catalyst Switch

Step 1
Step 2
Step 3

To create a Catalyst switch, follow these steps:

Devices W

Choose Service Inventory > Inventory and Connection Manager > Devices.

Click the Create button.
Select Catalyst Switch.

The Create Catalyst Device window appears, as shown in Figure 3-75.

Figure 3-75 Create Catalyst Device Window
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The General section of the Create Catalyst Device window contains the following fields:

Device Host Name (required) Must begin with a letter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field
must match the name configured on the target router device. Limited to 256 characters.

Device Domain Name (optional) Must begin with a letter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. The name
must match the domain name on the target router device.

Description (optional) Limited to 80 characters. Can contain any pertinent information about the
device such as the type of device, its location, or other information that might be helpful to service
provider operators.

Collection Zone (optional) Drop-down list of all collection zones within the ISC. Choices include:
None and all collection zones within the ISC. Default: None.

Management IP Address (optional) Valid IP address of the device that ISC uses to configure the
target router device.

Interfaces (optional) Click the Edit button to view, add, edit, and delete all interfaces associated
with the device. See Table 3-6 for a description of the Interfaces fields.

Table 3-6 Create Catalyst Device Interfaces Fields

Field Description Additional

Name Name of this interface. List can be sorted by this field.

Limited to 80 characters.

Encapsulation The Layer 2 Encapsulation for |DEFAULT

this device. DOTIQ
ETHERNET

ISL
FRAME_RELAY
FRAME_RELAY_IETF
HDLC

PPP

ATM
AALSSNAP
AALO

AALS
AALSMUX
AALSNLPID
AAL2
ENCAP_QinQ
GRE

IP Address IP address associated with this

interface.
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Table 3-6 Create Catalyst Device Interfaces Fields (continued)

Field Description Additional

Port Type NONE
ACCESS
TRUNK
ROUTED

VLAN ID The VLAN ID to assign to this

interface.

Associated Groups (optional) Click the Edit button to view, add, and remove all Device Group
associations.

Operating System (optional) Click the radio button for the operating system currently running on
the CAT switch. Choices include: Catalyst OS or Cisco I0S. Default: Catalyst OS. When you choose
the IOS operating system, VPNSM is available under the heading Catalyst Properties. If you click
the Edit button for VPNSM, you can Create, Edit, and Delete VPN Service Modules (VPNSMs).

The Login and Password Information section of the Create Catalyst Device window contains the
following fields:

Login User (optional) Not required by ISC. However, collection and upload/download will not
function without the Login User and Login Password as ISC will not be able to access the device.
Should match what is configured on the target router device. Limited to 80 characters.

Login Password (optional) Not required by ISC. However, collection and upload/download will not
function without the Login User and Login Password, because ISC will not be able to access the
device. Should match what is configured on the target router device. Limited to 80 characters.

Verify Login Password (optional) Must match the Login Password field. Limited to 80 characters.

Enable User (optional) Not required by ISC. However, collection and upload/download only
function if the Login User has sufficient privileges to configure the router in EXEC mode. Should
match what is configured on the target router device. Limited to 80 characters.

Enable Password (optional) Not required by ISC. However, collection and upload/download only
function if the Login User has sufficient privileges to configure the router in EXEC mode. Should
match what is configured on the target router device. Limited to 80 characters.

Verify Enable Password (optional) Must match the Enable Password field. Limited to 80
characters.

The Device and Configuration Access Information section of the Create Catalyst Device window
contains the following fields:

Terminal Session Protocol (optional) Configures the method of communication between ISC and
the device. Choices include: Telnet, Secure Shell (SSH), and CNS. In previous versions of ISC, this
field was called the Transport field. Default: The default set in the DCPL properties.

Config Access Protocol (optional) Administers the access protocol for config upload and download.
Choices include: Terminal, TFTP, and FTP. Default: The default set in the DCPL properties.

SNMP Version (optional) Configures the version of SNMP to use when communicating with the
device. Choices include: SNMP v1/v2c and SNMP v3. Default: The default set in the DCPL
properties.

[ oL-10727-01
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Step 4
Step 5

The SNMP v1/v2c section of the Create Catalyst Device window contains the following fields:

Community String RO (optional) SNMP Read-Only Community String. Many tasks use SNMP to
access the device. This field must match what is configured on the target router device. Limited to
80 characters.

Community String RW (optional) SNMP Read-Write Community String. Many tasks use SNMP
to access the device. This field must match what is configured on the target router device. Limited
to 80 characters.

Enter the desired information for the Catalyst device you are creating.

To access the Additional Properties section of the Create Catalyst Device, click Show.

The Additional Properties window appears, as shown in Figure 3-76.

Figure 3-76 Catalyst Device Additional Properties Window
Additional Properties: Hide
SHMP v3
SKMP Security Level: I Default (Mo Authentication/Mo Encryption) j

Authentication User Name:

Authentication Passward:

Yerify Authentication Passward:

Authentication Algarithm: MHaone j

Encryption Passward:

Yerify Encryption Passwoard:

|
|
|
Ii
|
|
Encryption Algarithim: Im

Terminal Server Options

Terminal Server: Mane j

Port: ID

Device Platform Information

Flatform:
Software Wersion:
Image Marme:
Serial Mumber:

Device Owner's Email Address:

| Save | Cancel

149132

The SNMP v3 section of the Catalyst Device Properties window contains the following fields:

SNMP Security Level (optional) Choices include: Default (<default_set_in_DCPL>),
Authentication/No Encryption, and Authentication/Encryption. Default: Default
(<default_set_in_DCPL>). Note: When you change the DCPL property, the
<default_set_in_DCPL> variable changes.

Authentication User Name (optional) User name configured on the specified device router. User
must have permission to the object identification numbers (OIDs) specified in the security request
(that is, write permission for a set request, and read permission for a get request). Should match what
is configured on the target router device. Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Limited to 80 characters.

Cisco IP Solution Center Infrastructure Reference, 4.2
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e Authentication Password (optional) Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Should match what is configured on
the target router device. Limited to 80 characters.

¢ Verify Authentication Password (optional) Must match the Encryption Password field. Limited to
80 characters.

¢ Authentication Algorithm (optional) Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Choices include: None, MDS5, and
SHA. Default: None.

¢ Encryption Password (optional) In previous versions of ISC, this field was called Privacy
Password. Should match what is configured on the target router device. Should be provisioned if the
SNMP Security Level is Authentication/Encryption. Limited to 80 characters.

¢ Verify Encryption Password (optional) Must match the Encryption Password field. Limited to 80
characters.

¢ Encryption Algorithm (optional) In previous versions of ISC, this field was called Privacy
Protocol. Should be provisioned if the SNMP Security Level is Authentication/Encryption. Choices
include: None and DES 56. Default: None.

The Terminal Server Options section of the Catalyst Device Properties window contains the following
fields:

e Terminal Server (optional) Choices include: None and the list of existing Terminal Server names.
Default: None.

e Port (optional) Disabled until a Terminal Server is selected. Range: 0-65535. Default: 0.

The Device Platform Information section of the Catalyst Device Properties window contains the
following fields:

¢ Platform (optional) Should match what is configured on the target router device. Limited to 80
characters.

¢ Software Version (optional) Should match what is configured on the target router device. Limited
to 80 characters.

¢ Image Name (optional) Should match what is configured on the target router device. Limited to 80
characters.

e Serial Number (optional) Should match what is configured on the target router device. Limited to
80 characters.

¢ Device Owner’s Email Address (optional) Used in the To: field when the Email button is selected
from the device list. Limited to 80 characters and must be valid Email format.

Step6  Enter any desired Additional Properties information for the Catalyst device you are creating.
Step7  Click Save.

The Devices window reappears with the new Catalyst device listed.

Creating a Cisco Device

To create a Cisco device, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Devices.

Step2  Click the Create button.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 3

Select Cisco Device.

The Create Cisco Device window appears, as shown in Figure 3-77.

Figure 3-77 Create Cisco Device Window
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The General section of the Create Cisco I0OS Device window contains the following fields:

Device Host Name Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required
and must match the name configured on the target router device. Limited to 256 characters.

Device Domain Name (optional) Must begin with a letter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. The name
must match the domain name on the target router device.

Description (optional) Limited to 80 characters. Can contain any pertinent information about the
device such as the type of device, its location, or other information that might be helpful to service
provider operators.

Collection Zone (optional) Drop-down list of all collection zones within the ISC. Choices include:
None and all collection zones within the ISC. Default: None.

Management IP Address (optional) Valid IP address of the device that ISC uses to configure the
target router device.

Interfaces (optional) Click the Edit button to view, add, edit, and delete all interfaces associated
with the device. See Table 3-7 for a description of the Interface fields.

Table 3-7 Create Cisco Device Interface Fields
Field Description Additional
Name Name of this interface. List can be sorted by this field.
Limited to 80 characters.
Encapsulation The Layer 2 Encapsulation for |DEFAULT
this device. DOTIQ
ETHERNET
ISL

FRAME_RELAY
FRAME_RELAY_IETF
HDLC

PPP

ATM

AALS5SNAP

AALO

AALS

AAL5SMUX
AALSNLPID

AAL2

ENCAP_QinQ

GRE

IP Address IP address associated with this

interface.
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Step 4
Step 5

Associated Groups (optional) Click the Edit button to view, add, and remove all Device Group
associations.

The Login and Password Information section of the Create Cisco IOS Device window contains the
following fields:

Login User (optional) Not required by ISC. However, collection and upload/download will not
function without the Login User and Login Password as ISC will not be able to access the device.
Should match what is configured on the target router device. Limited to 80 characters.

Login Password (optional) Displayed as stars (*). Not required by ISC. However, collection and

upload/download will not function without the Login User and Login Password as ISC will not be
able to access the device. Should match what is configured on the target router device. Limited to
80 characters.

Verify Login Password (optional) Displayed as stars (*). Must match the Login Password field.
Limited to 80 characters.

Enable User (optional) Not required by ISC. However, collection and upload/download only
function if the Login User has sufficient privileges to configure the router in EXEC mode. Should
match what is configured on the target router device. Limited to 80 characters.

Enable Password (optional) Displayed as stars (*). Not required by ISC. However, collection and
upload/download only function if the Login User has sufficient privileges to configure the router in
EXEC mode. Should match what is configured on the target router device. Limited to 80 characters.

Verify Enable Password (optional) Displayed as stars (*). Must match the Enable Password field.
Limited to 80 characters.

The Device and Configuration Access Information section of the Create Cisco IOS Device window
contains the following fields:

Terminal Session Protocol (optional) Configures the method of communication between ISC and
the device. Choices include: Telnet, Secure Shell (SSH), and CNS. In previous versions of ISC this

Config Access Protocol (optional) Administers the access protocol for config upload and download.
Choices include: Terminal, TFTP, and FTP. Default: The default set in the DCPL properties.

SNMP Version (optional) Configures the version of SNMP to use when communicating with the
device. Choices include: SNMP v1/v2c and SNMP v3. Default: The default set in the DCPL
properties.

The SNMP v1/v2c section of the Create Cisco IOS Device window contains the following fields:

Community String RO (optional) SNMP Read-Only Community String. Many tasks use SNMP to
access the device. This field must match what is configured on the target router device. Limited to
80 characters.

Community String RW (optional) SNMP Read-Write Community String. Many tasks use SNMP
to access the device. This field must match what is configured on the target router device. Limited
to 80 characters.

Enter the desired information for the Cisco IOS device you are creating.

To access the Additional Properties section of the Create Cisco Device, click Show.

The Additional Properties window appears, as shown in Figure 3-78.
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The SNMP v3 section of the Cisco IOS Device Properties window contains the following fields:

e SNMP Security Level (optional) Choices include: Default (<default_set_in_DCPL>),
Authentication/No Encryption, and Authentication/Encryption. Default: Default
(<default_set_in_DCPL>). Note: When you change the DCPL property, the
<default_set_in_DCPL> variable changes.

¢ Authentication User Name (optional) User name configured on the specified device router. User
must have permission to the object identification numbers (OIDs) specified in the security request
(that is, write permission for a set request, and read permission for a get request). Should match what
is configured on the target router device. Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Limited to 80 characters.

[ oL-10727-01
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Authentication Password (optional) Displayed as stars (¥). Should be provisioned if the SNMP
Security Level is Authentication/No Encryption or Authentication/Encryption. Should match what
is configured on the target router device. Limited to 80 characters.

Verify Authentication Password (optional) Displayed as stars (*). Must match the Encryption
Password field. Limited to 80 characters.

Authentication Algorithm (optional) Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Choices include: None, MDS5, and
SHA. Default: None.

Encryption Password (optional) Displayed as stars (*). In previous versions of ISC, this field was
called Privacy Password. Should match what is configured on the target router device. Should be
provisioned if the SNMP Security Level is Authentication/Encryption. Limited to 80 characters.

Verify Encryption Password (optional) Displayed as stars (*). Must match the Encryption
Password field. Limited to 80 characters.

Encryption Algorithm (optional) In previous versions of ISC, this field was called Privacy
Protocol. Should be provisioned if the SNMP Security Level is Authentication/Encryption. Choices
include: None and DES 56. Default: None.

The Terminal Server and CNS Options section of the Cisco I0S Device Properties window contains the
following fields:

Terminal Server (optional) Choices include: None and the list of existing Terminal Server names.
Default: None.

Port (optional) Disabled until a Terminal Server is selected. Range: 0-65535. Default: 0.

Fully Managed (optional) If the Fully Managed check box is checked, the device becomes a fully
managed device. ISC performs additional management actions only for fully managed devices.
These actions include e-mail notifications upon receipt of device configuration changes originated
outside ISC and the scheduling of enforcement audit tasks upon detection of possible intrusion.
Default: Not selected and therefore not selected.

Device State (optional) Choices include: ACTIVE and INACTIVE. ACTIVE indicates that the
router has been plugged on the network and can be part of ISC tasks such as collect config and
provisioning. INACTIVE indicates the router has not been plugged-in. Default: ACTIVE.

CNS Identification Required if the Device Event Identification field is set to CNS_ID. Only valid
characters that Cisco 10S allows are alphanumeric characters and (.) (-) ().

Device Event Identification (optional) Indicates whether the CNS Identification field contains a
HOST_NAME or CNS_ID. Default: HOST_NAME.

Most Recent CNS event (optional) Choices include: None, CONNECT, and DISCONNECT.
Changing from the default of None is not recommended. Note: The last connect or disconnect CNS
TIBCO event received by ISC for each CNS-enabled I10S device is automatically recorded.

IE2100 (optional) Disabled unless the Device State field is INACTIVE or the Terminal Session
Protocol field is CNS. A valid IE2100 must be selected if the Terminal Session Protocol is CNS.
Choices include: None and the list of existing IE2100 names. Default: None.

CNS Software Version (optional) Choices include: 1.3, 1.3.1, 1.3.2, 1.4, and 1.5. This is the release
version of Cisco CNS Configuration Engine that manages the IOS device. Default: 1.4.

CNS Device Transport (optional) Choices include: HTTP and HTTPS. This field determines what
will be the transport mechanism used by ISC to create, delete, or edit devices in the IE2100
repository. If HTTPS is used, the Cisco CNS Configuration Engine must be running in secure mode.
Default: HTTP.

Cisco IP Solution Center Infrastructure Reference, 4.2
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The Device Platform Information section of the Cisco IOS Device Properties window contains the
following fields:

e Platform (optional) Should match what is configured on the target router device. Limited to 80
characters.

¢ Software Version (optional) Should match what is configured on the target router device. Limited
to 80 characters.

¢ Image Name (optional) Should match what is configured on the target router device. Limited to 80
characters.

¢ Serial Number (optional) Should match what is configured on the target router device. Limited to
80 characters.

¢ Device Owner’s Email Address (optional) Used in the To: field when the Email button is selected
from the device list. Limited to 80 characters and must be valid Email format.

Step6  Enter any desired Additional Properties information for the Cisco IOS device you are creating.
Step7  Click Save.

The Devices window reappears with the new Cisco IOS device listed.

Creating a Terminal Server

To create a Terminal Server device, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Devices.
Step2  Click the Create button.
Step3  Select Terminal Server.

The Create Terminal Server window appears, as shown in Figure 3-79.
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Figure 3-79 Create Terminal Server Window
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The General section of the Create Terminal Server window contains the following fields:

¢ Device Host Name (required) Must begin with a letter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field
must match the name configured on the target router device. Limited to 256 characters.

e Device Domain Name (optional) Must begin with a letter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. The name
must match the domain name on the target router device.

¢ Description (optional) Limited to 80 characters. Can contain any pertinent information about the
device such as the type of device, its location, or other information that might be helpful to service
provider operators.

¢ Collection Zone (optional) Drop-down list of all collection zones within the ISC. Choices include:
None and all collection zones within the ISC. Default: None.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Management IP Address (optional) Valid IP address of the device that ISC uses to configure the
target router device.

Interfaces (optional) Click the Edit button to view, add, edit, and delete all interfaces associated
with the device. See Table 3-8 for a description of the Interfaces fields.

Table 3-8 Create Terminal Server Device Interfaces Fields

Field Description Additional

Name Name of this interface. List can be sorted by this field.
Limited to 80 characters.

Encapsulation The Layer 2 Encapsulation for |DEFAULT

this device. DOTI1Q

ETHERNET
ISL

FRAME_RELAY
FRAME_RELAY_IETF
HDLC

PPP

ATM

AALS5SNAP

AALO

AALS

AAL5SMUX
AALSNLPID

AAL2

ENCAP_QinQ

GRE

IP Address IP address associated with this

interface.

Associated Groups (optional) Click the Edit button to view, add, and remove all Device Group
associations.

The Login and Password Information section of the Create Terminal Server window contains the
following fields:

Login User (optional) Not required by ISC. However, collection and upload/download will not
function without the Login User and Login Password as ISC will not be able to access the device.
Should match what is configured on the target router device. Limited to 80 characters.

Login Password (optional) Displayed as stars (*). Not required by ISC. However, collection and

upload/download will not function without the Login User and Login Password as ISC will not be
able to access the device. Should match what is configured on the target router device. Limited to
80 characters.

Verify Login Password (optional) Displayed as stars (*). Must match the Login Password field.
Limited to 80 characters.

[ oL-10727-01
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¢ Enable User (optional) Not required by ISC. However, collection and upload/download only
function if the Login User has sufficient privileges to configure the router in EXEC mode. Should
match what is configured on the target router device. Limited to 80 characters.

e Enable Password (optional) Displayed as stars (*). Not required by ISC. However, collection and
upload/download only function if the Login User has sufficient privileges to configure the router in
EXEC mode. Should match what is configured on the target router device. Limited to 80 characters.

¢ Verify Enable Password (optional) Displayed as stars (*). Must match the Enable Password field.
Limited to 80 characters.

The Device and Configuration Access Information section of the Create Terminal Server window
contains the following fields:

¢ Terminal Session Protocol (optional) Configures the method of communication between ISC and
the device. Choices include: Telnet, Secure Shell (SSH), CNS, and RSH. In previous versions of
ISC, this field was called the Transport field. Default: The default set in the DCPL properties.

¢ Config Access Protocol (optional) Administers the access protocol for config upload and download.
Choices include: Terminal, TFTP, FTP, and RCP. Default: The default set in the DCPL properties.

e SNMP Version (optional) Configures the version of SNMP to use when communicating with the
device. Choices include: SNMP v1/v2c and SNMP v3. Default: The default set in the DCPL
properties.

The SNMP v1/v2c section of the Create Terminal Server window contains the following fields:

e Community String RO (optional) SNMP Read-Only Community String. Many tasks use SNMP to
access the device. This field must match what is configured on the target router device. Limited to
80 characters.

e Community String RW (optional) SNMP Read-Write Community String. Many tasks use SNMP
to access the device. This field must match what is configured on the target router device. Limited
to 80 characters.

Step4  Enter the desired information for the Terminal Server you are creating.
Step 5 To access the Additional Properties section of the Create Terminal Server, click Show.

The Additional Properties window appears, as shown in Figure 3-80.
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Figure 3-80 Terminal Server Device Properties Window
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The SNMP v3 section of the Terminal Server Device Properties window contains the following fields:

e SNMP Security Level (optional) Choices include: Default (<default_set_in_DCPL>),
Authentication/No Encryption, and Authentication/Encryption. Default: Default
(<default_set_in_DCPL>). Note: When you change the DCPL property, the
<default_set_in_DCPL> variable changes.

e Authentication User Name (optional) User name configured on the specified device router. User
must have permission to the object identification numbers (OIDs) specified in the security request
(that is, write permission for a set request, and read permission for a get request). Should match what
is configured on the target router device. Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Limited to 80 characters.

¢ Authentication Password (optional) Displayed as stars (*). Should be provisioned if the SNMP
Security Level is Authentication/No Encryption or Authentication/Encryption. Should match what
is configured on the target router device. Limited to 80 characters.

¢ Verify Authentication Password (optional) Displayed as stars (*). Must match the Encryption
Password field. Limited to 80 characters.

¢ Authentication Algorithm (optional) Should be provisioned if the SNMP Security Level is
Authentication/No Encryption or Authentication/Encryption. Choices include: None, MDS5, and
SHA. Default: None.

¢ Encryption Password (optional) Displayed as stars (*). In previous versions of ISC, this field was
called Privacy Password. Should match what is configured on the target router device. Should be
provisioned if the SNMP Security Level is Authentication/Encryption. Limited to 80 characters.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 6
Step 7

Verify Encryption Password (optional) Displayed as stars (*). Must match the Encryption
Password field. Limited to 80 characters.

Encryption Algorithm (optional) In previous versions of ISC, this field was called Privacy
Protocol. Should be provisioned if the SNMP Security Level is Authentication/Encryption. Choices
include: None and DES 56. Default: None.

The Device Platform Information section of the Terminal Server Device Properties window contains the
following fields:

Platform (optional) Should match what is configured on the target router device. Limited to 80
characters.

Software Version (optional) Should match what is configured on the target router device. Limited
to 80 characters.

Image Name (optional) Should match what is configured on the target router device. Limited to 80
characters.

Serial Number (optional) Should match what is configured on the target router device. Limited to
80 characters.

Device Owner’s Email Address (optional) Used in the To: field when the Email button is selected
from the device list. Limited to 80 characters and must be valid Email format.

Enter any desired Additional Properties information for the Terminal Server device you are creating.

Click Save.

The Devices window reappears with the new Terminal Server device listed.

Creating a Cisco CNS IE2100

~

Note

Step 1
Step 2
Step 3

To use the Cisco CNS IE2100 functionality on ISC, you must first set up the Cisco CNS IE2100
appliance and the ISC workstation as explained in Appendix B, “Setting Up Cisco CNS IE2100
Appliances with ISC” in the Cisco IP Solution Center Installation Guide, 4.2. You must also create a
Cisco IOS device to communicate with the Cisco CNS IE2100 appliance. See Appendix A, “Setting Up
Oracle for ISC,” in the Cisco IP Solution Center Installation Guide, 4.2.

To create a Cisco CNS IE2100 appliance, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Devices.

Click the Create button.
Select IE2100.

The Create IE2100 Device window appears, as shown in Figure 3-81.
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Figure 3-81 Create IE2100 Device Window

General
Device Host Mame -
Drevice Domain Marme:
Description:

IP Address:

25322

Mate: * - Reguired Field

The General section of the Create IE2100 Device window contains the following fields:

¢ Device Host Name (required) Must begin with a letter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. This field
must match the name configured on the target router device. Limited to 256 characters.

¢ Device Domain Name (optional) Must begin with a letter, digit, or underscore followed by letters,
digits, underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. The name
must match the domain name on the target router device.

¢ Description (optional) Limited to 80 characters. Can contain any pertinent information about the
device such as the type of device, its location, or other information that might be helpful to service
provider operators.

e TP Address (optional) Valid IP address of the Cisco CNS IE2100 device that ISC uses to configure
the target router device.

Step4  Enter the desired information for the Cisco CNS IE2100 device you are creating.
Step5  Click Save.
The Devices window reappears with the new Cisco CNS IE2100 device listed.

Editing a Device

From the Edit window, you can modify the fields that have been specified for a particular device.

To access the Edit window, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Devices to access the Devices
window shown in Figure 3-82.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-82 Deviices List Window

Devices
Show Devices with | Device Name V| matching |~ Find
% Showing 1 - 8 of 8 recards
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5 0 & =we Cisco 105 Device
B. [] &8 ces Cizco [0S Device
O & c=s Cisco 105 Device
8. [] & cels Cisco [0S Device
Rows per page: m [<] 4] Gota page: of 1 [> [=0
crote Jj car || voeie [ coono | emun [| cony |
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Step2  Select a single device to edit by checking the box to the left of the Device Name. You can also select a
device to edit by clicking on the hyperlink of the device name.

Step3  Click the Edit button. This button is only enabled if a device is selected.

The Edit window appropriate to the type of device selected appears. For example, if you selected a Cisco
I0S device the Edit Cisco IOS Device window appears, as shown in Figure 3-83.
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Edit Cisco Device
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LHEHBLER

Terminal Session Pratocal: | Default (Telnet) j

Config Access Protocol: | Detault (Terminal) j

08: fos

SMMP Version: [ Default (SNMP w1 A2c) x]
SNMPviv2e

Cammunity String RO Ipublic:

Community String R |pri\.fate

| Save | Cancel

Mote: * - Required Field

149144

Devices W

Step4  Enter the changes you want to make to the selected device.

Step5  Click Save.

The changes are saved and the Devices window reappears.

[ oL-10727-01
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Deleting Devices

From the Delete window, you can remove selected devices from the database.

To access the Delete window, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Devices to access the Devices
window shown in Figure 3-84.

Figure 3-84

Devices

Devices List Window

Show Devices with | Device MName ~ | matching |*

Management IP

Showing 1 - 8 of 8 records

# |:| Device Hame Address Type Parent Device Hame
1.0 & pet Cizco [0S Device
2. [] &9 pes Cisoo [0S Device
3.0 &8 =w2 Cizco [0S Device
4. [] & =w3 Cisoo [0S Device
5.1 &8 =wd Cizco [0S Device
6. [] &9 ce3 Cisoo [0S Device
7.0 & ces Cizco [0S Device
8. [] &9 cels Cisoo [0S Device
Rows per page: | 10 1<) €] Goto page: 1 of 1 [ =1
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Step 2 Select one or more devices to delete by checking the check box(es) to the left of the Device Name(s).

Step3  Click the Delete button. This button is only enabled if one or more devices are selected.

The Confirm Delete window appears, as shown in Figure 3-85.

Figure 3-85

Confirm Delete

Confirm Delete Window

Device Hame

Confirm Delete
Showing 1 -1 of 1 record
Management IP Tyoe Parent Device
Address Mame

1. ensw3950-1.cisco.com

[ |

Rowes per page: | 10

Cisco |05 Device

1<]<] Goto page:l1 of 1 [ [0

| Delete || Cancel |

149142
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Step 4 Click the Delete button to confirm that you want to delete the device(s) listed.

The Devices window reappears with the specified device(s) deleted.

Editing a Device Configuration

From the Config window, you can edit the configuration for a specified device.

To access the Config window, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Devices to access the Devices
window shown in Figure 3-86.

Figure 3-86 Deviices List Window

Devices
Showy Devices with | Device Mame | matching |
% Showing 1 - 8 of 8 recards
- Management IP -
# |:| Device Hame Address Type Parent Device Hame
1. & pet Cisoo [0S Device
2. [] & pe3 Cizco [0S Device
3.0 &8 =w2 Cisoo [0S Device
4. [] &8 =ws Cizco [0S Device
5. ] & =we Cisoo [0S Device
6. [ | & ce3 Cizco [0S Device
.00 & ced Cisoo [0S Device
8. [ ] & cel3 Cizco [0S Device
Rowvs per page: | 10 1] €] Goto page: 1 of1 [+ =1
.| I | I I |
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Step2  Select a single device to modify by checking the check box to the left of the Device Name.
Step3  Click the Config button.

The Device Configurations window for the selected device appears, as shown in Figure 3-87.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 4

Step 5
Step 6

Step 7

Figure 3-87 Device Configurations Window

Device Configurations

Device: ensw2950-1.cisco.com Allowed Configs: unlimited

# I

Showing 1- 3 of 3 records

Date Recyclable
1. [~ Mov0DB 065321 FMPST Yes
2. T Mov0206:41:30 PMPST Yes
3. I_ Mow 08 06:37:56 PM PST Yes
Rows perpage:| 10 x| 1<] <] Goto page: [1 of1 [0
| Eat || peete [ ox | g
z

Check the box to the left of the Date for the configuration that you want to modify and click the Edit
button. This button is only enabled if a device is selected.

The Device Configuration window for the selected device appears, as shown in Figure 3-88.

Figure 3-88 Device Configuration Window

Device Configuration

[

Device: vmd-2950b Config: Mar 18 02:04:52 PM PST

Recyclable: i

]
wversion 12.0
no service pad
service timestamps debug uptime
service timestamps log uptime
no service password-encryption
]
hostname vwd-z2950b

]

enahle password movedZnw
]

ip subnet-zero
no ip domain-lookup
]

-

[

Cancel

o
—
uxl
(ul
i)

Click OK to return to the Devices window.

Cisco IP Solution Center Infrastructure Reference, 4.2

Enter the changes you want to make to the selected device configuration.
Click Save.

The changes are saved and the Device Configurations window reappears.
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E-mailing a Device's Owner

Step 1

Step 2

Step 3

From the E-mail window, you can send a device report via e-mail to the owners of specified devices.

To access the E-mail window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Devices to access the Devices
window shown in Figure 3-89.

Figure 3-89

Devices

Devices List Window

Show Devices with | Device MName ~ | matching |*

Showing 1 - 8 of 8 records
Management IP

# |:| Device Hame Address Type Parent Device Hame
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2. [] &9 pes Cisoo [0S Device
3.0 &8 =w2 Cizco [0S Device
4. [] & =w3 Cisoo [0S Device
5.1 &8 =wd Cizco [0S Device
6. [] &9 ce3 Cisoo [0S Device
7.0 & ces Cizco [0S Device
8. [] &9 cels Cisoo [0S Device
Rows per page: | 10 1<) €] Goto page: 1 of 1 [ =1
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Select the devices for which you want to send a device report by checking the check box(es) to the left
of the Device Name(s).

Click the E-mail button. This button is only enabled if one or more devices are selected.

The Send Mail to Device Owners window appears, as shown in Figure 3-90.

[ oL-10727-01
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Figure 3-90 Send Mail to Device Owners Window

Send Mail to Device owners

Please separate E-mail addreszes using comima.

T I

ol |

Subject: ID evice Report
Messane: ;I

.
Il »

93789

Step4  Compose the e-mail that you want to send to the selected device owners.
Step5  Click Send.

The e-mail is sent and the Devices window reappears.

Copying a Device

From the Copy window, you receive a copy of the chosen device and can name it and change values.

To access the Copy window, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Devices to access the Devices
window shown in Figure 3-91.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-91
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Select a single device to copy by checking the check box to the left of the Device Name.

Click the Copy button. This button is only enabled if a device is selected.

A window appropriate to the type of device selected to copy appears. You receive an exact copy of the
selected device but the Name, Management IP Address, all Interfaces, and VPNSM blades for a Catalyst
Switch running Cisco IOS are blanked out and you must fill in the required information and save this
new device. See the “Creating a Device” section on page 3-76 for specifics.

Device Groups

Every network element that ISC manages must be defined as a device in the system. After you have
defined your network elements as devices, you can organize the devices into groups for collection and
management purposes.

This section describes how to create, edit, and delete device groups and e-mail device group owners. This
section includes the following:

e Accessing the Device Groups Window, page 3-102

e Creating a Device Group, page 3-102
e Editing a Device Group, page 3-105

e Deleting Device Groups, page 3-105

¢ E-mailing a Device Group, page 3-106

[ oL-10727-01
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Accessing the Device Groups Window

The Device Groups feature is used to create, edit, and delete device groups and e-mail device group
owners.

To access the Device Groups window, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Device Groups to access the
Device Groups window shown in Figure 3-92.

Figure 3-92 Device Groups Window

Device Groups

Show Device Groups with | Device Group Name j matching I* Iﬂl
Showving 1-4 of 4 records
# Device Group Hame Description
1. [T groupt

2. [T Device Group 1
3. [T Device Group B

4. [ DeviceC

Rows per page: I 1a 'l

| Create | |

93820

The Device Groups window contains the following:
¢ Device Group Name Lists the name of the device group. You can sort the list by device group name.
¢ Description Lists the description of the device group.

From the Device Groups window, you can create, edit, or delete device groups or e-mail device group
owners using the following buttons:

¢ Create Click to create new device groups. Enabled only if no device group is selected.

¢ Edit Click to edit a selected device group (select device group by checking the corresponding box).
Enabled only if a single device group is selected.

¢ Delete Click to delete selected device group(s) (select device group by checking the corresponding
box). Enabled only if one or more device groups are selected.

e E-mail Click to send e-mail to the owner of a selected device group (select device group by checking
the corresponding box). Enabled only if one or more device groups are selected.

Creating a Device Group

From the Create Device Group window, you can create different device groups.

To create a device group, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Device Groups.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step2  Click the Create button.

The Create Device Group window appears, as shown in Figure 3-93.

Figure 3-93 Create Device Group Window

Create Device Group

Mame :
Description:
Devices: # Marne De=cription Edit |

Rows per page; I 10 =| 1] ] 3ot page: |1 of 1 (2 (20

| Sanwe || Cancel |

117443

Mate; * - Reguired Field

The Create Device Group window contains the following fields:

e Name (required) Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. Limited to 80
characters.

e Description (optional) Any pertinent information about the device group that could be helpful to
service provider operators. Limited to 512 characters.

Step3  Enter the name and the description of the Device Group that you are creating.
Step4  Click Edit.

The Select Group Members window appears, as shown in Figure 3-94.

[ oL-10727-01
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Figure 3-94 Select Group Members Window

Select Group Members

158148

Step5  Select the devices that you want to be group members by checking the check box to the left of the device
name.

Step6  Click OK.

The Create Device Group window appears listing the selected devices, as shown in Figure 3-95.

Figure 3-95 Create Device Group Window

ECreate Device Group

mlote: * - Reguired Field

152149

Step7  Click Save.

The Device Groups window reappears with the new device group listed.

Cisco IP Solution Center Infrastructure Reference, 4.2
m. oL-10727-01 |



| Chapter3 Service Inventory — Inventory and Connection Manager

Device Groups W

Editing a Device Group

From the Edit Device Group window, you can modify the fields that have been specified for a particular
device group.

To access the Edit Device Group window, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Device Groups.

Step2  Select a single device group to modify by checking the check box to the left of the Device Group Name.
Step3  Click the Edit button. This button is only enabled if a device group is selected.

The Edit Device Group window appears, as shown in Figure 3-96.

Figure 3-96 Edit Device Group Window

Edit Device Group
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Step4  Enter the changes you want to make to the selected device group.

Step5  Click Save.

The changes are saved and the Device Groups window reappears.

Deleting Device Groups

From the Delete window, you can remove selected device groups from the database.

To access the Delete window, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Device Groups.

Step2  Select one or more device groups to delete by checking the check box(es) to the left of the Device Group
Names.

Step3  Click the Delete button. This button is only enabled if one or more device groups are selected.

The Confirm Delete window appears, as shown in Figure 3-97.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-97 Confirm Delete Window

Confirm Delete

Confirm Delete
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Rowvs per page: I 10 'I
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Step4  Click the Delete button to confirm that you want to delete the device group(s) listed.

The Device Groups window reappears with the specified device group(s) deleted.

E-mailing a Device Group

From the E-mail window, you can send a device report via e-mail to the owners of specified device
groups.

To access the E-mail window, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Device Groups.

Step2  Select the device groups for which you want to send a device report by checking the check box to the
left of the Device Group Name.

Step3  Click the E-mail button. This button is only enabled if one or more device groups are selected.

The Send Mail to Device owners of selected groups window appears, as shown in Figure 3-98.
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Figure 3-98 Send Mail to Device Owners of Selected Groups Window
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Step4  Compose the e-mail that you want to send to the selected device group owners.
Step5  Click Send.

The e-mail is sent and the Device Groups window reappears.

Customers

A customer site is a set of IP systems with mutual IP connectivity between them without the use of a
VPN. Each customer site belongs to exactly one customer. A customer site can contain one or more (for
load balancing) edge device routers. This section describes how to create, edit, and delete customers.
This section includes the following:

e Accessing the Customers Window, page 3-108
e Creating a Customer, page 3-108

e Editing a Customer, page 3-109

e Deleting Customers, page 3-110

¢ Creating Customer Sites, page 3-111

e CPE Devices, page 3-112

Cisco IP Solution Center Infrastructure Reference, 4.2
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Accessing the Customers Window

The Customers feature is used to create, edit, and delete customers.

To access the Customers window, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Customers to access the
Customers window shown in Figure 3-99.

Figure 3-99 Customers Window
Customers
Shove Customers with Customer MName matching * |—|
Showving 1-3 of 3 records
# [
1 r
2 I
. O
Rows per page: | 10 7

95238

The Customers window contains the following:
e Customer Name Lists the names of customers. You can sort the list by customer name.

From the Customers window, you can create, edit, or delete customers using the following buttons:
e Create Click to create new customers.

e Edit Click to edit selected customer (select by checking the corresponding box). Enabled only if a
single customer is selected.

¢ Delete Click to delete selected customer (select customer by checking the corresponding box).
Enabled only if one or more customers are selected.

Creating a Customer

From the Create Customer window, you can create different customers.

To create a customer, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Customers.

Step2  Click the Create button.

The Create Customer window appears, as shown in Figure 3-100.
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Figure 3-100 Create Customer Window

Create Customer

u
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The Create Customer window contains the following fields:

e Name (required) Must begin with a letter. Can contain letters, numbers, and these punctuation
characters: period, underscore, and dash. Limited to 80 characters.

e Customer Abbreviation This field in used only for L2ZVPN and L2TPv3 Frame Relay service
requests. The entry in this field is used to construct a connect name. When this field is left blank,
DLCI switching is the transport mode used. Limited to 9 characters.

e Customer Information (optional) Any pertinent information about the customer that could be
helpful to service provider operators. Limited to 256 characters.

¢ Site of Origin Enabled (optional) This check box appears only when you have MPLS permissions.
Check this check box to enable the site of origin.

Step3  Enter the name and information for the Customer that you are creating. Check the Site of Origin
Enabled check box if you want this enabled.

Step4  Click Cancel if you do not want to save this information, and you will proceed to the previous window.

Otherwise, click Save. The changes are then saved and the Customers window reappears.

Editing a Customer

From the Edit Customer window, you can modify the fields that have been specified for a particular
customer.

To access the Edit Customer window, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Customers.
Step2  Select a single customer to modify by checking the check box to the left of the Customer Name.
Step3  Click the Edit button. This button is only enabled if a customer is selected.

Cisco IP Solution Center Infrastructure Reference, 4.2
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The Edit Customer window appears, as shown in Figure 3-101.

Figure 3-101 Edit Customer Window

Edit Custemer

Marme - [Customer]

Custarmer Abbreviation: ICUST1
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| Sawve || Cancel
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Step4  Enter the changes you want to make to the selected customer.
Step5  Click Cancel if you do not want to save this information, and you will proceed to the previous window.

Otherwise, click Save. The changes are then saved and the Customers window reappears.

Deleting Customers

From the Delete window, you can remove selected customers from the database.

To access the Delete window, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Customers.
Step2  Select one or more customers to delete by checking the check box to the left of the Customer Name.
Step3  Click the Delete button. This button is only enabled if one or more customers are selected.

The Confirm Delete window appears, as shown in Figure 3-102.
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Figure 3-102 Confirm Delete Window

Delete Customer
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Step4  Click Cancel if you do not want to save this information, and you will proceed to the previous window.

Otherwise, click Delete to confirm that you want to delete the customer(s) listed. The Customers window
reappears with the specified customer(s) deleted.

Creating Customer Sites

To access the Customer Sites window, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager.

Step2  Click on Customer Sites listed in the Inventory and Connection Manager tree in the left column under
Customers.

The Customer Sites window appears.

Figure 3-103 Customer Sites Window

Customer Sites

Show Sites with | =ite MName ~ | matching |~

Showing 1 - 2 of 2 records

# | ] Site Hame Customer Hame
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The Customer Sites window contains the following:

¢ Site Name Lists the names of sites. The first character must be a letter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limit: 80 characters. You can sort
the list by site name.

Cisco IP Solution Center Infrastructure Reference, 4.2
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e Customer Name Lists the names of customer. The first character must be a letter. Can contain
letters, numbers, and these punctuation characters: period, underscore, and dash. Limit: 80
characters. You can sort the list by customer name.

From the Customer Sites window, you can create, edit, or delete customer sites using the following
buttons:

¢ Create Click to create new customer sites. Enabled only if no customer site is selected.

¢ Edit Click to edit selected customer sites (select by checking the corresponding box). Enabled only
if a single customer site is selected.

¢ Delete Click to delete selected customer site(s) (select by checking the corresponding box(es)).
Enabled only if one or more customer sites are selected.

CPE Devices

The CPE feature provides a list of CPEs that have been associated with a site through the CPE editor or
Inventory Manager. To access the CPE Devices window, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager.

Step2  Click on CPE Devices listed in the Inventory and Connection Manager tree in the left column under
Customers.

The CPE Devices window appears.

Figure 3-104 CPE Devices Window

CPE Devices
Showy CPEs with | Device Mame | matching |
Showing 1 - 3 of 3 recards
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The CPE Devices window contains the following:

e Device Name Lists the names of devices. The first character must be a letter. Can contain letters,
numbers, and these punctuation characters: period, underscore, and dash. Limit: 80 characters. You
can sort the list by device name.

¢ Customer Name Lists the names of customer. The first character must be a letter. Can contain
letters, numbers, and these punctuation characters: period, underscore, and dash. Limit: 80
characters. You can sort the list by customer name.
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e Site Name Lists the names of sites. The first character must be a letter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limit: 80 characters. You can sort
the list by site name.

¢ Management Type When associating a CE with a customer site, you can select Managed or
Unmanaged. Other choices are available (see below), but they should not be confused with this
primary choice.

Create CPE Device

Managed—A managed CE can be provisioned directly by the provider using ISC. The CE must
be reachable from an ISC server.

Unmanaged —An unmanaged CE cannot be provisioned directly by the provider. If Unmanaged
is selected, the provider can use ISC to generate a configuration, and then send the configuration
to the customer for placement on the CE.

Managed - Management LAN —A managed Management LAN or Management CE (MCE) is
configured like a managed CE router, but it resides in the provider space. Normally, an MCE
acts as the network operations center (NOC) gateway router.

Unmanaged - Management LAN —An unmanaged Management LAN or MCE is configured
like an unmanaged CE router, but it resides in the provider space. Normally, an MCE acts as the
network operations center (NOC) gateway router.

Directly Connected —In most cases, the CE is connected to a PE router. In this case, the CE is
connected to a workstation or other device.

Directly Connected Management Host —In most cases, the CE is connected to a PE router. In
this case, the CE is connected to a workstation or other device, on which ISC resides.

Multi-VRF —A multi-VRF CE (MVRFCE) is owned by the customer, but resides in the
provider space. It is used to off-load traffic from the PE.

Unmanaged Multi-VRF—An unmanaged multi-VRF CE is provisioned like an unmanaged CE
(configurations are not uploaded or downloaded to the device by the provider). It is owned by
the customer and resides in the provider space.

This section explains how to create a CPE device.

Step 1 Click Create to create new CPE devices. Enabled only if no customer site is selected. The resulting
window is shown in Figure 3-105, “Create CPE Device Window.”

[ oL-10727-01
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Figure 3-105 Create CPE Device Window

Create CPE Device

Device Namex:
Site: Namex:

management Type: kanaged -

116250

Meote: * - Required Field

Step2  Click Select for the required Device Name and Site Name. For each, you receive a list of the devices
and sites, respectively, from which you can choose one in each window and then click Select. Click
Cancel if you do not want to save this information, and you will proceed to the previous window.

Step3  The drop-down window for Management Type allows you choose the management type of the CPE
device you are creating.

Step4  Click Cancel if you do not want to save this information, and you will proceed to the previous window.

Otherwise, click Save. The changes are saved and the CPE Device window reappears.

Edit CPE Device

Click Edit to edit a single CPE device selected in Figure 3-104. The result is a window as shown in the
example in Figure 3-106, “Edit CPE Device Window,” for which you can make changes and Save.
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Figure 3-106
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Delete CPE Device

Click Delete to delete selected CPE device(s) (select by checking the corresponding box). Enabled only
if one or more CPE devices are selected. A Confirm Delete window allows you to continue with the
deletion or cancel this deletion.

Providers

116251

This section describes how to create and manage providers. This section includes the following:

e Accessing the Providers Window, page 3-116

e (Creating a Provider, page 3-116

e Editing a Provider, page 3-117

e Deleting Providers, page 3-118

e Creating Provider Regions, page 3-119
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e Creating PE Devices, page 3-120

e Creating Access Domains, page 3-121

Accessing the Providers Window

The Providers feature is used to create and manage providers.

To access the Providers window, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Providers to access the Providers
window shown in Figure 3-107.

Figure 3-107 Providers Window

Providers
Shovwy Providers with Provider Mame matching “
Showing 1 -1 of 1 record
| Provider Hame Provider BGP AS
1. [] Provwider 99
Rowvs per page: | 10 1] €] Goto page: 1 of1 [+ =1

L | e | e |

188152

The Providers window contains the following:
¢ Provider Name Lists the names of providers. You can sort the list by provider name.

e Provider BGP AS The Unique number assigned to each BGP autonomous system. Range: 1 to
65535.

From the Providers window, you can create, edit, or delete providers using the following buttons:
¢ Create Click to create new providers. Enabled only if no customer is selected.

e Edit Click to edit a selected provider (check the corresponding box). Enabled only if a single
provider is selected.

¢ Delete Click to delete selected provider(s) (check the corresponding box(es)). Enabled only if one
or more providers are selected.

Creating a Provider

From the Create Provider window, you can create different providers.

To create a provider, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Providers.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step2  Click the Create button.

The Create Provider window appears, as shown in Figure 3-108.

Figure 3-108 Create Provider Window

Create Provider
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Mote: * - Required Field

The Create Provider window contains the following fields:

e Name (required) Must begin with a letter. Can contain letters, numbers, and these punctuation
characters: period, underscore, and dash. Limited to 80 characters.

e BGP AS (required) Each BGP autonomous system is assigned a unique 16-bit number by the same
central authority that assigns IP network numbers. Range: 1 to 65535.

¢ Contact Information (optional) Any pertinent information about the provider that could be helpful
to service provider operators. Limited to 256 characters.

Step3  Enter the name, BGP AS, and any contact information for the Provider that you are creating.

Step4  Click Save.

The Providers window reappears with the new provider listed.

Editing a Provider

From the Edit Provider window, you can modify the fields that have been specified for a particular
provider.

To access the Edit Provider window, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Providers.
Step2  Select a single provider to modify by checking the check box to the left of the Provider Name.
Step3  Click the Edit button. This button is only enabled if a customer is selected.

The Edit Provider window appears, as shown in Figure 3-109.
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Figure 3-109 Edit Provider Window
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Step4  Enter the changes you want to make to the selected provider.
Step5  Click Save.

The changes are saved and the Providers window reappears.

Deleting Providers

From the Delete window, you can remove selected providers from the database.

To access the Delete window, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Providers.
Step2  Select provider(s) to delete by checking the check box to the left of the Provider Name.
Step3  Click the Delete button. This button is only enabled if one or more Providers are selected.

The Confirm Delete window appears, as shown in Figure 3-110.
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Figure 3-110 Confirm Delete Window

Delete Provider{s)

Confirm Delete
Showing 1-1 of 1 recaords
# Mame

1. Provider2,

Rows per page: |10
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Click the Delete button to confirm that you want to delete the provider(s) listed.

The Providers window reappears with the specified provider(s) deleted.

Creating Provider Regions

Step 1
Step 2

A Provider Region is considered to be a group of provider edge routers (PEs) within a single BGP
autonomous system. The primary objective for defining Provider Regions is to allow a provider to
employ unique IP address pools in large Regions, such as Europe, Asia Pacific, and so forth.

To access the Provider Regions window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager.

Click on Provider Regions listed in the Inventory and Connection Manager tree in the left column under
Providers.

The Provider Regions window appears.

Figure 3-111 Provider Regions Window

Provider R%iuns

Show Regions with | FE Fegion Mame % | matching |*

Showing 1 -1 of 1 record
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The Provider Regions window contains the following:

¢ PE Region Name Lists the names of regions. Must begin with a letter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can
sort the list by region name.

[ oL-10727-01
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¢ Provider Name Lists the names of providers. Must begin with a letter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can
sort the list by provider name.

From the Provider Regions window, you can create, edit, or delete provider regions using the following
buttons:

¢ Create Click to create new provider regions. Enabled only if no customer is selected.

¢ Edit Click to edit selected provider regions (check the corresponding box). Enabled only if a single
provider region is selected.

¢ Delete Click to delete selected provider regions (check the corresponding box(es)). Enabled only if
one or more provider regions are selected.

Creating PE Devices

The PE Devices feature provides a list of provider edge routers (PEs) that have been associated with the
region, either through the PE editor or Inventory Manager.

To access the PE Devices window, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager.

Step2  Click on PE Devices listed in the Inventory and Connection Manager tree in the left column under
Providers.

The PE Devices window appears.

Figure 3-112 PE Devices Window
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The PE Devices window contains the following:

¢ Device Name Lists the names of devices. The first character must be a letter. Can contain letters,
numbers, and these punctuation characters: period, underscore, and dash. Limit: 80 characters. You
can sort the list by device name.
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¢ Provider Name Lists the names of providers. Must begin with a letter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can
sort the list by provider name.

e Region Name Lists the names of regions. Must begin with a letter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can
sort the list by region name.

¢ Role Type Choices include: N-PE, U-PE, P, PE_AGG.
From the PE Devices window, you can create, edit, or delete providers using the following buttons:
¢ Create Click to create new PE device. Enabled only if no PE device is selected.

¢ Edit Click to edit selected PE device (check the corresponding box). Enabled only if a single PE
device is selected.

¢ Delete Click to delete selected PE device(s) (check the corresponding box(es)). Enabled only if one
or more PE devices are selected.

Creating Access Domains

To access the Access Domains window, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager.

Step2  Click on Access Domains listed in the Inventory and Connection Manager tree in the left column under
Providers.

The Access Domains window appears.

Figure 3-113 Access Domains Window
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The Access Domains window contains the following:

¢ Access Domain Name Lists the names of access domain. The first character must be a letter. Can
contain letters, numbers, and these punctuation characters: period, underscore, and dash. Limit: 80
characters. You can sort the list by access domain name.

e Provider Name Lists the names of providers. Must begin with a letter. Can contain letters, numbers,
and these punctuation characters: period, underscore, and dash. Limited to 80 characters. You can
sort the list by provider name.
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From the Access Domains window, you can create, edit, or delete access domains using the following
buttons:

¢ Create Click to create new access domain. Enabled only if no access domain is selected.

e Edit Click to edit a selected access domain (check the corresponding box). Enabled only if a single
access domain is selected.

¢ Delete Click to delete selected access domain(s) (check the corresponding box(es)). Enabled only
if one or more access domains are selected.

Resource Pools

Cisco IP Solution Center enables multiple pools to be defined and used during operations. The following
resource pools are available:

e [P address pool: The IP address pool can be defined and assigned to regions or VPNs. This feature
gives the service operator the flexibility to manage the allocation of all IP addresses in the network.

e Multicast pool: The Multicast pool is used for Multicast MPLS VPNGs.

¢ Route Target (RT) pool: A route target is the MPLS mechanism that informs PEs as to which routes
should be inserted into the appropriate VRFs. Every VPN route is tagged with one or more route
targets when it is exported from a VRF and offered to other VRFs. The route target can be considered
a VPN identifier in MPLS VPN architecture. RTs are a 64-bit number.

¢ Route Distinguisher (RD) pool: The IP subnets advertised by the CE routers to the PE routers are
augmented with a 64-bit prefix called a route distinguisher (RD) to make them unique. The resulting
96-bit addresses are then exchanged between the PEs, using a special address family of
Multiprotocol BGP (referred to as MP-BGP). The RD pool is a pool of 64-bit RD values that Cisco
IP Solution Center uses to make sure the IP addresses in the network are unique.

¢ Site of origin pool: The pool of values for the site-of-origin (SOO) attribute. The site-of-origin
attribute prevents routing loops when a site is multihomed to the MPLS VPN backbone. This is
achieved by identifying the site from which the route was learned, based on its SOO value, so that
it is not readvertised back to that site from a PE in the MPLS VPN network.

e VCID pool: VC ID pools are defined with a starting value and a size of the VC ID pool. (VC ID is
a 32-bit unique identifier that identifies a circuit/port.) A given VC ID pool is not attached to any
Inventory object. During the deployment of an Ethernet Service (EWS, ERS for example), VC ID is
auto-allocated from the VC ID pool.

e VLAN ID pool: VLAN ID pools are defined with a starting value and a size of the VLAN pool. A
given VLAN ID pool can be attached to an Access Domain. During the deployment an Ethernet
Service (EWS, ERS for example), VLAN ID can be auto-allocated from the Access Domain’s
VLAN pools. This gives the Service Provider a tighter control of VLAN ID allocation.

All these resources, that are made available to the service provider, enable the automation of service
deployment.

This section describes how you can create and manage pools for various types of resources. This section
includes the following:

e Accessing the Resource Pools Window, page 3-123
¢ Creating an IP Address Pool, page 3-124
e Creating a Multicast Pool, page 3-125
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e Creating a Route Distinguisher and Route Target Pool, page 3-126
e Creating a Site of Origin Pool, page 3-128

e Creating a VC ID Pool, page 3-130

¢ Creating a VLAN Pool, page 3-130

e Deleting Resource Pools, page 3-132

Accessing the Resource Pools Window

Step 1

The Resource Pools feature is used to create and manage various types of resource pools.

To access the Resource Pools window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Resource Pools to access the
Resource Pools window shown in Figure 3-114.

Figure 3-114 Resource Pools Window
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From the Resource Pools window, you have access to the following buttons:

¢ Pool Type Choices include: IP Address, Multicast, Route Distinguisher, Route Target, Site of
Origin, VC ID, and VLAN. The fields displayed in the Resource Pools window vary depending on
the pool type selected.

e Create Click to create new resource pools. Enabled only if no resource pool is selected.

¢ Delete Click to delete selected resource pools (select by checking the corresponding box(es)).
Enabled only if one or more resource pools are selected.

[ oL-10727-01
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Creating an IP Address Pool

Step 1
Step 2
Step 3

ISC uses IP address pools to automatically assign IP addresses to PEs and CEs. Each Region has an IP
address pool to use for IP numbered addresses (/30 pools) and a separate IP address pool for IP
unnumbered addresses (/32 loopback address pools).

Within a VPN or extranet, all IP addresses must be unique. Customer IP addresses must not overlap with
the provider's IP addresses. Overlapping IP addresses are only possible when two devices cannot see
each other—that is, when they are in isolated VPNs.

From the Create IP Address Pool window, you can create IP address pools.

To create an IP address pool, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Resource Pools.
Select IP address from the Pool Type in the upper left of the Resource Pools window.
Click the Create button.

The Create IP Address Pool window appears, as shown in Figure 3-115.

Figure 3-115 Create IP Address Pool Window
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The Create IP Address Pool window contains the following fields:
e TP Address Pool (required) Text field in the format a.b.c.d/mask, for example 172.0.0.0/8.
¢ Pool Mask (bits) (required) Choices include: 30 and 32
where:
30 is used for IP numbered address pools (/30)
32 is used for IP unnumbered loopback address pools (/32).

¢ Pool Association (required) Choices include: Region, VPN, and Customer from the drop-down
list. Then you can click the Select button to receive all selections for the choice you made in the
drop-down list. From this new window, make your selection and click Select.

Note If you choose VPN, an additional optional field appears, Pool Name Suffix, when you return to
Figure 3-115. This field allows the creation of multiple address pools within the same VPN. If
you are creating this address pool for DM VPN usage, the recommendation is to use this field to
specify a suffix.
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Step4  Enter the required information for the IP address pool you are creating.
Step5  Click Save.

The Resource Pools window reappears with the new IP address pool listed.

Creating a Multicast Pool

From the Create Multicast Pool window, you can create multicast pools. These pools are global and are
not associated with any provider or customer.

To create a multicast pool, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Resource Pools.
Step2  Select Multicast from the Pool Type in the upper left of the Resource Pools window.
Step3  Click the Create button.

The Create Multicast Pool window appears, as shown in Figure 3-116.

Figure 3-116 Create Multicast Pool Window
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The Create Multicast Pool window contains the following fields:

e Multicast Address (required) Text field in the format a.b.c.d/mask, for example 239.0.0.0/8. Range:
224.0.1.0/8 to 239.255.255.255/32.

e Use for default MDT (optional) This is a check box. Default: selected.

e Use for Data MDT (optional) This is a check box. The data MDT contains a range of multicast
group addresses and a bandwidth threshold. Thus, whenever a CE behind a multicast-VRF exceeds
that bandwidth threshold while sending multicast traffic, the PE sets up a new data MDT for the
multicast traffic from that source. The PE informs the other PEs about this data MDT and, if they
have receivers for the corresponding group, the other PEs join this data MDT. Default: selected.

Step4  Enter the required information for the multicast pool you are creating.
Step5  Click Save.

The Resource Pools window reappears with the new multicast pool listed.
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Creating a Route Distinguisher and Route Target Pool

MPLS-based VPNs employ Border Gateway Protocol (BGP) to communicate between PEs to facilitate
customer routes. This is made possible through extensions to BGP that carry addresses other than IPv4
addresses. A notable extension is called the route distinguisher (RD).

The purpose of the route distinguisher (RD) is to make the prefix value unique across the network
backbone. Prefixes should use the same RD if they are associated with the same set of route targets (RTs)
and anything else that is used to select routing policy. The community of interest association is based on
the route target (RT) extended community attributes distributed with the Network Layer Reachability
Information (NLRI). The RD value must be a globally unique value to avoid conflict with other prefixes.

The MPLS label is part of a BGP routing update. The routing update also carries the addressing and
reachability information. When the RD is unique across the MPLS VPN network, proper connectivity is
established even if different customers use non-unique IP addresses.

For the RD, every CE that has the same overall role should use a VRF with the same name, same RD,
and same RT values. The RDs and RTs are only for route exchange between the PEs running BGP. That
is, for the PEs to do MPLS VPN work, they have to exchange routing information with more fields than
usual for IPv4 routes; that extra information includes (but is not limited to) the RDs and RTs.

From the Create Route Distinguisher Pool window, you can create route distinguisher pools.

To create a route distinguisher pool, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Resource pools.
Step2  Select Route Distinguisher from the Pool Type in the upper left of the Resource Pools window.
Step3  Click the Create button.

The Create Route Distinguisher Pool window appears, as shown in Figure 3-117.

Figure 3-117 Create Route Distinguisher Pool Window
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The Create Route Distinguisher Pool window contains the following fields:
e RD Pool Start (required) Range: 0 to 2147483646.
¢ RD Pool Size (required) Range: 1 to 2147483647.
e Provider (required)

Step4  Enter the RD Pool Start and Size information for the route distinguisher pool you are creating.
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Step5  Click the Select button.

The Provider for new Resource Pool window appears, as shown in Figure 3-118.

Figure 3-118 Provider for New Resource Pool Window
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Step6  Select one of the providers listed and click Select.
Step7  Click Save.
The Resource Pools window reappears with the new route distinguisher pool listed.

To create a Route Target Pool, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Resource pools.

Step2  Select Route Target from the Pool Type in the upper left of the Resource Pools window.

Step3  Click the Create button.

The Create Route Target Pool window appears, as shown in Figure 3-119.

Figure 3-119 Create Route Target Pool Window
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The Create Route Target Pool window contains the following fields:
e RT Pool Start (required) Range: 0 to 2147483646.
¢ RT Pool Size (required) Range: 1 to 2147483647.
e Provider (required)

Step4  Enter the RT Pool Start and Size information for the route target pool you are creating.

[ oL-10727-01
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Step5  Click the Select button.

The Provider for new Resource Pool window appears, as shown in Figure 3-120.

Figure 3-120 Provider for New Resource Pool Window
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Step6  Select one of the providers listed and click Select.
Step7  Click Save.

The Resource Pools window reappears with the new route target pool listed.

Creating a Site of Origin Pool

In MPLS VPN, CE sites use private/public AS numbers and when one AS number is used for each VPN,
all sites belonging to the same VPN share the same private/public AS number. The default BGP behavior
is to drop any prefix if its own AS number is already in the AS path. As a result, a customer site does
not learn prefixes of a remote site in this situation. AS-OVERRIDE must be configured (if there are hub
sites involved, ALLOWAS-IN must be configured) to allow those prefixes to be sent by PE routers but
a routing loop can occur.

For example, CE1 and CE2 belong to the same customer VPN and have the same AS number 65001. The
AS path between two customer sites is 65001 - 1234 - 65001 and prefixes cannot be exchanged between
customer sites because AS 65001 is already in the path. To solve this problem, AS-OVERRIDE options
are configured on PE routers; but it introduces a routing loop into the network without using extended
community site of origin attributes.

Site of origin is a concept in MPLS VPN architecture that prevents routing loops in sites that are
multi-homed to the MPLS VPN backbone and in sites using AS-OVERRIDE in conjunction. Site of
origin is a type of BGP extended community attribute used to identify a prefix that originated from a site
so that the re-advertisement of that prefix back to the site can be prevented. This attribute uniquely
identifies the site from which the PE router learned the route. Site of origin is tagged at PE in peering
with BGP neighbors using an inbound route-map and works in conjunction with BGP CE-PE routing
protocol.

Site of origin must be unique per customer site per VPN/customer (when these sites are multi-homed).
Therefore, the same value of site of origin must be used on PE routers connected to the same CE router
or to the same customer site.

Note  Each time a customer site is created, ISC generates a unique site of origin value from the selected site
of origin provider pool if Site of Origin is enabled. This site of origin value must be unique per customer
site per customer/VPN.
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From the Create Site of Origin Pool window, you can create site of origin pools.

To create a site of origin pool, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Resource pools.
Step2  Select Site of Origin from the Pool Type in the upper left of the Resource Pools window.
Step3  Click the Create button.

The Create Site of Origin Pool window appears, as shown in Figure 3-121.

Figure 3-121 Create Site of Origin Pool Window
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The Create Site of Origin Pool window contains the following fields:
e SOO Pool Start (required) Range: 0 to 2147483646.
e SOO Pool Size (required) Range: 1 to 2147483647.
e Provider (required)
Step4  Enter the SOO Pool Start and Size information for the site of origin pool you are creating.
Step5  Click the Select button.

The Provider for new Resource Pool window appears, as shown in Figure 3-122.

Figure 3-122 Provider for New Resource Pool Window
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Step6  Select one of the providers listed and click Select.
Step7  Click Save.

The Site of Origin pools window reappears with the new route target pool listed.
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Creating a VC ID Pool

From the Create VC ID Pool window, you can create VC ID pools. These pools are global and are not
associated with any provider or customer

To create a VC ID pool, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Resource pools.
Step2  Select VC ID from the Pool Type in the upper left of the Resource Pools window.
Step3  Click the Create button.

The Create VC ID Pool window appears, as shown in Figure 3-123.

Figure 3-123 Create VC ID Pool Window
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The Create VC ID Pool window contains the following fields:
e VC Pool Start (required) Range: 1 to 2147483646.
e VC Pool Size (required) Range: 1 to 2147483647.
Step4  Enter the required information for the site of origin pool you are creating.
Step5  Click Save.
The VC ID Pools window reappears with the new VC ID pool listed.

Creating a VLAN Pool

From the Create VLAN Pool window, you can create VLAN pools.
To create a VLAN pool, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Resource pools.
Step2  Select VLAN from the Pool Type in the upper left of the Resource Pools window.
Step3  Click the Create button.

The Create VLAN Pool window appears, as shown in Figure 3-124.
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Figure 3-124 Create VLAN Pool Window
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The Create VLAN Pool window contains the following fields:
e VLAN Pool Start (required) Range: 1 to 4094.
e VLAN Pool Size (required) Range: 1 to 4094.
¢ Access Domain (required)
Step4  Enter the VLAN Pool Start and Size information for the VLAN pool you are creating.
Step5  Click the Select button.

The Access Domain for new VLAN Pool window appears, as shown in Figure 3-125.

Figure 3-125 Access Domain for new VLAN Pool Window
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Step6  Select one of the access domains listed and click Select.
Step7  Click Save.
The VLAN Pools window reappears with the new VLAN pool listed.
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Deleting Resource Pools

Step 1
Step 2
Step 3

Step 4

Step 5

From the Resource Pool window, you can delete specific resource pools.

To delete resource pools, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > Resource pools.
Select a pool type from the Pool Type in the upper left of the Resource Pools window.

Select one or more resource pools to delete by checking the check box(es) to the left of the resource
pool(s).
Click the Delete button.

The Confirm Delete window appears, as shown in Figure 3-126.

Figure 3-126 Confirm Delete Window
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Click the Delete button to confirm that you want to delete the resource pool(s) listed.

The Resource Pools window reappears with the specified pool(s) deleted.

CE Routing Communities

A VPN can be organized into subsets called CE routing communities, or CERCs. A CERC describes how
the CEs in a VPN communicate with each other. Thus, CERCs describe the logical topology of the VPN.
Cisco IP Solution Center can be employed to form a variety of VPN topologies between CEs by building
hub and spoke or full mesh CE routing communities. CERCs are building blocks that allow you to form
complex VPN topologies and CE connectivity.

The most common types of VPNs are hub-and-spoke and full mesh.

¢ A hub-and-spoke CERC is one in which one or a few CEs act as hubs, and all spoke CEs talk only
to or through the hubs, never directly to each other.

¢ A full mesh CERC is one in which every CE connects to every other CE.

These two basic types of VPNs—full mesh and hub and spoke—can be represented with a single CERC.
Whenever you create a VPN, the Cisco IP Solution Center software creates one default CERC for you.
This means that until you need advanced customer layout methods, you will not need to define new

Cisco IP Solution Center Infrastructure Reference, 4.2
m. oL-10727-01 |



| Chapter3

Service Inventory — Inventory and Connection Manager

CE Routing Communities

CERGC:s. Up to that point, you can think of a CERC as standing for the VPN itself—they are one and the
same. If, for any reason, you must override the software’s choice of route target values, you can do so
only at the time you create a CERC in the Cisco IP Solution Center software.

To build very complex topologies, it is necessary to break down the required connectivity between CEs
into groups, where each group is either fully meshed, or has a hub and spoke pattern. (Note that a CE
can be in more than one group at a time, if each group has one of the two basic patterns.) Each subgroup
in the VPN wants its own CERC. Any CE that is only in one group just joins the corresponding CERC
(as a spoke if necessary). If a CE is in more than one group, then you can use the Advanced Setup choice
during provisioning to add the CE to all the relevant groups in one service request. Given this
information, the provisioning software does the rest, assigning route target values and VRF tables to
arrange exactly the connectivity the customer requires. You can use the Topology tool to double-check
the CERC memberships and resultant VPN connectedness.

Cisco IP Solution Center supports multiple CEs per site and multiple sites connected to the same PE.
Each CERC has unique route targets (RT), route distinguisher (RD), and VPN Routing and Forwarding
instance (VRF) naming. After provisioning a CERC, it is a good idea to run the audit reports to verify
the CERC deployment and view the topologies created by the service requests. The product supports
linking two or more CE routing communities in the same VPN.

This section describes how you can create and manage CE routing communities. This section includes
the following:

e Accessing the CE Routing Communities Window, page 3-133
¢ Creating CE Routing Communities, page 3-134
e Deleting CE Routing Communities, page 3-135

Accessing the CE Routing Communities Window

Step 1

The CE Routing Communities feature is used to create and manage CERC:s.

To access the CE Routing Communities window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > CE Routing Communities to
access the CE Routing Communities window shown in Figure 3-127.

Figure 3-127 CE Routing Communities Window
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From the CE Routing Communities window, you can create, edit, or delete CE routing communities
using the following buttons:

¢ Create Click to create new CE routing communities. Enabled only if no CE routing community is
selected.

e Edit Click to edit selected CE routing communities (select by checking the corresponding box).
Enabled only if one CE routing community is selected.

¢ Delete Click to delete selected CE routing communities (select by checking the corresponding
box(es)). Enabled only if one or more CE routing communities are selected.

Creating CE Routing Communities

2
Tip

Step 1
Step 2

When you create a VPN, the Cisco IP Solution Center software creates one default CE routing
community (CERC) for you. But if your network topology and configuration require customized CERC
definitions, you can define CERCs customized for your network.

Customized CERCs should be defined only in consultation with the VPN network administrator. To
build complex topologies, it is necessary to break down the required connectivity between CEs into
groups, where each group is either fully meshed or has a hub-and-spoke pattern. A CE can be in more
than one group at a time, as long as each group has one of the two basic configuration patterns.

Each subgroup in the VPN wants its own CERC. Any CE that is only in one group just joins the
corresponding CERC (as a spoke if necessary). If a CE is in more than one group, then you can use the
Advanced Setup choice during provisioning to add the CE to all the relevant groups in one service
request. Given this information, Cisco IP Solution Center does the rest, assigning route target values and
VREF tables to arrange the precise connectivity the customer requires.

To create a CE routing community, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > CE Routing Communities.
Click Create.

The Create CE Routing Community window appears, as shown in Figure 3-128.
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Figure 3-128 Create CE Routing Community Window
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Step3  Complete the CERC fields as required for the CE Routing Community:
a. Provider Name (required) To specify the service provider associated with this CERC, click Select.
The Select Provider dialog box is displayed.
b. From this new window, choose the name of the service provider, then click Select.
c. Name (required) Enter the name of the CERC.
d. CERC Type Specify the CERC type: Hub and Spoke or Fully Meshed.

e. Auto-Pick Route Target Values Choose to either let Cisco IP Solution Center automatically set the
route target (RT) values or set the RT values manually.

By default, the Auto-pick route target values check box is checked. If you uncheck the check box,
you can enter the Route Target values manually.

A

Caution  If you choose to bypass the Auto-pick route target values option and set the route target (RT) values
manually, note that the RT values cannot be edited after they have been defined in the ISC software.

Step4  When you have finished entering the information in the Create CE Routing Community dialog box, click
Save.

After creating the CERC, you can add it to the VPN.

Deleting CE Routing Communities

From the CE Routing Community window, you can delete specific CERCs.

To delete CERC(s), follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > CE Routing Communities

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 2
Step 3

Step 4

VPNs

Select CERC(s) to delete by checking the check box(es) to the left of the CERC name.
Click the Delete button.

The Confirm Delete window appears.

Click OK to confirm that you want to delete the CERC(s) listed.

The CE Routing Communities window reappears with the specified CERC(s) deleted.

At its simplest, a virtual private network (VPN) is a collection of sites that share the same routing table.
A VPN is also a framework that provides private IP networking over a public infrastructure such as the
Internet. In Cisco IP Solution Center: MPLS VPN Management, a VPN is a set of customer sites that are
configured to communicate through a VPN service. A VPN is defined by a set of administrative policies.

A VPN is a network in which two sites can communicate over the provider’s network in a private manner;
that is, no site outside the VPN can intercept their packets or inject new packets. The provider network
is configured such that only one VPN’s packets can be transmitted through that VPN—that is, no data
can come in or out of the VPN unless it is specifically configured to allow it. There is a physical
connection from the provider edge network to the customer edge network, so authentication in the
conventional sense is not required.

This section describes how you can create and manage pools for various types of resources. This section
includes the following:

e Accessing the VPNs Window, page 3-136
e Creating a VPN, page 3-137
e Deleting VPNSs, page 3-140

Accessing the VPNs Window

Step 1

The VPN feature is used to create and manage various types of VPNs.

To access the VPN window, follow these steps:

Choose Service Inventory > Inventory and Connection Manager > VPN to access the VPN window
shown in Figure 3-129.
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Figure 3-129 VPNs Window
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From the VPNs window, you can create, edit, or delete VPNs using the following buttons:
¢ Create Click to create new VPNs. Enabled only if no VPN is selected.

¢ Edit Click to edit a selected VPN (check the corresponding box). Enabled only if one VPN is
selected.

e Delete Click to delete selected VPN(s) (check the corresponding box(es)). Enabled only if one or
more VPNs is selected.

Creating a VPN

To create a VPN, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > VPN.
Step2  Click Create.
The Create VPN window appears, as shown in Figure 3-130.
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Figure 3-130 Create VPN Window
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Step3  Complete the fields as required for the VPN:
Name (required) Enter the name of the VPN.

a
b. Customer (required) To select the customer associated with this VPN, choose Select.

(4

From the list of customers, select the appropriate customer, then click Select.

d. If you want MPLS attributes, complete the fields in the MPLS Attributes section of the window. For
VPLS, skip to step t.
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Create Default CE Routing Community (optional) To create a default CE routing community,
check the Create Default CE Routing Community check box and select a provider.

Enable Multicast To enable multicast VPN routing, check the Enable Multicast check box.

An IP address that starts with the binary prefix 7710 is identified as a multicast group address. There
can be more than one sender and receiver at any time for a given multicast group address. The
senders send their data by setting the group address as the destination IP address. It is the
responsibility of the network to deliver this data to all the receivers in the network who are listening
to that group address.

N

Note  Before you can create a VPN with multicast enabled, you must define one or more multicast
resource pools.

Enable Auto Pick MDT Addresses (optional) To enable auto picking MDT addresses, check the
Enable Auto Pick MDT Addresses check box.

Default MDT Address If Enable Auto Pick MDT Addresses is set on, Default MDT Address is
required.

Data MDT Subnet (optional)

Data MDT Size (optional) If Enable Multicast is set on, Data MDT Size is required. From the
drop-down list, select the data MDT size.

MDT refers to a multicast distribution tree (MDT). The MDT defined here carries multicast traffic
from customer sites associated with the multicast domain.

Data MDT Threshold (optional) If Enable Multicast is set on, Data MDT Threshold is required.
Enter the bandwidth threshold for the data multicast distribution tree.

The data MDT contains a range of multicast group addresses and a bandwidth threshold. Thus,
whenever a CE behind a multicast-VRF exceeds that bandwidth threshold while sending multicast
traffic, the PE sets up a new data MDT for the multicast traffic from that source. The PE informs the
other PEs about this data MDT and, if they have receivers for the corresponding group, the other
PEs join this data MDT.

Default PIM Mode (optional)
Enable PIM SSM (optional)

SSM List Name

Multicast Route Limit (optional)
Enable Auto RP Listener (optional)
Configure Static-RP (optional)

CE Routing Communities (optional) If Enable Multicast is set on, CE Routing Communities is
required. If you do not choose to enable the default CERC, you can select a customized CERC that
you have already created in ISC. From the CE Routing Communities pane, click Select.

The Select CE Routing Communities dialog box is displayed.
Check the check box for the CERC you want used for this service policy, then click Select.

You return to the Create VPN dialog box, where the new CERC selection is displayed, along with
its hub route target (HRT) and spoke route target (SRT) values.

If you want VPLS attributes, the optional fields for that are in u. to x.
Enable VPLS (optional) Check this check box to enable VPLS.
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Cisco IP Solution Center Infrastructure Reference, 4.2 B



Chapter3  Service Inventory — Inventory and Connection Manager |

I Named Physical Circuits

Step 4

v. VPN ID (optional)

w. Service Type (optional) Click the drop-down list and choose from ERS (Ethernet Relay Service) or
EWS (Ethernet Wire Service).

x. Topology (optional) Select the VPLS topology from the drop-down list: Full Mesh (each CE will
have direct connections to every other CE) or Hub and Spoke (only the Hub CE has connection to
each Spoke CE and the Spoke CEs do not have direct connection to each other).

When satisfied with the settings for this VPN, click Save.

You have successfully created a VPN, as shown in the Status display in the lower left corner of the VPN’
dialog box.

Deleting VPNs

Step 1
Step 2
Step 3

Step 4

From the VPNs window, you can delete specific VPNs.
To delete VPN(s), follow these steps:

Choose Service Inventory > Inventory and Connection Manager > VPN.

Select VPN(s) to delete by checking the check box(es) to the left of the VPN name.
Click the Delete button.

The Confirm Delete window appears.

Click OK to confirm that you want to delete the VPN(s) listed.

The VPNs window reappears with the specified VPN(s) deleted.

Named Physical Circuits

Named physical circuits (NPCs) are named circuits that describe a physical connection between a CPE
or U-PE and an N-PE. The intermediate nodes of the NPCs can either be CPE or PE. They can be
connected in a circular fashion forming a ring of devices, which is represented by an entity known as
NPC Rings. NPC Rings represent the circular topology between devices (CPE or PE) to the Named
Physical Circuits. To create an NPC, you must specify how the source CPE/U-PE and the destination
N-PE are connected and specify the intermediate nodes.

The connectivity of the NPCs is defined by specifying a set of devices serving as physical links; each
device has two interfaces that are part of the NPC connections. The Incoming Interface defines the
interface from the CE direction. The Outgoing Interface defines the interface toward the PE direction.

You can also add (meaning after the chosen device) or insert (meaning before the chosen device) an NPC
Ring in the link.

Keep in mind the following when you are creating an NPC:

¢ In the ISC software, the device you select can be any node in the link. The ISC software only shows
the appropriate devices. The first device must be a CPE or U-PE and the last device must be an N-PE.
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e NPCs should be created before the MPLS multi-device, VPLS, or L2ZVPN service request is created
with cpel and pel. So when you create the SR, you would select the policy, cpel, pel, and the NPC
that defines the link between cpel and pel.

This section describes how you can create and delete NPCs and create, edit, and delete NPC Rings. This
section includes the following:

e Accessing the Named Physical Circuits Window, page 3-141
¢ Creating a Named Physical Circuit, page 3-142

e Deleting Named Physical Circuits, page 3-146

e Creating NPC Rings, page 3-146

e Editing NPC Rings, page 3-150

e Deleting NPC Rings, page 3-150

Accessing the Named Physical Circuits Window

The Named Physical Circuits feature is used to create and delete NPCs. You cannot edit or modify.

To access the Named Physical Circuits window, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > Named Physical Circuits to
access the window shown in Figure 3-131, “Named Physical Circuits Window.”
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Figure 3-131 Named Physical Circuits Window
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From the Named Physical Circuits window, you can create or delete NPCs using the following buttons:
¢ Create Click to create new NPCs. Enabled only if no NPC is selected.

¢ Delete Click to delete selected NPC(s) (select by checking the corresponding box(es)). Enabled only
if one or more NPCs are selected.

Creating a Named Physical Circuit

To add an NPC physical link, follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Named Physical Circuit.

Step 2 Click the Create button in Figure 3-131, “Named Physical Circuits Window,” and a window, as shown
in Figure 3-132, “Create a Named Physical Circuit Window,” appears.
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Figure 3-132 Create a Named Physical Circuit Window
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Each line represents a physical link and each physical link contains the following attributes:
¢ Device
¢ Incoming Interface
¢ Outgoing Interface

¢ Ring (optional)

Before adding a ring in an NPC, create a ring and save it in the repository, as explained in the
“Creating NPC Rings” section on page 3-146.

An NPC must have at least one link defined. The link must have two Devices, an Incoming
Interface, and an Outgoing Interface.

Note

Click Add Device or Insert Device and a window as shown in Figure 3-133, “Select Device Window,”

Step 3
appears.
Figure 3-133 Select Device Window
ShDWI CPE | devices \;\fherelDe‘\-’ice Name | matching I* | Find |
Showing 1 - 3 of 3 records
# Device Hame Customer Mame Site Mame Man_sﬁ;gnent
1. ¢ cel3 Custamert east MARMAGED
2. (" ced Custarmert east MANAGED
3. ¢ ced Custamert east MARMAGED
Fows per page: | 10 j 1<] €] Goto page: |1 of 1 |
| Select || Cancel | E
o
=
Step4  Be sure that the drop-down list in Show is CPE or PE. Click a radio button next to a device and then
click Select.
Step5  Figure 3-132, “Create a Named Physical Circuit Window,” reappears with the chosen Device.

Cisco IP Solution Center Infrastructure Reference, 4.2 B
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Step 6

Step 7

Step 8
Step 9
Step 10

Figure 3-134 Create Named Physical Circuit Window

Create a Hamed Physical Circuit

# Jevice Incoming Interface Outgoing |rterface Ring
a ..

2.

11625%

If you want to add a device to your NPC as the last item or after the item checked in the check box, click
the Add Device button in Figure 3-132 on page 3-143 and then add device and interface information as
explained in the previous steps. If you want to insert a device to your NPC as the first item or before the
item checked in the check box, click the Insert Device button in Figure 3-132 on page 3-143 and then
add device and interface information as explained in the previous steps.

In the Outgoing Interface column in this new version of Figure 3-132, “Create a Named Physical
Circuit Window,” click Select outgoing interface and a window as shown in Figure 3-135, “Select
Outgoing Interface Window,” appears with a list of interfaces.

Figure 3-135 Select Outgoing Interface Window

Interfaces for device enceld

Show Device Interfaces with | [Nterface Mame  * | pyaching |”

Showing 1-6 of 6 recaords

#  Select Interface Logical Mame

1. Ethernet 192.168.129.189/30
2, Ethernett 1921681329129
3. Loophackd 192.165.115.70/32
4. Loophack 14111132
3. Seriall

B. Seriall

Rows per page: | 10« <] <] Goto page: 1 of1 (@) [»[2]

101985

Click a radio button next to the interface to be the source interface for this NPC and then click Select.
Figure 3-132, “Create a Named Physical Circuit Window,” reappears with the chosen Interface.

In the Incoming Interface column in this new version of Figure 3-132, “Create a Named Physical
Circuit Window,” click Select incoming interface and a window as shown in Figure 3-136, “Select
Incoming Interface Window,” appears with a list of interfaces.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 11
Step 12

Step 13

Note

Step 14
Step 15

Named Physical Circuits

Figure 3-136 Select Incoming Interface Window

Interfaces for device enpel

ShowDevice Interfaces with | Mterface Mame | matching |
Showing 1-10 of 18 records
# Select Interface Logical Mame
ATHS0
Ethernet2io
Ethernet2i
Ethernet2i2
Ethernet2is
FastEthernet0m
FastEthernet4m0
Hzsil M
Hzsil M
Loophackd 192,168 115 64,32

BB "E e

—=

Rows per page; | 10 - 1<] ] soto page: |1 of 2 (Ga) [ 2]

1014987

Click a radio button next to the interface to be the incoming interface for this NPC and then click Select.

Figure 3-132, “Create a Named Physical Circuit Window,” reappears with the chosen Incoming
Interface.

If you created an NPC ring that you want to insert or add into this NPC, as explained in the “Creating
NPC Rings” section on page 3-146, you can click Insert Ring or Add Ring and the ring appears at the
beginning or before the item checked in the check box for Insert Ring or the ring appears at the end or
after the item checked in the check box for Add Ring, as shown in Figure 3-137, “Select NPC Ring
Window.”

When inserting a ring, select the source device of the ring that connects to a source device or an NPC
and the destination device of the ring that connects to the destination device of the NPC.

If you have not created an NPC ring that you want to insert into this NPC, proceed to Step 17.

Figure 3-137 Select NPC Ring Window

Show PG rings | With Ring Mame *| matching "
Showing 1-1 of 1 records
# Select
1. 1-enpel -Ethernet 20
Rawe per page: | 10« 1] ] Goto page: |1 af1 (Ga) [ [2]

1014988

Click a radio button next to the ring you choose and then click Select.

Figure 3-132, “Create a Named Physical Circuit Window,” reappears with the chosen Ring.

[ oL-10727-01
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Step16  Select the missing devices and interfaces as explained in the “Creating NPC Rings” section on
page 3-146.

Step 17  Click Cancel if you do not want to save this information, and you will proceed to the previous window.

Otherwise, click Save. Figure 3-132, “Create a Named Physical Circuit Window,” reappears with the
new NPC listed.

Deleting Named Physical Circuits

To delete NPC(s), follow these steps:

Step1  Choose Service Inventory > Inventory and Connection Manager > Named Physical Circuits to
access the window shown in Figure 3-131, “Named Physical Circuits Window.”

Step2  Select one or more NPCs to delete by checking the check box(es) on the left.
Step3  Click the Delete button.
The Delete NPC window appears.

Note  If the specified NPC is being used by any of the Service Requests, you will not be allowed to delete it.
An error message appears explaining this.

Step4  Click the Delete button to confirm that you want to delete the NPCs listed.

Figure 3-131, “Named Physical Circuits Window,” reappears with the specified NPCs deleted.

Creating NPC Rings

To create NPC rings, follow these steps:

Step 1 Choose Service Inventory > Inventory and Connection Manager > NPC Rings and a window as
shown in Figure 3-138, “NPC Rings Window,” appears.

Figure 3-138 NPC Rings Window

H P_I.L: Rings
Showy NPC rings with name matching *
Showving 0 of 0 recards
# | ] Hame
Rowvs per page: | 10 1] €] Goto page: 1 of1 [+ =1

‘ Create H H H Cancel ‘

158158
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Step2  Click the Create button and a window as shown in Figure 3-139, “Create Ring Window,” appears.

A ring has a minimum of three physical links that form a ring.

Figure 3-139 Create Ring Window

Create Ring

# Source Device Source Interface Destination Device Drestination |rterface
1. Select source interface Select destination interface
2. Select source interface Select destination interface
3. Select source interface Select destingtion interface
Edit Cross Links Save Cancel

116311

Note At any time, if you click Cancel, everything you have chosen disappears.

Step3  Start with the first line, which represents the first physical link.

Step 4 In the Source Device column, click Select source device and a window as shown in Figure 3-140,
“Select Source Device — CPE/PE Window,” appears.

Note  The CPE you choose must be a Multi-VRF CE.

Figure 3-140 Select Source Device — CPE/PE Window

ShDWICPE b I:ha\ricesv\rherelDEViCe Name x| matchingl'k | Find |

Showing 1 - 3 of 3 records

# Device Hame Customer Mame Site Mame Man:&;;nent
1. " celd Customert east MANAGED
2. ce3 Customeri east MANAGED
3. (7 ced Customer! east MANAGED
Rows perpage: |10 | 1]« Goto page:l1 of 1 [ [20
Lin)
| Select || Cancel | g
-

Step5  Click a radio button next to the device to be the source device for this physical link and then click Select.

Step6  Figure 3-139, “Create Ring Window,” reappears with the chosen Source Device.

Note  When choosing the Source Device for a physical link, this same choice is made for the Destination
Device for the previous physical link (or the last physical link if you are choosing for the first physical
link). For a selected device, do not select the same interface for the source and destination interface.

Step7  In the Source Interface column in this new version of Figure 3-139, “Create Ring Window,” click
Select source interface and a window as shown in Figure 3-141, “Select Source Interface Window,”
appears with a list of interfaces.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-141 Select Source Interface Window

Interfaces for device cel3

Showe Device Interfaces with |nt9ﬁace[§ame | matching *

# Interface Hame IP Address Logical Mame
1. () Ethernetd 172.29.146.36/26

2. (O Ethernet!

Rows per page: | 10 [<] <] Go to page: 1 of 1 [ [0

| Select || Cancel |

154159

Step8  Click a radio button next to the interface to be the source interface for this physical link and then click
Select.

Step9  Figure 3-139, “Create Ring Window,” reappears with the chosen Source Interface.

Step10  In the Destination Device column in this new version of Figure 3-139, “Create Ring Window,”, click
Select destination device and a window as shown in Figure 3-142, “Select Destination Device —
CPE/PE Window,” appears.

Figure 3-142 Select Destination Device — CPE/PE Window

Jid| dEViCESWhBrEIDBViCB Name = matchinglhk | Find |

Showing 1 - 3 of 3 recards

# Device Name Custorrier Marre Site Narme Ma”?&:gnem
1. ™ celd Custormert east MAMAGED
2. (" ced Customerl east MAMNAGED
3. ced Custormert east MAMAGED

Rows perpage: |10 =] 14 Goto page:l1 of 1 B k0

| Select || Cancel |

149444

Step11  Click a radio button next to the device to be the destination device for this physical link and then click
Select.

Step12 Figure 3-139, “Create Ring Window,” reappears with the chosen Destination Device.

Note = When choosing the Destination Device for the a physical link, this same choice is made for the next
Source Device. Do not choose the same Interface for these devices.

Step 13  In the Destination Interface column in this new version of Figure 3-139, “Create Ring Window,” click
Select destination interface and a window as shown in Figure 3-143, “Select Destination Interface
Window,” appears with a list of interfaces.
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Step 14

Step 15
Step 16
Step 17

Step 18

Step 19

Step 20

Step 21

Named Physical Circuits

Figure 3-143 Select Destination Interface Window

Interfaces for device ced

Showy Device Interfaces with | Interface Mame matching *

# Inte Hame IP Address Logical Mame
AT

-

AThA1 M

AT 72

Ethernet0ia 172.29.146.26/26
Ethernet0i

Ethernet0s2

Ethernet0s3

Ethernet0rid

Seriall

o 1 s A = R 4 B U % B o |

O o0o0o0oc0OOoC0O0

s

Seriall M

Rows pet page: | 10 v 1<) €] Goto page: 1 of 2 [ =1

| Select H Cancel ‘
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Click a radio button next to the interface to be the destination interface for this NPC and then click
Select.

Figure 3-139, “Create Ring Window,” reappears with the chosen Destination Interface.
Repeat Step 4 to Step 15 for the middle physical links and Step 4 to Step 9 for the last physical link.

If you want to insert an extra physical link in the ring, check the check box for the line that represents
the physical link you want the new physical link to follow and click Insert. Implement Step 4 to Step 15
to fill in the remaining entries in this new physical link.

If you want to delete a physical link in the ring but a minimum of three physical links will remain, check
the check box for the line that represents the physical link you want to delete and click Delete.

If you want to establish additional cross links between non-adjacent devices in this ring, you can click
Edit Cross Links in Figure 3-139, “Create Ring Window,” and you then view a new window like
Figure 3-139 with no entry. Click the Add button and you can choose from the devices already in your
ring. The result is a new entry in Figure 3-139 with this device as the Source Device. Establish the
Destination Device and Source and Destination Interfaces as you did when creating the ring. The choices
of devices and interfaces is limited to those already established in your ring.

~

Note  To Edit Cross Links, a minimum of four devices is needed to form this ring.

Click Cancel if you do not want to save this information, and you will proceed to the previous window.

Otherwise, when you have completed setting up your ring click Save. The new ring is added in
Figure 3-138, “NPC Rings Window,” and a green check for Succeeded appears. The new ring is
identified by the source device-source interface.

To create a ring with more than three physical links, check the check box for the link in Figure 3-139 on
page 3-147 to which you want to insert and the Insert button is then enabled. Proceed in adding links as
explained in this section.

[ oL-10727-01
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Editing NPC Rings
To edit NPC rings, follow these steps:

~
Note  If the specified NPC Ring is participating in any of the Named Physical Circuits, then you can not edit
the ring. An error message appears containing IDs of the NPCs that contain the NPC Ring.

Step1  Choose Service Inventory > Inventory and Connection Manager > NPC Rings and a window as
shown in Figure 3-144, “NPC Rings Window,” appears.

Figure 3-144 NPC Rings Window

HPC Rings
ShowMPC rings with name matching ¢
Showing 1-1 of 1 records
#
1.
Rows per page: | 10 = [<] <] 5oto page: |1 of1 (Ga) [» [2]

1019849

Step2  Check the check box next to the line that represents an NPC ring and then click Edit. A window as shown
in Figure 3-139, “Create Ring Window,” appears with all the data for this ring. Proceed as in the
“Creating NPC Rings” section on page 3-146 to make any changes you want.

Step3  When you have the ring as you want it, click Save.

Step4  Figure 3-138, “NPC Rings Window,” appears with the appropriate name (source device-source
interface) and a green check for Succeeded appears.

Deleting NPC Rings

To delete NPC rings, follow these steps:

S

Note  If the specified NPC Ring is participating in any of the Named Physical Circuits, then you can not delete
the ring. An error message appears containing IDs of the NPCs that contain the NPC Ring.

Step1  Choose Service Inventory > Inventory and Connection Manager > NPC Rings and a window as
shown in Figure 3-145, “NPC Rings Window,” appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 3-145 NPC Rings Window

HPC Rings
ShowMPGC rings with name matching i
Showing 1-1 of 1 records
#
1.
Rows per page: | 10« <] <] o to page: 1 of 1 (Ga) [ [0

101989

Step2  Check the check box(es) next to the line(s) that represent(s) NPC ring(s) that you want to delete and then
click Delete. A window as shown in Figure 3-146, “Delete Rings Window,” appears with the chosen
ring(s) for deletion.

Figure 3-146 Delete Rings Window

Delete Ring(s)

Confirm Delete
Showing 1-1 of 1 records
#
1. 2-encel1-Ethernetd
Rows per pags: | 10 = 1<] <] Gotopage: |1 of 1 ([Ba) [»[2]

101991

Step3  Click Cancel if you change your mind about deleting the chosen ring(s) or click Delete to actually delete
the ring.

Step4  Figure 3-145, “NPC Rings Window,” appears with the remaining ring names and a green check for
Succeeded appears.
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CHAPTER I

Service Inventory—Discovery

This chapter describes how to use the Discovery feature to discover devices, connections, and services
for the IP Solution Center (ISC) provisioning process. It contains the following sections:

e Overview of ISC Discovery, page 4-1
e Technical Notes for ISC Discovery, page 4-4

e Summary of Tasks for Discovery (Cisco ISC MPLS VPN Management and LZVPN Management),
page 4-7

e Summary of ISC Discovery Steps for MPLS Diagnostics Expert, page 4-11

e Step l: Perform Preliminary Steps, page 4-14

e Step 2: Perform Device Discovery, page 4-23

e Step 3: Perform Discovery Data Collection, page 4-34

e Step 4: Perform Role Assignment, page 4-34

e Step 5: Perform NPC Discovery, page 4-47

e Step 6: Perform MPLS VPN Service Discovery (Optional), page 4-54

e Step 7: Perform L2VPN (Metro Ethernet) Service Discovery (Optional), page 4-63
e Step 8: Commit Discovered Devices and Services to ISC Repository, page 4-75

e Step 9: Create and Run a Collect Config Task for the Discovered Devices, page 4-76
e Step 10: View and Edit Services, page 4-76

Overview of ISC Discovery

ISC simplifies the process for building a network device inventory by discovering the devices,
connections, and services that your MPLS VPN or L2ZVPN Metro Ethernet network comprises.

The ISC Discovery feature can be used to provision three of the applications in the Cisco ISC application
suite:

e Cisco IP Solution Center MPLS VPN Management
e Cisco IP Solution Center L2 VPN Management
e Cisco IP Solution Center MPLS Diagnostics Expert

The Cisco IP Solution Center Traffic Engineering Management has its own Discovery interface and
process. This is documented in Chapter 2 of the Cisco IP Solution Center Traffic Engineering
Management User Guide, 4.2, “TE Network Discovery.”

[ oL-10727-01
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Multiple service discovery processes are supported and you can restart from any of the previous steps.
Support for multiple discovery processes allows you to do incremental discovery of the network. The
ability to restart from previous steps helps you roll back the discovery process to a selected previous step.
You can then resume discovery from that step instead of needing to restart the entire discovery process
from the beginning.

The commit to ISC happens only at the end of the discovery phase, not after each step. The Discovery
process does not change the state of ISC during discovery workflow. It is only at the end of the workflow
that a user can commit the discovered devices and services to ISC.

The Discovery process provides you with several choices on how to discover your network topology.

1. If you are running Discovery to provision Cisco IP Solution Center MPLS VPN Management or
Cisco IP Solution Center L2 VPN Management, you can choose between three Discovery methods:

a. CDP Discovery

You can use the Cisco Discovery Protocol (CDP) to discover devices connected to an initial
device that has an IP address you provide in a policy.xml file.

b. Device/Topology Based Discovery

You can use a Device/Topology-based method. This method uses XML files that specify device
and NPC topology information.

c. Import Configuration File Based

You can use an Import Configuration Files-based method. This method uses a directory on the
server that contains configuration files for the devices to be discovered and an XML file that
contains device connectivity information that is used to automatically create NPCs.

2. You can choose the network topology to discover an MPLS VPN topology, an L2VPN (Metro
Ethernet) topology, or both.

If you choose L2VPN (Metro Ethernet) Discovery, you can discover either a Metro Ethernet with an
MPLS core, a Metro Ethernet with an Ethernet core, or a combination of the two, a mixed core. In
a mixed core, the L2ZVPN services can span across the MPLS core or they can be confined to a local
Ethernet domain alone (local switched services). Local switched services that do not traverse N-PE
devices across an ethernet domain can also be discovered. Figure 4-1, “Mixed Core,” shows a mixed
core.
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Figure 4-1 Mixed Core
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CE1

149200

Figure 4-2 illustrates the phases in the Discovery process.

Figure 4-2 ISC Discovery Steps
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Table 4-1 describes the phases in the Discovery process.

Table 4-1 Steps in the Discovery Process

Step Description

Device Discovery Discovers devices in the MPLS VPN and/or
Metro Ethernet topology.

Discovery Data Collection Collects the I0S configuration for the devices
discovered.

Role Assignment Does the role assignment for the discovered
devices based on rules.xml, and prompts you to
edit the device roles as N-PE, U-PE, or CE.

NPC Discovery Displays discovered NPCs and allows addition or
removal of NPCs.

MPLS VPN Discovery Discovers the topology for your MPLS VPN
network and lets you change it as required.

Note The MPLS VPN Discovery step is not
required if you are using ISC Discovery
with Cisco IP Solution Center MPLS
Diagnostics Expert.

(L2VPN) Metro Ethernet Discovery Discovers the topology for your Metro Ethernet
network and lets you change it as required.

Note The (L2VPN) Metro Ethernet Discovery
step is not required if you are using ISC
Discovery with Cisco IP Solution Center
MPLS Diagnostics Expert.

Technical Notes for ISC Discovery

This section presents technical tips and general information about the ISC Discovery process.

The ISC Discovery feature can be used to provision three of the applications in the Cisco ISC application
suite:

e Cisco IP Solution Center MPLS VPN Management
¢ Cisco IP Solution Center LZVPN Management
e Cisco IP Solution Center MPLS Diagnostics Expert

Although the general steps are similar, there are some differences in the workflow for the various types
of Discovery. These are described in the section covering each ISC application:

e Using ISC Discovery with Cisco IP Solution Center MPLS VPN Management, page 4-5

e Using ISC Discovery With Cisco IP Solution Center L2ZVPN Management, page 4-6

e Using ISC Discovery with Cisco IP Solution Center MPLS Diagnostics Expert, page 4-6

e Using ISC Discovery With Cisco IP Solution Center Traffic Engineering Management, page 4-7
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Note  Cisco IP Solution Center Traffic Engineering Management has its own Discovery interface and process.

This is documented in Chapter 2 of the Cisco IP Solution Center Traffic Engineering Management User
Guide, 4.2, “TE Network Discovery.”

For technical notes on using ISC Discovery in installations that include both Cisco IP Solution Center
Traffic Engineering Management and Cisco IP Solution Center MPLS VPN Management, see Using ISC
Discovery With Cisco IP Solution Center Traffic Engineering Management, page 4-7.

General Notes

Note the following points before running ISC Discovery.

You can use the ISC GUI to create providers, customers, and resource pools before doing Discovery.
Only one user can control the Discovery workflow interface at a given time.

The procedures in the chapter show a “generic” procedure. If you do not have licenses for a
particular application, you will not see the selections for that application on the start screen for ISC
Discovery.

Perform “manual” device collection after discovery is over.

After you have started the Discovery process, a Restart button appears on the Discovery Workflow
window. You can click the Restart button, a drop-down list of completed steps pops up and you can
select a step and restart from that step.

Using the Discovery Log Files

A log file is written for each phase of the Discovery process. You can view a log file by clicking the View
selection in the Log column next to each discovery phase summary on the Discovery Workflow window.

The log file provides useful information in the event a discovery step fails.

Using ISC Discovery with Cisco IP Solution Center MPLS VPN Management

If you are running the Discovery process to discover an MPLS VPN network for use with Cisco IP
Solution Center MPLS VPN Management, note the following points:

You must perform all of the main steps in the Discovery process.

You can use either CDP Discovery, Device/Topology, or Import Configuration Files-based
Discovery

ISC does not support partial mesh VPN topologies. If the Discovery process discovers a Partial
Mesh VPN, you must split the partial mesh VPN into smaller units (usually a combination of full
mesh VPNs and Hub and Spoke VPNs).

After completion of the automated Discovery process, you must schedule and run a
Task Manager > Collect Config task for all discovered devices.

[ oL-10727-01
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Using ISC Discovery With Cisco IP Solution Center L2VPN Management

If you are running the Discovery process to discover an L2VPN network that will be provisioned and
managed using Cisco IP Solution Center L2ZVPN Management, note the following points:

~

Note

You must perform all of the main steps in the Discovery process.

You can use either CDP Discovery, Device/Topology, or Import Configuration Files-based
Discovery. The recommendation is to use either Device/Topology or Import Configuration
Files-based Discovery.

A new L2VPN service is discovered when any of the following are found compared to the services
existing in ISC:

— A new Virtual LAN Identifier (VLAN ID) in an Ethernet core (Ethernet access domain)

— A new Virtual Circuit Identifier (VC ID) for virtual private wire service (VPWS) services on an
MPLS core.

— A new VPLS Forwarding Instance Identifier (VFI ID) for virtual private LAN service (VPLS)
services on an MPLS core.

The Discovery process for Cisco IP Solution Center LZVPN Management can discover Metro
Ethernets with an MPLS core, an Ethernet core, or both.

Prior to performing the NPC Discovery step for Cisco IP Solution Center LZVPN Management, you
must specify the Access Domain for N-PE devices.

Any new links that are configured on NPCs marked as Existing Modified or Conflicting are not
discovered.

After completion of the automated Discovery process, you must schedule and run a
Task Manager > Collect Config task for all discovered devices.

There is no synchronization in L2VPN service discovery. Any modification must be done
manually through the ISC user interface. Only new VPNs are discovered.

Using ISC Discovery with Cisco IP Solution Center MPLS Diagnostics Expert

If you are running the Discovery process to discover an MPLS VPN network for use with Cisco MPLS
Diagnostics Expert, note the following points.

You can use either CDP Discovery, Device/Topology, or Import Configuration Files-based
Discovery. The recommendation is to use either Device/Topology or Import Configuration
Files-based Discovery.

For Cisco IP Solution Center MPLS Diagnostics Expert, you only need to perform the Device
Discovery, Discovery Data Collection, and Role Assignment Steps. You do not need to perform the
NPC Discovery step or the Service Discovery step. However, you can let the NPC Discovery process
run.

See Figure 4-5 on page 4-12 for a flowchart of the required steps for ISC Discovery with Cisco IP
Solution Center MPLS Diagnostics Expert.

If you are using Cisco IP Solution Center MPLS Diagnostics Expert, then you normally only need
to discover P and PE devices. Therefore, when you perform the Role Assignment step for discovered
devices, you only need to assign roles to the P and PE devices.
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~

Note If you do discover any CE devices, you must assign them CE roles.

e After completion of the automated Discovery process, you must schedule and run a
Task Manager > Collect Config task for all discovered devices.

Using ISC Discovery With Cisco IP Solution Center Traffic Engineering
Management

Normally you do not have to run the ISC Discovery process if you are using Cisco IP Solution Center
Traffic Engineering Management. Cisco IP Solution Center Traffic Engineering Management has its
own discovery process,. This process is documented in Chapter 2 of the Cisco IP Solution Center Traffic
Engineering Management User Guide, 4.2, “TE Network Discovery.”

However, if you are running both Cisco IP Solution Center Traffic Engineering Management (TEM) and
Cisco IP solution Center MPLS VPN Management, you must run the Discovery process for Cisco IP
Solution Center MPLS VPN Management.

Note the following points:
¢ One region (default region) is used for TEM.

e If you are also running ISC Discovery for MPLS VPN Management, make sure you run the
Discovery workflow described in this chapter firsz, and then run the Cisco IP Solution Center Traffic
Engineering Management process later.

Summary of Tasks for Discovery (Cisco ISC MPLS VPN
Management and L2VPN Management)

Figure 4-3 provides a general workflow diagram for the Discovery process used with the Cisco IP
Solution Center MPLS VPN Management or Cisco IP Solution Center L2 VPN Management application.

)

Note Figure 4-5 on page 4-12 provides a general workflow diagram for the Discovery process as used with
the MPLS Diagnostics Expert application.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 4-3 Basic Workflow for Discovery with Cisco ISC MPLS VPN Management or Cisco ISC
L2VPN Management
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Summary of Tasks for Discovery (Cisco ISC MPLS VPN Management and L2VPN Management)

Table 4-2 describes each task in the Discovery workflow for Cisco ISC MPLS VPN Management and
Cisco ISC L2VPN Management.

Table 4-2 Description of Discovery Steps for M PLS VPN Management and L2VPN
Management

Step Description

Step 1: Perform Preliminary Perform preliminary steps that are required for ISC Discovery. See Step

Steps

1: Perform Preliminary Steps, page 4-14.
e Review System Requirements
See Review System Requirements, page 4-15.
¢ Install Licenses
See Install Licenses, page 4-15
e (CDP Discovery Only) Verify That a Unique TIBCO Port Is Defined

See (CDP Discovery Only) Verify That a Unique TIBCO Port Is
Defined, page 4-15

e (CDP Discovery Only) Verify That CDP Is Running on Devices To
Be Discovered

See (CDP Discovery Only) Verify That CDP Is Running on Devices
To Be Discovered, page 4-16

¢ Code XML Files Required for Discovery
See Code XML Files Required for Discovery, page 4-16

Step 2: Perform Device Discovery

e Start Device Discovery
See Starting Device Discovery, page 4-23.
e After Device Discovery is complete, enter device passwords

For information on entering device passwords, see Setting Password
Attributes (Required Step), page 4-30.

e Enter additional device information as required

See Setting General Device Attributes, page 4-32 and Setting Cisco
CNS Attributes, page 4-33.

Step 3: Perform Discovery Data
Collection

Start configuration collection. No input is required for this step. See
Step 3: Perform Discovery Data Collection, page 4-34.

Step 4: Perform Role Assignment

Assign device roles to each device. See Step 4: Perform Role
Assignment, page 4-34.

Step 5: Perform NPC Discovery

If you are discovering a Metro Ethernet Network with an Ethernet Core,
perform the required preliminary steps. See Preliminary Steps Before
Completing NPC Discovery for Metro Ethernet Networks, page 4-47

e Start NPC Discovery
See Step 5: Perform NPC Discovery, page 4-47
* Modify and/or add NPCs as required.

See Adding a Device for an NPC, page 4-51, Adding a Ring, page
4-52, Inserting a Device, page 4-53, Inserting a Ring, page 4-53, or
Deleting a Device or a Ring, page 4-53.

[ oL-10727-01
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Description of Discovery Steps for M PLS VPN Management and L2VPN Management

Step

Description

Step 6: Perform MPLS VPN
Service Discovery
(optional)

Start MPLS VPN Service Discovery. See Step 6: Perform MPLS VPN
Service Discovery (Optional), page 4-54.

This step is required for the Cisco IP Solution Center MPLS VPN
Management application,

Note  This step is not required for the Cisco IP Solution Center
L2VPN Management application or the Cisco IP Solution

Center MPLS Diagnostics Expert application.

Step 7: Perform L2VPN Service
Discovery (optional)

Start L2ZVPN Service Discovery. See Step 7: Perform L2VPN (Metro
Ethernet) Service Discovery (Optional), page 4-63.

This step is required for the Cisco IP Solution Center L2ZVPN
Management application.

Note  This step is not required for the Cisco IP Solution Center MPLS
VPN Management application or the Cisco IP Solution Center

MPLS Diagnostics Expert application.

Step 8: Commit Discovered
Devices and Services to
ISC Repository

Commit the discovered devices and services to the ISC repository. Prior
to this step, discovery workflow stores the discovered devices and
services in a temporary repository, which gets committed to ISC only at
the last step of discovery workflow.

Step 9: Create and Run a Collect
Config Task for
Discovered Devices

From the ISC Start Page, choose Monitoring > Task Manager. Select
the Collect Config task and select all of the devices discovered in the
Device Discovery step; then submit the task.

See Step 9: Create and Run a Collect Config Task for the Discovered
Devices, page 4-76.

Step 10: View and Edit Services

View the services that have been created and modify them as required
See Step 10: View and Edit Services, page 4-76.

Within each step, additional tasks must be performed and choices must be made. Figure 4-4 shows a
detailed flowchart that illustrates all of the steps in the Discovery workflow.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 4-4

Summary of ISC Discovery Steps for MPLS Diagnostics Expert ||

Detailed Diagram of Discovery Steps (Cisco ISC MPLS VPN Management and Cisco

ISC L2VPN Management)
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Summary of ISC Discovery Steps for MPLS Diagnostics Expert

Figure 4-5 shows the basic Discovery steps for Cisco ISC with the MPLS Diagnostics Expert (MDE)
application. For MDE, several of the steps required for Cisco ISC MPLS VPN Management and Cisco

ISC L2VPN Management are not required.
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Figure 4-5 Discovery Workflow for the MPLS Diagnostics Expert Application
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Summary of ISC Discovery Steps for MPLS Diagnostics Expert

Table 4-3 Description of Discovery Steps for M PLS Diagnostics Expert

Step

Description

Step 1: Perform Preliminary Steps

Perform preliminary steps that are required for
ISC Discovery.

e Review System Requirements

See Review System Requirements, page 4-15.
¢ Install Licenses

See Install Licenses, page 4-15
¢ Code XML Files Required for Discovery

For specific instructions, see the following
section:

— Code XML Files Required for Discovery,
page 4-16.

Step 2: Perform Device Discovery

e Start Device Discovery
See Starting Device Discovery, page 4-23.

e After Device Discovery is complete, enter
device passwords

For information on entering device
passwords, see Setting Password Attributes
(Required Step), page 4-30.

e Enter additional device information as
required

See Setting General Device Attributes, page
4-32 and Setting Cisco CNS Attributes, page
4-33.

Step 3: Perform Discovery Data Collection

Start configuration collection. No input is
required for this step. See Step 3: Perform
Discovery Data Collection, page 4-34.

Step 4: Perform Role Assignment

Assign device roles to each device. See Step 4:
Perform Role Assignment, page 4-34.

For MDE, you normally discover only P and PEs
and assign P and PE roles to them However, if you
discover CEs, assign CE roles to the CE devices.

Note  Although you do not have to edit NPCs for
MPLS Diagnostics Expert, after you
perform role assignment this step should
complete.

Step 5: Create and Run a Collect Config Task for
Discovered Devices

From the ISC Start Page, choose Monitoring >
Task Manager. Select the Collect Config task
and select all of the devices discovered in the
Device Discovery step; then submit the task.

See Step 8: Commit Discovered Devices and
Services to ISC Repository, page 4-75.

[ oL-10727-01
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Step 1: Perform Preliminary Steps

Before you initiate the ISC Discovery process, complete the following preliminary steps:

e Review System Requirements
e Ensure the Repository Is Empty

e Install Licenses

e (CDP Discovery Only) Verify That a Unique TIBCO Port Is Defined

e (CDP Discovery Only) Verify That CDP is Running on Devices To Be Discovered
¢ Code XML Files Required for Discovery

Figure 4-6 summarizes the preliminary steps for ISC Discovery.

Figure 4-6 Summary of Preliminary Steps for Discovery
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Review System Requirements

Cisco recommends that you thoroughly review the system requirements for ISC before planning your
installation, to be sure that you have all the hardware and software that you must successfully install.

The system recommendations and requirements for ISC are listed in Chapter 1, “System
Recommendations” of the Cisco IP Solution Center Installation Guide, 4.2.

Before starting Discovery, the appropriate licenses (both Activation and VPN licenses) must be installed.
Also, each license must be large enough to handle all possible discovered objects. For information on
installing licenses, see the “Installing License Keys” section of Chapter 2 of the Cisco IP Solution Center
Installation Guide, 4.2, “Installing and Logging In to ISC.”

Install Licenses

Before starting Discovery, the appropriate licenses (both Activation and VPN licenses) must be installed.
Also, each license must be large enough to handle all possible discovered objects. For information on
installing licenses, see the “Installing License Keys” section of Chapter 2 of the Cisco IP Solution Center
Installation Guide, 4.2, “Installing and Logging In to ISC.”

(CDP Discovery Only) Verify That a Unique TIBCO Port Is Defined

If you are using CDP Discovery to discover the network topology, make sure the TIBCO Port is unique.
Otherwise, CDP discovery will fail.

During installation, the TIBCO port can be specified if the “custom” Installation Type is selected at the
start of the installation process. Otherwise, the default port installed is 7530. You specify the TIBCO
port on the Choose TIBCO Port dialog.

The port number that is specified must be unique throughout the network, and no other ISC installations are
allowed with the same port.

Figure 4-7 shows the Choose TIBCO Port dialog.

Figure 4-7 Choose TIBCO Port
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(CDP Discovery Only) Verify That CDP Is Running on Devices To Be Discovered

If CDP Discovery is going to be used, use the show c¢dp command to ensure that CDP is running on all
of the devices intended to be discovered.

For each device, enter the show cdp command, as shown in Example 4-1.

Example 4-1 The show cdp Command:

Router# show cdp

Global CDP information:
Sending CDP packets every 120 seconds
Sending a holdtime value of 180 seconds
Sending CDPv2 advertisements is enabled

Router#

Note  When performing CDP Discovery for devices with more than one IP address configured, it is possible
that CDP discovery will find an IP address other than the management IP address. If the IP address found
is not accessible from the ISC server, then it will not be possible to discover that device using CDP
discovery.

Code XML Files Required for Discovery

Before you can run ISC Discovery, you must code XML files that are required for the Discovery process.
A different set of files is required, depending on whether you use CDP Discovery or
Device/Topology-based Discovery.

Table 4-4 describes the XML files and indicates which files are required for each type of discovery

method.
Table 4-4 XML Files Used with ISC Discovery
XML File Description Required for |Required for
cbp Device/Topology
Discovery Based Discovery
policy.xml Specifies one or more seed IP addresses that can |Yes No
be reached from the specified seed device and a
maximum hop count for the device discovery
process.
device.xml Specifies information used to locate devices, No Yes
such as device IP addresses and Object IDs
(OIDs).
topology.xml Specifies information used to build NPCs used |No Yes
by MPLS VPN and/or Metro Ethernet topology.

Note = Make sure that the coding in your XML files is accurate. If there are errors in the files, you might need
to re-run the Discovery process.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Sample XML Files

The initial installation of ISC provides sample XML files that you can use as a starting point in coding
your own XML files. The sample XML files are located in the following directory:

<install_directory>/resources/discovery/sample

where install_directory is the installation directory that you specified when prompted by the ISC
installation program.

Coding the policy.xml File

The policy.xml file:
¢ Is required for CDP Discovery.

e Isrequired for Cisco IP Solution Center MPLS VPN Management, Cisco IP Solution Center Metro
Ethernet and L2ZVPN Management, and Cisco MPLS Diagnostics Expert.

¢ Is not required for Device/Topology-based Discovery.
¢ Is not required for Cisco IP Solution Center Traffic Engineering Management.
e Provides a seed IP address that the CDP protocol uses to discover devices near the seed device.

Example 4-2 shows the sample policy.xml file that is provided with the ISC installation.

Example 4-2 Sample policy.xml File

<?xml version='1.0' encoding='UTF-8'?>
<DISCOVERY_POLICY overwrite_existing policy="true">
<DISCOVERY_METHOD>
<CDP ipaddress="209.168.133.232" hop="1"/>
</DISCOVERY_METHOD>
<SNMP_COMMUNITY>
<RO_COMMUNITY>
<COMMUNITY community="public"/>
</RO_COMMUNITY>
<RW_COMMUNITY>
<COMMUNITY community="public"/>
</RW_COMMUNITY>
</SNMP_COMMUNITY>

</DISCOVERY_POLICY>

If there are additional routers that are on the other side of PE routers on the edge of the core segment of
the network, you can specify more than one seed IP address in order to discover these devices.

Example 4-3 shows a policy.xml file that contains two seed IP addresses.

Example 4-3 Policy.xml File with Two IP Addresses

<?xml version='1.0' encoding='UTF-8'?>
<DISCOVERY_POLICY overwrite_existing policy="true">
<DISCOVERY_METHOD>
<CDP ipaddress="209.168.133.241" hop="8"/>
</DISCOVERY_METHOD>
<DISCOVERY_METHOD>
<CDP ipaddress="209.168.133.244" hop="8"/>
</DISCOVERY_METHOD>
<SNMP_COMMUNITY>

[ oL-10727-01
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Step 1

Step 2

<RO_COMMUNITY>
<COMMUNITY community="public"/>
</RO_COMMUNITY>
<RW_COMMUNITY>
<COMMUNITY community="private"/>
</RW_COMMUNITY>
</SNMP_COMMUNITY>

</DISCOVERY_POLICY>

Table 4-5 describes the XML tags used in the policy.xml file.

Table 4-5 XML Tags and Attributes Used in the policy.xml File

Tag Description

<DISCOVERY_METHOD> |Starts a <DISCOVERY_METHOD> tag. The
<DISCOVERY_METHOD> tag must contain a <CDP> tag.

<CDP> Starts a <CDP> tag. The <CDP> tag specifies a seed IP address and
a hop count.

The <CDP> tag must contain the following attributes:

e ipaddress

e hop
ipaddress Specifies the IP address of a seed device. Required attribute for the
<CDP> tag.
hop Specifies the number of hops from the device identified by the

ipaddress attribute to go in discovering devices. Required attribute for
the <CDP> tag.

Follow these steps to edit the sample policy.xml file:

Edit the sample file and replace the IP address specified with the ipaddress XML attribute with an
appropriate IP address from your network.

This IP address is a device that can be reached from the ISC host. For each seed device, an accessible
interface on the starting point is configured, because the management interface must be provided. The
management interface is the address on the device that the ISC host uses to reach the device.

~

Note  You can provide more than one IP address. This is useful in situations where one network
domain is on the other side of a PE router on the edge of the core segment of the network.

Edit the hop count specified with the hop attribute and specify a hop count that will be used when the
Discovery process is initialized.

When you choose the seed devices and hop count, pick a seed device that can reach a large section of
the network. Pick one or more of them until you think these devices will enable you to reach your entire
managed network.

Point-of-presence (POP) routers are usually good choices. If you choose all the POPs in your network
as the collection of seed devices and put in the appropriate number of hubs, you discover the entire
managed network.

Cisco IP Solution Center Infrastructure Reference, 4.2
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To pick the hop count number, go to the CE that is the furthest from its associated POP, and count the
number of devices between them. If this number is N, the hub number is N+1, assuming you are picking
the POP as the seed.

If you need to add additional IP addresses for seed devices, code additional
<DISCOVERY_METHOD> tags.

Within the additional <DISCOVERY_METHOD> tags, include <CDP> tags.

For each <CDP> tag, specify an IP address with the ipaddress attribute and a hop count with the hops
attributes.

Save the policy.xml file to an appropriate directory on the ISC host.

When you run the Discovery process, the process queries the starting point device for its CDP table.
From this table, all of those devices are queried for their CDP information. This process continues until
the maximum hop count from the starting point is reached. When you use the CDP-based method, note
that only devices running CDP are discovered.

Coding the device.xml File

The device.xml file:
e Is required for Device/Topology-based Discovery.
¢ Is not required for CDP-based Discovery.

¢ Isrequired for Cisco IP Solution Center MPLS VPN Management, Cisco IP Solution Center L2ZVPN
Management, and ISC MPLS Diagnostics Expert.

¢ Is not required for Cisco IP Solution Center Traffic Engineering Management.
¢ Specifies information used to locate devices, such as device IP addresses and Object IDs (OIDs).

Example 4-4 shows a sample device.xml file. Use the sample file as an example and save your edited
file in an appropriate directory.

Example 4-4 Sample device.xml file

<network>

<device>

<device-name>mlpe8</device-name>
<ip-address>209.168.133.244</ip-address>
<system-object-1d>.1.3.6.1.4.1.9.1.509</system-object-id>
<snmp-info>

<ro-community>public</ro-community>

</snmp-info>

</device>

<device>

<device-name>mlswll</device-name>
<ip-address>209.168.133.170</ip-address>
<system-object-id>.1.3.6.1.4.1.9.1.574</system-object-id>
<snmp-info>

<ro-community>public</ro-community>

</snmp-info>

</device>

<device>
<device-name>mlswl6</device-name>

[ oL-10727-01
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<ip-address>209.168.133.175</ip-address>
<system-object-id>.1.3.6.1.4.1.9.1.574</system-object-id>
<snmp-info>

<ro-community>public</ro-community>

</snmp-info>

</device>

<device>

<device-name>mlswl7</device-name>
<ip-address>209.168.133.176</ip-address>
<system-object-id>.1.3.6.1.4.1.9.1.574</system-object-id>
<snmp-info>

<ro-community>public</ro-community>

</snmp-info>

</device>

</network>

Table 4-6 describes the XML tags used in the device.xml file.

Table 4-6 XML Tags Used in the device.xml File
Tag Description
<device> Starts a <device> tag. The <device> tag must

<device> tag:

e <device-name>

e <ip-address>

e <system-object-id>

e <snmp-info>

contain the following tags:

The following tags are optional within the

<device-name>

Specifies the name of the device. Required within
the <device> tag.

<ip-address>

Specifies the IP address of the device. Required
within the <device> tag.

<system-object-id>

(optional) Can be included to specify the SNMP
Object ID (OID) for the device. If this is provided,
it is specified within the <device> tag.

<snmp-info>

Specifies SNMP information for the device. The
<snmp-info> tag must contain a
<ro-community> tag. Optional within the
<device> tag.

<ro-community>

Specifies the level of SNMP access for the device.
Normally, this should be “public.” Required
within the <snmp-info> tag.

Follow these steps to code the device.xml file:

Step 1 Edit the sample device.xml file provided with the installation.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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For each device that is to be discovered by ISC, code a <device> entry. Each <device> entry must
contain the following tags:

e A <device-name> tag specifying the device name.

e An <ip-address> tag specifying the IP address for the device.
¢ A <system-object-id> tag specifying the OID for the device.

¢ An <snmp-info> tag specifying <ro-community> information

Save the device.xml file to an appropriate directory on the ISC host.

Coding the topology.xml File

The topology.xml file:
e Is required for Device/Topology-based Discovery.
¢ Is not required for CDP-based Discovery.

¢ Isrequired to perform ISC Discovery for Cisco IP Solution Center MPLS VPN Management, Cisco
IP Solution Center L2ZVPN Management, and Cisco IP Solution Center MPLS Diagnostics Expert.

¢ Is not required for Cisco IP Solution Center Traffic Engineering Management.
¢ Specifies information used to locate devices, such as device IP addresses and Object IDs (OIDs).

The topology.xml file specifies the discovery protocol that is used in the discovery process, and, for each
connection, specifies the starting IP address, the starting interface, the end device, and the end interface

Example 4-5 shows a sample topology.xml file. Use the sample file as an example and save your edited
file in an appropriate directory.

Example 4-5 Sample topology.xml File

<topology>

<connection discovery-protocol="CDP" fromDevice="mlswl9" fromIP="209.168.133.178"
fromInterface="GigabitEthernetl/1/2" toDevice="mlsw21" toIP="209.168.133.220"
toIF="GigabitEthernetl/1/1" >

</connection>

<connection discovery-protocol="CDP" fromDevice="mlswl9" fromIP="209.168.133.178"
fromInterface="FastEthernetl1/0/23" toDevice="mlsw21l" toIP="209.168.133.220"
toIF="FastEthernetl/0/24" >

</connection>

<connection discovery-protocol="CDP" fromDevice="mlswl9" fromIP="209.168.133.178"
fromInterface="FastEthernet

1/0/24" toDevice="mlswl8" toIP="209.168.133.177" toIF="FastEthernetl/0/23" >
</connection>

<connection discovery-protocol="CDP" fromDevice="mlswl9" fromIP="209.168.133.178"
fromInterface="FastEthernetl/0/22" toDevice="mlsw22" toIP="209.168.133.221"
toIF="FastEthernetl/0/24" >

</connection>

</topology>

Table 4-7 describes the XML tags used in the topology.xml file.
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Table 4-7 XML tags and Attributes Used in the topology.xml File
Tag Description
<connection> Starts a <connection> tag. The <connection> tag

must specify the following attributes:
e discovery-protocol
e fromDevice
e FromIP
¢ Fromlnterface
e toDevice
e tolP
¢ tolF

discovery-protocol Specifies the Discovery protocol used to discover
the network topology. Normally, this is “CDP.”

fromDevice Specifies the name of the device from which the
Named Physical Circuit starts. Required attribute
for the <connection> tag.

FromIP Specifies the management IP address of the
device from which the Named Physical Circuit
starts. Required attribute for the <connection>
tag.

FromInterface Specifies the name of the device interface from
which the Named Physical Circuit starts.
Required attribute for the <connection> tag.

toDevice Specifies the name of the device to which the
Named Physical Circuit connects. Required
attribute for the <connection> tag.

toIP Specifies the management IP address of the
device from which the Named Physical Circuit
connects. Required attribute for the
<connection> tag.

tolF Specifies the device interface on the device to
which the Named Physical Circuit connects.
Required attribute for the <connection> tag.

Follow these steps to code the topology.xml file:

Step 1 Edit the sample topology.xml file provided with the installation.

Step2  For each NPC connection that is to be discovered by ISC, code a <connection > entry. Each
<connection> entry must contain the following tags:

e A discovery-protocol attribute specifying the CDP protocol.
¢ A fromDevice attribute specifying the device from which the NPC starts.

¢ A FromlP attribute specifying the management IP address from which the NPC starts.

Cisco IP Solution Center Infrastructure Reference, 4.2
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¢ A FromlInterface attribute specifying the device interface from which the NPC starts.

¢ A toDevice attribute specifying the name of the device to which the NPC connects.

e A tolIP attribute specifying the management IP address of the device to which the NPC connects
¢ A tolF attribute specifying the name of the interface on the device to which the NPC connects

Save the topology.xml file to an appropriate directory on the ISC host.

Step 2: Perform Device Discovery

This section describes how to start the device discovery process and edit device configuration.

Starting Device Discovery

Step 1
Step 2
Step 3

Step 4

To start discovery, follow these steps:

Log in to ISC.
Click the Service Inventory tab.

The Service Inventory window appears, as shown in Figure 4-8.

Figure 4-8 Service Inventory Window
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Click Discovery.
The Discovery window appears, as shown in Figure 4-9.

Initially, the CDP Discovery method is selected and the window displays the required input for this
method.

[ oL-10727-01
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Figure 4-9 Device Discovery—CDP Fields
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Step5  Choose a Discovery method:

e To use the Cisco Discovery Protocol (CDP) method, click the CDP radio button, with the resulting
window as shown in Figure 4-9, “Device Discovery—CDP Fields.”

e To use the Device/Topology method, click the Device/Topology button, with the resulting widow as
shown in Figure 4-10, “Device Discovery—Device/Topology Fields.”

e To use the Import Configuration Files method, click the Import Configuration Files button, with

the resulting window as shown in Figure 4-11, “Device Discovery—Import Configuration File
Fields.”
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Figure 4-10 Device Discovery—Device/Topology Fields
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Figure 4-11 Device Discovery—Import Configuration File Fields
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Step6  In the Discovery window, specify the settings indicated in Table 4-8.

[ oL-10727-01
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Table 4-8 Discovery Settings

Setting Description

Name In this field, enter a unique name of your choice
for the Workflow name. If you do not enter a name
in this field, the system automatically generates a
unique name for you.

CDP Click this radio button to select Cisco Discovery
Protocol (CDP) as the Discovery method.

Policy File If you click the CDP button, specify the path to

your policy.xml file here. This file is an XML file
that indicates the IP address of one or more
devices used as a starting point for the discovery
process.

For more information on the policy.xml file, see
Coding the policy.xml File, page 4-17.

Output Device File This editable optional field defaults to an XML
file of the discovered devices. This file can then

be an input Devices File for rerunning discovery
using the Device/Topology option.

Output Connection File This editable optional field defaults to an XML
file that contains device connectivity information
that is written during CDP device discovery. This
file can then be an input NPC Topology File for
rerunning discovery using the Device/Topology
option.

Device/Topology Click this radio button to select Device/Topology
as the Discovery method.

Devices File If you click the Device/Topology button, specify
the path to your device.xml file here. This file
contains information used to locate the devices in
your network, such as IP addresses and OIDs.

For more information on the device.xml file, see
Coding the device.xml File, page 4-19.

NPC Topology File If you click this optional Device/Topology button,
specify the path to your topology.xml file here.
This file contains information used to determine
the NPC topology of your network.

For more information on the topology.xml file,
see Coding the topology.xml File, page 4-21.

Import Configuration Files Click this radio button to select Import
Configuration Files as the Discovery method.

Directory This required field is the directory on the server
that contains configuration files for the devices to
be discovered. The format of these files must be
<filename>.cfg.
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Table 4-8 Discovery Settings (continued)

Setting Description

NPC Topology File This field contains an XML file that contains
device connectivity information that is used to
automatically create NPCs.

MPLS VPN To discover devices used in an MPLS VPN
service, click the MPLS VPN radio button.

L2VPN (Metro Ethernet) Discovery To discover layer 2 devices used in a Metro
Ethernet service, click the L2ZVPN (Metro
Ethernet) Discovery radio button.

Step7  Click the Start button.

The discovery process starts and the Discovery Workflow window appears, as shown in Figure 4-12.

Figure 4-12 Discovery Workflow Window
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The Discovery Workflow window indicates the progress of each phase of device discovery:

e When the window first appears, the status indicator is yellow and indicates that the device discovery
process is Initializing.

e The status indicator then indicates that the process is In Progress.

e After the discovery processes has completed, the display indicates how many devices were
discovered, and the status indicator changes to orange and indicates that there is Pending Input, as
shown in Figure 4-13.
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Figure 4-13 Discovery Workflow Window with Device Input Pending

Discovery Workflow

Summary

Workflow Status Start Time End Time Log Summary
Winrkflowe-1 |:|\n Progress  2006-10-30 D6:56:50 [Wiew] [Wiew]
Step Status Start Time End Time Log Summary
Device Discovery |:| Pending Input 2006-10-30 06:56:51 [iew] [Wiew]
Discovery Data Collection -Not Started [Wienw] [Wiew]
Rale Assignment -Not Started [t Evie] [t¥ienn]
MPC Discovery -Not Started [Wienw] [Wiew]
MPLS VPN Discovery -Not Started [t Evie] [t¥ienn]
L2VPM (Metro Ethernet) Discovery - Mot Started [Wienw] [Wiew]
Progress

Device Discovery discovered 13 devices. Select "Continue’ to edit and save the devices, or select 'Restart’ to rerun a
Discovery Step.

Restart v| | Continue

Auto Refresh: [v

158166

The Progress area at the bottom of the window indicates how many devices were discovered.

At the lower right of the window there is a Restart button. You can click this button to restart the entire
discovery process. However, if you restart the Discovery process, any work that has been done previous
to restarting Discovery is lost.

Note  After each phase of the Discovery process, make sure that you check the log file to ensure that there were
no errors in the process. For specific instructions, see Using the Discovery Log Files, page 4-5.

Editing Device Configurations

After the initial discovery of devices in your network, you must edit the information that ISC maintains
about the devices. This allows the Discovery process to collect configuration information about the
devices that are required to determine the network topology and generate service requests.

Editing device configuration includes these steps:
e Setting Password Attributes (a required step)
e Setting General Device Attributes
e Setting Cisco CNS Attributes

Follow these steps to edit device configurations:

Step1  When the Discovery Workflow window indicates that the Device Discovery is Pending Input, click the
Continue button.

Step2  The General Attributes - Devices window appears, as shown in Figure 4-14.
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Figure 4-14 The General Attributes-Devices Window
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The General Attributes - Devices window allows you to do the following:
1. Delete devices.

If devices appear in the device list that you do not want to configure, you can delete them, as
explained in Step 5.

2. Set the following groups of attributes for each device:

— General Attributes—The general attributes include the hostname of the device, the device
type, the management IP address, and other settings.

You can accept the default attributes shown in the General Attributes - Devices window or
change them as required.

For a list of the general attributes, see Setting General Device Attributes, page 4-32.

— Password Attributes—The password attributes include the username and password for the
device and the enable username and password for the device. You must set these attributes.

— CNS Attributes—If the device is a CNS device, set the CNS attributes.

If you want to filter the devices that appear in the window, enter part of the device name for the devices
that you want to view, preceded or followed by the asterisk (*) and then click the Find button.

If the Find field displays an asterisk, all devices are displayed.
The setting in the Find field applies to all of the attributes windows.

To change the display to show one of the attributes areas, click the Attributes button at the bottom of
the window and use the pull-down list to select the attributes area to display.

e If you need to change the general attributes for the device, such as the protocol used to configure the
device (Config Access Protocol), you can do this in the initial window that appears.

If the General Attributes - Devices window is not the current window, click the Attributes button
and select General Attributes from the pull-down list.

[ oL-10727-01
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See Setting Password Attributes (Required Step), page 4-30 for instructions on setting the General
Attributes.

¢ To set the password attributes, click the Attributes button and then select Password Attributes from
the pull-down list.

For instructions on setting the password attributes, see Setting Password Attributes (Required Step),

page 4-30.

S

Note  This is a required step. To enable configuration collection, you must set the password attributes.

e If you need to change the CNS attributes, see Setting Cisco CNS Attributes, page 4-33.
Step5 If you want to delete one or more devices, follow these steps:
a. Check the check box next to each device that you want to delete.

If you need to delete more than one device, you can check the check box next to the heading for the
list of the devices. This selects all of the devices in the list. You can then uncheck the boxes next to
any devices that you do not want to delete.

b. To delete the devices, click the Delete button.

Setting Password Attributes (Required Step)

In order for the Configuration Collection phase to succeed, you must set the password attributes for each
device. Follow these steps to set password attributes:

Step 1 If the Password Attributes window is not the current window, click the Attributes button and select
Password Attributes from the pull-down list.

Step2  The Password Attributes window appears, as shown in Figure 4-15.
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Figure 4-15
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Follow these steps to select the devices and password attributes to configure:

a. Check the check box next to a device that has password attributes you want to configure.

If several devices have the same password attributes, you can check multiple check boxes. If all of
the devices have the same password attributes, you can check the box to the left of the heading row
to select all of the devices in the list. If this check box is checked, you can uncheck it to deselect all

of the devices.

b. To select the password attributes to configure, check one or more of the check boxes next to the

attribute names in the heading row.

Click the Edit button.

The Edit Attributes window for passwords appears, as shown in Figure 4-16.

[ oL-10727-01
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Step 5

Step 6

Figure 4-16 Edit Attributes Window for Password Attributes
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Enter the following information for the device:

¢ Login Password—Enter the login password for the device

e Login User—Enter the username for the device

¢ Enable User—Enter the name of a user with enable privileges

e Enable Password— Enter the enable password for the enable user
Click Save.

The information that you entered appears in the Password Attributes window.

Setting General Device Attributes

Step 1

Step 2

After you complete the device discovery process, the General Attributes - Devices window displays the
current general attributes settings for each device.

Follow these steps to change the general attributes for a device:

Click on the attribute that you want to change.

An Edit Attributes dialog box appears for the selected attribute.
In the dialog box, indicate the new setting for the attribute.

The General Device attributes include the following:

e Host Name—Must begin with a letter, digit, or underscore followed by letters, digits, underscores,
spaces, hyphens, or dots ending with a letter, digit, or underscore. This field is required and must
match the name configured on the target router device. Limited to 256 characters.

¢ Device Type—The device type includes the following devices:
- Cisco Router

— Catalyst OS device

Cisco IP Solution Center Infrastructure Reference, 4.2
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— Terminal server
- IE2100 (Cisco CNS appliance)

¢ Device Description (not editable from this window)—Can contain any pertinent information
about the device, such as the type of device, its location, or other information that might be helpful
to service provider operators. Limited to 80 characters.

¢ Management Address—Valid IP address of the device that ISC uses to configure the target router
device. This IP address must be reachable from the ISC host.

¢ Domain Name—Must begin with a letter, digit, or underscore followed by letters, digits,
underscores, spaces, hyphens, or dots ending with a letter, digit, or underscore. The name must
match the domain name on the target router device.

¢ Config Access Protocol—Administers the access protocol for config upload and download.
Choices include: Telnet, Terminal, TFTP, and RCP.

Setting Cisco CNS Attributes

If one of the devices is a Cisco CNS device, follow these steps to set CNS attributes:

Step 1 If the CNS Attributes window is not the current window, click the Attributes button and select CNS
Attributes from the pull-down list.

Step2  The CNS Attributes window appears, as shown in Figure 4-17.

Figure 4-17 CNS Attributes Window
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Step3  Click an existing Event Identification item.

The Edit Attributes dialog box for Event Identification appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step4  From the pull-down list for Event Identification attribute, select one the following:

e Event-Identification—Indicates whether the CNS Identification field contains a HOST NAME or
CNS ID. Default: HOST NAME.

Saving the Device Configuration

After you are finished making device configuration changes, click the Continue button.
The Device Discovery indicator turns green and indicates that Device Discovery is Complete.

The Discovery Data Collection phase begins automatically.

Step 3: Perform Discovery Data Collection

After you save your device configuration settings, the Discovery Data Collection phase of Device
Discovery starts automatically.

While Cisco IP Solution Center is collecting the device configurations, the Discovery Data Collection
indicator is yellow and indicates that the process is In Progress.

When the Discovery Data Collection phase is complete, the indicator changes to green and indicates that
the process is Complete. You are now ready to assign device roles.

Step 4: Perform Role Assignment

After the Discovery Data Collection phase of Device Discovery is complete, the Discovery Workflow
window indicates that the Role Assignment phase is Pending Input, as shown in Figure 4-18.

Figure 4-18 Discovery Workflow with Role Collection Pending Input
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Follow these steps to assign device roles:
e Initiate Device Role Assignment
e Change the Device Assignment Display
¢ Change Device Assignments
¢ Determine Device Roles
¢ Assign CE Device Roles
¢ Assign PE Device Roles

The following sections describe each of these steps.

Initiating Device Role Assignment

Step 1

Step 2

Follow these steps to initiate device role assignment:

In the Discovery Workflow window, click Continue.

The Role Assignment - Un-assigned Devices window appears, as shown in Figure 4-19.

Figure 4-19 Role Assignment - Un-assigned Devices Window
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On the Role Assignment - Un-assigned Devices window, if you select a single device, you are prompted
directly for the device role assignment. However, if you select more than one device, either the Role
Assignment - CEs window or the Role Assignment - PEs window appears. On these windows you can
specify the desired device roles.

If you want to change the way that the devices are displayed, see the following section, Changing the
Device Assignment Display, page 4-36.

[ oL-10727-01
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Changing the Device Assignment Display

Step 1

Step 2

You can change the way devices are displayed in the Role Assignment window in the following ways:

* You can change the display to show unassigned devices, PE devices, or CE devices using the
pull-down list at the bottom of the Role Assignment window.

¢ You can change the range of devices that are displayed using the Show devices with selection at the
top of the window in combination with the matching field.

Follow these steps to change the category of devices that is displayed:

To change the category of devices that is displayed, select a value from the pull-down list at the bottom
of the Role Assignment window:

e To view PE devices, select PEs.
e To view CE devices, select CEs.
e To view unassigned devices, select Un-assigned Devices.

To change the range of devices that are displayed, use the Show devices with selection at the top of the
window in combination with the matching field.

e Tolistdevices by hostname, select Device Host Name and enter a search value in the matching field,
then click Find.

¢ To list devices by domain name, select Device Domain Name name and enter a search value in the
matching field, then click Find.

¢ To list devices by management IP address, select Management IP Address and enter a search value
in the matching field, then click Find.

The value in the matching field specifies a search mask that controls which devices are displayed. An
asterisk (*) specifies display of all devices by the selected search criteria. A string followed by an
asterisk specifies display of all devices starting with part of a hostname, domain name, or management
IP address. And a string preceded by an asterisk specifies display of all devices ending with part of a
hostname, domain name, or management IP address.

You can specify more than one wildcard (asterisk) value in a search string. For example, to display all
devices that have “ce” in the hostname, enter *ce* in the matching field.

The display changes depending on the selection that you made. For example, if two devices have been
assigned the CE role, the Role Assignment - CEs window appears and shows a listing similar to the one
in Figure 4-20.

Cisco IP Solution Center Infrastructure Reference, 4.2
m. oL-10727-01 |



| Chapter4

Service Inventory—Discovery

Step 4: Perform Role Assignment Il

Figure 4-20 Role Assignment - CEs Window
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Changing Device Assignments

In some instances, the device discovery process assigns the wrong device role to groups of devices. For
example, devices that should be PEs can be assigned as CEs.

If this occurs, perform these steps:

e If all the devices you expected would appear as PEs are not listed on the Role Assignment - PEs
window, check the Role Assignment - Unassigned Devices window and the Role Assignment - CEs
window and assign the devices as PE devices.

— Go to the Role Assignment - CEs window and select any devices that should be PE devices
— Click the Assign as PEs button
The Role Assignment - PEs window appears and now lists the devices that you assigned as PEs.

e If other devices are not assigned as desired, change their basic device assignment as required.

Assigning Devices Individually or in Bulk

Using the windows provided for Role Assignment, you can assign device roles one device at a time or
using bulk assignment (by selecting several devices and assigning them all the same role).

If you assign device roles for a single device, you can also assign the other device attributes, such as Site,
Region, etc. However, if you assign device roles in bulk, then you cannot assign the other attributes at
this time. You will have to go to the PEs or CEs window later to assign the other attributes.

[ oL-10727-01
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Determine Device Roles

The purpose of device assignment is to categorize the devices discovered in the provider’s network into
two general groups:

e Provider-related devices—Provider Edge (PE) devices.

See Assigning the PE Role, page 4-38 for instructions on assigning the PE roles (U-PE, N-PE, P, or
PE-AGG).

¢ Customer-related devices—Customer Edge (CE) devices
See Assigning the CE Role, page 4-41 for instructions on assigning the CE role.
For PE devices, use the following guidelines to determine device roles:
e Assign a device that is at the center of a core domain as a P device.

e Assign any devices that interface with users of the VPN services as U-PE devices. These are devices
that are on the customer facing edge of a domain.

e Assign any devices that are on the edge of the MPLS core domain or L2ZVPN core domain as N-PE
devices.

e Assign any devices that are in device rings or which connect to multiple U-PE devices as PE-AGG
devices.

For CE devices, see the descriptions of the CE roles in the section on assigning CE roles (Assigning
the CE Role, page 4-41) for specific information.

Assigning the PE Role

Follow these steps to assign a device as a PE device:

Step 1 In the Role Assignment - Un-assigned Devices window, select a device that you want to assign as a PE.
e To select a device, check the check box next to the device name.
e To deselect a device, uncheck the check box next to the device name.

Step2  Click the Assign as PE(s) button.

The Assign as PE window appears, as shown in Figure 4-21.
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Figure 4-21 Assign as PE Window
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In the Assign as PE window, assign the required information for the PE.

To assign a PE Region Name, click the Select button.

The PE Region Name window appears, as shown in Figure 4-22.

Figure 4-22 PE Region Name Window
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In the PE Region Name window, click the radio button next to the region name that you want to
assign and then click Select.

The Assign as PE window appears with the region name in the PE Region field.
To assign a PE role, select a value from the pull-down list for the PE Role field.

The PE role specifies the architectural role that a PE router performs. Assign the PE role based on
the network layer to which the device belongs.

[ oL-10727-01
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You can select the following PE roles:

- N-PE—Assign devices that are at the edge of domains (within the Edge layer) as Network
Facing Provider Edge (N-PE) devices.

- U-PE—Assign devices within the User Facing Provider Edge as U-PE devices.
— P—Assign a device that is at the center of a core domain as a Provider Core (P) device.

- PE-AGG—Assign devices within the Aggregation Layer as Provider Edge Aggregation
(PE-AGG) devices.

d. Click OK.

The Role Assignment - PEs window appears with the specified values shown.

Editing the PE Role

After you have assigned one or more devices as PE devices and they appear in the Role Assignment -
PEs window, you can edit the PE role. You can edit the PE role even if no values have been assigned in
the Assign as PE window.

Follow these steps to edit the Role Assignment values for a PE device:

Step1  While the Role Assignment phase of Device Discovery is active, choose the Role Assignment - PEs

window.

If the Role Assignment - Un-assigned Devices or the Role Assignment - CEs window is active, select
Role-Assignment - PEs from the pull-down list at the bottom of the window.

The Role Assignment - PEs window appears, as shown in Figure 4-23.

Figure 4-23 Role Assignment - PEs Window
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Note that on this window, sorting is disabled for the following columns:
e PE Device Host Name
e PE Provider Name
e PE Region Name.
Cisco IP Solution Center Infrastructure Reference, 4.2
m. oL-10727-01 |



| Chapter4 Service Inventory—Discovery

Step 2

Step 3

Step 4

Step 4: Perform Role Assignment Il

In the sample window shown in Figure 4-23, one of the PEs has role information assigned. The other
two PEs have been assigned as PEs but do not have role information assigned. You can edit any of the
information for the PEs, whether information has been entered or not.

Select one or more PEs to edit.
e To select a specific PE, check the check box next to the device name.
e To select all the PEs shown in the window, check the check box in the heading row.
To edit the PE role, follow these steps:
a. Click the Edit button at the bottom of the window and choose PE Role from the pull-down list.
You are prompted to select a PE role.
b. Select a value from the pull-down list for the PE Role field.
You can select the following PE roles:
- N-PE—Assign devices within the Edge layer as Network Facing Provider Edge (N-PE) devices.
— U-PE—Assign devices within the User Facing Provider Edge as U-PE devices.
— P—Assign devices within the Core layer as Provider Core (P) devices.

- PE-AGG—Assign devices within the Aggregation Layer as Provider Edge Aggregation
(PE-AGG) devices.

The specified PE role appears in the Role Assignment - PEs window.
To edit the PE provider name or PE region name, follow these steps:

a. Click the Edit button at the bottom of the window and choose Region/Provider from the pull-down
list.

You are prompted for a Region name.

b. Click the radio button next to one of the region names listed in the pop-up window and then click
the Select button.

The specified Region Name and its associated Provider Name appear in the Role Assignment - PEs
window.

Assigning the CE Role

Step 1

Step 2

Follow these steps to assign a device as a CE device:

In the Role Assignment - Un-assigned Devices window, select a device that you want to assign as a CE.
e To select a device, check the check box next to the device name.
e To deselect a device, uncheck the check box next to the device name.

Click the Assign as CE(s) button.

[ oL-10727-01
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Step3  The Assign as CE window appears, as shown in Figure 4-24.

Figure 4-24 Assign as CE Window
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Step4  In the Assign as CE window, assign the required information for the CE.
a. To assign a Customer Name (required field), click the Select button.

The Customer Name window appears, as shown in Figure 4-25.

Figure 4-25 Customer Name Window
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b. To assign a customer name, click the radio button next to the customer name that you want to assign
and then click the Select button.

The Assign as CE window appears with the specified customer name displayed.

c. To assign a CE management type, select a value from the pull-down list for the CE Management
Type.

The CE Management type specifies the architectural role that a CE router performs. Assign the CE
management type based on the network layer to which the device belongs.

Cisco IP Solution Center Infrastructure Reference, 4.2
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You can select the following CE management types:

MANAGED-REGULAR—This is the default CE role assignment. Assign this role to CEs that
you want the Provider to manage. The CE must be reachable from an ISC server. When you
assign this role, then when you create a router in the Inventory Manager interface, the router
configuration is automatically downloaded.

UNMANAGED—Assign this role to a device that you want to manage manually. If this role is
assigned, then the device configuration is not assigned automatically when a new device is
created and the device must be configured manually. An unmanaged CE cannot be provisioned
directly by the provider. If Unmanaged is selected, the provider can use ISC to generate a
configuration, and then send the configuration to the customer for placement on the CE.

MANAGED-MGMT-LAN—Specifies that the device management is linked to the PE
configuration. The configuration is downloaded automatically when a new device is created. A
managed Management LAN or Management CE (MCE) is configured like a managed CE router,
but it resides in the provider space. Normally, an MCE acts as the network operations center
(NOC) gateway router.

UNMANAGED-MGMT-LAN—Specifies that the device management is linked to the PE
configuration, but the configuration is not downloaded automatically when a new device is
created. An unmanaged Management LAN or MCE is configured like an unmanaged CE router,
but it resides in the provider space. Normally, an MCE acts as the network operations center
(NOC) gateway router.

DIRECT-CONNECTED-REGULAR—In most cases, the CE is connected to a PE router. In
this case, the CE is connected to a workstation or other device.

DIRECT-CONNECTED-MGMT-HOST—In most cases, the CE is connected to a PE router.
In this case, the CE is connected to a workstation or other device on which ISC resides.

MULTI-VRF—Specifies that there is a device between the PE and the CE that is a VPN
routing/forwarding instance (VRF). A multi-VRF CE (MVRFCE) is owned by the customer, but
resides in the provider space. It is used to off-load traffic from the PE.

UNMANAGED-MULTI-VRF—An unmanaged multi-VRF CE is provisioned like an
unmanaged CE (configurations are not uploaded or downloaded to the device by the provider).
It is owned by the customer and resides in the provider space.

d. Click OK.

The Role Assignment - CEs window appears with the specified values shown.

~

Note

Editing the CE Role

The CE Site value is unassigned at this point. To assign this value, you must edit the settings.
See Editing the CE Role, page 4-43 for instructions on this task.

After you have assigned one or more devices as CE devices and they appear in the Role Assignment -
CEs window, you can edit the CE role. You can edit the CE role even if no values have been assigned in
the Assign as CE window.

[ oL-10727-01
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Step 1

Step 2

Step 3

Step 4

Follow these steps to edit the Role Assignment values for a CE device:

While the Role Assignment phase of Device Discovery is active, choose the Role Assignment - CEs
window.

If the Role Assignment - Un-assigned Devices or the Role Assignment - PE window is active, select
Role-Assignment - CEs from the pull-down list at the bottom of the window.

The Role Assignment - CEs window appears, as shown in Figure 4-26.

Figure 4-26 Role Assignment - CEs Window
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In the sample Role Assignment - CEs window shown in Figure 4-26, two of the CEs have role
assignment information assigned, and two have no information assigned. You can edit any of the
information for the CEs, whether information has been entered or not.

Note that on this window, sorting is disabled on the following columns:
¢ CE Device Host Name
e CE Site Name
e CE Customer Name
Select one or more CEs to edit.
e To select a specific CE, check the check box next to the device name.
e To select all the CEs shown in the window, check the check box in the heading row.
To edit the Customer name, follow these steps:
a. Click the Edit button at the bottom of the window and choose Customer from the pull-down list.
You are prompted to select a customer name.

b. To select a customer name, click the radio button next to one of the customer names that is displayed,
and then click the Select button.

The Role Assignment - CEs window appears with the specified customer name displayed.
To edit the CE management type, follow these steps:
a. Select one or more CEs to edit.

b. Click the Edit button at the bottom of the window and choose CE Management Type from the
pull-down window.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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The CE Management type specifies the architectural role that a CE router performs. Assign the CE
management type based on the network layer to which the device belongs.

You can select the following CE management types:

MANAGED-REGULAR—This is the default CE role assignment. Assign this role to CEs that
you want the Provider to manage. The CE must be reachable from an ISC server. When you
assign this role, then when you create a router in the Inventory Manager interface, the router
configuration is automatically downloaded.

UNMANAGED—Assign this role to a device that you want to manage manually. If this role is
assigned, then the device configuration is not assigned automatically when a new device is
created and the device must be configured manually. An unmanaged CE cannot be provisioned
directly by the provider. If Unmanaged is selected, the provider can use ISC to generate a
configuration, and then send the configuration to the customer for placement on the CE.

MANAGED-MGMT-LAN—Specifies that the device management is linked to the PE
configuration. The configuration is downloaded automatically when a new device is created. A
managed Management LAN or Management CE (MCE) is configured like a managed CE router,
but it resides in the provider space. Normally, an MCE acts as the network operations center
(NOC) gateway router.

UNMANAGED-MGMT-LAN—Specifies that the device management is linked to the PE
configuration, but the configuration is not downloaded automatically when a new device is
created. An unmanaged Management LAN or MCE is configured like an unmanaged CE router,
but it resides in the provider space. Normally, an MCE acts as the network operations center
(NOC) gateway router.

DIRECT-CONNECTED-REGULAR—In most cases, the CE is connected to a PE router. In
this case, the CE is connected to a workstation or other device.

DIRECT-CONNECTED-MGMT-HOST—In most cases, the CE is connected to a PE router.
In this case, the CE is connected to a workstation or other device on which ISC resides.

MULTI-VRF—Specifies that there is a device between the PE and the CE that is a VPN
routing/forwarding instance (VRF). A multi-VRF CE (MVRFCE) is owned by the customer, but
resides in the provider space. It is used to off-load traffic from the PE.

UNMANAGED-MULTI-VRF—An unmanaged multi-VRF CE is provisioned like an
unmanaged CE (configurations are not uploaded or downloaded to the device by the provider).
It is owned by the customer and resides in the provider space.

c. Click Select.
The Role Assignment - CEs window appears with the specified CE management type displayed.

Step5  To specify a site name or edit an existing site name, follow these steps:

a. Select one or more CEs to edit.

b. Click the Edit button at the bottom of the window and choose Site from the pull-down window.

The Site Name window appears, as shown in Figure 4-27.

[ oL-10727-01
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Figure 4-27 Site Name Window
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c. In the Site Name window, click the radio button next to the site name that you want to assign and

then click the Select button.

The Role Assignment - CEs window appears with the specified site names displayed.

Saving the Role Assignment Information

After you finish assigning roles to the devices, click the Continue button.

The Role Assignment Discovery indicator turns green and indicates that Role Assignment is Complete.

You are now ready to start the NPC Discovery phase of Device Discovery.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 5: Perform NPC Discovery

After the Role Assignment phase of Device Discovery is complete, the Discovery Workflow window
indicates that the NPC Discovery phase is Pending Input, as shown in Figure 4-28.

Figure 4-28 Discovery Workflow with NPC Discovery Pending Input

Discovery Workflow

Summary

Workflow Status Start Time End Time Log Summary
‘oo 1 I:l\n Progress  2006-10-30 06:56:50 [t Evie] [t¥ienn]
Step Status Start Time End Time Log Summary
Device Discovery |:| Complete 2006-10-30 06:56:51  2006-10-30 07:01:02  [view] [Wiew]
Discovery Data Collection |:|Complete 2006-10-30 07:01:43 2006-10-30 07:03:12 [Wiew] [Wiew]
Rale Assignment |:| Complete 2006-10-30 07:05:27  2006-10-30 07:16:08  [Wiew] [t¥ienn]
NP Discovery |:| Pending Input 2006-10-30 07:16:15 [+iew] [Wiew]
MPLS VPN Discovery -Not Started [t Evie] [t¥ienn]
L2VPM (Metto Ethernet) Discovery - Mot Started [+iew] [Wiew]
Progress

Select "Continue’ to edit NPCs, or select ‘Restart’ to rerun a Discovery Step.

| Restart '| | Continue

Auto Refresh: [v

158168

Follow these general steps to view a list of the NPCs that have been discovered and add or remove NPCs
as required:

e Ifyou are discovering a Metro Ethernet topology with an Ethernet core, perform the steps described
in Preliminary Steps Before Completing NPC Discovery for Metro Ethernet Networks, page 4-47.

e Complete the steps for starting NPC assignment as described in Starting NPC Assignment, page
4-49

e If necessary, complete steps for adding or modifying NPCs as described in Adding a Device for an
NPC, page 4-51 and the sections that follow.

Preliminary Steps Before Completing NPC Discovery for Metro Ethernet
Networks

Follow these steps if you are discovering a Metro Ethernet topology with an Ethernet core.

e Create one or more Access Domains and assign the devices that were discovered in the Device
Discovery phase to the Access Domain(s).

e C(Create at least one Resource Pool.
e [Edit the “inter N-PE interface” for each device.

These steps are performed using the Inventory and Connection Manager in the Service Inventory
interface (Service Inventory > Inventory and Connection Manager).

Cisco IP Solution Center Infrastructure Reference, 4.2
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Create Access Domains

Follow these steps to create access domains and add discovered devices to the domains:

Step1  In the ISC start page, select Service Inventory.

Step2  In the Service Inventory window, select Inventory and Connection Manager.
The Inventory and Service manager window appears.

Step3  In the left area of the window, select Access Domains.
The Access Domains window appears.

Step4  Create one or more Access Domains and assign the devices in the L2ZVPN Metro Ethernet topology to
these Access Domains.

For detailed instructions on creating Access Domains, see the “Creating Access Domains” section on
page 3-121.

Create Resource Pools

Follow these steps to create a resource pool:

Step1  In the ISC start page, select Service Inventory.

Step2  In the Service Inventory window, select Inventory and Connection Manager.
The Inventory and Service manager window appears.

Step 3 In the left area of the window, select Resource Pools.
The Resource Pools window appears.

Step4  Create a Resource Pools.

Step5  For the Pool Type, make sure that you select VLAN.

Step 6 For the Start value, enter 2.

Step7  For the Pool Size value, enter a value large enough to accommodate the number of devices in the
resource pool, for example, 500.

For detailed instructions on creating Resource Pools, see the “Resource Pools” section on page 3-122.

Edit Inter-N-PE Interfaces

Follow these steps to edit the “Inter N-PE” interfaces for the devices in your Metro Ethernet topology:

Step1  In the ISC start page, select Service Inventory.

Step2  In the Service Inventory window, select Inventory and Connection Manager.
The Inventory and Service manager window appears.

Step3  In the left area of the window, select PE Devices.

The PE Devices window appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step4  Select each PE device in your topology and do the following:
a. Click the Edit button
The Edit PE window appears.
b. Locate the interface that connects to each device that the device is connected to.
c¢. For each interface, in the Metro Ethernet column, change Any to None.
d. Save your changes

Go the following section, Starting NPC Assignment, page 4-49 and follow the steps for starting NPC
assignment.

Starting NPC Assignment

Follow these steps to initiate NPC assignment:

Step1  In the Discovery Workflow window, click Continue.

The Named Physical Circuits window appears, as shown in Figure 4-29.

Figure 4-29 Named Physical Circuits Window
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The Named Physical Circuits window initially displays any discovered circuits.

At this point, you can create, add, or remove NPCs as required.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Named physical circuits (NPCs) are named circuits that describe a physical connection between a CPE
or PE-CLE and a PE-POP. The intermediate nodes of the NPCs can either be CPE or PE. They can be
connected in a circular fashion forming a ring of devices, which is represented by an entity known as
NPC Rings. NPC Rings represent the circular topology between devices (CPE or PE) to the Named
Physical Circuits. To create an NPC, you must specify how the source CPE/PE-CLE and the destination
PE-POP are connected and specify the intermediate nodes.

Step2  If you need to define an NPC, follow these steps:
a. In the Named Physical Circuits window, click Create.

The Create a Physical Circuit window appears, as shown in Figure 4-30.

Figure 4-30 Create Physical Circuits Window.
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Initially, the list of NPCs is empty.
b. Click the Add Device button

The Select a Device window appears, as shown in Figure 4-31.

Figure 4-31 Select a Device Window
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Step 3 In this window, click the radio button for a device and then click the Select button.

The Create a Named Physical Circuit window appears with an initial device added, as shown in
Figure 4-32.
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Figure 4-32 Create a Named Physical Circuit Window with Initial Device Added
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The buttons on the window are now active.
c. Click a device that appears in the screen and then select one of the following actions:
— To insert a device, click the Insert Device button.
- To insert a ring, click the Insert Ring button.
— To add a device, click the Add Device button.
— To add a ring, click the Add Ring button.
— To delete an existing device or ring, select a device and then click the Delete button.

Step4  Refer to the following sections for additional information.

Adding a Device for an NPC

Step1  To select an incoming interface on the Create a Named Physical Circuit window click on Select
Incoming Interface.

The Select Device Interface window appears, as shown in Figure 4-33.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 4-33 Select Device Interface Window
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This window shows the interfaces on the selected device.
Step2  Click the radio button next to an interface in the list and then click the Select button.
The selected interface now appears in the Create a Named Physical Circuit window.
Step3  To select an outgoing interface, click on Select Outgoing Interface.
A list of interfaces configured on the device appears
Step4  Click the radio button next to an interface in the list and then click the Select button.
The outgoing interface now appears in the Create a Named Physical Circuit window.
Step5  Select additional devices as required and specify incoming and/or outgoing interfaces.

Step6  After you are finished, click the Save button in the Create a Named Physical Circuit window.

Adding a Ring

Follow these steps to add a ring before the currently selected device:

Step1  In the Create a Named Physical Circuit window, click Add Ring.

The Select NPC Rings window appears. This window shows any rings that exist in the network topology.

Step 2 Click the radio button next to a ring listed in the window and then click the Select button.

The selected ring now appears in the Create a Named Physical Circuit window.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Inserting a Device

To insert a device after the last device in the topology, follow these steps:

Step 1 In the Create a Named Physical Circuit window, click the Insert Device button.
The Select a Device window appears, as shown in Figure 4-31.

Step2  Check the check box next to a device that you want to insert and then click the Select button.
The device now appears on the Create a Named Physical Circuit window.

Step3  Click select incoming interface.
A list of interfaces on the selected device appears.

Step4  Check the check box next to the interface that you want to choose and then click Select.

The selected interface now appears on the list of interfaces.

Inserting a Ring

To insert a ring after the last device in the topology, follow these steps:

Step 1 In the Create a Named Physical Circuit window, click the Insert Ring button.
A list of the currently existing rings appears.
Step2  In the list of rings, check the check box next to the ring that you want to insert and then click Select.

The selected ring now appears on the Create a Named Physical Circuit window.

Deleting a Device or a Ring

Follow these steps to delete a device or a ring:

Step 1 In the Create a Named Physical Circuit window, select a device or ring and then click the Delete button.

The create NPC window appears with the device deleted.

Saving the NPC Configuration

After you have selected two devices and have configured the connection between them, follow these
steps to save the NPC configuration:

Step 1 In the Create a Named Physical Circuit window, click Save.

The NPC process validates the NPC configuration.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step2  Click Continue to continue.

The workflow window appears with NPC discovery marked as completed, as shown in Figure 4-34.

Figure 4-34 NPC Complete Window

Discovery Workflow

Summary
Workflow Status Start Time End Time Log Summary
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Step 6: Perform MPLS VPN Service Discovery (Optional)

After you have completed the NPC Discovery phase of Device discovery, if you selected MPLS VPN
Discovery when you initiated the Discovery process, the NPC Discovery phase is marked as complete,
and the MPLS VPN Discovery step is marked as Pending Input, as shown in Figure 4-35.

Figure 4-35 Discovery Workflow Window with MPLS VPN Discovery Pending Input
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Step 1

Note

Step 2

Step 6: Perform MPLS VPN Service Discovery (Optional) | |

You are now ready to initiate configuration of the discovered MPLS VPN using the MPLS VPN
Discovery user interface. Follow these steps to configure MPLS VPN services:

In the Discovery Workflow window, click Continue.

The MPLS VPNs window appears and lists the MPLS VPN that were discovered. The status of the
discovered MPLS VPNss is indicated as follows:

e If the MPLS VPN topology for a discovered MPLS is valid and ready to save in the ISC Repository,
then the VPN Status indicates a Valid VPN and the status indicator is green.

e If the MPLS VPN topology for a discovered MPLS is invalid (the topology is Partial Mesh), is
missing a Customer assignment, or includes an invalid CERC, then the VPN Status indicates an
Invalid VPN and the status indicator is yellow. Partial Mesh topology VPNs are not supported by
Cisco ISC, and must be broken into Full Mesh and/or Hub and Spoke components.

The MPLS VPN window shown in Figure 4-36 shows an invalid MPLS VPN (the topology is Partial
Mesh and the Customer Name is blank).

Figure 4-36 MPLS VPNs Window with Invalid MPLS VPN
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Raows per page: |10 'I 1] €] Goto pase:[1 of 1 [ =0
Join YPHs | ‘ Spit YPH ‘ | Details | | Edit | | Continue | -
=]
o
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If the MPLS VPN Discovery process discovers an MPLS VPN with a Partial Mesh topology, you must
split the VPN into two or more separate VPNs that have a supported topology (Hub and Spoke or Full
Mesh).

Do one of the following:
e If you want to change the view in the MPLS VPNs window, select another view option.
For a description of the MPLS VPN view options, see Filtering the MPLS VPN View, page 4-56.

e If the MPLS VPNs are valid and you do not need to make any changes to the MPLS VPN topology
at this time, click Continue to create MPLS VPN services based on the discovered topology.

e If one or more of the discovered MPLS VPNs are invalid, you must complete the following steps:
— Split the VPN—Select an invalid VPN and then click the Split VPN button.
See Splitting a VPN, page 4-56 for instructions.

[ oL-10727-01

Cisco IP Solution Center Infrastructure Reference, 4.2 B



Chapter4  Service Inventory—Discovery |

[ | Step 6: Perform MPLS VPN Service Discovery (Optional)

— Create New VPNs and add CERCs—You must create new VPNs containing the devices in the
VPN that you have split, and add CERCs to each new VPN.

See Creating a VPN, page 4-59 for instructions.

Filtering the MPLS VPN View

Step 1

Step 2

Follow these steps to change the view in the MPLS VPN screen:

Pull down the menu next to the Show VPNs with field.
You can filter the list of VPNs by VPN Name, Customer Name, Topology, VPN Type, or Description.
To limit which VPN are displayed within the selected category, enter a value in the Matching field.

The value in the matching field specifies a search mask that controls which sites are displayed. An
asterisk (*) specifies display of all sites by the selected search criteria. A string followed by an asterisk
specifies display of all sites starting with part of the element specified in the Show VPNs with field.

You can specify more than one wildcard (asterisk) value in a search string. For example, to display all
VPN that have “cisco” as part of the Customer Name, enter *cisco* in the matching field.

The display changes to display the VPNs with the selected criteria.

Splitting a VPN

Step 1
Step 2

In some situations, you might need to split an existing MPLS VPN before you complete the MPLS VPN
Discovery process and actually create the MPLS VPN services.

For example:

e If the MPLS Service Discovery process discovers an invalid MPLS VPN (an MPLS VPN with a
Partial Mesh topology), you must split the VPN into two or more CERCs that have a supported
topology (Hub and Spoke or Full Mesh).

¢ You might also choose to split MPLS VPN to change your topology, depending on your processing
needs. Only one VPN can be split at a time.

Follow these steps to split a VPN:

In the MPLS VPNs window, check the check box next to a VPN that you want to split.
Click the Split VPN button.
The Split VPN window appears, as shown in Figure 4-37 and Figure 4-38.
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Figure 4-37 Split VPN Window (Left Portion)
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Figure 4-38 Split VPN Window (Right Portion)
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Step3  In the Split VPN window, select several of the links.

In the example shown in Figure 4-38, select the links that would comprise either a Hub and Spoke or
Full Mesh topology.

For example, in the Split VPN window shown in Figure 4-37 and Figure 4-38, the first three links all
have Route Targets of 1:102 and together form a Full Mesh topology.

The remaining two links have Route Targets of 1:106 and 1:105. These links together form a Hub and
Spoke topology.

To split this VPN, the first three links need to be associated with one CERC, and the two remaining links
need to be associated with another CERC. Then we can split this VPN into two separate VPNs following
the ISC best practice convention of one CERC per VPN.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 4

Step 5
Step 6

Step 7
Step 8

Step 9

Click the Create/Modify CERC button.
You are prompted for a CERC name.
Enter the new CERC name and then click the Save button.

Repeat these steps for the rest of the devices that are included in invalid VPNs.

For example, in the topology shown Figure 4-37 and Figure 4-38, select the devices that have the route

target 1:106 to 1:105.
Click the Create/Modify CERC button.

When you are prompted for a CERC name, enter the new CERC name and then click the Save button.

The Split VPNs window appears again, and the right portion of the window shows the new CERCs that

have been created.

Figure 4-39 shows an example.

Figure 4-39 Split VPNs Window After Creation of a Valid CERC Topology
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Notice that in the example in Figure 4-39, the two new CERCs that have been created (valid_cerc_one
and valid_cerc_two), have valid topologies. The first CERC, valid_cerc_one, has a Full Mesh topology

and the second CERC, valid_cerc_two, has a Hub and Spoke topology.
Click the Save button.

You are now ready to continue to the next step, creating VPNs and adding CERCs to the VPNGs.
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Creating a VPN

Step 1

Step 2

Step 3

Step 4
Step 5

Step 6

Step 7

After you have created a CERC, you must create a VPN and then add the CERC to it.

Follow these steps to create a VPN:

In the Split VPN window, select Create/Modify VPN.
The Create VPN window appears, as shown in Figure 4-40.

Figure 4-40 Create VPN Window
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Select the CERCs that you want to assign to the VPN.

In the example shown in Figure 4-40, select valid_cerc_one.

In the VPN Name field, enter a name for the VPN.

For this example, enter vpn_one.

Click the Assign VPN Name button.

Click Save.

The VPN is created and appears in the Split VPN window in the VPN Name field.
Create any additional VPNs as needed.

149076

Continuing with the CERCs shown in the sample windows in Splitting a VPN, page 4-56, a VPN must

be created and have a CERC assigned to it. To do this:
a. In the Split VPN window, click Create/Modify VPN.
b. In the Create VPN window, create a second VPN and assign a CERC to it.

In the example screen, you could select the second CERC (valid_cerc_two) to the newly created

VPN to it.

After you are finished creating VPN, click the Save button in the Split VPN window.

The MPLS VPNs window appears, as shown in Figure 4-41.

[ oL-10727-01
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Figure 4-41 MPLS VPNs Window with Valid VPN and Invalid VPN

Home | Shortouts | Accourt | index: | Help | 2hout | Logout

Cisco Srsrems
IP Solution Center
Service Inventory | r r r r |

User: admin

ger * Discovery * O

Customer: Fone

You Are Here: + Service Invertory = Discovery

MPLS YPHs
Show VPNs with [VPN Mame | matching [+ Find
Showving 1 - 2 of 2 records
# " VUPHHame VPN Status c";:;";er Topology  VPH Type CERC Name Description

1. 7 wpn_one l:l Irealicd Customert HUB_AMD_SPOKE EXTRAMET walid_cerc_two MPLS VPN dizcovered by 1SC

2. [ wpn_two [ vaiia customerz FULL_MESH  INTRAMET vali_cerc_one MPLS PN tiscovered by ISC
Rows per page: I 10 VI 1] <] Gota page:l‘l of 1 B0
Join YPHs | ‘ Split YPH || Details | | Edit | | Continue |

Operation:  Edit VPN
Status: g Succeededd

140009

In the example shown in Figure 4-41, one of the VPN’ is marked as Valid and has a green status
indicator. However, the other VPN shown in the window is marked as Invalid and has a yellow

indicator.

Note

This occurs because in some instances, the MPLS Discovery process cannot completely validate
the data. In this situation, you can still continue with the Service Discovery process and create
MPLS VPN services. However, the process will skip the invalid VPN, and you must configure

the VPN service manually using the ISC provisioning commands.

Step8  Follow these steps to assign a Customer to each VPN:
a. Select a VPN entry in the MPLS VPNs window and then click the Edit button.

The Edit VPN window appears, as shown in Figure 4-42.
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Figure 4-42 Edit VPN Window
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b. Click the Select button next to the Customer Name field.
A list of customer names appears.
c¢. Click the radio button next to customer name and then Select.
d. If you want to rename the CERC, click Rename and then rename it.
e. Click Save.

The Customer name now appears in the MPLS VPNs window.

Note  In some cases, an apparently valid VPN will be marked as invalid. This VPN will be skipped in the
processing. You will then have to configure it manually using the ISC provisioning commands.

Step9  After you are finished editing VPN, click the Continue button to initiate the MPLS VPN service
creation process.

Viewing VPN Link Details

Follow these steps to view details of VPNs that were discovered:

Step 1 In the MPLS VPNs window, select a VPN that has details you want to view and then click the Details
button.

The MPLS VPN Link window appears, as shown in Figure 4-43.
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Step 2

Figure 4-43 MPLS VPN Links Window
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To filter the MPLS VPN links that are displayed, select a value from the pull-down list in the Show Sites
with field.

You can filter the list of VPNs by From Site, From CE, From CE Domain, Route Target, To Site, To CE,
or to CE Domain.

The value in the matching field specifies a search mask that controls which sites are displayed. An
asterisk (¥) specifies display of all sites by the selected search criteria. A string followed by an asterisk
specifies display of all sites starting with part of the element specified in the Show Sites with field.

You can specify more than one wildcard (asterisk) value in a search string. For example, to display all
sites that have “realtime” in the From CE Name, select From CE Name in the Show Sites with field
and then name, enter *realtime* in the matching field.

The display changes to show only the specified links.

Saving the MPLS VPNs and Initiating MPLS VPN Service Creation

After you are finished editing the data for the discovered MPLS VPNs in the MPLS VPNs window, click
the Continue button.

The Discovery process creates VPN services. After the process is complete, the Discovery Workflow
window indicates that the MPLS VPN Discovery process is COMPLETE and the status indicator is
green.

If you also selected L2ZVPN (Metro Ethernet) Discovery in the Discovery window before starting the
Discovery process, you can now proceed to Metro Ethernet service discovery.
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Step 7: Perform L2VPN (Metro Ethernet) Service Discovery

(Optional)

Step 1

Step 2

If you selected L2ZVPN (Metro Ethernet) Discovery in the Discovery window before starting the
Discovery process, then after the previous steps are complete, the Discovery Workflow window shows
the L2ZVPN (Metro Ethernet) Discovery as Pending Input, as shown in Figure 4-44.

Figure 4-44 Discovery Workflow Window with MPLS Ethernet Discovery Pending Input
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Follow these steps to initiate Metro Ethernet Service Discovery:

Before you initiate Metro Ethernet Service Discovery, follow these steps:

b.

g.

Choose Service Inventory > Inventory and Connection Manager.

In the task pane at the left of the Inventory and Connection Manager window, select Access
Domains.

Create access domains for any N-PE devices in the Metro Ethernet topology.

For detailed instructions, see the “Creating Access Domains” section on page 3-121.

Choose Service Inventory > Inventory and Connection Manager.

In the task pane at the left of the Inventory and Connection Manager window, select Resource Pools.
Create resource pools for each of the access domains that you created.

For detailed instructions, see the “Resource Pools” section on page 3-122.

Choose Service Inventory > Discovery.

The Discovery Workflow window shows the L2ZVPN (Metro Ethernet) Discovery process as Pending
Input.

Click Continue.

The L2VPN Discovery (Ethernet Services) window appears, as shown in Figure 4-45.

[ oL-10727-01
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Step 3

Figure 4-45 L2VPN Discovery (Ethernet Services) Window
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Select one of the following actions:

¢ View/Edit Discovered Layer 2 Services grouped by VPN—Lets you view the discovered L2ZVPN
services and edit them as required.

¢ View/Edit Discovered Layer 2 End to End Wires—Lets you view the discovered Layer 2 End to
End wires and edit them as required.

¢ View/Edit Discovered Layer 2 VPLS Links—Lets you view the discovered Layer 2 Virtual Private
LAN Service (VPLS) links and edit them as required.

The following sections of this chapter describe each of these actions.

Viewing Discovered Layer 2 Services Grouped by VPN

Step 1

Follow these steps to view discovered Layer 2 services grouped by VPN:

In the L2VPN Discovery (Ethernet Services) window, click the VPNs button.
The L2 VPNs window appears, as shown in Figure 4-46.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 4-46 L2 VPNs Window
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The L2 VPNs window allows you to perform the following tasks:
e View detailed information about a Layer 2 VPN.
This task is explained in the following steps of this procedure.
¢ Display a window that allows you to edit the configuration information for an existing Layer 2 VPN.
See Editing Discovered Layer 2 Services Grouped by VPN, page 4-66 for detailed instructions.
e Delete an existing Layer 2 VPN.
See Deleting Discovered Layer 2 Services Grouped by VPN, page 4-67 for instructions on this task.

Step2  To view detailed information about a Layer 2 service, check the check box next to a VPN that has details
you want to view, and then click the Details button.

The Link Details window appears, as shown in Figure 4-47.

Figure 4-47 Link Details Window
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Close
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The Link Details window shows the details about the discovered VPN, such as the User-Network
Interface (UNI), in a table format.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step3  When you are finished viewing the link details, click the Close button.

Editing Discovered Layer 2 Services Grouped by VPN

You can edit a discovered Layer 2 VPN service to change the policy that is applied to the service. Follow
these steps to edit a Layer 2 VPN service:

Step 1 In the L2 VPNs window, check the check box next to a VPN that you want to edit, and then click the
Edit button.

The Edit Link Policy window appears, as shown in Figure 4-48.

Figure 4-48 Edit Link Policy Window
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Step2  To change the link policy for the service, follow these steps:
a. Click the Policy button next to the Policy Name field.
A list of policies appears.

You can change the list of policies by choosing a filter from the pull-down list in the Show VPN
policies with field and/or entering a search mask in the Matching field.

You can filter the policy list by Policy Name, Customer Name, Provider Name, or Global policy
name. And you can limit the lists of policies displayed in the selected category by entering a value
in the Matching field.

Step3  Click the radio button next to a policy that you want to apply to the service and then click Select.
Step4 Do one of the following:
e Click Save to save your changes.

¢ Click Cancel to cancel the changes.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Deleting Discovered Layer 2 Services Grouped by VPN

Step 1

Step 2

Follow these steps to delete a Layer 2 service:

In the L2 VPNs window, check the check box next to a VPN that you want to delete, and then click the
Delete button.

The following message appears:

Links/End to End wires associated with all selected VPNs will be deleted as a result of
this operation. Do you really want to Delete?

If you are sure that you want to delete the VPN, click OK; otherwise, click Cancel.
If you click OK, the VPN and associated links and end-to-end wires are deleted.

Viewing Discovered Layer 2 End to End Wires

Step 1

Follow these steps to view discovered Layer 2 end-to-end wires:

In the L2VPN Discovery (Ethernet Services) window, click the End-End Wires button.
The Metro Ethernet End to End Wires window appears, as shown in Figure 4-49.

Figure 4-49 Metro Ethernet End to End Wires Window
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The Metro Ethernet End to End Wires window allows you to perform the following tasks:
* View detailed information about a Metro Ethernet end-to-end wire.
This task is explained in the following steps of this procedure.
e Edit the VPN associated with the end-to-end wire.
See Editing the VPN Associated with an End to End Wire, page 4-69 for a description of this task.
e Split an existing end-to-end wire into two end-to-end wires

See Splitting Layer 2 Service End to End Wires, page 4-70 for a description of this task.

[ oL-10727-01
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¢ Join existing end-to-end wires into a single end-to-end wire
See Joining Layer 2 Service End to End Wires, page 4-71 for a description of this task.
e Delete an existing end-to-end wire.
See Deleting Discovered Layer 2 Services Grouped by VPN, page 4-67 for instructions on this task.

Step 2 To view detailed information about a Layer 2 service, check the check box next to a VPN that has details
you want to view, and then click the Details button.

The Link Details window appears, as shown in Figure 4-50.

Figure 4-50 Link Details Window
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Close
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Step3  When you are finished viewing the link details, click the Close button.

Step4  If you want to view the details of the interfaces in the end-to-end wire, click the interface name in either
the AC1 UNI or AC2 UNI field.

If you click on an interface name, the Interface Detail window appears, as shown in Figure 4-51.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 4-51 Interface Detail Window
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The Interface Detail window shows details about the selected interface, such as the hostname of the host
where the interface is located, the type of encapsulation used on the interface, and the switch mode used
on the interface.

149086

Step5 When you are finished viewing the interface details, click the Close button.

Editing the VPN Associated with an End to End Wire

From the Metro Ethernet End to End Wires window, you can also edit the VPN that is associated with
the end-to-end wire.

Follow these steps to edit the VPN associated with an end-to-end wire:

Step 1 In the Metro Ethernet End to End Wires window, click a VPN name shown in the VPN name field.

The Edit VPN window appears, as shown in Figure 4-52.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 4-52 Edit VPN Window for L2VPN VPNs
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Step 2 To edit the VPN name, enter a new VPN name in the VPN Name field.
Step3  To edit the Customer Name, follow these steps:
a. Click the Select button next to the Customer Name.
A list of customers appears.
b. Click the radio button next to the new Customer Name that you want to configure.
c. Click the Save button.

The new VPN name and/or Customer Name appears in the Metro Ethernet End to End Wires window.

Splitting Layer 2 Service End to End Wires
You can split off an existing end-to-end wire from the VPN that it is associated with and associate it with
anew VPN.

Follow these steps to split an end-to-end wire from an existing VPN:

Step 1 In the Metro Ethernet End to End Wires window, check the check box next to an end-to-end wire entry
that you want to split from a VPN.

N

Note  If there is only one ID for the VPN associated with the end-to-end wire, then you cannot perform
a split action on the wire.

Step2  Click the Split button.
A message appears asking if you want to proceed.
Step3  If you want to continue with the process, click OK.

The end-to-end wires are split and are associated with two new VPNs. These names of the VPNs are
created by the system by adding a new number to the end of the existing VPN name.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Joining Layer 2 Service End to End Wires

Step 1

Step 2

You can join two existing end-to-end wires to a single VPN.

Follow these steps to join two existing end-to-end wires:

In the Metro Ethernet End to End Wires window, check the check box next to several end-to-end wire
entries that you want to join.

A message appears asking if you want to proceed.
If you want to continue with the process, click OK.

The selected end-to-end wires are joined to a new VPN. The name for this VPN is created by the system
by adding a new number to the end of the existing highest numbered VPN name.

Deleting Layer 2 Service End to End Wires

Step 1

Step 2

Step 3

Follow these steps to delete an existing end-to-end wire:

In the Metro Ethernet End to End Wires window, check the check box next to one or more end-to-end
wires that you want to delete.

A message appears asking if you want to proceed.
If you want to continue with the process, click OK.

The selected end-to-end wire (or wires) is deleted. Any Attachment Circuit(s) associated with the wire(s)
are also deleted.

Click Close to close the Metro Ethernet End to End Wires window.

Viewing Discovered Layer 2 VPLS Links

Step 1

Follow these steps to view discovered Layer 2 VPLS links:

In the L2VPN Discovery (Ethernet Services) window, click the VPLS Links button.
The VPLS Links window appears, as shown in Figure 4-53.

[ oL-10727-01
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Figure 4-53
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The VPLS Links window allows you to perform the following tasks:

e View detailed information about a VPLS link.

This task is explained in the following steps of this procedure.

149115

e Display a window that allows you to edit the configuration information for an existing VPLS link.

See Editing Discovered Layer 2 VPLS Links, page 4-73 for detailed instructions.

e Delete an existing Layer 2 VPN.

See Deleting Discovered Layer 2 VPLS Links, page 4-74 for instructions on this task.

Step2  To view detailed information about a VPLS link, check the check box next to a VPLS link that has details
you want to view, and then click the Details button.

The Link Detail window appears, as shown in Figure 4-54.
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Figure 4-54 Link Detail Window

Link Detail
General
VYPH Hame: DiscoveredyPLSYPN_vpls_mpls_ers-1003
Customer Hame: Default_Customer
Policy Hame: DiscoveredyPLSPolicy _YPLS_ERMS_MO CE
Link Properties
H-PE: milped
HPE Interface: GigahitEthernet 712
U-PE: mizwe
UHI: GigahitEthernet0/a
VLAH: 753
CE:
CE Interface:

Close

149091

The Link Detail window shows the details about the discovered VPN, such as the User-Network
Interface (UNI), in a table format.

Step3  When you are finished viewing the link details, click the Close button.

Editing Discovered Layer 2 VPLS Links

You can edit a discovered Layer 2 VPLS link to change the policy that is applied to the service. Follow
these steps to edit a Layer 2 VPLS link:

Step 1 In the VPLS Links window, check the check box next to a VPLS link that you want to edit and then click
the Edit button.

The Edit Link Policy window appears, as shown in Figure 4-55.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 4-55 Edit Link Policy Window
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To change the link policy for the link, follow these steps:
a. Click the Policy button next to the Policy Name field.

A list of policies appears.

You can change the list of policies by choosing a filter from the pull-down list in the Show VPN
policies with field and/or entering a search mask in the Matching field.

You can filter the policy list by Policy Name, Customer Name, Provider Name, or Global policy
name. And you can limit the lists of policies displayed in the selected category by entering a value
in the Matching field.

Click the radio button next to a policy that you want to apply to the service, and then click Select.
Do one of the following:
e Click Save to save your changes.

¢ Click Cancel to cancel the changes.

Deleting Discovered Layer 2 VPLS Links

Step 1

Step 2

Follow these steps to delete a VPLS link:

In the VPLS Links window, check the check box next to a VPLS link that you want to delete and then
click the Delete button.

The following message appears:

The selected link(s) will be deleted. Do you really want to Delete?

If you are sure that you want to delete the VPLS, click OK; otherwise, click Cancel.
If you click OK, the VPLS link(s) are deleted.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step3  Click Close to close the VPLS links window.

Saving the L2VPN Metro Ethernet Policy and Initiating Service Creation

After you are finished viewing or editing the discovered L2ZVPN Metro Ethernet topology, click the
Close button to return to the L2 VPN Discovery (Ethernet Services) window.

Click the Continue button to initiate the L2 VPN Service Discovery process.

The Discovery Workflow window appears and indicates that the L2 VPN Service Discovery process is
In Progress. The status indicator is yellow.

After the L2 VPN Service Discovery process is complete, the status indicator changes to green, and the
Discovery Workflow window indicates that the L2 VPN Service Discovery process is Complete, as
shown in Figure 4-56.

Figure 4-56 Discovery Workflow Window with L2 VPN Service Discovery Completed
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Step 8: Commit Discovered Devices and Services to ISC
Repository

Click the Continue button to commit the discovered devices and services to the ISC repository. Prior to
this step, discovery workflow stores the discovered devices and services in a temporary repository, which
gets committed to ISC only at the last step of discovery workflow.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 9: Create and Run a Collect Config Task for the Discovered

Devices

~

Note
Step 1
Step 2
Step 3
Step 4

Step 5

Before you view and edit services, follow these steps to run a Create Config task for the devices:

For additional information on the Create Config task, see the“Create” section on page 7-3 for Tasks.

On the ISC Start page, select Monitoring.
The Monitoring window appears.
Select Task Manager.
The Tasks window appears.
Click the Create button and choose Collect Config from the pull-down list.
The Create Task window appears.
Click the Next button.
The Collect Config Task window appears.
On the Collect Config task window, follow these steps to create and run a Collect Config task:
a. Click the Select/Deselect button.
A dialog window appears, listing the devices that were discovered by the Discovery process.
b. Select all of the devices shown on the list.
c. Click the Select button.
The Collect Config Task window appears again.
d. Specify the additional settings for the Collect Config task as required.
e. Click the Submit button.

You are now ready to view and edit services as described in the following section, Step 10: View and
Edit Services, page 4-76

Step 10: View and Edit Services

Step 1

Step 2

After you have successfully completed the MPLS VPN and/or LZVPN Metro Ethernet service creation
process, you can view the services that were created and modify them using the service requests editors.

Follow these steps to view the L2VPN services:

If the Service Inventory window is not currently active, click the Service Inventory tab.
The Service Inventory window is now active.
In the Service Inventory window, click Service Inventory.

The Inventory and Connection Manager window appears, as shown in Figure 4-57.
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Note

Figure 4-57
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Click Service Requests.
The Service Requests window appears, as shown in Figure 4-58.
Figure 4-58 Service Requests Window
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-~ CPE Devices 4[4 -PEND\NG WPLE ADD Default_Customer DiscoveredyPLSPol... 92905 346 PM
* Providers ) .
- Provider Reglons 5. 0s -PEND\NG L2WPN ADD Default _Customer DiscoveredyYPWSPal.. 92905 3:46 PM
« PE Devices 66 -PEND\NG L2WPHN ADD Default_Customer DiscoveredYPWSPol... 929105 3:46 PM
= Aocess Domains
- Resource Pools Rows per page: I 10 vl 1< zota page:lﬂ of 1 [ 621
+ CE Routing Communities
< WPRE o i R
o AR Servers Auto Refresh: [v | Create vH Details: H Status '|| Edit H Deploy. r” Decommission H Purge '|
* Mamed Physical Circutts
MNPC Rings
[Ta)
ol
=]
o
i
—

If you need to edit MPLS VPN as part of this process, see the Splitting a VPN, page 4-56, Creating a
VPN, page 4-59, Viewing VPN Link Details, page 4-61, and Saving the MPLS VPNs and Initiating
MPLS VPN Service Creation, page 4-62.
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I Step 10: View and Edit Services

Step4  For detailed information on modifying Service Requests for L2ZVPN Metro Ethernet networks, see the
Cisco IP Solution Center Metro Ethernet and L2VPN User Guide, 4.2.

Step5  For general information on the release, see the Release Notes for Cisco IP Solution Center, 4.2, provided
with the release.
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CHAPTER

Service Inventory—Device Console

From the Home window of Cisco IP Solution Center (ISC), which you receive upon logging in, click the
Service Inventory tab or area in the data pane of the window, and you receive a window as shown in
Figure 5-1, “Service Inventory Selections.”

Figure 5-1 Service Inventory Selections

Home | Shorteuts | sccourt | Index | Help | 2bout | Logout
Cisco Srsiems P ?

IP Solution Center

Service Inventory | [ [ [ User: admin

ction Manage

You Are Here: + Service Inventory Customer: Monge
Service Inventory

Tools to manages inventory elements, service regquests, and devices.

ne—rll v and C tion M
Etfi Creste and manage inventory elements and Service Reguests (SRs) for licensed services, and view:
;-Q) topology maps.

Discoveny

ﬁi\ Discover devices, connections, and services.

5 D evice Console
—:=—; Download commands and configlets to devices and viewsdevice configuration.

125050

Click on Device Console and you proceed to Figure 5-2, “Example of Device Console Selections” and
can choose one of the device related operations.

Device Console

Step 1

Note

Device Console is the starting point for many operations. To navigate through Device Console, follow
these steps:

Choose Service Inventory > Device Console and you receive a window as shown in the example in
Figure 5-2, “Example of Device Console Selections.”

The radio button last selected will be the one shown in Figure 5-2.

[ oL-10727-01
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Figure 5-2 Example of Device Console Selections

Device Conscle - Choeose Operation

S, * Download Commands

Dowanload Ternplate

Device Configuration Manzger

|t 0 A

O 1. Choeose QOperation

EXEC Commands
Feload

i R T

Select Operation bethod: St

-

Advanced (via wizard)

129035

Step2  To select one of the operations, click the radio button for one of the following selections and then click
Next:

Note  All operations apply only to Live mode, not ECHO mode.

¢ Download Commands, page 5-2 Download operation commands and configlets. The Select
Operation Method selections of Simplified and Advanced (via wizard) are only available for
Download Commands and are explained in that section.

¢ Download Template, page 5-3 Downloads template configlets to the specified devices.

e Device Configuration Manager, page 5-7 Displays different versions of configuration files created
on a repository per timestamp and writes to running-configuration or start-up configuration.

e EXEC Commands, page 5-9 Allows you to send to target devices any Cisco IOS commands that can
be executed in enable mode.

¢ Reload, page 5-13 Remotely reloads devices.

Download Commands

To download commands, follow these steps:

Step 1 Choose Service Inventory > Device Console > Download Commands.

Step2  The Select Operation Method default is Simplified, which indicates that in a single window you have
the options for selecting the Devices, Device Groups, and Operation Commands. You do not need to
multi-click. In a single window you can submit the required parameters to complete the task. Advanced
(via wizard) indicates you must go to multiple windows to achieve the task. In this method, you select
Device, click Next, select Device Groups, click Next, select Operation Command, and then the
summary.

Step3  Click Next. A window as shown in Figure 5-3, “Device Console—Download Commands: Select
Devices,” appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
m. oL-10727-01 |



| Chapter5 Service Inventory—Device Console

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Device Console W

Figure 5-3 Device Console—Download Commands: Select Devices

Device Conscle - Doewnload Commands

Devices: Select/Dezelect
Groups: Select/Dezelact
Cperation Caommands: | RYE—

Options: I Upload Config Ater Download
I_ Retrieve device attributes

OK Gancel

129042

Mote: * - Reguired Field

In the Devices row, click Select/Deselect. In the new window, check the check box for each device you
want. Uncheck a check box if you do not want this device. Then click Select. Figure 5-3 then reappears
with the selected devices in the Devices row.

In the Groups row, click Select/Deselect. In the next window, check the check box for each group you
want. Uncheck a check box if you do not want this group. Then click Select. The selected groups appear
in the Groups row.

In the Operation Commands field, enter the commands you want to download or click Load File to
select a set of commands to place in the Operation Commands field.

If you leave the Upload Config After Download check box unchecked, you do not upload the
configuration file after the download.

If you leave the Retrieve device attributes check box unchecked, you do not retrieve any device
attributes. If you check the Retrieve device attributes check box, after the template is downloaded,
SNMP is used to retrieve interface information and issue additional show commands, such as

show version.

Click OK to submit the download and you receive a window with the Device Console Operation Result
and in the bottom left corner a Status. You can click Download or Done.

When you click Download, you return to Step 6 to download additional commands on the selected
devices.

When you click Done, you return to Figure 5-2.

Download Template

Step 1

To download a template, follow these steps:

Choose Service Inventory > Device Console > Download Template from Figure 5-2 and click Next.
A window as shown in Figure 5-4, “Device Console—Download Template: Select Devices,” appears.

[ oL-10727-01

Cisco IP Solution Center Infrastructure Reference, 4.2 B



Chapter5  Service Inventory—Device Console |

I Device Console

Figure 5-4 Device Console—Download Template: Select Devices

evice Conscle - Downlead Template: Select Devices

el )| AR LR K

1. Choose O peration

O 2. Sedext D evices

O 3. Select Device Groups

O &, Zelect Download
Template

O & Dovenlozd Template
Surnrmary
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Step2  Continue with Step 3 if you want to add devices; proceed to Step 8 to delete devices; or click Next to
proceed to Step 10 for 3. Select Device Groups.

Step3  Click Add, as shown in Figure 5-4, to 2. Select Devices.

Step4  From the resulting window, as shown in Figure 5-5, “Device Selection,” check the check box(es) for
each device you want to select. Then click Select.

Figure 5-5 Device Selection

DeviceName ) g | e

Cigco |05 Device

Cigco |05 Device

Cigco |05 Device

Cigco |05 Device

149017

Step5  You return to Figure 5-4 with the added devices.
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Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

Device Console W

For each device, you can click the added Clear button to clear the Upload to Customer/Site column to
reflect none selected, or you can click the added Select button and a new window allows you to Create
Customer, Create Site, Select, or Cancel. When you click Select in this new window, you return to
Figure 5-4 with the added customer or site.

You can repeat Step 3 to Step 6 to add more devices, you can delete devices, as explained in Step 8, or
you can proceed by going to Step 9.

To delete devices, check the check box(es) for the devices you want to delete and then click Delete.
Select carefully, because there is no chance to confirm this deletion.

When you have all the devices you want, click Next. You proceed to 3. Select Device Groups, starting
in Step 10.

Continue with Step 11 if you want to add device groups; proceed to Step 14 to delete device groups; or
click Next to proceed to Step 16 for 4. Enter Download Commands.

Click Add, as shown in Figure 5-6, to 3. Select Device Groups. Adding Device Groups is optional.

Figure 5-6 Device Group Selection

Show Device Groups with | Dev¥ice Group Mame hd matching | | Find |

Showing 0 of O records

# I_ Device Group Hame D escrpticn

Fowe per page: | 10 j |]<] (] Zoto page: |1

1490149

From the resulting window, as shown in Figure 5-7, “Group Association,” check the check box(es) for
each device group you want to select. Then click Select.

Figure 5-7 Group Association

Groups Associgted with Oevice Console

Shove D evice Groups \.n.q"thl Device Group Mame j matching | |M
Showing 1 - 2 of 2 records

" I_ Device Group D e=crption

Hame

1. [T Device-Group-1
2. [ Device-Group-2

Rows per page: | 10 =] [<] <] Goto page: |1 of 1 [ [0

| Select || Cancel |

143015

You return to Figure 5-6 with the added device groups. You can repeat Step 11 to Step 12 to add more
device groups, you can delete device groups, as explained in Step 14, or you can proceed by going to
Step 15.

To delete device groups, check the check box(es) for the devices you want to delete and then click
Delete. Select carefully, because there is no chance to confirm this deletion.

[ oL-10727-01
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Step15 When you have all the device groups you want, click Next. You proceed to 4. Select Download
Template, starting in Step 16.

Step 16  For 4. Select Download Template, the resulting window is shown in Figure 5-8, “Select Download
Template.”

Figure 5-8 Select Download Template

Showing 0 of O records
# Template Data File Action

Rows per page: | 10 | 1] ] 3ot page: |1 of 1 (2 (20
Select

149020

Step17 In Figure 5-8, you can click the Select button.

Step18 A window as shown in Figure 5-9, “Add/Remove Templates,” appears. Click Add to add templates or
Remove to remove templates. When you have the templates you want, click OK.

When you click Add you get a Template Datafile Chooser window with the template choices in the tree.
Click + to open the folders and subfolders in the tree, until you get the property you want to choose.
Click on that property and it is added to your list. Repeat this until all the templates you want are in your
list. In each added property, you can click View and you receive the configlet for that data file. To return,
click OK. In Figure 5-9, check the check box(es) for the template(s) you want. In each template row,
click the Action drop-down list and choose APPEND or PREPEND to add information after or before,
respectively; check or uncheck the Active check box; and then click OK.

Figure 5-9 Add/Remove Templates
/3 Add/Remove Templates - Microsoft Internet Explorer -1O| x|
=
Showing 1 - 1 of 1 record
# Template [rata File Action Active Add
1. [T Dia-Channelization! DK-CHOC 2-5TS1-PATH SR_Data |APPEND j -
= =
Rowes per page: |10 = 1] <] 3ot page:|1 of 1 b= 20
| 0K ‘ ‘ Cancel ‘
F
[ E

Step19  You return to Figure 5-8 with the updated information.
Step20 Click Next and you proceed to 5. Download Template Summary, as explained in Step 21.

Step21 For 5. Download Commands Summary, a window as shown in Figure 5-10, “Download Template
Summary,” appears.
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Step 22

Step 23

Step 24

Device Console W

Figure 5-10 Download Template Summary
Devices: ped
T2
cesd
ezl LRI = Device Groups: Device-Group-1

® 1. Choose Operation

® 2. Select Devices

® 3. Select Device Groups

® 4. Select Downlozd
Template ™ Retrieve device attributes

05, Download Template

Summary

Template: DlA-Channelizations OK-CHOCT 2-5T51-PATH

|_ Uplozd Config After Dowwnlozd

149045

In Figure 5-10, if you leave the Upload Config After Download check box unchecked, you do not
upload the configuration file after the download. If you check the Upload Config After Download
check box, you upload the new configuration file after you download the templates in Step 18. If you
leave the Retrieve device attributes check box unchecked, you do not retrieve any device attributes. If
you check the Retrieve device attributes check box, after the template is downloaded, SNMP is used
to retrieve interface information and issue additional show commands, such as show version.

Click Back until you correct any information you want to change or click Finish to submit the download
and you receive a window with the Download Template Results and in the bottom left corner a Status
with a green check mark for Succeeded.

Click Done and you return to Figure 5-2 on page 5-2.

Device Configuration Manager

Step 1

To display the configuration, download the configuration to the startup configuration on the device, or
download the configuration to the running configuration on the device, follow these steps:

Choose Service Inventory > Device Console > Device Configuration Manager and from Figure 5-2
click Next. A window as shown in Figure 5-11, “Device Configuration Manager,” appears.

[ oL-10727-01
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Figure 5-11 Device Configuration Manager

Device Conzole - Device Configuration Manager: Select Device Version
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Step 2 In the Device row, click Select and a window as shown in Figure 5-12, “Device Selection,” appears.

Figure 5-12 Device Selection

Show Devices with | Device Mame hd matching | | Find |

Showing 1 - & of 8 recaords
_ Management IP Parent D evice

# D evice Hame Agdress Type Hame

1. ¢ pel Cigco 05 Device
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3 w2 Cigco 05 Device

4. & =wi Cigco |05 Device

5. =wd Cigco 05 Device

G. ¢ ce3 Cigco |05 Device

7. ced Cigco 05 Device

8. (¢ cel3 Cigco |05 Device

Rows per page: | 10 | 1] ] 3ot page: |1 of 1 (2 (20

| Select || Cancel |

149022

Step 3 From the devices listed, click the radio button for the device you want to select. Then click Select.
Step4  You return to Figure 5-11 with the added device. You can repeat Step 2 to Step 3 to change the device.

Step5  When you have selected the device you want, go to the Configuration to Display row and click the
Select a Version... drop-down list. Click the version you want and then click Load to load that
configuration file.
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Step 6

Step 7

Device Console W

Click one of the following radio buttons or keep the default:
¢ Display only The configuration file can only be viewed.

¢ Download to startup The configuration file is downloaded to the start up configuration of the
selected router.

)
Note  For Download to startup, the Device Access Protocol (defined in device creation) must be
either ftp or tftp. If this is not the case, the Device Configuration Manager Results window

appears and indicates that you must set up either ftp or tftp.

¢ Download to running The configuration file is downloaded to the router’s running configuration
file.

~
Note  When the DCPL property copy-running-to-startup in the GTL/ios folder is set to the default
of true, the router’s running configuration file is also copied to the start up configuration.

Click Finish. If in Step 6 you chose Display only, you automatically return to Figure 5-2 on page 5-2.
If in Step 6 you clicked Download to startup or Download to running, you get a Device Configuration
Manager Results window. In the Status box, you get a green check mark for Succeeded or a red Failed
status and you must click Done to return to Figure 5-2 on page 5-2.

EXEC Commands

Step 1

EXEC Commands allows you to send to target devices any Cisco IOS commands that can be executed
in enable mode. You can only view the router information. You cannot edit or delete the information.

To execute EXEC Commands, follow these steps:

Choose Service Inventory > Device Console > EXEC Commands and in Figure 5-2 click Next. A
window as shown in Figure 5-13, “Device Console—EXEC Commands: Select Devices,” appears.

[ oL-10727-01
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Figure 5-13 Device Console—EXEC Commands: Select Devices
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Step2  Continue with Step 3 if you want to add devices; proceed to Step 6 to delete devices; or click Next to
proceed to Step 8 for 3. Select Device Groups.

Step 3 Click Add, as shown in Figure 5-13, to 2. Select Devices.

Step 4 From the resulting window, as shown in Figure 5-14, “Device Selection,” check the check box(es) for
each device you want to select. Then click Select.

Figure 5-14 Device Selection
Show Devices with I Device MName | matehing | | Find |
Zhawing 1 - § of § records
# u D evice Hame Man:g:rg = Type Para“r;r?:uce

1. [~ pe Cisco 105 Device
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3. [ sw2 Cisco 105 Device

4 [ =wa Cisca 105 Device

5. [~ swd Cisco 105 Device

B. [~ ce3 Cisca 105 Device

7. [~ ced Cisco 105 Device

5. [ cel3 Cisca 105 Device

Rows per page: | 10 =] 1<] ] Gota page: I1 of1 Bl

| Select || Cancel |

1449017

Step5  You return to Figure 5-13 with the added devices. You can repeat Step 3 to Step 4 to add more devices,
you can delete devices, as explained in Step 6, or you can proceed by going to Step 7.

Step6  To delete devices, check the check box(es) for the devices you want to delete and then click Delete in
Figure 5-13. Select carefully, because there is no chance to confirm this deletion.
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Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Device Console W

When you have all the devices you want, click Next. You proceed to 3. Select Device Groups, starting
in Step 8.

Continue with Step 9 if you want to add device groups; proceed to Step 12 to delete device groups; or
click Next to proceed to Step 14 for 4. Enter EXEC Commands.

Click Add, as shown in Figure 5-15, to 3. Select Device Groups.

Figure 5-15 Device Group Selection
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From the resulting window, as shown in Figure 5-16, “Group Association,”’check the check box(es) for
each device group you want to select. Then click Select.

Figure 5-16 Group Association
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You return to Figure 5-15 with the added device groups. You can repeat Step 9 to Step 10 to add more
device groups, you can delete device groups, as explained in Step 12, or you can proceed by going to
Step 13.

To delete device groups, check the check box(es) for the devices you want to delete and then click
Delete. Select carefully, because there is no chance to confirm this deletion.

When you have all the device groups you want, click Next. You proceed to 4. Enter EXEC Commands,
starting in Step 14.

[ oL-10727-01
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Step14 For 4. Enter EXEC Commands, the resulting window is shown in Figure 5-17, “Operation
Commands.”
Figure 5-17 Operation Commands
Device Consele - EXEC Commands: Enter EXEC Command
Input File: I Browse... | Load File
Commands:
[t AL 110
1. Choose Operation
2 Select Devices
# 3. Select Device Groups
[ 4. Enter EXEC Command
O5.EXEC Commands
Surnmary
un
-Step dof5- £
< Back Hext = Cancel g
...... s
Step15 In Figure 5-17, you can click the Browse button to input an existing file with Cisco IOS configuration
commands. Then click the Load File button to put the file’s information in the Commands field.
Otherwise, you can enter the Cisco IOS configuration commands directly in the Commands field.
Step16  Click Next and you proceed to 5. EXEC Commands Summary, as explained in Step 17.
Step17 For 5. EXEC Commands Summary, a window as shown in Figure 5-18, “EXEC Commands
Summary,” appears.
Figure 5-18 EXEC Commands Summary
Device Consele - EXEC Commands: EXEC Command Summary
Devices:
Device Groups:
Cornmands:
e R L0
B4, Choose O peration
B2, Select Devices
B3, Select Device Groups
4 Erter EXEC Command
05, EXEC Commands
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-Step S ofs- &
< Back Finish Cancel =
...... 5
Step 18

Click Back until you correct any information you want to change or click Finish to retrieve the
information from the router. You then receive a window with the EXEC Commands Results and a
Status with a green check mark for Succeeded. You can click EXEC or Done.
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Reload

Step 19
Step 20

Step 1

Step 2

Step 3
Step 4

Device Console W

When you click EXEC, you return to Step 14 to enter additional commands on the selected devices.

When you click Done, you return to Figure 5-2 on page 5-2.

To reload (reboot) the router, follow these steps:

Choose Service Inventory > Device Console > Reload and from Figure 5-2 click Next. A window as
shown in Figure 5-19, “Device Console—Reload: Select Devices,” appears.

Figure 5-19 Device Console—Reload: Select Devices
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Continue with Step 3 if you want to add devices; proceed to Step 6 to delete devices; or click Next to
proceed to Step 8 for 3. Select Device Groups.

Click Add, as shown in Figure 5-19, to 2. Select Devices.

From the resulting window, as shown in Figure 5-20, “Device Selection,” check the check box(es) for
each device you want to select. Then click Select.
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Step 5

Step 6

Step 7

Step 8

Step 9

Figure 5-20
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You return to Figure 5-19 with the added devices. Repeat Step 3 to Step 4 to add more devices; delete
devices, as explained in Step 6; or proceed by going to Step 7.

To delete devices, check the check box(es) for the devices you want to delete and then click Delete.
Select carefully, because there is no chance to confirm this deletion.

When you have all the devices you want, click Next. You proceed to 3. Select Device Groups, starting

in Step 8.

Continue with Step 9 if you want to add device groups; proceed to Step 12 to delete device groups; or
click Next to proceed to Step 14 for 4. Reload Devices Summary.

Click Add, as shown in Figure 5-21, to 3. Select Device Groups.

Figure 5-21 Device Group Selection
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Step10 From the resulting window, as shown in Figure 5-22, “Group Association,” check the check box(es) for
each device group you want to select. Then click Select.
Figure 5-22 Group Association
Groups Associated with Device Console
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Step11  You return to Figure 5-21 with the added device groups. Repeat Step 9 to Step 10 to add more device
groups; delete device groups, as explained in Step 12; or proceed by going to Step 14.
Step12 To delete device groups, check the check box(es) for the devices you want to delete in Figure 5-21 and
then click Delete. Select carefully, because there is no chance to confirm this deletion.
Step13  When you have all the device groups you want, click Next. You proceed to 4. Reload Devices Summary,
starting in Step 14.
Step14 For 4. Reload Devices Summary, a window as shown in Figure 5-23, “Reload Summary,” appears.
Figure 5-23 Reload Summary
Device Conscele - Relead: Relead Devices Summary
Devices:
Device Groups:
[l 11
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Step15 Click Back until you correct any information you want to change or click Finish to submit the reload
and you receive a window with the Reload Results and a Status with a green check mark for Succeeded.
Step16  Click Finish and you return to Figure 5-2 on page 5-2.
Cisco IP Solution Center Infrastructure Reference, 4.2
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CHAPTER

Service Design

From the Home window of Cisco IP Solution Center (ISC), which you receive upon logging in, click the
Service Design tab and you receive a window as shown in Figure 6-1, “Service Design Selections.”

Figure 6-1 Service Design Selections

Service Design

Tools to create and manage policies, templates, protocols, and network objects.

Policies
"'\,\#’} Create and manage Policies for licensed services.

Templates
G Create and manage Templates and associated data.

qps LinkQo3
T Create and manage [P Link QoS and Ethernet Link Glos seftings.

153141

Next you can choose the following selections:
¢ Policies, page 6-1 Create and manage Policies for licensed services.
¢ Templates, page 6-2 Create and manage Templates and associated data.

¢ Link QoS, page 6-39 Create and manage IP Link QoS and Ethernet Link QoS settings.

Policies

Policies is explained in each of the User Guides for each of the applicable licensed services.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Templates

Step 1

Templates supports the browsing, creation, and deletion of Template Folders, Templates, and Data Files
and it supports the viewing of Template-generated configurations. The configuration created from the
template and data file can be downloaded to devices. When creating a Service Request, you can select
from the list of templates and data files and associate them with the Service Request. At Deploy time,
the template and data file are instantiated and the configuration is appended or prepended to the configlet
generated by ISC.

ISC provides a way to integrate a template with ISC configlets.
For a given customer edge router and/or provider edge router, you specify the following:
e template name
e template data file name
e whether the template configuration file should be appended or prepended to the ISC configlet
¢ whether the template configuration file is active or inactive for downloading to the edge device

The template data files are tightly linked with the corresponding template. You can use a data file and
its associated template to create a template configuration file. The template configuration file is merged
with (either appended or prepended to) the ISC configlet. ISC downloads the combined ISC configlet
and template configuration file to the edge device router.

* You can download a template configuration file to a router.

* You can apply the same template to multiple edge routers, assigning the appropriate template data
file for each device. Each template data file includes the specific data for a particular device (for
example, the management IP address or host name of each device).

To use Templates, follow these steps:

Choose Service Design > Templates and you receive a window as shown in Figure 6-2, “Templates.”

Figure 6-2 Templates

Home | Shortcuts | sceourt | indes | Help | About | Logout

Cisco SrsTems

IP Solution Center

|Seruice Design ‘ |
0s +

+ Templates * Protocols * Link

User: admin

+ Policies

You Are Here: + Service Design® Templates

Templates

E () DI &-Channelization Folder:
(] Examples
ECTqes Showy Templates matching I Show
Showing 0-0 of 0 records
[} Template Mamne D escription
Mo records
Rowe per page:l 1a ﬂ N]Q]Gotopage:l 1 of1 Pages DD'
m
[¥o]
Creste Template Creste Data Fils Edit Delste || &
[l

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 2

Templates W

Template examples are shown in the left column. A complete list of template examples is specified in
the “Template Examples” section on page 6-22. A complete list of Repository variables is shown in the
“Summary of Repository Variables” section on page 6-24. An explanation of a tool for importing and
exporting templates into and from an ISC database is given in the “Importing and Exporting Templates”
section on page 6-38.

Then you can do any of the following:
e View Templates Tree and Data Pane, page 6-3
e Create Folders and Subfolders, page 6-4
e Create Template, page 6-5
e Create Data File, page 6-15
e Edit, page 6-20
e Delete, page 6-21

View Templates Tree and Data Pane

When you choose Service Design > Templates, you receive a window as shown in Figure 6-3, “Tree and
Data Pane Structure.”

The Templates tree is in the left column. You can continue clicking the + sign next to each created folder
and subfolder until you get to the last level of information. The last possible level is the template name.
Data file information is not kept in the tree.

The right section of the window is the data pane. The name of the folder or template is in the upper-left
corner. When you check the check box next to the template or data file information, the Create
Template, Create Data File, Edit, or Delete buttons are enabled as described in the following sections.

When there are many templates in a folder or many data files in a template, the Show Template
Matching or Show Data File Matching filter in the upper right-hand corner of the data pane can be very
useful. For example, you might just want to work with templates or data files that start with abe. In this
case, enter abce* in the field and then click the Show button. Only the templates or data files that start
with abc appear.

You can also View configurations when the table displays data files.

[ oL-10727-01
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Figure 6-3 Tree and Data Pane Structure

Home | Shorteuts | 2ccourt | index | Help | sbout | Logout
Cisco SrsTems i J

IP Solution Center

Uszer: admin

‘fou Are Here: + Service Designz Templates

Templates

5142901 & Channelization Folder:
@ 10K-CHOCT 2-5TS1-PATH
@ A0K-2T3-CHAMMELIZED
-[E] 10K-G T 3-UNCHANNELIZED
-[2] P4-MC-E3-CHAMNELIZED
- [E] PAMEC-STMA -8 3-CHANNELLZ
- [E] PAMC-STMA -8U4-CHANNELILZ
-[2] PA-MG -T3-CHANNELIZED
A Examples
@ Aocesslist
-[E] socessListt
-[E] aEwanaos
B dG0s

BiEL2

EIEATH

@ CLP_Egress
@ GLP_Ingress
{AFrameRelay
@ classification

Show Templates matching I Show

Showing 0-0 of O records

[} Template Mame D escription

Mo records

Riows per page:l 10 j

N]'ﬂ]Gotopage:l 1 of1 Pages () [»[2]

Edit | Delete

| Create Data File

Create Template

[/ —— E

Right-click above to display menu.

125054

Create Folders and Subfolders

Step 1
Step 2

Note

Step 3

To create a new folder or subfolder, follow these steps:

Choose Service Design > Templates.

In the Templates tree, right-click in the white area and choose New > Folder to create a new folder or
right-click on an existing folder or subfolder and choose New > Folder to create a subfolder.

There is no limit to the number of levels of folders and subfolders you can create.

In the new text field that appears in the Templates tree, type the new folder or subfolder name, as shown
in the first entry of the Templates tree in Figure 6-4, “Folder Naming.”

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 6-4 Folder Naming

Cisco SrsTEMs ] Home | Shortcuts | sceourt | indes | Help | sbout | Logout
IP Solution Center

o
Service Design User: admin

= + Templates * Protocals + Lin

‘You Are Here: + Service Designz Templates

Templates

(= — Folder:

() Dl &-Channelization

E L3 Exampies Show Templates matching I Show
EH[_Joo0s

Showing 0-0 of 0 records

Mo records

Rows per page:l 10 | 1< Gotopage| 1 of1Pages P3¢

Create Data File

1259055

Copying Folders or Subfolders

Step 1
Step 2

Step 3

To copy a folder or subfolder and paste it into another folder or subfolder, follow these steps:

Select a folder or subfolder and then right-click and you receive the opportunity to copy. Click Copy.

Right-click on the folder or subfolder into which you want to paste the copied folder or subfolder and
all its content and click Paste.

You will see the new folder or subfolder and all its content in the selected location. You can edit and
rename from there.

Note  This function works with Internet Explorer but not with Netscape.
Create Template

You can either create a new template in an existing folder or you can create a new folder first and then
create the template. To create a new folder, see the section “Create Folders and Subfolders”.
To create a new template, follow these steps:

Step1  Choose Service Design > Templates.

Step2  In the Templates tree, click on the folder in which you want to create a new template.

Step3 A window appears as shown in Figure 6-5, “Folder with Existing Templates.”

[ oL-10727-01

Cisco IP Solution Center Infrastructure Reference, 4.2 B



Chapter6  Service Design |

W Templates

Figure 6-5 Folder with Existing Templates

E o Templates | x

Home | Shortcuts | sceourt | indes | Help | About | Logout

Cisco SrsTems
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” Service Degign |
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+ Templates + Prc
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Templates
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Bl Showy Templates matching I Show
Showing 1-3 of 3 records
[} Template Mame D escription
1. - CEWanD oS
2. I AccessList
3. I~ Accesslist
Rows per pagE:I 10 j N]ﬂGUtUpage.l 1 of Pagas bbl
s
‘ Create Template | | Create Data File ‘ | Edit | | Dedete | g
[

Step4  Click the Create Template button and you receive a window as shown in Figure 6-6, “Template Editor.”

Figure 6-6 Template Editor

Template Editor

Template Editor

Template Namex: I

Description: |

Bodyx:

Reguired Fislds [ Has User Section

129057

'Select 8 Click Go ]| 6o || | save || ctose |

Step5  Enter the following:

¢ Template Name (required) This must be a unique name within a folder. This name must begin with
an alphabetic character and can only contain alphanumeric characters, underscores, and hyphens.

e Description (optional) You can enter any description here.

¢ Body (required) Enter the configuration text, Velocity template language directives, and variables
that you want included.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Note

Templates

The Velocity template language is explained at http://jakarta.apache.org/velocity/user-guide.html.

An example template is shown in Figure 6-7, “Example Template.”

Figure 6-7 Example Template

Template Editor

Template Editor

Template Mame: |

Description: |

&myf b# This template demonstrate if-else statements, repeat sStatements, =
mathematic
## expression, 1 dimensional wvariskles

access-list 103 permit host $CE-1lo0 §mgt-prefix §mgt-mwask
access-list 104 permit §protocol.get (0
]
fiforeach ($class in Sclass-waps)

class-mwap match-all §class

match $fclass-match.get ($velocityCount)

#end
1
policy-map §service-policy
fiforeach ($class in §class-maps)

class $class

#if ($class == "business") |

*Required Fields | Has User Section

s o=l 0 [ e | e |

03447

ISC has the template system predefined variable $TMSystem that can be used within the template body
text to access template system functions. The syntax is as follows, where, $ipAddrMask is a string that
contains an IP address and its mask in the format of: 10.33.4.5/30 and $ipAddr is a string that contains

and IP address:

$TMSystem.CurrentTimeInIOSFormat() returns: "hh:mm:ss day_of_month month_of_year year"
$TMSystem.getAddr($ipAddrMask) returns: 10.33.4.5
$TMSystem.getMask($ipAddrMask) returns: 255.255.255.252
$TMSystem.getReverseMask($ipAddrMask) returns: 0.0.0.3
$TMSystem.getNetworkAddr($ipAddrMask) returns: 10.33.4.4
$TMSystem.getClassfulNetwork Addr($ipAddrMask) returns: 10.0.0.0
$TMSystem.getOctet1($ipAddr) returns: first octet of ipAddr
$TMSystem.getOctet2($ipAddr) returns: second octet of ipAddr
$TMSystem.getOctet3($ipAddr) returns: third octet of ipAddr
$TMSystem.getOctetd($ipAddr) returns: fourth octet of ipAddr
$TMSystem.SubstringToDelim($PE_Intf_Name, “:”, “0”) returns: Serial2/0/0

[ oL-10727-01
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Note  For $TMSystem.SubstringToDelim, the text before the ““:” character (the delimiter) of the string
$PE_Intf_Name, where $PE_Intf_Name equals “Serial2/0/0:4”, is returned. The “0” in the
previous call indicates the text to the left of the delimiter is returned. A “1” indicates the text to
the right of the delimiter is returned.

Step6  Click the Select & Click Go drop-down list. If you want to validate the information you entered in
Step 5, select Validate and then click the Go button. Otherwise, select Variables and then click the Go
button and you receive a window as in Figure 6-8, Template Variables”.

Figure 6-8 Template Variables
= Template VYariables — Netscape : J|
Showing 1-10 of 34 records
Wariable Type Cras cription
1. class-match String
2 bestEffart-pet String
3 manag-pet String
4, goldBurst Integer
5 buginess-meighting- constant Integer
6. sihrerBurst String
7. be-rnak String
2. & rp- qu e- lirnit String
9. & be-rnin-thresh String
0. GESublnterface String
Frovis perpage:lﬂ Id]é]G-:-t-:- page:|1_ of 4 Pages ﬁbl
o
=

Step7  Click the radio button for the Variable you want to edit and click Edit. You receive a window as shown
in Figure 6-9, “Variable Definition—Type String.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 6-9 Variable Definition— Type String

Variable bestEffort-pot

Type: I String j
Description: I

Required:

Pattern:

Minirmum Length:

[«
Dimensian: I 1] j

|

|

|

Iaximum Length:

¥ Default Value: I
" Available Values {comma separated):

xRequired Fields

120058

Step8  In Figure 6-9, click the drop-down list for Type to receive the following choices:

String Proceed to Step 9.

Integer Proceed to Step 10.

Float Proceed to Step 11.

IPv4 Address Proceed to Step 12.
Sub-Template Proceed to Step 13.
Dynamic Java Class Proceed to Step 14.
Dynamic URL Proceed to Step 15.

Step9  The default Type to appear is String, a combination of ASCII characters considered as a group. The
resulting Variable window is shown in Figure 6-9 and its attributes are as follows:

Description (optional) You can enter any descriptive statement about this variable here.

Required Leave the default of the checked check box if this variable is required. Otherwise,
uncheck it.

Dimension Choose 0 (default), which indicates a scalar or enum variable; choose 1, in which case
the variable becomes a one-dimensional array; or choose 2, in which case the variable becomes a
two-dimensional array.

Pattern (optional) Specify a regular expression pattern of the string. For example, a pattern of
isc[0-9]+ defines a string that starts with isc followed by one or more digits from 0 to 9.

Minimum Length (optional) If you specify a minimum length, the string cannot be less than the
length specified here.

Maximum Length (optional) If you specify a maximum length, the string cannot exceed the length
specified here.

Radio Button: Default (optional) If there is a default value for the specified variable, specify it here.

Radio Button: Available Values (optional) Enter string values for this variable. Separate the values
by commas.

[ oL-10727-01
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After you enter all the data, click OK to accept this information for the specified variable; continue
editing all variables you want to change in this same way, then click OK in a window such as Figure 6-8,
which now includes these updated variables; click Save and then Close or click Close and when asked,
agree to Save for a window such as Figure 6-6. Create a Data File is shown in the “Create Data File”
section on page 6-15, Edit is shown in the “Edit” section on page 6-20, and Delete is shown in the
“Delete” section on page 6-21.

Step10 When you choose the Type Integer, a whole number, the resulting Variable window is shown in
Figure 6-10 and its attributes are as follows:

¢ Description (optional) You can enter any descriptive statement about this variable here.

¢ Required Leave the default of the checked check box if this variable is required. Otherwise,
uncheck it.

¢ Dimension Choose 0 (default), which indicates a scalar or enum variable; choose 1, in which case
the variable becomes a one-dimensional array; or choose 2, in which case the variable becomes a
two-dimensional array.

e Minimum Value (optional) If you specify a minimum value, the integer cannot be less than the
value specified here.

e Maximum Value (optional) If you specify a maximum value, the integer cannot exceed the value
specified here.

¢ Radio Button: Default (optional) If there is a default value for the specified variable, specify it here.

¢ Radio Button: Available Values (optional) Enter string values for this variable. Separate the values
by commas.

After you enter all the data, click OK to accept this information for the specified variable; continue
editing all variables you want to change in this same way, then click OK in a window such as Figure 6-8,
which now includes these updated variables; click Save and then Close or click Close and when asked,
agree to Save for a window such as Figure 6-6. Create a Data File is shown in the “Create Data File”
section on page 6-15, Edit is shown in the “Edit” section on page 6-20, and Delete is shown in the
“Delete” section on page 6-21.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 6-10 Variable Definition— Type Integer
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" Available Values {comma separated):

=
Dimension; I o=
|
|
|

xRequired Fields

129059

Step11  When you choose the Type Float, a number that has no fixed number of digits before or after the decimal
point, the resulting Variable window is shown in Figure 6-11 and its attributes are as follows:

Description (optional) You can enter any descriptive statement about this variable here.

Required Leave the default of the checked check box if this variable is required. Otherwise,
uncheck it.

Dimension Choose 0 (default), which indicates a scalar or enum variable; choose 1, in which case
the variable becomes a one-dimensional array; or choose 2, in which case the variable becomes a
two-dimensional array.

Minimum Value (optional) If you specify a minimum value, the floating point value cannot be less
than the value specified here.

Maximum Value (optional) If you specify a maximum value, the floating point value cannot exceed
the value specified here.

Radio Button: Default (optional) If there is a default value for the specified variable, specify it here.

Radio Button: Available Values (optional) Enter string values for this variable. Separate the values
by commas.

[ oL-10727-01
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After you enter all the data, click OK to accept this information for the specified variable; continue
editing all variables you want to change in this same way, then click OK in a window such as Figure 6-8,
which now includes these updated variables; click Save and then Close or click Close and when asked,
agree to Save for a window such as Figure 6-6. Create a Data File is shown in the “Create Data File”
section on page 6-15, Edit is shown in the “Edit” section on page 6-20, and Delete is shown in the
“Delete” section on page 6-21.

Figure 6-11 Variable Definition— Type Float

Variable bestEffort-poct
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I aximum alle:

¥ Default Value:
™ Bvailable Valuss {comma separated):

=
Dimension; I o=
|
|
|

xRequired Fields

128060

Step12 When you choose the Type IPv4 Address, the resulting Variable window is shown in Figure 6-12 and
its attributes are as follows:

¢ Description (optional) You can enter any descriptive statement about this variable here.

¢ Required Leave the default of the checked check box if this variable is required. Otherwise,
uncheck it.

¢ Dimension Choose 0 (default), which indicates a scalar or enum variable; choose 1, in which case
the variable becomes a one-dimensional array; or choose 2, in which case the variable becomes a
two-dimensional array.

¢ Subnet Mask (optional) Enter a valid subnet mask.
e Class (optional) Enter the class of the IP address. The options are: Undefined, A, B, or C.
¢ Radio Button: Default (optional) If there is a default value for the specified variable, specify it here.

e Radio Button: Available Values (optional) Enter string values for this variable. Separate the values
by commas.

After you enter all the data, click OK to accept this information for the specified variable; continue
editing all variables you want to change in this same way, then click OK in a window such as Figure 6-8,
which now includes these updated variables; click Save and then Close or click Close and when asked,
agree to Save for a window such as Figure 6-6. Create a Data File is shown in the “Create Data File”
section on page 6-15, Edit is shown in the “Edit” section on page 6-20, and Delete is shown in the
“Delete” section on page 6-21.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 6-12 Variable Definition— Type IPv4
Variable bestEffort-pet
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Required: [+
Dirnension: a j
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When you choose the Type Sub-Template, you instantiate one subtemplate into the Main template. The
resulting Variable window is shown in Figure 6-13 and its attributes are as follows:

¢ Description (optional) You can enter any descriptive statement about this variable here.

¢ Required Leave the default of the checked check box if this variable is required. Otherwise,
uncheck it.

¢ Location (required) Enter the full path name of the parent template. For example /test2/testyy.

The variable varName is defined as the subtemplate type (by selecting Variables and clicking Go). The
Sub-Template defined earlier is called and you must provide the subtemplate path. The syntax is as
follows:

$<varName>.callWithDatafile(<DatafileName>)

After you enter all the data, click OK to accept this information for the specified variable; continue
editing all variables you want to change in this same way, then click OK in a window such as Figure 6-8,
which now includes these updated variables; click Save and then Close or click Close and when asked,
agree to Save for a window such as Figure 6-6. Create a Data File is shown in the “Create Data File”
section on page 6-15, Edit is shown in the “Edit” section on page 6-20, and Delete is shown in the
“Delete” section on page 6-21.

[ oL-10727-01
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Figure 6-13 Variable Definition— Type Sub-Template
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Step14  When you choose the Type Dynamic Java Class, the resulting Variable window is shown in Figure 6-14
and its attributes are as follows:

¢ Description (optional) You can enter any descriptive statement about this variable here.

e Required Leave the default of the checked check box if this variable is required. Otherwise,
uncheck it.

The variable varName is defined as the Dynamic Java Class type (by selecting Variables and clicking
Go). The syntax is as follows:

$<varName>.<method_name_in_Java_class> ([<parameters>])

After you enter all the data, click OK to accept this information for the specified variable; continue
editing all variables you want to change in this same way, then click OK in a window such as Figure 6-8,
which now includes these updated variables; click Save and then Close or click Close and when asked,
agree to Save for a window such as Figure 6-6. Create a Data File is shown in the “Create Data File”
section on page 6-15, Edit is shown in the “Edit” section on page 6-20, and Delete is shown in the
“Delete” section on page 6-21.

Figure 6-14 Variable Definition— Type Dynamic Java Class
Variable a

Type: | Dynamic Java Class j

Description: |

Required: v

EHEA

93454

*Required Fields

Step15 When you choose the Type Dynamic URL, the resulting Variable window is shown in Figure 6-15 and
its attributes are as follows:

¢ Description (optional) You can enter any descriptive statement about this variable here.

e Required Leave the default of the checked check box if this variable is required. Otherwise,
uncheck it.

Cisco IP Solution Center Infrastructure Reference, 4.2
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The variable varName is defined as the Dynamic URL type (by selecting Variables and clicking Go).
The syntax is as follows:

$<varName>.callURL (<url-address>)

After you enter all the data, click OK to accept this information for the specified variable; continue
editing all variables you want to change in this same way, then click OK in a window such as Figure 6-8,
which now includes these updated variables; click Save and then Close or click Close and when asked,
agree to Save for a window such as Figure 6-6. Create a Data File is shown in the “Create Data File”
section on page 6-15, Edit is shown in the “Edit” section on page 6-20, and Delete is shown in the
“Delete” section on page 6-21.

Figure 6-15 Variable Definition— Type Dynamic URL

Variable a

Type: | Dwnamic LURL j

Description: |
Required: [

EE=]

i
*Required Field=s

934EE

Copying Templates

Step 1
Step 2

Step 3

Note

To copy a template and paste it into another folder, follow these steps:

Select a template and then right-click and you receive the opportunity to copy. Click Copy.

Right-click on the folder into which you want to paste the copied template and all its data files and click
Paste.

You will see the new template and all its data files in the selected location. You can edit and rename from
there.

This function works with Internet Explorer but not with Netscape.

Create Data File

Step 1

You can create a new data file from an existing template. If the template you want is not available, go to
the “Create Template” section on page 6-5.

To create a data file, follow these steps:

Choose Service Design > Templates.

[ oL-10727-01
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Step2  In the Templates tree in the left part of your window, do one of the following

1. Left-click on the folder or subfolder in which the template for which you want to create a data file
exists or

2. Click on the + next to the folder of choice and then click on the template for which you want to create
a data file.

Step3  If you chose 1. in Step 2, a window appears as shown in Figure 6-16, “Choose Existing Template >
Create Data File.”

Figure 6-16 Choose Existing Template > Create Data File
Templates
D Dl&-Channelizetion Felder: Examples
EC0 Exampl
D Q);asmp = Showe Templates matching Show
Showing 1-3 of 3 records
o Template Mame D escription
1. ~ CEWanCOS
2 [ Arcesslistl
3 ( Accesslist
Rowe per page: L j lﬂﬂGUtUpEgE.l 1 of1 Pages bb'
e
Create Template | | Create Data File | | Edit | ‘ Delete | 8
]

Check the check box for the template for which you want to create a data file and click Create Data
File. Then proceed to Step 5.

Otherwise, proceed to Step 4.

Step4  If you chose 2. in Step 2, the buttons appear as shown in Figure 6-17, “Choose Existing Template >
Create Data File.”

Figure 6-17 Choose Existing Template > Create Data File
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EH( oS

Create Template | | Create Data File ‘ | Edit | | Dedete |
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Click Create Data File and proceed to Step 5.

Step5  An example of a window that appears is shown in Figure 6-18, “Template Data File Editor.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 6

Step 7

Step 8

Templates W
Figure 6-18 Template Data File Editor
Data File Editor
General
Templste: Dl A-ChannelizationP &-MC-T 3-CHANNELIZED
Data File Marme - I
Description: I
Varables
ctriklame | {Stringy | Vars
it - | Edit Vars
Feguired Fields | | Di=play COptional Yariahbles

‘ Save H Configlat H Close ‘

1290684

In the General area, fill in the following:

¢ Data File Name (required) This must be a unique name. This name must begin with an alphabetic
character and can only contain alphanumeric characters and the underscore.

¢ Description (optional) Enter any description that helps you identify this data file.

In the example in Figure 6-18, in the Variables area, cntrlName is a string variable (Dimension defined
when the template was created was 0); you can also create a one-dimensional array (Dimension defined
when the template was created was 1); and t1-list is a two-dimensional array (Dimension defined when
the template was created was 2).

If t1-list is a Dynamic Java Class variable, you must enter the entire Java Class package name. For
example: com.cisco.isc.class_name.

If you click Vars as shown in Figure 6-18, you receive a window as shown in Figure 6-19, “Template
Data File Editor.”

Figure 6-19 Template Data File Editor

Varable ctriHame x:

Services: I rFLS j

$auto_Assign_IP_Address iy
FCE_BGP_AS_ID
Warighles: |$CE_DLCI
FCE_EIGRP_AS_ID
$CE_Facing_MVRFCE_BGF_aS_ID Fi

Select Cancel

126065
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Click the Services drop-down list to have access to variables for:
e MPLS
e L2VPN
e QoS
e VPLS
Then click the entry in Variables that you want to use and click Select.
If you have a 0 dimensional entry (set as Dimension 0 when creating a template), you can only enter
variables in the provided field.
~
Note  The Vars button is available only if ecntrlName is a String Variable.
Step9  When you click Edit, as shown in Figure 6-18, the resulting window depends on whether you are editing
a 1 or 2 dimensional array.
Proceed to Step 10 for information about a 1 dimensional array.
Proceed to Step 13 for information about a 2 dimensional array.
Step10 For a one-dimensional array (set as Dimension 1 when creating the template), when you click Edit, you
receive a window as shown in Figure 6-20, “Editing a One-Dimensional Array.”
Figure 6-20 Editing a One-Dimensional Array
Variable b *
first
second
third
Step11  To add a variable, click Add and a window, as shown in Figure 6-21, “Adding a Variable,” appears in

which you can add the variable. Then click OK.

Figure 6-21 Adding a Variable

Variable b

Walue:
[=tring)

93441
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Step12 To edit or delete a variable, highlight the variable in Figure 6-20 and click Edit or Delete. For Edit you
receive a window as shown in Figure 6-21. Then click OK. For Delete, be sure you want to delete. After
you click Delete, it automatically occurs and the window is updated. Proceed to Step 19.
Step13  For a two-dimensional array (set as Dimension 2 when creating the template), when you click Edit, you
receive a window as shown in Figure 6-22, “Editing a Two-Dimensional Array.
Figure 6-22 Editing a Two-Dimensional Array
Variable a ™
Add Row
Add Column
0K Cancel
Step14 Click Add Row in Figure 6-22 and a window, as shown in Figure 6-23, “Enter Row Information,”
appears. Enter a value and click OK.
Figure 6-23 Enter Row Information
Variable t1-list -
Foy {=tring)
OK Cancel
Step15 Click Add Column in Figure 6-22 and a window as shown in Figure 6-24, “Enter Column Information,”
appears. Enter a value and click OK.
Figure 6-24 Enter Column Information
Variable t1-list -
Calurmn:
rString)
OK Cancel
g
Cisco IP Solution Center Infrastructure Reference, 4.2
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Step16 A resulting window, as shown in Figure 6-25, “Two-Dimensional Array Results,” appears.
Figure 6-25 Two-Dimensional Array Results
Variable t1-list -
|7 IF IF Add Row
|F |E |E Add Column
oK || cances ||B
Step17  You can check any of the check boxes (toggles) and you can then Edit or Delete that row or column. You
can also continue to Add Row and Add Column as shown in Step 15 and Step 16, respectively.
Step18  When you complete setting up your two-dimensional array, click OK in Figure 6-25.
Step19 A window as shown in Figure 6-18 is updated to reflect the new data file information.
Step20 You can then click Save and then Close to save this information and close this file; click Configure to

Edit

Step 1
Step 2

Step 3

show the configuration file; or click Close and then be sure to click OK, if you want to save the
information you have created. If you do not want to save this information, click Close and then click
Cancel.

To edit a Template or Data File, follow these steps:

Choose Service Design > Templates.

In the Templates tree, left-click on the folder or subfolder in which the template you want to edit exists
or the template in which the data file you want to edit exists. Alternatively, when the name in the upper
left corner of the data pane is a template, you can click on the template name to edit the template.

To edit a template, a window appears as shown in Figure 6-26, “Choose Existing Template > Edit.” To
edit a data file, a window appears as shown in Figure 6-27, “Choose Existing Data File > Edit.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 4

Note

Step 5
Step 6

Delete

Step 1
Step 2

Step 3

Templates
Figure 6-26 Choose Existing Template > Edit
Templates
D D1&-Channelization Felder: Examples
E I
g Q);asmp = Showe Templates matching Show

Showing 1-3 of 3 records

1.

- CEWanCOS
2. u AccessList]
3. - AccessList
Rowe per page:| 10 | N]G]Gntnpage'l 1 of1 Pagss (Ga) bRl
@
Create Template | | Create Data File | | Edit | ‘ Delete | 8
I}
Figure 6-27 Choose Existing Data File > Edit
Templates
E1 301 A-Channeization Template: 10K-CHOGC12-5TS1-PATH
i+[E] 10K-CHOG12-5TS1-PATH
(5] 10K-CT3-CHANNELIZED Shaw Data Files matching | Show

{5] 10K-CT3-UNCHANNELIZED
{5] P 4-MGC-E3-CHANNELIZED
21 pao-Stort-aus.cHanneLsz L e [ Gl
i[E] P AMC-STM1-AU4-CHANNELI 2 1. [T sRDaa Wiews

[2] PAMC.T3.CHANNELIZED

e xamples Rows per pags| 10 =1 14 cotopege] 1 of1Pages @) [ Bl

EHJoos

Showing 1-1 of 1 recards

| Create Template | | Create Data File ‘ | Edit | | Delete |

Check the check box for the template or data file you want to edit.

125062

For a data file, there is a Configlet column in which you can click View to view the configuration file.

Click Edit.

When editing a template, you receive a window as shown in Figure 6-6, “Template Editor.” Then

proceed as in Step 5 in the Create Template section. When editing a data file, you receive a window as
shown in Figure 6-17, “Choose Existing Template > Create Data File.” Then proceed as in Step 5 in the

Create Data File section.

To delete a Template or Data File, follow these steps:

Choose Service Design > Templates.

In the Templates tree, left-click on the folder or subfolder in which the template you want to delete exists

or the template in which the data file you want to delete exists.

To delete a template, a window appears as shown in Figure 6-28, “Choose Existing Template > Delete.

i)

To delete a data file, a window appears as shown in Figure 6-29, “Choose Existing Data File > Delete.”

[ oL-10727-01
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Figure 6-28 Choose Existing Template > Delete

Templates

D D1&-Channelization Felder: Examples
FC0 Examples ) l—
[:I a0 Showe Templates matching Show

Showing 1-3 of 3 records

1.

- CEWanCOS
2. u AccessList]
3. - AccessList
Rowe per page:| 10 d| N]C]Gntnpage'l 1 nof1 Pages (Ba) [ (=1
@
Create Template | | Create Data File | | Edit | ‘ Delete | 8
I}
Figure 6-29 Choose Existing Data File > Delete
Templates
E1E3D1 A-Charneization Template: 10K-CHOC12-5TS1-PATH
[5] 10K-CHOC12-ETS1-PATH . )
@ 10K-GT3-CHANNELIZED Shovwy ata Files matching I Show
E 10K-CT3-UNCHANNELIZED e
{2] PAMC-E3-CHANNELIZED
B ramcs-auzcrace] IR B
[ PAMG-STMI-AU4-GHANNELIZ 1. [T sRDaa Miews
(2] P&-MG-T3-CHANNELIZED
E L Examples Rowe per page:l 10 x| 1 Gota page:l 1 ot1Pages (63 [ [0
EH( Joos =
| Create Template | | Create Data File ‘ | Edit | | Dedete | 8
[}

Step4  Check the check box for the template or data file you want to delete.

Note  For a data file, there is a Configlet column in which you can click View to view the configuration file.

Step5  Click Delete.

Step6  You receive an updated window as shown in Figure 6-28, “Choose Existing Template > Delete” or

Figure 6-29, “Choose Existing Data File > Delete” with the deleted template or data file no longer
available.

Template Examples

In the left column, the hierarchy pane, of Service Design > Templates, as shown in Figure 6-2,
“Templates,” template examples appear. See Table 6-1, “Template Examples and Their Descriptions.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table 6-1 Template Examples and Their Descriptions

Templates W

Folder

Template

Description

DIA-Channelization

10K-CHOC12-STS1-PATH

Sample template to break down
channelized OC12 to STS-1 paths.

10K-CT3-CHANNELIZED

Sample template creates T1 out of
channelized T3 line card.

10K-CT3-UNCHANNELIZED

Sample template Creates either a
fullrate T3 or a subrate T3 interface out
of a channelized T3.

PA-MC-E3-CHANNELIZED

Sample template Creates E1 (channel
groups) out of E3.

PA-MC-STM1-AU3-CHANNELIZE

Sample template Creates E1 (channel
groups) out of TUG-2. This template
uses AU-3 AUG mapping that further
creates TUG-2s.

PA-MC-STM1-AU4-CHANNELIZE

Sample template Creates E1 (channel
groups) out of TUG-2. This template
uses AU-4 AUG mapping that creates
TUG-3s and TUG-2s.

PA-MC-T3-CHANNELIZED

Sample template Creates T1 (channel
groups) out of T3.

Examples

AccessList

Demonstrates templates with nested
repeat loop and multi-dimension
variable.

AccessListl

Demonstrates the simplest template
variable substitution.

CEWanCOS

Demonstrates if-else statements,
repeat statements, mathematical
expressions, and one-dimensional
variables.

QoS/L2/ATM

CLP_Egress

Sample template to demonstrate the
setting of qos_group and ATM Cell
Loss Priority at the output of an
interface.

CLP_Ingress

Sample template sets MPLS
experimental bit of the ATM Cell,
marked with Cell Loss Priority, at the
input of an interface.

QoS/L2/Ethernet

3400_Egress

QoS/L2/FrameRelay

classification

Sample template to demonstrate the
bandwidth reservation based on
FrameRelay DLCI value.

[ oL-10727-01
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Summary of Repository Variables

This section contains the following tables:

e Table 6-2 on page 6-24, “L2VPN Repository Variables”
e Table 6-3 on page 6-27, “MPLS Repository Variables”
e Table 6-4 on page 6-34, “QoS Repository Variables”

e Table 6-5 on page 6-36, “VPLS Repository Variables”

Table 6-2 provides a summary of the L2ZVPN Repository variables available from ISC Templates.

Table 6-2 L2VPN Repository Variables

Repository Variable Dimension |Description

AC_Loopback_Address 0 PE loopback address also known as the router
ID

CE_DLCI 0 DLCI value on CE for Frame Relay
encapsulation

CE_Encap 0 Encapsulation of the CE interface

CE_Intf_Desc 0 Interface description for the CE interface

CE_Intf_Main_Name 0 Major interface name for the CE interface

CE_Intf _Shutdown 0 Shutdown flag for the CE interface

CE_VCD 0 VCD value on CE for ATM encapsulation

CE_VCI 0 VCI value on CE for ATM encapsulation

CE_Vlan_ID 0 VLAN ID on CE for Ethernet encapsulation

CE_VPI 0 VPI value on CE for ATM encapsulation

L2VPNCLECeFacingEncapsulation 0 Encapsulation of the UNI

L2VPNCLECeFacingInterfaceName 0 Name of the UNI

L2VPNCLEPeFacingEncapsulation 0 Encapsulation of the NNI (should always be
dotlq)

L2VPNCLEPeFacingInterfaceName 1 Name of the NNI (uplinks) (the number can
be more than 1 in case of a ring topology,
hence any array)

L2VPNDFBIT_SET 0 Indicates not to fragment the bit set (for
L2TPv3 only)

L2VPNDynamicModeUseDefaults 0 Dynamic session setup using ISC default
values (for L2TPv3 only)

L2VPN_intf_main_name 1 The main interface name for a CE or PE port

L2VPNIP_PMTU 0 Enable the discovery of the path MTU for
tunneled traffic (for L2TPv3 only)

L2VPNIP_TOS 0 Configure the value of the TOS byte in IP
headers of tunneled packets or reflects the
TOS byte value from the inner IP header (for
L2TPv3 only)

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Table 6-2 L2VPN Repository Variables (continued)
Repository Variable Dimension |Description
L2VPNIP_TTL 0 Configure the value of the time to live byte in
the IP headers (for L2TPv3 only)
L2VPNL2TP_CLASS_NAME 0 The L2TP class name to overwrite the default
L2TP class name (for L2TPv3 only)
L2VPNL2TPv3Sequence 0 Specifies the direction in which sequencing of

data packets in a pseudo wire is enabled (for
L2TPv3 only)

L2VPNLocalCookieHighValue 0 Specifies the last 4 bytes of the value that the
peer PE must include in the cookie field of
incoming L2TP packets (for L2ZTPv3 only)

L2VPNLocalCookieLow Value 0 Specifies the first 4 bytes of the value that the
peer PE must include in the cookie field of
incoming L2TP packets (for L2ZTPv3 only)

L2VPNLocalCookieSize 0 Specifies the size (0, 4, or 8) of the cookie
field of incoming L2TP packets (for L2TPv3
only)

L2VPNLocalLoopBack 1 The head of the L2TPv3 tunnel

L2VPNLocalSessionld 0 Specifies the ID for the local L2TPv3 session
(for L2TPv3 only)

L2VPNLocalSwitchLoopBackl1 1 The loopback] for the local switch (for
L2TPv3 only)

L2VPNLocalSwitchLoopBack?2 1 The loopback? for the local switch (for
L2TPv3 only)

L2VPNRemoteCookieHighValue 1 Specifies the last 4 bytes of the value that this

PE must include in the cookie field of
incoming L2RP packets (for L2TPv3 only)

L2VPNRemoteCookieLow Value 1 Specifies the first 4 bytes of the value that this
PE must include in the cookie field of
incoming L2RP packets (for L2TPv3 only)

L2VPNRemoteCookieSize 1 Specifies the size (0, 4, or 8) of the cookie
field of outgoing L2TP packets (for L2TPv3
only)

L2VPNRemoteLoopback 0 The tail of the L2TPv3 tunnel

L2VPNRemoteSessionID 1 Specifies the ID for the remote L2TPv3
session (for L2TPv3 only)

L2VPNSessionSetupMode 0 Defines how the L2TPv3 session is set up
(static or dynamic) (for L2TPv3 only)

L2VPNTransportMode 0 Defines how the L2TPv3 data is transferred

(for Frame Relay: DLCI or Port; for ATM: VP
or VC) (for L2TPv3 only)

L2VPNUniMajorInerfaceName 0 The main interface name of the UNI
L2VPNVcld 0 The virtual circuit ID of the L2TPv3 or AToM
tunnel

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table 6-2 L2VPN Repository Variables (continued)

Repository Variable Dimension |Description

PE_DLCI 0 DLCI value on PE for Frame Relay
encapsulation

PE_Encap 0 Encapsulation of the PE interface

PE_Intf Desc 0 Interface description for the PE interface

PE_Intf Main_Name 0 Major interface name for the PE interface

PE_VCD 0 VCD value on PE for ATM encapsulation

PE_VCI 0 VCI value on PE for ATM encapsulation

PE_Vlan_ID 0 VLAN ID on PE for Ethernet encapsulation

PE_VPI 0 VPI value on PE for ATM encapsulation

PseudoWire_Class_Type_Of_Core 0 Core type of the Service Provider over which
L2VPN is provisioned

Uni_Aging 0 Length of time the MAC address can stay on
the port security table

Uni_Cdp_Enable 0 Flag to enable or disable layer 2 tunnelling on
a Cisco Discover Protocol (CDP)

Uni_Cdp_Threshold 0 Number of packets per second to be received
before the interface is shut down for the CDP
protocol

Uni_Mac_Address 0 Number of MAC addresses allowed for port
security

Uni_Port_Security 0 Flag to enable or disable security on a UNI
interface

Uni_Protocol_Tunnelling 0 Flag to enable or disable Layer 2 Bridge
Protocol Data Unit (BPDU) protocol
tunnelling on a UNI interface

Uni_Recovery_Interval 0 Amount of time to wait before recovering a
UNI port

Uni_Shutdown 0 Flag indicating whether the User Network
Interface (UNTI) is shutdown

Uni_Speed Value of the UNTI link speed

Uni_Stp_Enable Flag to enable or disable layer 2 tunnelling on
a Spanning Tree Protocol (STP)

Uni_Stp_Threshold 0 Flag to enable or disable layer 2 tunnelling on
an STP

Uni_Violation_Access 0 Action taken when a port security violation is
detected

Uni_Vtp_Enable 0 Flag to enable or disable layer 2 tunnelling on
a VLAN Trunk Protocol (VTP)

Uni_Vtp_Threshold 0 Flag to enable or disable layer 2 tunnelling on

a VTP

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Table 6-3 provides a summary of the MPLS Repository variables available from ISC Templates.

Table 6-3

MPLS Repository Variables

Repository Variable

Dimension

Description

Advertised_Routes_To_CE

2

List of one or more IP addresses of the
advertised static route to be placed on the PE
to define the CE’s address space

CE_BGP_AS_ID

BGP AS ID on a CE when the routing
protocol between a CE and a PE is BGP

CE_DLCI

DLCI value on CE for Frame Relay
encapsulation

CE_EIGRP_AS_ID

EIGRP AS ID on a CE when the routing
protocol between a CE and a PE is EIGRP

CE_Facing MVRFCE_BGP_AS_ID

BGP AS ID on an MVRFCE when the routing
protocol between a CE and an MVRFCE is
BGP, when an MPLS link includes an
MVRFCE

CE_Facing. MVRFCE_DLCI

DLCI value on CE facing MVRFCE interface
for Frame Relay encapsulation, when an
MPLS link includes an MVRFCE

CE_Facing. MVRFCE_EIGRP_AS_ID

EIGRP AS ID on an MVRFCE when the
routing protocol between a CE and an
MVRECE is EIGRP, when an MPLS link
includes an MVRFCE

CE_Facing. MVRFCE_Intf

Name of the CE facing interface on an
MVRFCE, when an MPLS link includes an
MVRFCE

CE_Facing. MVRFCE_Intf_Address

IP address assigned to the CE facing
MVRECE interface, when an MPLS link
includes an MVRFCE

CE_Facing. MVRFCE_Intf_Encap

Encapsulation for CE facing of an MVRFCE
interface, when an MPLS link includes an
MVRFCE

CE_Facing_ MVRFCE_Intf_Name

Name of the CE facing MVRFCE interface,
when an MPLS link includes an MVRFCE

CE_Facing MVRFCE_Intf_Type

Interface type for CE facing of an MVRFCE
interface, when an MPLS link includes an
MVRFCE

CE_Facing_ MVRFCE_Ospf_Process_ID

OSPF process ID on MVRFCE when the
routing protocol between a CE and an
MVRCE is OSPF, when an MPLS link
includes an MVRFCE

CE_Facing_ MVRFCE_Tunnel_Src_
Addr

Tunnel source address on CE facing
MVREFCE interface for GRE encapsulation
when an MPLS link includes an MVRFCE

[ oL-10727-01
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Table 6-3 MPLS Repository Variables (continued)
Repository Variable Dimension |Description
CE_Facing. MVRFCE_VCD 0 VCD value on CE facing MVRFCE interface

for ATM encapsulation, when an MPLS link
includes an MVRFCE

CE_Facing. MVRFCE_VCI 0 VCI value on CE facing MVRFCE interface
for ATM encapsulation, when an MPLS link
includes an MVRFCE

CE_Facing. MVRFCE_VLAN_ID 0 VLAN ID on CE facing MVRFCE interface
for Ethernet encapsulation, when an MPLS
link includes an MVRFCE

CE_Facing. MVRFCE_VPI 0 VPI value on CE facing MVRFCE interface
for ATM encapsulation, when an MPLS link
includes an MVRFCE

CE_Intf_Address 0 IP address assigned to the CE interface

CE_Intf_Encap 0 Encapsulation of the CE interface

CE_Intf Name 0 Name of the CE interface

CE_MVRFCE_Bandwidth_Metric_For_ 0 Bandwidth metric for redistribution of EIGRP

Redistribution when the routing protocol between a CE and
an MVRFCE is EIGRP, when an MPLS link
includes an MVRFC

CE_MVRFCE_BGP_AS_ID 0 BGP AS ID on a CE when the routing
protocol between a CE and an MVRFCE is
BGP, when an MPLS link includes an
MVRFCE

CE_MVRFCE_Delay_Metric_For_ 0 Delay metric for redistribution of EIGRP

Redistribution when the routing protocol between a CE and
an MVRFCE is EIGRP, when an MPLS link
includes an MVRFC

CE_MVRFCE_EIGRP_AS_ID 0 EIGRP AS ID on a CE when the routing
protocol between a CE and an MVRFCE is
EIGRP, when an MPLS link includes an
MVRFCE

CE_MVRFCE_Loading_Metric_For_ 0 Loading metric for redistribution of EIGRP

Redistribution when the routing protocol between a CE and
an MVRFCE is EIGRP, when an MPLS link
includes an MVRFC

CE_MVRFCE_MTU_Metric_For_ 0 MTU metric for redistribution of EIGRP

Redistribution when the routing protocol between a CE and
an MVRFCE is EIGRP, when an MPLS link
includes an MVRFC

CE_MVRFCE_Ospf_Process_ID 0 OSPF process ID on CE when the routing

protocol between a CE and an MVRCE is
OSPF, when an MPLS link includes an
MVRFCE

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Table 6-3 MPLS Repository Variables (continued)

Repository Variable Dimension |Description

CE_Ospf_Process_ID 0 OSPF process ID on CE when the routing
protocol between a CE and a PE is OSPF

CE_Tunnel_Src_Addr 0 Tunnel source address on CE for GRE
encapsulation

CE_VCD 0 VCD value on CE for ATM encapsulation

CE_VCI 0 VCI value on CE for ATM encapsulation

CE_Vlan_ID 0 VLAN ID on CE for Ethernet encapsulation

CE_VPI 0 VPI value on CE for ATM encapsulation

Export_Map 0 Name of the export map associated with the
VRF

Extra_CE_Loopback_Required 0 Flag to indicate whether an extra loopback
request is required on the CE

Import_Map 0 Name of the import map associated with the
VRF

Is_Default_Info_Originate 0 Flag to indicate whether the
default-information originate command for
BGP on the PE when STATIC is a running
protocol between a CE and a PE

Is_Default_Routes_Sent_To CE 0 Flag to indicate whether the default routes are
sent to a remote CE

Join_Grey_Mgmt_Vpn 0 Flag to indicate whether MPLS will join a
Grey Management VPN

Max_route_threshold 0 Percentage of the maximum number of routes
that can be imported into the VRF

Max_Routes 0 Maximum number of routes than can be
imported into the VRF

MPLSExportRouteTargets 1 List of Route Targets that are exported for a
particular VRF associated with the MPLS
VPN link

MPLSImportRouteTargets 1 List of Route Targets that are imported for a
particular VRF associated with the MPLS
VPN link

MPLSCLEPeFacingInterfaceName 0 The name of the interface on the device facing
the PE for that particular MPLS VPN link

MPLSCLEPeFacingEncapsulation 0 The encapsulation of the interface on the
device facing the PE for that particular MPLS
VPN link

MPLSCLECeFacingInterfaceName 0 The name of the interface on the device facing
the CE for that particular MPLS VPN link

MPLSCLECeFacingEncapsulation 0 The encapsulation of the interface on the

device facing the CE for that particular MPLS
VPN link

[ oL-10727-01
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Table 6-3 MPLS Repository Variables (continued)
Repository Variable Dimension |Description
MPLSCelnterfaceMask 0 The mask of the IP address assigned to the CE
interface for a particular MPLS VPN link
MPLSPelnterfaceMask 0 The mask of the IP address assigned to the PE
interface for a particular MPLS VPN link
MPLSCeLoopbackAddress 0 The IP address of the extra CE loopback
address for a particular MPLS VPN link
MVRFCE_CE_Advertised_Routes_To_ 2 List of one or more IP addresses of the
CE advertised static route to be placed on the PE
to define the CE’s address space, when the
MPLS link includes an MVRFCE
MVRFCE_CE_IP_Unnumbered 0 Flag to indicate whether the MVRCE to CE
link is unnumbered, when an MPLS link
includes an MVRFCE
MVRFCE_CE_Is_Default_routes_Sent_ 0 Flag to indicate whether the default routes are
To_CE sent to a remote CE, when an MPLS link
includes an MVRFCE
MVRFCE_CE_NBR_ALLOW_AS_IN 0 AllowASIn flag when the routing protocol
between a CE and an MVRFCE is BGP, when
an MPLS link includes an MVRFCE
MVRFCE_CE_NBR_AS_OVERRIDE 0 ASOpverride flag when the routing protocol
between a CE and an MVRFCE is BGP, when
an MPLS link includes an MVRFCE
MVRFCE_CE_Ospf_Area_Number 0 OSPF area number when the routing protocol
between a CE and an MVRCE is OSPF, when
an MPLS link includes an MVRFCE
MVRFCE_CE_Routes_To_Reach_ 2 List of one or more IP addresses to specify the
Other_Sites static routes to put on the CE, when the MPLS
link includes an MVRFCE
MVRFCE_CE_Routing_Protocol Routing protocol between MVRFCE and CE
PE_BGP_AS_ID BGP AS ID on a PE when the routing protocol
between a CE and a PE is BGP
PE_Cable_Both_Helper_Address_List 1 List of DHCP server IP addresses to which
both cable modem and host UDP broadcasts
are forwarded
PE_Cable_Modem_Helper_Address_list 1 List of DHCP server IP addresses to which
cable modem UDP broadcasts are forwarded
PE_Cable_Modem_Host_Helper_ 1 List of DHCP server IP addresses to which
Address_List host UDP broadcasts are forwarded
PE_Cable_Modem_Secondary_Address_ 1 List of cable modem secondary addresses for
List cable interfaces
PE_CE_Bandwidth_Metric_For_ 0 Bandwidth metric for redistribution of EIGRP
Redistribution when the routing protocol between a CE and a
PE is EIGRP
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Table 6-3 MPLS Repository Variables (continued)

Repository Variable Dimension |Description

PE_CE_Delay_Metric_For_ 0 Delay metric for redistribution of EIGRP

Redistribution when the routing protocol between a CE and a
PE is EIGRP

PE_CE_IP_Unnumbered 0 Flag to indicate whether the PE to CE link is
unnumbered

PE_CE_Loading_Metric_For_ 0 Loading metric for redistribution of EIGRP

Redistribution when the routing protocol between a CE and a
PE is EIGRP

PE_CE_MTU_Metric_For_ 0 MTU metric for redistribution of EIGRP

Redistribution when the routing protocol between a CE and a
PE is EIGRP

PE_CE_NBR_Allow_AS_In 0 AllowASIn flag when the routing protocol
between a CE and a PE is BGP

PE_CE_NBR_AS_Override 0 ASOverride flag when the routing protocol
between a CE and a PE is BGP

PE_CE_Ospf_Area_Number 0 OSPF area number when the routing protocol
between a CE and a PE is OSPF

PE_CE_Reliability_Metric_For_ 0 Reliability metric for redistribution of EIGRP

Redistribution when the routing protocol between a CE and a
PE is EIGRP

PE_CE_Routing_Protocol Routing protocol between PE and CE

PE_DLCI DLCI value on PE for Frame Relay
encapsulation

PE_EIGRP_AS_ID 0 EIGRP AS ID on a PE when the routing
protocol between a CE and a PE is EIGRP

PE_Facing. MVRFCE_BGP_AS_ID 0 BGP AS ID on an MVRFCE when the routing
protocol between a PE and an MVRFCE is
BGP, when an MPLS link includes an
MVRFCE

PE_Facing. MVRFCE_DLCI 0 DLCI value on PE facing MVRFCE interface
for Frame Relay encapsulation, when an
MPLS link includes an MVRFCE

PE_Facing. MVRFCE_EIGRP_AS_ID 0 EIGRP AS ID on an MVRFCE when the
routing protocol between a PE and an
MVRECE is EIGRP, when an MPLS link
includes an MVRFCE

PE_Facing. MVRFCE_Intf 0 Name of the PE facing interface on an
MVRFCE, when an MPLS link includes an
MVRFCE

PE_Facing MVRFCE_Intf_Address 0 IP address assigned to the PE facing

MVRECE interface, when an MPLS link
includes an MVRFCE

[ oL-10727-01
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Table 6-3 MPLS Repository Variables (continued)

Repository Variable Dimension |Description

PE_Facing. MVRFCE_Intf_Encap 0 Encapsulation for PE facing of an MVRFCE
interface, when an MPLS link includes an
MVRFCE

PE_Facing. MVRFCE_Intf_Name 0 Name of the PE facing MVRFCE interface,
when an MPLS link includes an MVRFCE

PE_Facing_ MVRFCE_Intf_Type 0 Interface type for PE facing of an MVRFCE
interface, when an MPLS link includes an
MVRFCE

PE_FACING_MVRFCE_OSPF_ 0 OSPF process ID on an MVRFCE when the

Process_ID routing protocol between a PE and an

MVRCE is OSPF, when an MPLS link
includes an MVRFCE

PE_Facing. MVRFCE_Tunnel_Src_Addr 0 Tunnel source address on PE facing MVRFCE
interface for GRE encapsulation when an
MPLS link includes an MVRFCE

PE_Facing MVRFCE_VCD 0 VCD value on PE facing MVRFCE interface
for ATM encapsulation, when an MPLS link
includes an MVRFCE

PE_Facing. MVRFCE_VCI 0 VCI value on PE facing MVRFCE interface
for ATM encapsulation, when an MPLS link
includes an MVRFCE

PE_Facing MVRFCE_VLAN_ID 0 VLAN ID on PE facing MVRFCE interface
for Ethernet encapsulation, when an MPLS
link includes an MVRFCE

PE_Facing. MVRFCE_VPI 0 VPI value on PE facing MVRFCE interface
for ATM encapsulation, when an MPLS link
includes an MVRFCE

PE_Intf Address 0 IP address assigned to the PE interface
PE_Intf Desc 0 Interface description for the PE interface
PE_Intf_Encap 0 Encapsulation of the PE interface

PE_Intf Name 0 Name of the PE interface

PE_Intf Shutdown 0 Shutdown flag for the PE interface
PE_IS_Cable_Modem_Maintenance_ 0 Flag to indicate whether the interface is a
Interface maintenance interface
PE_MVRFCE_Bandwidth_Metric_For_ 0 Bandwidth metric for redistribution of EIGRP
Redistribution when the routing protocol between a PE and

an MVRFCE is EIGRP, when an MPLS link
includes an MVRFCE

PE_MVRFCE_BGP_AS_ID 0 BGP AS ID on a PE when the routing protocol
between a PE and an MVRFCE is BGP, when
an MPLS link includes an MVRFCE
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Table 6-3 MPLS Repository Variables (continued)
Repository Variable Dimension |Description
PE_MVRFCE_Delay_Metric_For_ 0 Delay metric for redistribution of EIGRP
Redistribution when the routing protocol between a PE and
an MVRFCE is EIGRP, when an MPLS link
includes an MVRFCE
PE_MVRFCE_EIGRP_AS_ID 0 EIGRP AS ID on a PE when the routing
protocol between a PE and an MVRFCE is
EIGRP, when an MPLS link includes an
MVRFCE
PE_MVRFCE_IP_Unnumbered 1 Flag to indicate whether the PE to MVRFCE
link is unnumbered, when an MPLS link
includes an MVRFCE
PE_MVRFCE_Loading_Metric_For_ 0 Loading metric for redistribution of EIGRP
Redistribution when the routing protocol between a PE and
an MVRFCE is EIGRP, when an MPLS link
includes an MVRFCE
PE_MVRFCE_MTU_Metric_for_ 0 MTU metric for redistribution of EIGRP
redistribution when the routing protocol between a PE and
an MVRFCE is EIGRP, when an MPLS link
includes an MVRFCE
PE_MVRFCE_NBR_ALLOW_AS_IN 0 AllowASIn flag when the routing protocol
between a PE and an MVRFCE is BGP, when
an MPLS link includes an MVRFCE
PE_MVRFCE_NBR_AS_OVERRIDE 0 ASOverride flag when the routing protocol
between a PE and an MVRFCE is BGP, when
an MPLS link includes an MVRFCE
PE_MVRFCE_Ospf_Area_Number 0 OSPF area number when the routing protocol
between a PE and an MVRCE is OSPF, when
an MPLS link includes an MVRFCE
PE_MVRFCE_OSPF_Process_ID 0 OSPF process ID on PE when the routing
protocol between a PE and an MVRCE is
OSPEF, when an MPLS link includes an
MVRFCE
PE_MVRFCE_Reliability_Metric_For_ 0 Reliability metric for redistribution of EIGRP
Redistribution when the routing protocol between a PE and
an MVRFCE is EIGRP, when an MPLS link
includes an MVRFCE
PE_MVRFCE_Routing_Protocol 0 Routing protocol between PE and MVRFCE,
when an MPLS link includes an MVRFCE
PE_OSPF_PROCESS_ID 0 OSPF process ID on PE when the routing
protocol between a CE and a PE is OSPF
PE_Tunnel_Src_Addr 0 Tunnel source address on PE for GRE

encapsulation

PE_VCD

VCD value on PE for ATM encapsulation

PE_VC(CI

VCI value on PE for ATM encapsulation

[ oL-10727-01
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Table 6-3 MPLS Repository Variables (continued)

Repository Variable Dimension |Description

PE_Vlan_ID 0 VLAN ID on PE for Ethernet encapsulation

PE_VPI 0 VPI value on PE for ATM encapsulation

rd 0 Route Distinguisher value for the VRF

Redistribute_Connected 0 Flag to indicate whether the connected routes
are redistributed into BGP on the PE

Redistribute_Static 0 Flag to indicate whether the static routes are
redistributed into BGP on the PE

Redistributed_Protocol 1 List of routing protocols to be redistributed

Rip_Metrics 0 Metric for redistribution associated with RIP

Routes_To_Reach_Other_Sites List of one or more IP addresses to specify the
static routes to put on the CE.

vrfName 0 Name of the VRF

Table 6-4 provides a summary of the QoS Repository variables available from ISC Templates.

Table 6-4 QoS Repository Variables
Repository Variable Dimension |Description Example
QoS_Customer 0 Name of the customer ABC

QoS_Policy 0 Name of the QoS policy |Gold
QoS_Supported_MPLS 0 Boolean flag to indicate |true

whether MPLS is false

supported in the core.

The value is either true

or false.
QoS_PE_Remarking_ReRateLimiting 0 Boolean flag to indicate |true

whether re-marking and |false

re-rate-limiting is

required on PE. The

value is either true or

false.
QoS_CE_Marking_RateLimiting_ 1 List of marking and serial0
Interfaces rate-limiting interfaces |seriall

on CE ethernetl
QoS_CE_Marking_RateLimiting_ 1 List of interface HDLC

Interface_Encap

encapsulation types of HDLC
the marking and
rate-limiting interfaces  |ethernet
on CE (same order as
QoS_CE_Marking_Rate
Limiting_Interfaces)
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Table 6-4 QoS Repository Variables (continued)
Repository Variable Dimension |Description Example
QoS_PECLE_Marking_RateLimiting_ 0 Name of the marking and |ethernetl
Interface rate-limiting interface on

PECLE (for Ethernet

QoS)
QoS_PECLE_Marking_RateLimiting_ 0 Interface encapsulation |ethernet
Interface_Encap type of the marking and

rate-limiting interface on

PECLE (for Ethernet

QoS)
QoS_Link_Bandwidth 0 Bandwidth of the CE and [128000

PE link (bps)
QoS_LinkEndpoint_Role 0 Role of the link endpoint |CPE_Endpt

(that is, CPE or PE) PE_Endpt
QoS_LinkEndpoint_Hostname 0 Hostname of the link enpel

endpoint
QoS_LinkEndpoint_Platform 0 Platform type of the link |7206

endpoint
QoS_LinkEndpoint_Linecard_Model 0 Line-card model of the 8OCO03_ATM_TS-

link endpoint IR-B
QoS_LinkEndpoint_Interface 0 Interface name of the FastEthernet8/10.7

link endpoint 00
QoS_LinkEndpoint_Interface_Encap 0 Interface encapsulation |DOT1Q

type of the link endpoint

interface
QoS_LinkEndpoint_Type 0 Enumerator to indicate = |FRAME_RELAY

the type of the link

endpoint (“Interface”,

“ATM”, or

“FRAME_RELAY”)
QoS_LinkEndpoint_FR_Dlci 0 Frame-Relay DLCI 102

number of the link

endpoint
QoS_LinkEndpoint_ ATM_VPI 0 VPI value of the ATM 110

VC of the link endpoint
QoS_LinkEndpoint_ ATM_VCI 0 VCI value of the ATM 256

VC of the link endpoint
QoS_LinkEndpoint_ ATM_VCD 0 VCD value of the ATM |Atml

VC of the link endpoint
QoS_LinkEndpoint_ATM_PA_Model 0 The ATM port adaptor PA-A1-OC3MM

model of the link
endpoint

[ oL-10727-01
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Table 6-4

QoS Repository Variables (continued)

Repository Variable

Dimension

Description Example

QoS_Link UPE_UNI_VLAN_ID

The service’s VLAN ID 800
on the UNI port of the
device that is acting as a
U_PE (Ethernet QoS
only)

QoS_Link_UPE_NNI_VLAN_ID

The service’s VLAN ID {800
on the NNI port of the
device that is acting as a
U_PE (Ethernet QoS
only)

QoS_Link_NPE_NNI_VLAN_ID

The service’s VLAN ID 800
on the NNI port of the
device that is acting as an
N_PE (Ethernet QoS
only)

Table 6-5 provides a summary of the VPLS Repository variables available from ISC Templates.

Table 6-5 VPLS Repository Variables

Repository Variables Dimension |Description

VPLSCeEncapsulation 0 The encapsulation of the CE interface for a
particular VPLS link

VPLSCelnterfaceName 0 The name of the CE interface for a particular
VPLS link

VPLSCeMajorInterfaceName 0 The name of a major interface on a CE for a
particular VPLS link

VPLSCLECeFacingEncapsulation 0 The encapsulation of interfaces for a
particular device facing the CE

VPLSCLECeFacingInterfaceName 0 The interface name for a particular device
facing the CE (the number can be more than 1
in case of a ring topology, hence any array)

VPLSCLEPeFacingEncapsulation 0 The encapsulation of interfaces for a
particular device facing the PE

VPLSCLEPeFacingInterfaceName 1 The list of interface names for a particular
device facing the PE (the number can be more
than 1 in case of a ring topology, hence any
array)

VPLSDisableCDP 0 The flag to specify if the CDP has been
disabled on a UNI for a particular VPLS link

VPLSFilterBPDU 0 The flag to specify whether the BPDUs will
be filtered on a UNI for a particular VPLS link

VPLSPeEncapsulation 0 The encapsulation of the PE interface for a

particular VPLS link
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Table 6-5 VPLS Repository Variables (continued)

Repository Variables Dimension |Description

VPLSPelnterfaceDescription 0 The description assigned to the PE interface
for a particular VPLS link

VPLSPelnterfaceName 0 The name of the PE interface for a particular
VPLS link

VPLSPeMajorInterfaceName 0 The name of a major interface on a PE for a
particular VPLS link

VPLSPeNeighbors 1 The list of PE POPs participating in a
particular VPLS VPN

VPLSPeVfiName 0 The VFI name assigned to a particular VPLS
instance existing on the PE POP

VPLSPeVlanld 0 The VLAN ID assigned to the PE for a
particular VPLS link

VPLSPeVpnld 0 The VPN ID assigned to a particular VPLS
VPN

VPLSSystemMTU 0 The maximum MTU value for a packet
arriving on a UNI for a particular VPLS link

VPLSTunnelCDPEnable 0 The flag to specify if the CDP packets will be
tunneled to the remote site for a particular
VPLS link

VPLSTunnelCDPThreshold 0 The threshold value assigned for a CDP
protocol before a violation action is reported
on a UNI for a particular VPLS link

VPLSTunnelRecoverylInterval 0 Interval for the UNI to recover from a
shutdown scenario

VPLSTunnelSTPEnable 0 The flag to specify if the STP packets will be
tunneled to the remote site for a particular
VPLS link

VPLSTunnelSTPThreshold 0 The threshold value assigned for a STP
protocol before a violation action is reported
on a UNI for a particular VPLS link

VPLSTunnelVTPEnable 0 The flag to specify if the VTP packets will be
tunneled to the remote site for a particular
VPLS link

VPLSTunnelVTPThreshold 0 The threshold value assigned for a VTP
protocol before a violation action is reported
on a UNI for a particular VPLS link

VPLSUniAging 0 The aging timer set on a UNI for a particular
VPLS link

VPLSUniDuplex 0 The duplex assigned to the UNI for a
particular VPLS link

VPLSUniMajorInterfaceName 0 The name of a major interface on a UNI

device for a particular VPLS link

[ oL-10727-01
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Table 6-5 VPLS Repository Variables (continued)

Repository Variables Dimension |Description

VPLSUniMaxMacAddress 0 The maximum number of Mac addresses that
can be learned on a UNI for a particular VPLS
link

VPLSUniPortSecurity 0 The port security option on a UNI for a
particular VPLS link

VPLSUniProtocolTunneling 0 The flag to specify if the protocols will be
tunneled to the remote site for a particular
VPLS link

VPLSUniSecureMacAddresses 1 The explicit list of Mac addresses that can be
learned on a UNI for a particular VPLS link

VPLSUniShutdown 0 The shutdown flag on a UNI for a particular
VPLS link

VPLSUniSpeed 0 The speed assigned to the UNI for a particular
VPLS link

VPLSUniViolationAction 0 The violation action option on a UNI for a
particular VPLS link

VPLSUseNativeVlan 0 The flag to specify if the native VLAN will be
used on a UNI for a particular VPLS link

Importing and Exporting Templates

The importExportTemplateDB tool is available to import and export templates into and from an ISC
database. You can import or export the complete or partial template database by specifying appropriate
arguments. You can find this tool at: $ISC_HOME/bin/importExportTemplateDB.sh.

Enter the following:

importExportTemplateDB.sh <admin_user_id> <password> [<other_arguments>]
where:

<admin_user_id> is user identifier for someone with the admin role.

<password> is the password for the one with the admin role.

<other_arguments> is any combination of the following arguments separated by a space:

-nooverwrite

If you choose to use this nooverwrite argument, to prevent the overwriting of existing templates in the
database, it must precede all other arguments and must be in the third position after <admin_user_id>
and <password>.

~

Note  The default (when nooverwrite is not specified) is to overwrite the templates.

-exp_db <dest-dir>
Use this argument to export all templates and datafiles in the database, where <dest-dir> is the
destination directory to which you want to export.

Cisco IP Solution Center Infrastructure Reference, 4.2
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-imp_db <src-dir>
Use this argument to import all the files in <src-dir> into the database, where <src-dir> is the source
directory from which you want to import. The files in <src-dir> are created by the exp_db process.

-exp_template_folder <src-folder-path> <dest-dir>

Use this argument to export a database template folder and its subfolders, where <src-folder-path> is
the full path of the template folder to export and <dest-dir> is the directory where to place the exported
files.

-imp_template_folder <src-dir> <dest-folder>
Use this argument to import all files in <src-dir> into the database, where <src-dir> is the source
directory to import, and <dest-folder> is the destination import template folder.

-imp_template <srcfile> <dest-folder> <template-name>

Use this argument to import a template into the database, where <srcfile> is the full path of the template
to import, <dest-folder> is the full path of the parent folder, and <template-name> is the template name
in the database.

-imp_datafile <srcfile> <dest-template> <datafile-name>

Use this argument to import a template datafile into the database, where <srcfile> is the full path of the
datafile to import, <dest-template> is the full path of the parent template, and <datafile-name> is the
datafile name in the database.

-exp_template <template-pathname> <output-file>
Use this argument to export the database template to a file, where <template-pathname> is the full path
of the template to export, and <output-file> is the output filename.

-exp_datafile <datafile-pathname> <output-file>
Use this argument to export a template datafile to a file, where <datafile-pathname> is the full path of
the template datafile to export, and <output-file> is the output filename.

The Link QoS feature provides separate settings for IP QoS and Ethernet QoS.

IP QoS deals with link-level QoS settings that depend on Layer2 encapsulation and link bandwidth, such
as Aggregate Shapers (FRTS; ATM Shapers, parent-level cb-shaper), Link Efficiency Mechanisms
(FRF.12, LFIoMLPPP, and cRTP), and Interface-based Aggregated Rate Limiter.

Ethernet QoS allows you to configure Shape, Bandwidth, and Trust (CoS or DSCP) settings.

You can create a link QoS setting for a network independent of a VPN service. To manage
IP Link QoS Settings for an MPLS service or Ethernet Link QoS Settings for an L2VPN service, see
the Cisco IP Solution Center Quality of Service User Guide, 4.2.
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Monitoring

From the Home window of Cisco IP Solution Center (ISC), which you receive upon logging in, click the
Monitoring tab and you receive a window as shown in Figure 7-1, “Monitoring Selections.”

Figure 7-1 Monitoring Selections

Cisco SvsTems

Home | Shortouts | Accourt | Index | Help | 2hout | Logout |
IP Solution Center

|' | Monitoring | f

& + TE Performance Report ¢ Reports +

Uszer. admin

+ Task Manager + Fing

“ou &re Here: + Moritoring

Customer: Mone
Monitoring

Tools to manage task s, ping parameters, and generate Service Level Agreement (SLA) probes and reports.

ey Task Manager
:5 Create and schedule task s and montor task run details.

sia | SLA
E:I Manage probes and view reports.

TE - TE Performance Report
EI TE Performance Report..

—=1 Reports
El Create and scheduls reparts.

129069

Next you can choose the following selections:

¢ Task Manager, page 7-1 Create and schedule tasks and monitor task run details.

Ping, page 7-8 Perform Ping connectivity tests.

SLA, page 7-11 Manage probes and view reports.

TEM Performance Report, page 7-41 TEM performance report.
¢ Reports, page 7-41 Create and schedule reports.

Task Manager

ISC provides a Task Manager that allows you to view pertinent information about both current and

expired tasks of all types, and to create and schedule new tasks, delete specified tasks, and delete the
active and expired tasks.

Cisco IP Solution Center Infrastructure Reference, 4.2
[ oL-10727-m .m



Chapter7  Monitoring |

M Task Manager

This section contains the following subsections:
e Tasks, page 7-2
e Task Logs, page 7-7

Tasks

This section contains the following topics:
e Starting Task Manager, page 7-2
e C(Create, page 7-3
e Audit, page 7-5
e Details, page 7-6
e Schedules, page 7-6
e Logs, page 7-7
e Delete, page 7-7

Starting Task Manager

To start Task Manager, follow this step:

Step1  Click the Task Manager icon. The Tasks list page appears, as shown in Figure 7-2, “Tasks.”

Figure 7-2 Tasks

Tasks

Showe Tasks \r\.ﬂhl Marme ﬂ matching Ix of Type I : ﬂ |M

Showing 1 - 3 of 3 recards

# I_ Task Hame Type Targets Schedule M= Created on
Hame
SLA enable_traps 2005-11-22 ] a4, . 2005-11-22
1. I_ 241-00.0 SLA Traps Enable Single run at 2005-11-22 21:11:000  admin 3091-52 257
SLA enable_probes . A . 2005-11-22
2. |_ 20051152 21:11-00.0 SLA Enable Single run at 2005-11-22 21:11:000  admin 3111:18.524
SLA Crestion 2005-11-22 . ] . . 2005-11-22
3. I_ 1E5%000 SLA Creagtion Single run at 2005-11-22 1853000  admin 165047 189
Rows per page: | 10 | N] ﬁ] Goto page: |1 of1 bbl
&
Auto Refresh: F | Creste | | Audit | | Details | | Schedules | | Logs | | Dzl ste | §

The Tasks window displays information about each task by Task Name, Type, Targets, Schedules date
and time, the User Name who created those tasks, and the date Created on. To view, schedule, or delete
the listed tasks, check the corresponding check box.

New Tasks can also be created or audited using this window.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Create

To create a new task, follow these steps:

Step1  From the Tasks page, as shown in Figure 7-2, “Tasks,” click Create. From the resulting drop-down list,
you can choose from the following and that choice becomes the Type in Figure 7-3, “Create Tasks,”:

¢ Collect Config - collects configuration from devices.

e Password Management - manages user passwords and SNMP community strings.
e SLA Collection - collects data from SLA enabled devices.

¢ Service Deployment - deploys an existing SR.

¢ TE Discovery - populates the repository with tunnel and route data from the Traffic Engineering
network.

¢ TE Interface Performance - calculates tunnel and interface bandwidth utilization using SNMP.

Figure 7-3 Create Tasks

Create Task

Hame |Service Deployment Z005-12-06 18:14:24 445
Type: Service Deployrnent
Description: Created on 2005-12-06 15:14:24 448
] O O 111 .
01, Create Task
oz ...
Task Configuration Method: & Simplified

¢ Advanced (vig wizard)

149191

Mote: = - Reouired Field

Step2  Name: Enter the name of the task. You can accept the default value.
Step3  Type: Defined in Step 1.
Step4  Description: (optional) Enter a description.

Step5  Task Configuration Method (default: Simplified) Choose Simplified or Advanced (via wizard). If
you choose Simplified, you can make many selections in one window. If you choose Advanced (via
wizard), you navigate through many windows to make your selections.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step6  Click Next to continue. Depending on what type of task you select, the Task Devices or Task Service
Requests page appears, as shown in Figure 7-4, “Task Devices” and Figure 7-5, “Service Deployment
Task,” respectively, with variations.

Figure 7-4 Task Devices
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Options: [« Retrieve device attributes
F Eetrieve Interfaces

Schedule: e Moy

Later

Mane

Task Ownen Customer

i i B g

Provider

)

Mane

Sub it | | Cancel
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Figure 7-5 Service Deployment Task

Service Depleyment Task
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Semvice Requeﬁsx: Select/Deselect

Options: ™ Force Deployment

F Praovision and Audit
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Schedule: o Mowy
Later

I one
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i i B i
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Mote: * - Required Field

Step7  Click Select/Deselect to add devices or service requests.

Step8  In the resulting selection window, select the devices or service requests and click Select. The selected
devices or service requests appear in Figure 7-4, “Task Devices” or Figure 7-5, “Service Deployment
Task,” respectively.

Step9  Groups might or might not appear depending on the task you specify in the previous step. If it does
appear, you can add groups of devices, similarly to Step 7 and Step 8. If it does not appear or after you
complete this device group selection, proceed to Step 10.
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Step10 Choose the Options.
Step 11 For Schedule, click Now, Later, or None. If you choose Later, a Later Schedule category appears. You
are then required to click the Edit button and the Task Scheduler page appears, as shown in Figure 7-6,
“Task Schedule Details.”
Figure 7-6 Task Schedule Details
Task Schedule
Single Run: * Moy " Once
Periodic Rur:  © minute © Hourly  © Daily O wieekly O Morthly
Periodic Run Attributes
Start Date and Time
Date: |March = | |28 =||2003 »|
Time: |4 - 49 = | [P =
End Date and Time (Default is unlimited)
Date: |Munth j |Dayj |Yearj
Time: |HDurj |Minj |AMj
Step12 Select information to schedule the task and click OK (default is to schedule Now).
Step 13  Click Submit to continue. The new task is added to the list of tasks.
Audit
To get audit information, follow these steps:
Step 1 From the Tasks page, as shown in Figure 7-2, “Tasks,” click Audit. From the resulting drop-down list,
you can choose from the following and that choice becomes the Type in Figure 7-3, “Create Tasks,”:
¢ Config Audit - compares ISC generated configlet against the one in the device.
e L2VPN (L2TPv3) Functional Audit - audits L2TPv3 functionality.
e MPLS Functional Audit - audits MPLS functionality.
¢ TE Functional Audit - checks the Label-Switch Path (LSP) on a router against the LSP stored in
the repository.
Cisco IP Solution Center Infrastructure Reference, 4.2
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Details

Step 1

Step 2
Step 3

Schedules

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6
Step 7

To get details about a particular task, follow these steps:

From the Tasks page, as shown in Figure 7-2, “Tasks,” check a check box for one task for which you
want to see a detailed list of information.

Click Details.
Click OK to return to Figure 7-2, “Tasks.”

To change the scheduling of an existing task, follow these steps:

From the Tasks page, as shown in Figure 7-2, “Tasks,” check a check box for the one task for which you
want to reset the scheduling directions.

Click Schedules.

If you want to delete this task, proceed to Step 4. If you want to reset the scheduling directions, proceed
to Step 5.

In the new window, check the check box for the task you want to delete and click the Delete button. Then
proceed to Step 7.

In the new window, click Create, and you receive a window as shown in Figure 7-7, “Task Scheduling.”

Figure 7-7 Task Scheduling

Task Schedule

Single run; & pow ¢ Ornce
Periodic Run: ¢ wirute ¢ Hourly ¢ Daily ¢ weekly ¢ Mardhly

Periodic Run Atributes
Fun Interval:
Fun Limits:

Start Date and Time
Date: | December »| |6 x| |2005 =

Time:IE ﬂ ISEjIPMj
End Date and Time (Default is unlimited)

Date: |Month x| |Day =||‘Vear =

Time: | Hour [Min =] | am =]

@
| Sawe || Cance] |;
-+

Make the new scheduling selections you want and click Save to reset the scheduling directions.

Uncheck any check boxes and click OK to return to Figure 7-2, “Tasks.'

Cisco IP Solution Center Infrastructure Reference, 4.2
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Logs

This selection from the Tasks page, as shown in Figure 7-2, “Tasks,” is another way of doing what is
explained in the “Task Logs” section on page 7-7.

Delete

To delete one or more tasks, follow these steps:

Step 1 From the Tasks page, as shown in Figure 7-2, “Tasks,” check one or more check boxes for the task(s)
you want to delete.

Step 2 You receive a confirmation window. If you want to delete, click OK. If not, click Cancel.

Step3  You return to an updated Tasks page, as shown in Figure 7-2, “Tasks.”

Task Logs

Task Logs can be used to understand the status of a task, whether it completed successfully. You can also
use the Task Logs to troubleshoot why a task has failed. To view the Task Logs, follow these steps:

Step1  Click Task Manager. The Tasks page appears, as shown in Figure 7-8, “Tasks.”

Figure 7-8 Tasks
Tasks
(SRR
n Tagks Show T asks with | Mame | matching | oiType | =l [Find |
- Logs Showing 0 of 0 records
# l_ Task Hame Type Targets Schedule I:I::e Crﬁej
Rows per page: I 1m0 1] ] o to page: II af1 [ [0
[
e
Auto Refresh: [ | Creste 5 H Audit g H Detsil= || Schedules || Logs || Delete | 5
-

Step2  Click Logs under the TOC heading located on the left-hand side. The Task Logs page appears, as shown
in the Figure 7-9, “Task Logs.”

Figure 7-9 Task Logs
Task Logs
ShowRurtime Tasks with Task Name matching Ix _Find |
Showdng 0 of O records
AN Runtime Task Mame Action Start Time End Time Status
Rows per page: I m - 14 <] Goto page: Il of 1 [ [0
oy
o
Auto Refresh: p | Service Requests || Wiewy Log || Dl ste | é

This window displays the task by Runtime Task Name, and the Action, Start Time, End Time, and
the Status of the task. You can use this window to view or delete the logs.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Ping

Step 3
Step 4

Step 5

To view the log, check the check box for the row that represents the task and click the View Log button.

The Task Log page appears, as shown in Figure 7-10, “Task Log.”

Figure 7-10 Task Log

Task Log

Deployment Log for Task Task Created 2003-03-28 13:55:33.38 _Fri_Mar_28_13:55:44_PST_2003_9

Log Level: | Component: [* I:l

Date Level Comp it M g o

2003-03-25 135546 INFO  Provisioning.ProvDry  The argument to the ProvDrv are: [sForceRedeploy = false [sProvizion = true ipsec-rekey = false JobldList = 4
targets =[]

2003-03-28 135546 INFO  Provizioning.ProvDry  Opening repository ...

2003-03-23 135546 INFO  Provisioning.ProvDry  Open repostory succeeded

2003-03-26 135546 INFO  Provisioning ProvDry  ======== Creating ProvDrvSR for Job#4SR#S

2003-03-25 13:55:46 INFO  Provisioning.ProvDry  Fiter to getlogicalDevices: 1

2003-03-25 1359546 INFO  repository firewwallSR add Proviem: com.cisco.vpnsc repostary firewal RepDevidembershipE@a35h73
2003-03-25 135546 INFO  Provisioning.ProvDry Mumber of logicalDevices got: 1

2003-03-28 135547 INFO  repository firesvallSR add Provkem: com cisco vpnzc repostary firevwal RepDeviembership@osf4dd
2003-03-26 135547 INFO  Provisioning ProvDry  Processing logical device 2 with physical id 3

2003-03-26 135547 INFO  Provisioning ProvDry  Service blade for this device: com.cizco vpnsc prov firewsall PWServiceBlade
2003-03-25 13:55:47 INFO Provisioning.ProvDry  Create blade the first time: com.cisco vpnsc prov firewal P ServiceBlade

2003-03-25 1359547 INFO  prov PYWServiceBlade Debug = true

2003-03-28 135547 INFO  prov PVWServiceBlade Debug iz on: temporary directory = jexporthomefypnadmizcimpifiresalli 048888547147
2003-03-28 135547 INFO  Provisioning.ProvDry  Fiter to generateXhL: 1

2003-03-26 135547 INFO  repository firewsllSRE - generating fireweall SR ML

2003-03-26 135548 INFO  repository firewsllSR - add Proviem: com.cizcovpnsc repository firewsall RepDevMember shipi@ f4d59a
2003-03-25 135549 INFO  Provisioning.ProvDry  Cache input.xml with prefered value: 1 j

[ rourntoLoos |

It is possible to set the types of log level you want to view. Specify the Log Level and click on the Filter
button to view that information you want to view.

03473

Click Return to Logs to specify another log to view.

Ping is the way ISC monitors the VPN connectivity, that is, verifies the connectivity among various edge
devices comprising the VPN. To achieve this, you can perform a series of pings among these devices.
Ping has the following benefits:

e Ping is service independent and therefore can be used for functional auditing of MPLS applications.

¢ Ping can establish whether a service is working without doing a functional audit for that service.

¢ Ping can be used to verify IPv4 connectivity among CPEs prior to VPN service deployment.
However, Ping does not do the following:

¢ Ping does not work in environments where ICMP traffic is blocked, for example, in a Cisco I0S
router with an access-list denying all ICMP traffic.

e Ping can only inform you that there is a connectivity problem. It does not offer any service-specific
information. The connectivity problem can be due to many reasons, such as device failure,
misconfiguration, and so on, which ping cannot distinguish.

¢ Only the immediate subnet behind the router’s customer-facing (also, inside or nonsecured)
interface is supported. Campus subnets cannot be supported.

Cisco IP Solution Center Infrastructure Reference, 4.2
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The Ping GUI supports all possible pings for MPLS service requests. This section explains how to ping
MPLS service requests.

Note  ISC has a component Cisco MPLS Diagnostics Expert that might help you. See the Cisco MPLS
Diagnostics Expert 2.0 User Guide on ISC 4.2.

After you choose Monitoring > Ping, you receive a window as shown in Figure 7-11, “Services.”

Figure 7-11 Services
Services
Show Services with | Jab |10 | matehing [ af Type | MPLS VPN »| | Find
Showing 1 - 2 of 2 records
# I_ Job I State Type Operation Type Creator Customer Hame Policy Mame Last Medified Description
1. I_ 1 REQUESTED MPLS ADLD admin Customer! MPLSPolicy_PECE 1042705 5:25 PM
2. I_ 2 REQUESTED MPLS ADD adrnin Custarmer] MPLSPolicyM O _CE 10427035 2:25 PM
Rows per page: | 10 x| 1<) €] Goto pags: |1 of1 B0
Auto Refresh: |7 | Configure Fing Farameters | z
o
ﬁ'

The Type field indicates MPLS. Follow these steps:

Step 1 Check the check box next to each row for which you want to configure ping parameters.

Step2  Click the Configure Ping Parameters button, which becomes enabled. A window as shown in
Figure 7-12, “MPLS Parameters,” appears.

Figure 7-12 MPLS Parameters

MPLS Parameters

* Do PE ta CE Ping

Ping Type:
" Da CF ta CE Ping

Two-vay Ping: ||
Packet Repest Court: &
Datagram Size: 10k

| Etart Ping

149032

Fill in the following and then click Start Ping:

¢ Ping Type—Do PE to CE Ping When this radio button is chosen, a VRF ping occurs for all PE CE
pairs that form an MPLS VPN link. The IP addresses taken for this ping are the link end-point
addresses. For example, assume that an MPLS service request has two linked PE1<>CE1 and

Cisco IP Solution Center Infrastructure Reference, 4.2
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PE2<>CE2. Then this selection initiates four VRF pings: (PE1, CE1l), (PE2, CE2), (PE1, CE2), and
(PE2, CE1). When this selection is chosen, then after you click Start Ping, you go directly to Step 6
and receive a result page.

¢ Ping Type—Do CE to CE Ping When this radio button is chosen, a ping occurs between all CEs
that make the end-point in the service request. When this selection is chosen, then after you click
Start Ping, you go to Step 3.

¢ Two-way Ping (default: unavailable and deselected) This check box is only available when you
select Do CE to CE Ping. When a ping occurs from devicel to device2 and this check box is
checked, then a ping from device2 to devicel also occurs.

¢ Packet Repeat Count (default: 5) This value indicates how many ICMP packets to use for a ping.
e Datagram size (default: 100) This value is the packet size of ICMP used for pinging.
Step3  For Do CE to CE Ping, you proceed to a window as shown in Figure 7-13, “MPLS CE Selection.”

Figure 7-13 MPLS CE Selection

Showing 1-1 of 1 records

Source [P Destination
Address IP Address

1. ences] Site-ences] encebl Site-encebl Incomplete

-

Fows per page: 10

93738

Step4  Check the check box next to each row for which you want to select a CE.
Step5  Click the Start MPLS CE Ping button, which becomes enabled.

Step6  You receive a results window as shown in Figure 7-14, “MPLS Ping Test Results.

Figure 7-14 MPLS Ping Test Results

Showing 1-4 of 4 records

# Property Mame Property “alue
1. Packet repeat count ]

2. Datagram =ize 100

3. Two-way Ping no

4. Do PE to GE ping no

Showing 1-2 of 2 records

" Source P Destination
Address IP Address
1. mipe2 40.40.40.13 West mlze3 40.40.40.14 S iz
ELICCESS
2. mipe2 40.40.40.29 West micet 40.40.4030 SF g

SLCCESS
Rowe per page: 0 -

Auto Refresh:

93837

Cisco IP Solution Center Infrastructure Reference, 4.2
m. oL-10727-01 |



| Chapter?

Monitoring

SLA

Step 7

Note

Step 8

sitA W

The buttons at the bottom of the window are as follows:

¢ Redo Ping When you click this button, you restart all the pings. The parameters used are the same
as those specified in the last request.

e View Job Logs When you click this button, you receive logs of all the ISC jobs created for doing
ping. The ping application creates one job per selected service request.

¢ Refresh To selectively refresh, turn off the Auto Refresh button and click this button whenever you
want to update the results.

¢ Close Click this button to close the current ping request. You return to the Monitoring page.

Any column heading in blue indicates that by clicking that column header, you can sort on that column.

Click Close and you are finished with this Ping session.

A service-level agreement (SLA) defines a level of service provided by a service provider to any
customer. Performance is monitored through the SLA server. ISC monitors the service-related
performance criteria by provisioning, collecting, and monitoring SLAs on Cisco IOS routers that support
the Service Assurance Agent (SA Agent) devices. To provision the SLAs and to collect statistics for each
SLA, the data collection task requires minimal user input.

The SLA collection task collects the relevant performance data, stores it persistently, aggregates it, and
presents useful reports. The SLA collection task collects from the SA Agent MIB on devices. ISC
leverages the SA Agent MIB to monitor SLA performance on a 24 x 7 basis. Using the MIB, you can
monitor network traffic for the popular protocols:

¢ Dynamic Host Configuration Protocol (DHCP)

¢ Domain Name System (DNS)

e File Transfer Protocol (FTP)

e Hyper text Transfer Protocol (HTTP)

e Internet Control Message Protocol Echo (ICMP Echo)
e Jitter (voice jitter)

e Transmission Control Protocol Connect (TCP Connect)

e User Datagram Protocol Echo (UDP Echo).

SLA uses the embedded Sybase database, independent of whether you choose Oracle as your database.

The SLA operations Create, Delete, Enable Probes, Disable Probes, Enable Traps, and Disable
Traps automatically result in the creation of a task, which executes the actual operation. You can view
the status of the task by navigating Monitoring > Task Manager > Logs.

[ oL-10727-01
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This section explains how to configure SLA probes, collect SLA data, and view SLA reports about these
SLA probes.

Before you choose Monitoring > SLA, implement the setup procedures in the “Setup Prior to Using
SLA” section on page 7-12.”

Then choose Monitoring > SLA and you can select one of the following:
e Probes, page 7-12 is the default selection.
e Reports, page 7-36

Setup Prior to Using SLA

SLA is an SNMP activity. Be sure SNMP is enabled and the SNMP settings on the router match the
settings in the repository.

When creating an SLA From MPLS CPE or From MPLS PE or MVRF-CE, the service requests
associated with the devices must be in the Deployed state.

Probes

When you choose Monitoring > SLA > Probes, you receive a window as shown in Figure 7-15, “SLA
Probes.”

Figure 7-15 SLA Probes

Proebes
Show Probes with Source Device Mame matching : of Type all ﬂ |M
Showing 0 of O records
# I_ 1] Source Device Source IP Destination Device st Type Status UL
P Enabled
Rows per page: I 10 1<] { zoto page: |1 of1 [ (21
[l
lul
| || Creste || Enable || Dizable || | E

The default button that is enabled is Create and from the Create drop-down list, you can choose to create
SLA probes From Any SA Agent Device(s); From MPLS CPE; or From MPLS PE or MVRF-CE.
However, if you select one or more existing probes by clicking the row(s) of existing probe(s), then you
have access to the other buttons, Details, Delete, Enable, and Disable. For Enable and Disable, the
drop-down list contains options to enable or disable SLA Probes and SLA Traps.

The explanations of the buttons and subsequent drop-down lists is given as follows:

e Create Common Parameters, page 7-13 This section explains the SLA common parameters for all
of the probe creation types: From Any SA Agent Device(s); From MPLS CPE; or From MPLS
PE or MVRF-CE.

e Create From Any SA Agent Device(s), page 7-15 This section explains how to create probes from
any SA Agent device(s) and begins after creating common parameters.

e Create from MPLS CPE, page 7-17 This section explains how to create probes from an MPLS CPE
and begins after creating common parameters.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Create From MPLS PE or MVRF-CE, page 7-22 This section explains how to create probes from an
MPLS PE or MVRF-CE and begins after creating common parameters.

Protocols, page 7-24 This section is common Probes information for each of the Create paths.
Details, page 7-30 This section gives details about a specified probe.
Delete, page 7-31 This section explains how to delete a probe.

Enable Probes, page 7-32 This section explains how to enable the Probe and change its status from
Created to Active state.

Enable Traps, page 7-33 This section explains how to enable traps.

Disable Probes, page 7-34 This section explains how to disable the Probe and change its status from
Active to Disabled.

Disable Traps, page 7-35 This sections explains how to disable traps.

Create Common Parameters

Step 1

When you choose Monitoring > SLA > Probes, the default is the Probes page with only the Create
button enabled, as shown in Figure 7-15. From the Create drop-down list, you can choose From Any
SA Agent Device(s), From MPLS CPE, or From MPLS PE or MVRF-CE. The first window to appear
in all ways of creation is specified here. Then you proceed to the specific creation type you have chosen.

Follow these steps:

The window to appear is as shown in Figure 7-16, “SLA Common Parameters.”

Figure 7-16 SLA Common Parameters

S5LA Common Parameters

SLA Life [-1 {secs)
Threshold (5000 (msecs)
Timeout |5DDEI {m=ecs)
Freguency (0 - E04500} - (50 {secs)
TOE Categary: % Precedence ¢ DSOP
TOS@D-7" [0

Keep History: |_

Number of Buckets (1 - 60) [15

Enable Traps: |_

Faling Threshold (1 - Thresholdy = |3000 {msecs)

Maote: * - Reguired Field

143035

Accept the defaults or change the information in the fields of the common SLA parameters, as follows,
and then click Next:

SLA Life (required) is the number of seconds that the probe is active (with the maximum value of
a 32-bit integer in seconds). If the value is set to -1, the typical and default value, the probe is active
forever.

[ oL-10727-01
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e Threshold (required) is an integer that defines the threshold limit in milliseconds. When this
threshold is exceeded and traps are enabled, a trap is sent. The maximum value is the maximum
value of a 32-bit integer. If the SA Agent operation time exceeds this limit, the threshold violation
is recorded by the SA Agent. The value for Threshold must not exceed the value for Timeout. The
default value is 5000.

¢ Timeout (required) is the duration in milliseconds to wait for an SA Agent operation completion.
The value for Timeout must be less than or equal to the value for Frequency and greater than or
equal to the value for Threshold. The default value is 5000

¢ Frequency (0 - 604800) (required) is the duration in seconds between initiating each SA Agent
operation. The value for Frequency must be greater than or equal to the value for Timeout. The
default value is 60.

e TOS Category (default: Precedence) If you choose the Precedence radio button for TOS
Category, you have one set of type of service (TOS) values. If you choose the DSCP radio button
for TOS Category, you have a different set of TOS values.

¢ TOS (required) is an integer. The range and meanings of the values depend on whether the radio
button in the TOS Category is set to Precedence (values: 0 to 7) or DSCP (values: 0 to 63).

— When the TOS Category is set to Precedence, the valid values are 0 to 7. These values
represent the three most significant bits of the ToS field in an IP header. The default value is 0.
The meanings of the Precedence values are specified in Table 7-1, “Meanings of Precedence
Values.”

N

Note  Type of Service does not apply to the DNS and DHCP types of SLA probes. ISC ignores
any ToS value set for these two types of SLA probes. For example, if you first choose a
ToS value of 5, then choose the DNS, DHCP, and ICMP Echo protocols for an SLA
probe, ISC applies the selected ToS value to the ICMP Echo probe only.

Table 7-1 Meanings of Precedence Values

ToS Value Binary Value Meaning

7 111 Network Control

6 110 Internetwork Control
5 101 CRITIC/ECP

4 100 Flash Override

3 011 Flash

2 010 Immediate

1 001 Priority

0 000 Routine

— When the TOS Category is set to DSCP, the valid values are 0 to 63. These values represent
the six most significant bits of this ToS field in an IP header. The default value is 0. The
interpretation of these TOS values is user specified.

A
Note ISC maps the 0 - 7 PRECEDENCE values to the three most significant ToS bits by

left-shifting the value by five positions. Similarly, the 0 - 63 DSCP values are left-shifted
by two positions.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Keep History (default: unchecked) If you check the Keep History check box, you indicate to keep
the recent History Table on the router. Specifically, it is kept in the SA Agent MIB that keeps the
raw round-trip time (RTT) SLA measurement. This selection also enables you to indicate the
Number of Buckets of raw history data to keep. If you leave the default of an unchecked check box
for Keep History, no raw history data is kept. Keep History is not supported for HTTP and Jitter.

Number of Buckets (1 - 60) (required) The default is 15 when the Keep History check box is
checked. The range is 1 to 60 and indicates the number of most recent raw data entries to be kept in
the raw history data. When the specified Number of Buckets is surpassed, removal of buckets starts
with the oldest bucket to keep only the number of raw data entries specified.

Enable Traps (default: unchecked, which means No) If you check the Enable Traps check box, the
created SLA is configured to send three types of traps. This selection also enables you to indicate
the Falling Threshold. If you leave the Enable Traps check box unchecked, the traps are disabled
on the SLAs created in this task.

Falling Threshold (1 - Threshold) (required) The default is 3000 in milliseconds when the Enable
Traps check box is checked. The range is 1 to the Threshold value in milliseconds. When traps are
enabled and the delay meets the specified number of milliseconds, a trap is sent.

Next you proceed to Create From Any SA Agent Device(s), page 7-15, Create from MPLS CPE, page
7-17, or Create From MPLS PE or MVRF-CE, page 7-22.

Create From Any SA Agent Device(s)

N

Note

After you have completed the steps in Create Common Parameters, page 7-13, follow these steps:

IP connectivity must be available between the SA Agent devices.

Step 1 The next window to appear is as shown in Figure 7-17, “SLA Source Devices.”

Figure 7-17 SLA Source Devices

SLA Scurce Devices

Showing 1 - 3 of 3 records

2 Interface Type

1. pedt 1722914621 |1 1 CISCO_ROUTER
N 172.29.146 38 Select CISC0_ROUTER
3. [ ces 172.29.146 26 Select CISC0_ROUTER

Rows per page: I 10 j

1<) €] zoto page: II_nf'I B0

Add

149036

Step 2 Click the Add button and a window appears as shown in Figure 7-18, “SLA Devices > Add,” which lists
all the devices in the database that have a minimum of one interface. Check the check box next to each

row for the device you want to select, then click Select.

[ oL-10727-01
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Figure 7-18 SLA Devices > Add
Show Devices with I Device MName | matehing | | Find |
Zhawing 1 - § of § records
# u D evice Hame Man:g:rg = Type Para“r;r?:nice
1. [~ pe Cisco 105 Device
2. [~ pe3 Cisca 105 Device
3. [ sw2 Cisco 105 Device
4 [ =wa Cisca 105 Device
5. [~ swd Cisco 105 Device
B. [~ ce3 Cisca 105 Device
7. [~ ced Cisco 105 Device
5. [ cel3 Cisca 105 Device
Rows per page: | 10 j 1<] €] Goto page: |1_0f1 (= [l
| Select | | Cancel | ;
e

You return to Figure 7-17 and the newly added source device(s) appear. The information about this
source device is specified in the following columns:

¢ Device Name You can click this heading and the device names are organized alphabetically.

¢ Interface You can click Select and from the resulting window, you can update the IP address. Select
one radio button for an interface and click Select and the IP address changes in Figure 7-17.

¢ Type Gives you the type of the source device.

You can repeat Step 2 to Step 3 to add more devices, or you can delete any of the currently selected
source devices. To delete, check the check box next to each row for the device you want to delete and
then click Delete.

There is no second chance for deleting source devices. There is no confirm window.

Click Next. The next window to appear is as shown in Figure 7-19, “SLA Destination Devices.”

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 7-19 SLA Destination Devices

SLA Destination Devices

Showing 1 - 3 of 3 records

# I_ Cevice Mame Interface Type
1. [ pes 1722914623 Select CISCO_ROUTER
2. | swa 1722914639 Select CISCO_ROUTER
3 [ ces 1722914631 Select CISCO_ROUTER
Rows per page: I 10 1<] { zoto page: |1 of1 [ (21
| |

149037

Step6  Click the Add button and a window appears as shown in Figure 7-18, “SLA Devices > Add.” Check the
check box next to each row for the device you want to select. Then click Select.

Step7  You return to Figure 7-19 and the newly added destination device(s) appear. The information about this
destination device is specified in the following columns:

¢ Device Name You can click this heading and the device names are organized alphabetically.

¢ Interface You can click Select and from the resulting window, you can update the IP address. Select
one radio button for an interface and click Select and the IP address changes in Figure 7-19.

¢ Type Gives you the type of the source device.

Step8  You can repeat Step 6 to Step 7 to add more devices, or you can delete any of the currently selected
destination devices. To delete, check the check box next to each row for the device you want to delete
and then click Delete.

Note  There is no second chance for deleting destination devices. There is no confirm window.

Step9  Click Next. Proceed to the “Protocols” section on page 7-24.”

Create from MPLS CPE

After you have completed the steps in Create Common Parameters, page 7-13, follow these steps:

Step 1 The next window to appear is as shown in Figure 7-20, “SLA CPE Parameters.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 7-20 SLA CPE Parameters

VYPH Information
WP
Custarmer:
Source Device
CPE
(PE Interface -
D estinaticn Device(s)

* Connected PE
CPEs

Type:

Connected PE:
Connected PE Interface:

93482

Step2  Click the Select button for VPN and a window appears as shown in Figure 7-21, “Select VPN,” which
lists all the VPN in the database.

Figure 7-21 Select VPN

Show\PNs with | VPN Name | matching |* | Find |
Showing 1 - 6 of G records

# VPH Hame Customer Hame

1. ¢ Mple-YPH-1 Customer

2. ¢ Mpls-wPp-2 Custamer]

3¢ voml Customer

4. ¢ Wpn2 Customer

5 ¢ Wpn3 Customer2

B. ¢ Mpnd Customer2

Rows perpage: | 10 7| [<] <] Goto page: Il of 1 Bl

Click the radio button for the VPN you want to select. Then click Select.

149038

Step3  You return to Figure 7-20 and the newly added VPN and Customer information appear and a Select
button appears for CPE. You can change the VPN by repeating Step 2.

Step4  Click the Select button for CPE and a window appears as shown in Figure 7-22, “Select CPE,” which
lists the CPEs associated with the selected VPN. Click the radio button for the CPE you want to select.
Then click Select.

Figure 7-22 Select CPE

Showing 1-2 of 2 records

# Select
1. Custamer1 Site-enceal enced M AN AGED
2. Custamer1 Site-encetl Encet M AN AGED

Rowe per page: 110 -

93484
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You return to Figure 7-20 and the newly added CPE and its first interface appear and a Select button
appears for CPE Interface. You can change the CPE by repeating Step 4.

If you want to change the default CPE Interface information that appears, click Select and you receive
a window as shown in Figure 7-23, “Interfaces.”

Figure 7-23 Interfaces

Interfaces far device encesd

ShowDevice Interfaces with | INterface MName  *| matching |

Showing 1-6 of B records

¥ Select Interface Logical Mame
1. Ethernetd 192168120.137/30
2. Ethernet1 105.51/30
3. FastEthernetl
4. Loophackl 1921681158132
5. Loopback 1 114141 4052
B. Loophack2 1242421052

-

Rows per page: 10

93435

Click the radio button next to the row for the interface you want to select. Then click Select.

You return to Figure 7-20 and the newly added CPE Interface appears. You can change the CPE
Interface by repeating Step 6.

You can keep the default Type, by leaving the radio button for Connected PE chosen, which creates an
SLA between the CPE and its directly connected PE, or you can select the radio button for CPEs in the
same VPN. If you keep the default of Connected PE, proceed to Step 9. If you click the CPEs radio
button, proceed to Step 12.

Click Select for Connected PE Interface and a window appears as shown in Figure 7-24, “Connected
PE Interface.”

[ oL-10727-01
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Figure 7-24 Connected PE Interface

Interfaces for device enpes

ShowDevice Interfaces with | INterface Mame = pageping |

Showing 1-9 of 9 records

#  Select Interface Logical Mame
1. FastEthernet1 /1
2, Loophackd 192.168.113.69/32
3. Switchl
4. Swdtcht A 10101013530
3. Switch1.100 14.14.14.1/30
B. Swdtch1 120 10101013530
7. Swdtch1 132 1921681217130
. Switch1.400
9. Tunnel1 10.10.10.5430

-

Rowes per page: 1a

93426

Click the radio button next to the row for the interface you want to select. Then click Select.

Step 10  You return to Figure 7-20 and the newly added Connected PE Interface appears. You can change the
Connected PE Interface by repeating Step 9.

Step11  Click Next and proceed to the “Protocols” section on page 7-24.
Step12  When you click CPEs, the window is as shown in Figure 7-25, “CPEs.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 7-25 CPEs

LA Scurce and Destination Devices

VPR Mpals-4PH-1 Select

ok K Customer: Customer]

1. Common Parameters
2.8LA Devices
3. Protocols

4. Summary CPE Interface - 172.29.146.26 _ select |

" Connected PE

B

CPE : ced Select

149197

Step 13 Click the Select button for CPEs and a window appears as shown in Figure 7-26, “Select CPE
Associated with the Specified VPN,” which lists all the CPEs associated with the specified VPN in the
database.

Figure 7-26 Select CPE Associated with the Specified VPN

Showing 1-2 of 2 records

# I_ Customer Marne Site Marn e Device Mame Man:gs;nerrt
1. | Custornerd Ste-encest ences hd AN AGED
2. [ Customeri Site-encefi encefi il AN AGED
Rows per page: 10 j

| Select || Cancel |

Check the check box next to the row(s) for the CPE(s) you want to select. Then click Select.

Note Do not add a device chosen as a Source Device to Destination Device(s).

Step 14 You return to Figure 7-25 and the newly added Device Name appears.
Step15 Click Select in the Interface column and a window appears as in Figure 7-23.

Click the radio button next to the row for the CPE you want to select. Then click Select.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step16  You return to Figure 7-25 and the newly added CPE Interface appears. You can change the CPE
Interface by repeating Step 15.

Step 17  Check the check box next to each row for the Devices you want to remove. Then click the Remove button
and a window as shown in Figure 7-25 appears without the removed Device(s).

Step18  When Figure 7-25 reflects what you want, click Next and proceed to the “Protocols” section on
page 7-24.

Create From MPLS PE or MVRF-CE

After you have completed the steps in Create Common Parameters, page 7-13, follow these steps:

Step1  The next window to appear is as shown in Figure 7-27, “SLA Source and Destination Devices.”

Figure 7-27 SLA Source and Destination Devices

WP =¢: Select

Customer:

PEMYRF-CE ;

VRF [ =

PE= and CPE=: Showing 0 of O records

# [ Device Mame Interface

Rows per page: I 10 | <] { oto page: |1 ot (= [20

149 164

Step2  Click the Select button for VPN and a window appears as shown in Figure 7-28, “Select VPN,” which
lists all the VPN in the database. Click the radio button next to the row for the VPN you want to select.
Then click Select.

Figure 7-28 Select VPN

Showe VP Ns with | YPM Mame | matching | | Find |
Showing 1 - & of B records

# VYPH Hame Customer Hame

1. ¢ Mple-“PH-1 Customer!

2. ¢ Mple-WPH-2 Customer]

30 Vol Customerd

4. ¢ Wpn2 Gustamer]

3. " Wpn3 Customerz

B. ¢ “pnd Customerz

Rows per pags: I 10 = 1<] 4] Goto page: |1 ot (= [20
Select Cancel

149165
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You return to Figure 7-27 and the newly added VPN and Customer information appears. You can change
the VPN and Customer by repeating Step 2.

Click the new Select button for PE/MVRF-CE and you receive a drop-down list from which you can
choose PE or MVRF-CE. If you choose PE, a window appears as shown in Figure 7-29, “Select PE,”
which lists all the PEs associated with the selected VPN. If you choose MVRF-CE, a window appears
as shown in Figure 7-30, “Select CPE,” which lists all the MVRF-CEs associated with the selected VPN.
Click the radio button next to the row for the PE or MVRF-CE you want to select. Then click Select or
OK.

Figure 7-29 Select PE

PE for Mple-YPH-1
Showing 1 -1 of 1 record

# Provider Mame  PE Region Mame Device Mame  Role Type
1. & Provideri region_1 pet MN-PE
Riowe per page; I 1 [<] <] Goto page: |1 af 1 [ [0
o
| Select || Cancel | s
3

Figure 7-30 Select CPE

CPE for Mpls-WPH-1
Showing 0 of 0 records
Managem ent
Type

Rows per page: | 10 »| [€] ] Goto page: Il af 1 B2 [0

#  Custamer Mame Site Mame Device Mame

| Ok || Cancel |

149187

You return to Figure 7-27 and the newly added PE or MVRF-CE information appears. You can change
this selection by repeating Step 4.

If in Step 4 you chose MVRF-CE information, you can click the VRF drop-down list.

Click the new Select button for Destination Device(s)—PEs and CPEs and from a drop-down list,
choose PEs or CPEs. If you choose PEs, a window appears as shown in Figure 7-31, “Select PEs,”
which lists all the PE Interfaces in the database. If you choose CPEs, a window appears as shown in
Figure 7-32, “Select CPEs,” which lists all the CPE Interfaces in the database. Click the radio button
next to the row for the Device Interface you want to select. Then click Select.

Do not add a device chosen as a Source Device to Destination Device(s).

[ oL-10727-01
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Figure 7-31 Select PEs

PE= as=ociated with Mpls-WPH-1
Showing 1 -1 of 1 record
# I_ Provider Mame  PE Region Mame Device Mame  Role Type

1. [ Providert region_1 ped I-PE
Rows per page; I 1m0 = 1<] <] Goto page: I1 of 1 [ [0

| Select || Cancel |
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Figure 7-32 Select CPEs

CPE= aszociated with Mpls-VPH-1
Showing 1 -1 of 1 record
Managerment
Type
1. [ Customerd east cel M 21 AGED

Fows per page: I 10 = <] <] Goto page: |1 of 1 (2 (20

| Select || Cancel |

# I_ Customer Mame Site Mame Device Mame

149169

Step8  Youreturn to Figure 7-27 and you receive interface information. Click Select and you get a window from
which you can click a radio button next to a different interface. Click Select and the new interface

replaces the old interface. You can change the Interface by repeating this step.

Step9  Click Next and proceed to the “Protocols” section on page 7-24.

Protocols

You choose this location after you have completed all the steps in one of the Create functions: Create
Common Parameters, page 7-13; Create from MPLS CPE, page 7-17; or Create From MPLS PE or

MVREF-CE, page 7-22. Follow these steps:

Step1  The next window to appear is as shown in Figure 7-33, “Protocols.”

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 7-33 Protocols

SLA Protocols

Showing 0 of O records

# I_ Source Device Crestination Cevice Type Cre=scription
RoWE per page: I 0 = 1] €] Goto page: |1 of1 [ =0
| Add H Delets |

149034

Step2  Click the Add drop-down list and select:
e ICMP Echo (only available if destination devices are available) Proceed to Step 3.

e TCP Connect (not available for Create From MPLS PE or MVRF-CE; for all the other Creates, TCP
Connect is only available if destination devices are available) Proceed to Step 4.

e UDP Echo (only available if destination devices are available) Proceed to Step 5.

e Jitter (only available if destination devices are available) Proceed to Step 6.

e FTP (not available for Create from MPLS PE or MVRF-CE) Proceed to Step 7.

¢ DNS (not available for Create from MPLS PE or MVRF-CE) Proceed to Step 8.

e HTTP (not available for Create from MPLS PE or MVRF-CE) Proceed to Step 9.
e DHCP (not available for Create from MPLS PE or MVRF-CE) Proceed to Step 10.

Step3  From Step 2, if you chose ICMP Echo, you receive a window as shown in Figure 7-34, “Protocol ICMP
Echo.”

Figure 7-34 Protocol ICMP Echo

SLA Protocol

Protocal: IChP Echo

Request Size” 28 (0 - 16354 hytes)

OK Cancel

149178

Mate: * - Required Fizld

Enter the required information as follows, click OK, and then proceed to Step 11.

¢ Request Size (0 - 16384) (required) is a number that represents the number of octets (in bytes) to
be placed into the data portion of the packet. The default is 28.

Step4  From Step 2, if you chose TCP Connect, you receive a window as shown in Figure 7-35, “Protocol TCP
Connect.”

[ oL-10727-01
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Figure 7-35 Protocol TCP Connect

SLA Protocol

Protocal: TCP Connect
Destiration Port™ |23 (1 - B5535)
Reguest Size: I'I {1 - 16384 bytes)

OK Cancel

149 177

haote: * - Required Fizld

Enter the required and optional information as follows, click OK, and then proceed to Step 11.

¢ Destination Port (1 - 65535) (required) is the port number on the target to where the monitoring
packets is sent. If you do not specify a specific port, port 23 is used.

¢ Request Size (1 - 16384) (optional) is a number that represents the number of octets (in bytes) to
be placed into the data portion of the packet. The default is 1.

Step5  From Step 2, if you chose UDP Echo, you receive a window as shown in Figure 7-36, “Protocol UDP
Echo.”

Figure 7-36 Protocol UDP Echo

SLA Protocol

Praotocal: UDP Echao
Destination Port” |7 (1 - B5535)
Request Size: I'I 4 4 - 8192 bytes)

| OK | | Cancel |

143 176

hote: * - Required Field

Enter the required and optional information as follows, click OK, and then proceed to Step 11.

¢ Destination Port (1 - 65535) (required) is the port number on the target to where the monitoring
packets are sent. If you do not specify a specific port, port 7 is used.

¢ Request Size (4 - 8192) (optional) is a number that represents the number of octets (in bytes) to be
placed into the data portion of the packet. The default is 16.

Step6  From Step 2, if you chose Jitter, you receive a window as shown in Figure 7-37, “Protocol Jitter.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 7-37 Protocol Jitter

SLA Protocol

Protocal: Jitter

Destination Part™ 3000

Request Size: |32

Mumber of Packets: |1 1]

Interval: IEI:I

i1 - 65535]

{16 - 1500 bytes)

{1 - 10007

{1 -1000 mzecs)

OK

Cancel

haote: * - Required Fizld

Enter the required and optional information as follows, click OK, and then proceed to Step 11.

149175
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e Destination Port (1 - 65535) (required) is the port number on the target to where the monitoring

packets are sent. If you do not specify a specific port, port 8000 is used.

¢ Request Size (16 - 1500) (optional) is a number that represents the number of octets (in bytes) to

be placed into the data portion of the packet. The default is 32.

e Number of Packets (1 - 1000) (optional) is an integer that represents the number of packets that
must be transmitted. The default value is 10.

e Interval (1 -1000) (optional) is an integer, 1 to 1,000, that represents the inter-packet delay between
packets in milliseconds.The default value is 20.

Step7  From Step 2, if you chose FTP, you receive a window as shown in Figure 7-38, “Protocol FTP.”

Figure 7-38 Protocol FTP

SLA Protocol

Protocal. FTP

Lizer Marme:

Host IP Address ™

Pazswaord: I

File Path "™

OK

Cancel

Maote: * - Reguired Figld

Enter the required and optional information as follows, click OK, and then proceed to Step 11.

143174

¢ User Name (optional) If blank, anonymous is used.

e Password (optional) If blank, test is used.

e Host IP Address (required) Enter the IP address for File Transfer Protocol (FTP).
¢ File Path (required) Enter the path of the file you want to FTP on the FTP server.

[ oL-10727-01
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Step8  From Step 2, if you chose DNS, you receive a window as shown in Figure 7-39, “Protocol DNS.”

Figure 7-39 Protocol DNS

Pratocal: DM=

x
Marme Server : I

Mame to be Resnlvedx: I

Request Size - [1 {0 - 16384 bytes)

[l 8 | | Cancel

149171

Mote: * - Reguired Figld

Enter the required information as follows, click OK, and then proceed to Step 11.

e Name Server (required) is the string that specifies the IP address of the name server. The address is
in dotted IP address format.

¢ Name to be Resolved (required) is a string that is either the name or the IP address that is to be
resolved by the DNS server. If the string is a name, the length is 255 characters. If the string is an
IP address, it is in dotted IP address format.

¢ Request Size (0 - 16384) (required) is a number that represents the number of octets (in bytes) to
be placed into the data portion of the packet. The default is 1.

Step9  From Step 2, if you chose HTTP, you receive a window as shown in Figure 7-40, “Protocol HTTP.”

Figure 7-40 Protocol HTTP

SLA Protocol

Protocal: HTTF
ersion: I'I A
URL" |
Cache: v

Proxy Server:

Operation; HTTPGet =

Mame Server:

Raty Requesi*: I

Request Size” |1 (1 - 16384 bytes)

| 0K | | Cancel |

Mote: * - Reguired Field

143173

Enter the optional and required information as follows, click OK, and then proceed to Step 11.

e Version (default: 1.0) is a string that specifies the version of the HTTP server. Do not change this.
ISC only supports version 1.0.
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e URL (required) is a string that represents the URL to which an HTTP probe should communicate,
HTTPServerNamelldirectoryllfilename or HTTPServerAddress[/directoryllfilename (for example:
http://www.cisco.com/index.html or http://209.165.201.22/index.html). If you specify the
HTTPServerName, the Name Server is required. If you specify the HTTPServerAddress, the Name
Server is not required.

e Cache (default: selected, which means Yes) For an unchecked check box, the HTTP request should
not download cached pages. For a checked check box, the HTTP request downloads cached pages if
available, otherwise the request is forwarded to the HTTP server.

e Proxy Server (optional) is a string that represents the proxy server information (with a maximum
of 255 characters). The default is the null string.

¢ Name Server (optional, dependent on the URL setting) is the string that specifies the IP address of
the name server. The address is in dotted IP address format.

¢ Operation (default: HTTPGet) If you want HTTPRaw, which represents the HTTP request with
user defined payload, instead of the default HTTPGet which represents the HTTP get request, use
the drop-down list and make that choice.

¢ Raw Request (required if the Operation is HTTPRaw; not available if the Operation is
HTTPGet) is a string that is only needed if the Operation is HTTPRaw. It allows you to invoke
other types of HTTP operations other than the simple GET operation.

¢ Request Size (1 - 16384) (required) is a number that represents the number of octets (in bytes) to
be placed into the data portion of the packet. The default is 28.

From Step 2, if you chose DHCP, you receive a window as shown in Figure 7-41, “Protocol DHCP.”

Figure 7-41 Protocol DHCP

SLA Protocol

Protocal: DHCP

Destination IP Address™

| 0K | | Cancel |

149172

Mote: * - Reguired Field

Enter the required information as follows, click OK, and then proceed to Step 11.
e Destination IP Address (required)

You return to Figure 7-33 and additional columns of information now appear based on the Protocol
information you provided. Before you click Next to proceed, determine if you want to Add more
protocols, in which case repeat Step 2 to Step 10, or Delete any of the currently selected protocols, in
which case, click Delete and proceed much as in Step 2 to Step 10 to now delete protocols.

There is no second chance for deleting destination devices. There is no confirm window.

The next window to appear is a Probe Creation Task Summary window that shows the Description (date
and time created), Common Parameters, Source Devices, Destination Devices, and Protocols that you
have defined. If all exists the way you want it, click Finish. Otherwise, click Back and make corrections.

[ oL-10727-01
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Details

When you choose Monitoring > SLA > Probes, you can get details by following these steps:

Step1  Select an existing probe by checking the corresponding check box for which you want details. Then you
have access to the Details button, as shown in Figure 7-42, “SLA Probes > Details.”

Figure 7-42 SLA Probes > Details

Probes

Showy Probes with Source Device MName matching I* of Type IA” j ILI

Showing 1 -1 of 1 record

’ _ ’ Destination Traps
£ v [1] Source Device Source IP Destination Device P Type Status Enabled
el 172.29.146.21 DHCP Created Mo
Rows per page: |1E| VI 1<] ] Gota page:l1 of 1 [ =1
‘ Details ‘ | Create | ‘ Enable 1-‘ | Disable ‘l'| ‘ Delete ‘

149174

Step2  After you click the Details button, you receive a window as shown in Figure 7-43, “SLA Probes Details.”
This includes the Common Attributes information defined when you first Create and the Protocol
Specific Attributes information defined in the section Protocols.

Figure 7-43 SLA Probes Details

Probe Details

Common Attributes

Probe Type: DHCP
Source [P Address: 1722914621
Destination P Address: 0.0.0.0
Status: Created

SLA Life: unlimited
Threshald: 2000 meecs
Timeout: 5000 meecs
Fregquency: 60 secands
TOS Category: PRECEDENCE
TOS: 0

Keep History: [

Traps Enahled: [

Protocol Specific Attributes

Step3  Click OK to return to a window as shown in Figure 7-42. You can continue to select more Details or
complete another function.

149120
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Delete

When you choose Monitoring > SLA > Probes, you can delete probes from the list by following these
steps:

Step1  Select one or more existing probes by checking the check box(es) for the row(s) of existing probe(s).
Then you have access to the Delete button, as shown in Figure 7-44, “SLA Probes > Delete.”

Figure 7-44 SLA Probes > Delete
Probes
Showy Probes with Source Device MName matching “ of Type All j Find
Showing 1 -1 of 1 record
£ v [1] Source Device Source IP Destination Device DrEEAETT Type Status LI
Ip o Enabled
el 172.29.146.21 DHCP Created Mo

Rows per page: I 10 VI [<] 4] Gota page:l1 of 1 [» [=0

‘ Details H Create 'H Enable 1-” Disable 'H Delete ‘

149174

Step2  After you click the Delete button, a window as shown in Figure 7-45, “Confirm Delete Probes,” appears.

Figure 7-45 Confirm Delete Probes

Selected Probes

Confirm Delete Probes

Showving 1 -1 of 1 record

# D Source Device Source P Destination Device DEsiliEE Type Status UGS
IP Enzhled
1.1 pel 172.29.146.21 DHCP Created Mo

Rowvs per page: I 10 vl N] ﬁ] Goto page:|1 of 1 b bl

‘ OK | ‘ Cancel |

149181

Step3  Click OK if Figure 7-45 reflects what you want to delete or click Cancel if it does not.
)

Note  After the probe is deleted, it is deleted from the probe list page but still remains in the database.

Step4  You return to Figure 7-44 with updated information.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Enable Probes

When you choose Monitoring > SLA > Probes, you can enable probes by following these steps:

Step1  Select one or more existing probes by checking the check box(es) for the row(s) of existing probe(s).
Then you have access to the Enable button. From the Enable drop-down list, you have access to Probes,

as shown in Figure 7-46, “SLA Probes > Enable > Probes.”

Figure 7-46 SLA Probes > Enable > Probes

Probes

Shovwy Probes with Source Device Name matching I* of Type IA”

~||_Find

Showing 1 -1 of 1 record

. — . Destination Traps
# v 1} Source Device Source IP Deztinstion Device P Type Status Enabled
1. ¥ 1 pel 172.29.146.21 DHCP Mo

Rowes per page: I 10 vl <] <] zoto page:l'l of 1 B [0

| Details H Create H Enable 'H Disable 1-” Delete |

Probes

Traps

149182

Step2  After you choose Enable > Probes, a window as shown in Figure 7-47, “Confirm Enable Probes,”

appears.

Figure 7-47 Confirm Enable Probes

Selected Probes

Confirm Enable Probes

Showving 1 -1 of 1 record

# D Source Device Source P Destination Device DEsiliEE Type Status UGS
IP Enzhled
1.1 pel 172.29.146.21 DHCP Mo

Rionws per page: I 10 vl <] €] zoto page:|1 of 1 U [0

‘ 0K

| ‘ Cancel |

149183

Step3  Click OK if Figure 7-47 reflects the probes you want to enable or click Cancel if it does not. In both

cases, you return to Figure 7-46.

Step4  If this was successful, you receive a Status window with a green check mark for Succeeded. The Status

column is set to Active when the probe is created successfully on the router.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Enable Traps

When you choose Monitoring > SLA > Probes, you can enable traps by following these steps:

Step1  Select one or more existing probes by checking the check box(es) for the row(s) of existing probe(s).
Then you have access to the Enable button. From the Enable drop-down list, you have access to Traps,
as shown in Figure 7-48, “SLA Probes > Enable > Traps.”

Figure 7-48 SLA Probes > Enable > Traps

Probes
Shovwy Probes with Source Device Name matching I* of Type Al j Find
Showing 1 -1 of 1 record
# v 1} Source Device Source IP Deztinstion Device ST Type Status LEIE
IP Enabled
1. ¥ 1 pel 172.29.146.21 DHCP Created Mo
Rowes per page: I 10 vl <] <] zoto page:l'l of 1 B [0
| Details H Create H Enable 'H Disable 1-” Delete |
Probes
~J
oo
Traps -
=

Step2  After you choose Enable > Traps, a window as shown in Figure 7-49, “Confirm Enable Traps,” appears.
All the traps have 3000 ms as the falling threshold set automatically

Figure 7-49 Confirm Enable Traps

Selected Probes

Confirm Enable Traps
Showving 1 -1 of 1 record

# D Source Device Source P Destination Device DEsiliEE Type Status UGS
IP Enzhled

1.1 pel 172.29.146.21 DHCP Created Mo
Rowvs per page: I 10 vl |]<| <] Goto page:|1 of 1 [> [>|]
‘ OK | ‘ Cancel |

149184

Step3  Click OK if Figure 7-49 reflects the traps you want to enable or click Cancel if it does not. In both cases
you return to Figure 7-48.

Step4  If this was successful, you receive a Status window with a green check mark for Succeeded. The Traps
Enabled column is set to yes when the probes on the router are successfully changed.

Cisco IP Solution Center Infrastructure Reference, 4.2
[ oL-10727-m .m



Chapter 7

Monitoring |

N siA

Disable Probes

When you choose Monitoring > SLA > Probes, you can use Disable Probes to delete probes on the

devices. Follow these steps:

Step1  Select one or more enabled probes by checking the check box(es) for the row(s) of existing probe(s).
Then you have access to the Disable button. From the Disable drop-down list, you have access to

Probes, as shown in Figure 7-50, “SLA Probes > Disable > Probes.”

Figure 7-50 SLA Probes > Disable > Probes

Probes

Shovwy Probes with Source Device MName matching I* of Type IA”

~||_Find

Showving 1 -1 of 1 record

. - . Destination Traps
# v 1} Source Device Source IP Destination Device P Type Status Enabled
1. W 1 pel 1722914621 DHCP Mo

Rowvs per page: I 10 vl |]<| <] Goto page:|1 of 1 [> [>|]

| Details H Create H Enable 'H Dizable 1-” Delete |

Probes

Traps
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Step2  After you choose Disable > Probes, a window as shown in Figure 7-51, “Confirm Disable Probes,”

appears.

Figure 7-51 Confirm Disable Probes

Selected Probes

Confirm Disable Probes

Showing 1 -1 of 1 record

# D Source Device Source [P Deztinstion Device ST Type Status iz
IP Enahled
1.1 pel 17229146 21 DHCP Created Mo

Rowes per page: I 10 vl <] <] zoto page:l'l of 1 B [0

‘ OK

| ‘ Cancel |

149186

Step3  Click OK if Figure 7-51 reflects the probes you want to disable or click Cancel if it does not. In both

cases you return to Figure 7-50.

Step4  If this was successful, you receive a Status window with a green check mark for Succeeded, and the
probe’s status becomes Disabled when the probe on the router is successfully removed.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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When you choose Monitoring > SLA > Probes, you can disable traps by following these steps:

Step1  Select one or more existing probes by checking the check box(es) for the row(s) of existing probe(s).
Then you have access to the Disable button. From the Disable drop-down list, you have access to Traps,
as shown in Figure 7-52, “SLA Probes > Disable > Traps.”

Figure 7-52 SLA Probes > Disable > Traps
Prohes
Shovwy Probes with Source Device MName matching * of Type Al j Find
Showving 1 -1 of 1 record
# v 1} Source Device Source IP Destination Device DEsiliEE Type Status LG 7=
IP Enabled
1. [ 1 pe 172.29.146.21 DHCP Crested Mo
Rowvs per page: I 10 vl |]<| <] Goto page:|1 of 1 [> [>|]
| Details H Create H Enable 'H Dizable 1-” Delete |
Probes
Traps g
Step2  After you choose Disable > Traps, a window as shown in Figure 7-53, “Confirm Disable Traps,”
appears.
Figure 7-53 Confirm Disable Traps
Selected Prohes
Confirm Disable Traps
Showving 1 -1 of 1 record
£ D 5 Devi 5 P Destination Devi DEsiliEE T Stat UGS
ource Device aLrce ESTINST0on Device P YRE LIS Enaklad
1.1 sy 172.29.146.21 CHCP Crested Mo
Rowvs per page: I 10 vl |]<| <] Goto page:|1 of 1 [> [>|]
‘ OK H Cancel | E
g

Step3  Click OK if Figure 7-53 reflects the traps you want to disable or click Cancel if it does not. In both cases
you return to Figure 7-52.

Step4  If this was successful, you receive a Status window with a green check mark for Succeeded. The traps

are disabled when the probes on the router are successfully changed.

[ oL-10727-01
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Reports

When you choose Monitoring > SLA > Reports, you receive a window as shown in Figure 7-54, “SLA
Reports.”

Figure 7-54 SLA Reports

Reports
e 1111 1
- Probes Summary Report
u Reports Summary Report.
HTTP Report
HTTP Repaort.
Jitter Report
Jitter Repart.

Summary CoS Report
Summary Report with Class of Service information.

HTTP Co5S Report
HTTP Repart with Class of Service information.

Jitter CoS Report
Jitter Report with Class of Service information.
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You can then click on any of the following choices and receive that report

e Summary Report, page 7-36 This report summarizes all the information other than for HTTP and
Jitter (ICMP Echo, TCP Connect, UDP Echo, FTP, DNS, and DHCP).

e HTTP Report, page 7-39 This is a summary report for HTTP information.
e Jitter Report, page 7-39 This is a summary report for Jitter information.

e  Summary CoS Report, page 7-39 This report a summary report for Class of Service (CoS) other than
for HTTP and Jitter ICMP Echo, TCP Connect, UDP Echo, FTP, DNS, and DHCP).

e HTTP CoS Report, page 7-40 This report is for HTTP CoS information.
e Jitter CoS Report, page 7-41 This report is for Jitter CoS information.

Summary Report

From Figure 7-54, choose Summary Report and follow these steps:

Step 1 The resulting window is shown in Figure 7-55, “Parameters of Summary Report.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 7-55 Parameters of Summary Report

Parameters of Summary Report

Layout
Walue Displayedx: all -
Aggregate Byx: oAl Customer Provider WRR Source Router Probe
Tineling Al Yearly Monthly ** Weekly Diily Haourly
meine - zo0d »| [Jun =[5 = [ooon =
Filtering
Customer:
Provider:
WP

Source Routers:

Destination Fouters:
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Step2  For Figure 7-55, fill in the Layout fields, as follows:
¢ Value Displayed (required) (default: All) Click the drop-down list and choose one of the following:
— All to display all the values
— Connections (#) to display the number of connections
— Timeouts (#) to display the number of timeouts
— Connectivity (%) to display connectivity as a percentage
— Threshold Violations (%) to display threshold violations as a percentage
— Max Delay (ms) to display the maximum delay in milliseconds
— Min Delay (ms) to display the minimum delay in milliseconds
— Avg Delay (ms) to display the average delay in milliseconds.

e Aggregate By (required) (default: All) Click the radio button for how you want to aggregate the
data, by All, Customer, Provider, VPN, Source Router, or Probe.

e Timeline (required) (default: Weekly; starting with midnight of the first day of the selected week)
Click the radio button for the report data that you want to display, All data; Yearly data; Monthly
data; Weekly data; Daily data; or Hourly data. Also click the drop-down lists for the year, month,
day of the month, and time of day for which to start the report.

Step3  For Figure 7-55, fill in the Filtering fields, as follows.

Note  The report contains only the data that fulfills all the conditions in the filtering fields (all the conditions
are ANDed together).

Cisco IP Solution Center Infrastructure Reference, 4.2
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Note

Customer (optional) Click the Select button and from the resulting list of Customers, filter the list
if you choose. From the listed Customers, click the radio button for the Customer for which you want
this SLA report. Then click Select. The result is that you return to Figure 7-55 and the selected

customer is listed for Customer. You can repeat this process if you want to change your selection.

Provider (optional) Click the Select button and from the resulting list of Providers, filter the list if
you choose. From the listed Providers, click the radio button for the Provider for which you want
this SLA report. Then click Select. The result is that you return to Figure 7-55 and the selected
provider is listed for Provider. You can repeat this process if you want to change your selection.

VPN (optional) Click the Select button and from the resulting list of VPNs, filter the list if you
choose. From the listed VPNs, click the radio button for the VPN for which you want this SLA
report. Then click Select. The result is that you return to Figure 7-55 and the selected VPN is listed
for VPN. You can repeat this process if you want to change your selection.

Source Routers (optional) Click the Select button and from the resulting list of devices, filter the
list if you choose. From the listed devices, check the check box(es) for device(s). Then click Select.
The result is that you return to Figure 7-55 and Source Routers contains the selected device(s). You
can repeat this process if you want to change your selection.

Destination Routers (optional) Click the Select button and from the resulting list of devices, filter
the list if you choose. From the listed devices, check the check box(es) for device(s). Then click
Select. The result is that you return to Figure 7-55 and Destination Routers contains the selected
device(s). You can repeat this process if you want to change your selection.

Probes (optional) Click the Select button and from the resulting list of source probes, filter the list
if you choose. From the listed source probes, check the check box(es) for source probe(s). Then click
Select. The result is that you return to Figure 7-55 and Probes contains the selected source probe(s).
You can repeat this process if you want to change your selection.

Precedence (default: All) Click the drop-down list to select the other Precedence TOS choices, 0
to 7. These values represent the three most significant bits of the ToS field in an IP header. The
meanings of the Precedence values are specified in Table 7-1, “Meanings of Precedence Values.”

ISC maps the 0 - 7 PRECEDENCE values to the three most significant ToS bits by left-shifting
the value by five positions.

Type of Service does not apply to the DNS and DHCP types of SLA probes. ISC ignores any
ToS value set for these two types of SLA probes. For example, if you first choose a ToS value
of 5, then choose the DNS, DHCP, and ICMP Echo protocols for an SLA probe, ISC applies
the selected ToS value to the ICMP Echo probe only.

DSCP (default: All) Click the drop-down list to select the other DSCP TOS choices, 0 to 63. These
values represent the six most significant bits of this ToS field in an IP header. The interpretation of
these TOS values is user specified.

ISC maps the 0 - 63 DSCP values to the six most significant ToS bits by left-shifting the values
by two positions.

Probe Type (default: All) Click the drop-down list to select from the following types of probes:
ICMP Echo; UDP Echo; TCP Connect; HTTP; DNS; Jitter; DHCP; FTP.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Note  These probe types are explained in detail in the “Protocols” section on page 7-24.

Step4  Click OK in Figure 7-55 after you have the information you want.

Step5  The result is a Summary Report with the selections you made listed. You can Modify, Refresh, Print,
or Close this report with the appropriate button.

Note  If you choose Modify, you receive a window such as Figure 7-55 in which you can modify your
selections as explained in the previous steps.

HTTP Report
From Figure 7-54, choose HTTP Report and proceed similarly to the “Summary Report” section on
page 7-36, with the following exceptions:
e Value Displayed has different drop-down choices.
e There is no Destination Routers selection

e There is no Probe Type drop-down list in the equivalent of Figure 7-55, because the probe type is
automatically HTTP. The result is an HTTP Report.

Jitter Report
From Figure 7-54, choose Jitter Report and proceed similarly to the “Summary Report” section on
page 7-36, with the following exceptions:
¢ Value Displayed has different drop-down choices.
e There is no Destination Routers selection

e There is no Probe Type drop-down list in the equivalent of Figure 7-55, because the probe type is
automatically Jitter. The result is a Jitter Report.

Summary CoS Report

From Figure 7-54, choose Summary CoS Report for a summary of the Class of Service (CoS) reports,
which are based on the TOS values of the SLA probes, and follow these steps:

Step 1 The resulting window is shown in Figure 7-56, “Parameters of CoS Summary Report.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 2

Step 3

Step 4
Step 5

Note

HTTP CoS Report

Figure 7-56 Parameters of CoS Summary Report

Parameters of CoS Summary Report
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For Figure 7-56, fill in the Layout fields, as shown in Step 2 of the “Summary Report” section on
page 7-36, with the following exception. After Value Displayed and before Aggregate By, select the
radio button Precedence (default) or DSCP for the new TOS Type. The explanations are given in the
Filtering section, Step 3 of the “Summary Report” section on page 7-36.

For Figure 7-56, fill in the Filtering fields, as shown in Step 3 of the “Summary Report” section on
page 7-36, with the exception that there are no Precedence or DSCP drop-down lists. They are now in
the Layout fields, as explained in Step 2 in this section.

Click OK in Figure 7-56 after you have the information you want.

The result is a CoS Summary Report with the selections you made listed. You can Modify, Refresh,
Print, or Close this report with the appropriate button.

If you choose Modify, you receive a window such as Figure 7-56 in which you can modify your
selections as explained in the previous steps.

From Figure 7-54, choose HTTP Report and proceed exactly as in the “Summary CoS Report” section
on page 7-39, with the following exceptions:

¢ Value Displayed has the same drop-down choices as HTTP Report.

e There is no Destination Routers selection

Cisco IP Solution Center Infrastructure Reference, 4.2
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e There is no Probe Type drop-down list in the equivalent of Figure 7-56, because the probe type is
automatically HTTP CoS. The result is a CoS HTTP Report. This CoS HTTP report is based on the
TOS values of the SLA probes.

Jitter CoS Report

From Figure 7-54, choose Jitter Report and proceed exactly as in the “Summary CoS Report” section
on page 7-39, with he following exceptions:

e Value Displayed has the same drop-down choices as Jitter Report.
e There is no Destination Routers selection

e There is no Probe Type drop-down list in the equivalent of Figure 7-56, because the probe type is
automatically Jitter CoS. The result is a CoS Jitter Report. This CoS Jitter report is based on the
TOS values of the SLA probes.

TEM Performance Report

TEM Performance Report for Traffic Engineering Management is explained in detail in the Cisco IP
Solution Center Traffic Engineering Management User Guide, 4.2.

Reports

When you choose Monitoring > Reports, a tree of reports appears in the data pane. Click on the + sign
for each folder in the data pane and you receive a listing of all the provided reports. The non-SAMPLE
reports in the L2ZVPN folder are explained in the Cisco IP Solution Center Metro Ethernet and L2VPN
User Guide, 4.2 and the non-SAMPLE reports in the MPLS folder are explained in the Cisco IP Solution
Center MPLS VPN User Guide, 4.2.

Click on any of the specific reports and you can define how to set up the report. Figure 7-57, “Inventory
> SAMPLE - Template Report - Report Window,” shows the sample file under the folder Inventory.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 7-57 Inventory > SAMPLE - Template Report - Report Window
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This section explains the Reports feature and how to use it in the following areas:

e Introducing Reports, page 7-42
e Accessing Reports, page 7-43
e Using Reports GUI, page 7-43
e Running Reports, page 7-44

e Using the Output from Reports, page 7-45

e Creating Custom Reports, page 7-47

Introducing Reports

Network operators often want to have detailed reports on the services provisioned. For example, for a
given customer, you might want to see a list of the PE-CE connections and their detailed PE-CE

configuration parameters or you might want to see specific Layer2 or Layer3 service requests on a PE.
These reports help network operators by providing a centralized location for finding Service Requests

(SRs) and VPN information.

When you choose Monitoring > Reports, reports are grouped by type to allow for easy navigation. ISC
displays only predefined (canned) reports for which the user has RBAC permission.

You can select the filtering criteria and the outputs to be displayed in the report. You can save reports to

a variety of formats.

In addition to the predefined reports that are documented in the Cisco IP Solution Center Metro Ethernet
and L2VPN User Guide, 4.2 and the Cisco IP Solution Center MPLS VPN User Guide, 4.2, ISC provides
additional sample reports. Sample reports are provided for informational purposes only and are untested

and unsupported.

The data structures that ISC uses to provide reports in the GUI are defined in an XML format.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Accessing Reports

To access the reports, follow these steps:

Step 1 To access the reports framework in the ISC GUI, choose Monitoring > Reports.
Step2  Click on the folders to display the available reports.
The Reports window appears, as shown in Figure 7-57.

Step3  From the reports listed under one of the folders in the left navigation tree, click on the desired report to
bring up the window associated with that report.

Note  Several sample reports are provided in the each of the reports folders. These reports begin with the title
SAMPLE-. These reports are provided for informational purposes only. They are untested and
unsupported. You might want to use them, along with the supported reports, as a basis for creating your
own custom reports. See the “Creating Custom Reports” section on page 7-47 for information about
custom reports.

Using Reports GUI

This section provides some general comments on using the reports GUI. This information applies to all
reports. When you invoke a report, you see a window like the one shown in Figure 7-57.

The window is divided into several areas:
e Layout, page 7-43
e Filters, page 7-43
e Output Fields, page 7-44
e Sorting, page 7-44

Layout
This area displays the title of the report and allows you to select the chart type. You can enter your own
report title by overwriting the Title field.
~
Note  Only tabular output is supported.
Filters

In this pane you can define inputs or search criteria for the reports. Values entered here are compared
against corresponding values associated with data objects in the ISC repository. Values must be entered
for all fields. An asterisk (*) can be used as a wild-card character for an entire string.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Output Fields

Sorting

For each filterable field, the GUI displays a label and a text input field. For certain fields, the GUI also
displays a Select button that allows you to choose an existing object (for example, customer, Service
Type, SR State, and so on). All available output fields are displayed in the window, allowing you to select
the fields to include in the report. All output fields are selected by default.

Filter values must be in the same format as the values represented within ISC. For example, a Service
Request (SR) ID must be a number.

In this pane you can choose output fields to be displayed in the report. You can choose any or all of the
output fields by selecting them with the mouse. Use the Shift key to select a continuous range of output
values. Or, use the Control key to select random output values.

This pane allows you to select how you want to sort the report output. For Field:, use the first drop-down
list to select each filter field and then the second drop-down list to choose whether to display the report
fields in ascending or descending order. The sort order can also be changed after you have the report
output displayed (see Figure 7-58).

Running Reports

To run the report, click View in the lower right corner of the report window. This generates the report
output. An example of a report output is shown in Figure 7-58.

Figure 7-58 Report Output
Cisco SrsTeus IP Solution Center
SAMPLE - Template Report =
Showing 1-14 of 14 records 1] 4] Goto page: I 1 of1pages [0
Template Path < Template D cfinitien Hame Template Hame
1. AT CLP_Egress Datal
2. AT GLP_Ingress Datal
3. Dl&-Channelization 10K-CHOG12-5T51-PATH SR _Data
4. Dl&-Channelization 10K-CT3-CHANMELIZED SR _Data
5. DI&-Channelization 10K-CT3-UMCHANMELIZED SR _Data
6. Dl&-Channelization PAMC-E3-CHANNELIZED SR _Data
7. Dl&-Channelization PAMG-STM1 -2 3-CHANNELIZED SR _Data
8. Dl&-Channelization PAMC-STM1-AU4-CHANMELIZED SR _Data
9. Dl&-Channelization PAMG-T3-CHAMMELIZED SR _Data
10. Examples Accesslist Acl2000
11. Examples Accesslist] Protocol-IP
12. Examples Accesslist Protocol-TCP
13. Examples CEWanCOS CEWanCOS
14. FrameR elay classification Datal
=)
[ar)
Rows per page: | 20 j 1] 4] Goto page: I 1 of1pages [0 g

The reports GUI supports output in tabular format. The output is listed in columns, which are derived
form the outputs you selected in the reports window.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Each row (or record) represents one match of the search criteria you set using the filter fields in the
reports window.

In some cases, the value returned in a field can be displayed as one of the following:
¢ -1 means no information updated for this field
¢ F means false
¢ T means true

The column heading with a triangle icon is the output by which the records are sorted. By clicking on
any column heading, you can toggle between ascending and descending sort order. To sort on another
output value, click on the heading for that value.

For information on working with report output, see the “Using the Output from Reports” section on
page 7-45.

Using the Output from Reports

The icons at the upper right of the report output window (see Figure 7-59) provide the following
functions, respectively, moving from left to right:

e Export explained in the “Exporting Reports” section on page 7-45
e Print explained in the “Printing Reports” section on page 7-46
¢ E-mail explained in the “E-mailing Reports” section on page 7-46

e Link to web-based product documentation explained in the “Invoking Help” section on page 7-47

Figure 7-59 Report Output Icons

Exporting Reports

Click on the Export icon in Figure 7-59, “Report Output Icons,” to bring up a window like the one
shown in Figure 7-60 and then follow these steps.

Figure 7-60 Exporting Report Window

Exporting Report

Select a Farmat: ¢ ppp 6% gow

Rows (examples 1-3,8,100: |1-14
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Printing Reports

Select the appropriate radio button for the format you want:
e PDF file — Adobe’s portable document format.

e (SV file — Comma Separated Values format that allows for the data to be easily exported into a
variety of applications.

Select the rows you would like to save, then click OK.

ISC generates the report in the format you selected.

You must have the appropriate application on your system (for example, Acrobat Reader or Excel) to
view and save the output.

Click on the Print icon in Figure 7-59, “Report Output Icons,” to bring up a window like the one shown
in Figure 7-61.

Figure 7-61 Print Report

Printing Report

Rows (examples 1-3,8% [1-14

149043

This window allows you to display the report in a form more appropriate for printing. Select the desired
rows, then click OK. The results are displayed in your web browser, from which you can print the report.

E-mailing Reports

Click on the E-mail icon in Figure 7-59, “Report Output Icons,” to bring up a window like the one shown
in Figure 7-62 and then follow these steps.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 7-62 E-mail Report
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In the To: field (required), specify one or more e-mail addresses to which the report should be sent.

In the From: field (optional), enter an e-mail address you want to appear in the message header.

This allows a reply message to be sent to a valid e-mail address.

In the CC: field (optional), enter e-mail addresses for recipients you want to receive copies of this report.
The subject field shows the title of the report being sent.

You can overwrite this field to rename the report. This is what appears in the Subject field of the e-mail
message.

Select the radio button for the output format (PDF or CSV) in which you want the report sent.
Select the number of rows you want sent.

If applicable, in the Message field, write a message to announce the report, then click Send.

Click on the Help (?) icon in Figure 7-59, “Report Output Icons,” to link to the ISC documentation set
on the Cisco Systems web site:

http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/tsd_products_support_series_home.html

From that location, you can choose the type of ISC document you want to see.

Creating Custom Reports

The reports listed in the ISC GUI in the each folder are derived from an underlying configuration file.
The file is in XML format. You can access the file in the following location:

$ISC_HOME/resources/nbi/reports/ISC/<folder_name>_report.xml

where <folder_name> is Inventory, L2, or MPLS.

[ oL-10727-01
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Each of the available reports (including sample reports) is defined by XML content contained within an
<objectDef name> start and end tag under packageDef name = “<folder_name>". The intervening
XML content specifies the title of the report, all allowable filter parameters, outputs, and the default
sorting behavior. You can modify existing reports or copy them to use as templates for new reports.

To do this, follow these steps:

Stop the ISC server using the stopall command. See Chapter 2, “WatchDog Commands” for information
on starting and stopping ISC.

Open the $ISC_HOME/resources/nbi/reports/ISC/<folder_name>_report.xml (where:
<folder_name> is Inventory, L2, or MPLS) configuration file using an editing tool of your choice.

~

Note  You should backup the file before making any changes to it.

Depending on your needs, either modify an existing report or copy one and use it as the basis for a new
one.

Save the modified $ISC_HOME/resources/nbi/reports/ISC/<folder_name>_report.xml file.

Restart the ISC server using the startwd command. See Chapter 2, “WatchDog Commands” for
information on starting and stopping ISC.

After restarting ISC, the modifications take effect, based on changes you made to the
$ISC_HOME/resources/nbi/reports/ISC/<folder_name>_report.xml file.
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CHAPTER
Diagnostics

From the Home window of Cisco IP Solution Center (ISC), which you receive upon logging in, click the
Diagnostics tab and you receive a window as shown in Figure 8-1, “Diagnostics Selection.”

Figure 8-1 Diagnostics Selection
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The Cisco MPLS Diagnostics Expert (MDE) application is an automated, workflow-based network
management application that troubleshoots and diagnoses problems in Multiprotocol Label Switching
(MPLS) VPNs. MDE offers users the capability to reduce the amount of time required to diagnose
MPLS-related network outages—in many cases from hours to minutes. It performs diagnostics based on
analysis of network failure scenarios, across MPLS access, edge, and core networks. It is equally
applicable to both service provider and enterprise “self-deployed” MPLS VPN networks. Network
operations center (NOC) support technicians as well as second-line and third-line support can benefit
from this product. MDE optionally integrates with the provisioning features of the ISC MPLS VPN
component. To diagnose MPLS VPN core problems, Cisco IOS software releases supporting MPLS
operations and maintenance (OAM) features including label-switched path (LSP) ping and LSP
traceroute are required.

This application is explained in detail in the Cisco MPLS Diagnostics Expert 2.0 User Guide on ISC 4.2.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Administration

From the Home window of Cisco IP Solution Center (ISC), which you receive upon logging in, click the
Administration tab and you receive a window as shown in Figure 9-1, “Administration Selections.”

Figure 9-1 Administration Selections
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Then you can choose the following selections:
e Security, page 9-1 Create and manage Users, User Groups, User Roles, and Object Groups
e Control Center, page 9-22 Manage ISC configuration, servers, remote installation, and licensing
e Active Users, page 9-33 View users currently connected to ISC. Disconnect users.
e User Access Log, page 9-34 View the user access log.

e Manage TIBCO Rendezvous, page 9-36 Specify attributes for proper messaging among all Java™
Web Start distributed applications.

Security

This section describes how system administrators create, edit, and delete users, user groups, user roles,
and object groups and how privileges are assigned to these entities.

Cisco IP Solution Center Infrastructure Reference, 4.2
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The security features are only accessible to the user admin or users with the following roles:
e SysAdminRole gives access to all the ISC tools. This is similar to “root” in a UNIX system.
e UserAdminRole gives access to only the user management tools in Administration > Security.

Choose Administration > Security to access the user management tools. The window shown in
Figure 9-2, “Security Window,” appears.

Figure 9-2 Security Window
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@ Object Groups
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From the Security window, choose the following:
e Users, page 9-2 to manage users
e User Groups, page 9-7 to manage user groups
e User Roles, page 9-9 to manage user roles
e Object Groups, page 9-15 to manage object groups.

For an example of how to use the Users, User Groups, User Roles, and Object Groups, see the “User
Roles Design Example” section on page 9-19.

Users

Choose Administration > Security > Users and follow these steps:

Step 1 The window in Figure 9-3, “Users Window,” appears.
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Figure 9-3 Users Window
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Step2  The explanations of the buttons are given as follows:
e Details, page 9-3 View a User Detail Report
¢ Create, page 9-3 Create a new user
e Copy, page 9-5 Make a copy of an existing user and make changes to create a new user
e Edit, page 9-6 Edit selected user
e Delete, page 9-6 Delete selected user(s).

Details
When you click the Details button, located at the bottom of Figure 9-3, you receive the following
columns of information: User ID; User Group that a user belongs to; Role that a user occupies;
Resource Privilege permissions that a user has for each role occupied; Object Group that a user role is
associated with; Customer View that a user’s role is limited to; Provider View that a user’s role is
limited to.

Create

When you click the Create button, located at the bottom of Figure 9-3, a user with the required privileges
can create a new user. Follow these steps:

Step 1 Choose Administration > Security > Users.

Step2  Click the Create button and the window shown in Figure 9-4, “Create/Copy/Edit Users Window,”
appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 3

Figure 9-4 Create/Copy/Edit Users Window
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Enter information in the Security section, as follows:
e User ID (required) Enter a User ID for this new user.
e Password (required) New password to replace any existing password

e Verify Password (required) Confirm by re-entering the selected password

¢ Permission for Others Check each of the associated check boxes for the permission that the user
(to be created) wants to give to other users. The user who creates the object is the owner of the
objects. The creator can allow or disallow other users to View, Edit, and/or Delete the objects owned
by the creator by defining permissions. This is the last line of defense. For UserA to delete an object
X that UserB created, UserA must first have Delete permission for object X, then UserB’s settings
for permissions for others is checked, to finally decide whether UserA can delete object X.

Permission for others can be enabled or disabled by setting the property:

repository.rbac.checkCreatorPermissionEnabled. After you make a change, you must restart the
WatchDog by entering stopwd followed by startwd. For more WatchDog details, see Chapter 2,

“WatchDog Commands”.
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Step 5
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Step 1
Step 2
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User Groups Click Edit and you receive a list of the groups. Add this user to a user group(s). The
user inherits all the roles assigned to the group(s). You can filter this list. From the selected groups,
check the check box next to each group to which you want to add this user. Then click OK. You can
repeat this procedure if you want to change your selection.

A user’s group membership can also be changed in the group editor (see the “Edit” section on
page 9-8).

Assigned Roles Click Edit and you receive a list of the roles. You can filter this list. From the
selected roles, check the check box next to each role to which you want to assign this user. Then
click OK. You can repeat this procedure if you want to change your selection.

The user inherits all the privileges from the groups in which it participates and from the roles
assigned to it. That is, the permissions received by the user is an OR result of the permissions in each
role.

Enter information in the Personal Information section, as follows:

Full Name (required) Click the drop-down list and select a title; enter the first name; and then enter
the last name.

Work Phone (optional) Enter the work phone number.

Mobile Phone (optional) Enter the user’s cell phone or mobile phone number.
Pager (optional) Enter the user’s pager number.

Email (optional) Enter the user’s e-mail address.

Location (optional) Enter the user’s location.

Supervisor Information (optional) Enter information about the supervisor.

Enter information in the User Preferences section, as follows:

Language (optional) Click the drop-down list to select a language (at this time only English is
supported).

Rows per page (optional) This defines the number of rows per page for object listing. The default
is 10. The choices are: 5, 10, 20, 30, 40, 50, 100, 500, 1000, and 2500.

Logging Level (optional) The default is Warning. The choices are: Off, Severe, Warning, Config,
Info, Fine, Finer, Finest, and All (see all levels of logs). This defines the logging level for viewing
logging events. The list progresses from the least number of messages to the most number of
messages.

Initial Screen (optional) The default is Home. The choices are: Home, Service Inventory, Service
Design, Monitoring, Administration, Site Index, and Diagnostics. This is a way to specify the
first window you will see after logging in.

Click Save. Figure 9-3 reappears with the new user listed.

The Copy button, located at the bottom of Figure 9-3, provides a convenient way to create a new User
by copying the information for an existing User including User Groups, Assigned Roles, and User
Preferences. Follow these steps:

Choose Administration > Security > Users.

Check one check box for the existing User you want to copy and edit to create a new User.

[ oL-10727-01
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Step3  Click the Copy button and the window shown in Figure 9-4, “Create/Copy/Edit Users Window,”
appears.
Step4  Required entries are a User ID, Password, Verify Password, and Full Name.
Step5  Make all the other changes you want by following the instructions in the “Create” section on page 9-3.
Step6  Click Save and you will return to Figure 9-3. The newly created User is added to the list and a Status
Succeeded message appears in green.
Edit
The Edit button, located at the bottom of Figure 9-3, allows a user with the required privileges to edit
user-specific information. Follow these steps:
Step1  Choose Administration > Security > Users.
Step2  Check the check box for the row of the user you want to edit.
Step3  Click the Edit button and a window as shown in Figure 9-4, “Create/Copy/Edit Users Window,” appears.
~
Note  To change your password without the SysAdmin or UserAdmin privileges, click the Account tab on the
top of the Home page. This allows the user to edit the user profile, including changing the password.
Step4  Enter the desired information for the user profile, as specified in the “Create” section on page 9-3.
Step5  Click Save. Figure 9-3 reappears with the edited user listed.
Delete
The Delete button, located at the bottom of Figure 9-3, allows a user with the required privileges to
delete user-specific information. Follow these steps:
Step1  Choose Administration > Security > Users.
Step2  Check the check box(es) for the row(s) of the user(s) you want to delete.
Step3  Click the Delete button and a window as shown in Figure 9-5, “Users Confirm Delete” appears.

Figure 9-5 Users Confirm Delete
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Click Delete to continue with the process of deleting information for the specified user(s). Otherwise
click Cancel.

Figure 9-3, “Users Window,” reappears. If this was successful, the newly updated information appears
and a Status box appears in the lower left corner of the window with a green check mark for Succeeded.

A user group is a logical grouping of users with common privileges. The User Groups feature is used
to create, edit, or delete user groups.

To access the User Groups window, choose Administration > Security > User Groups and follow these
steps:

Step 1 The window in Figure 9-6, “User Groups Window” appears.
Figure 9-6 User Groups Window
User Groups
Show groups w’thl MName =l matching | | Find |
Shovwdng 0 of 0 records
2 Hame D escription
Rows per page: | 10 =] N] ﬂ Goto page: II of1 b bl
| Creste || Edit || Delete | g
Step2  The explanations of the remainder of the buttons is given as follows:
e Create, page 9-7 Create a new user group
e Edit, page 9-8 Edit selected user group
¢ Delete, page 9-9 Delete selected user group(s)
Create
The Create button, located at the bottom of Figure 9-6, allows a user with the required privileges to
create a user group. Follow these steps:
Step1  Choose Administration > Security > User Groups.
Step 2 Click the Create button and the window shown in Figure 9-7, “Create/Edit User Groups Window,”
appears.
Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 9-7 Create/Edit User Groups Window
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Step3  Enter information for the user group profile, as follows:
e Name (required) Enter a name for the new user group.
e Description (optional) Enter a description of this new user group.

¢ Roles This allows you to assign roles to this user group. Click Edit and you receive a list of the roles.
You can filter this list. From the selected roles, check the check box next to each role you want to
attach to this user group. Then click OK. You can repeat this procedure if you want to change your
selection.

e Users This allows you to add users to this user group. Click Edit and you receive a list of the users.
You can filter this list. From the selected users, check the check box next to each user you want to
attach to this user group. Then click OK. You can repeat this procedure if you want to change your
selection.

Step4  Click Save. Figure 9-6 reappears with the new user group listed.

Edit

The Edit button, located at the bottom of Figure 9-6, allows a user with the required privileges to edit
user group-specific information. Follow these steps:

Step 1 Choose Administration > Security > User Groups.
Step2  Check the check box for the row of the user group you want to edit.

Step3  Click the Edit button and a window as shown in Figure 9-7, “Create/Edit User Groups Window,”
appears.

Step4  Enter the desired information for the user group profile, as specified in Step 3 of the “Create” section on
page 9-7.

Step5  Click Save. Figure 9-6 reappears with the edited user group list.
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Delete
The Delete button, located at the bottom of Figure 9-6, allows a user with the required privileges to
delete user group-specific information. Follow these steps:
Step 1 Choose Administration > Security > User Groups.
Step 2 Check the check box(es) for the row(s) of the user group(s) you want to delete.
Step3  Click the Delete button and a window as shown in Figure 9-8, “User Groups Confirm Delete,” appears.
Figure 9-8 User Groups Confirm Delete
Confirm Delete
Showing 1 -1 of 1 record
# Marne De=cription
1. nesgroupd
Rows per page; I 1m0 = 14] ] Goto page: |1 of 1 [ [0
| Delete | | Cancel | g
Step4  Click Delete to continue the process of deleting information for the specified user group(s). Otherwise
click Cancel.
Step5  Figure 9-6, “User Groups Window,” reappears. If this was successful, the newly updated information
appears and a Status box appears in the lower left corner of the window with a green check mark for
Succeeded.
User Roles

A user role is a predefined or a user-specified role defining a set of permissions. The User Roles feature
is used to create, edit, or delete user roles.

To better understand the way roles are managed, certain specific characteristics of roles are defined as
follows:

e Parent Role All permission of the parent roles are inherited by the role that is being created or
edited (child role). A child role always has the same or more privileges than its parent role.

e Customer If a role is associated with a customer, a user of this role does not have access to the
objects associated with other customers. Object types that are constrained by customer view are:
Persistent Task, Customer Site, VPN, CPE, SR, Policy, Service Order, and resource pools that are
associated with a Customer, Customer Site, or VPN.

e Provider If a role is associated with a provider, a user of this role does not have access to the objects
associated with other providers. Object types that are constrained by provider view are: Persistent
Task, Access Domain, Region, PE, Policy, and some resource pools that are associated with a
provider, Access Domain, Region, or PE.

Customer view and provider view within a role have no affect on those objects that do not belong to
either a customer or a provider. Those object types are: task, probe, workflow, device, ISC host, and
template.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Note

Step 1

Permission operation types in a Role editor, namely View, Create, Edit, and Delete mean View, Create,
Modify, and Delete a database object. For example, SR modification (or subsumption) is viewed as Role
Based Access Control (RBAC) Creation. SR purge is viewed as RBAC Delete.

A Role can be enabled to be associated with Object Group(s). When Object Group association is
enabled, a Role can no longer be associated with a Customer or a Provider, and it cannot have a Parent
Role. Resources are limited to PE, CPE, and Named Physical Circuit only. PE and CPE permission
implies Device Permission.

A global policy, the one that is not associated with any customer or provider, is accessible by both
customer-view roles and provider-view roles.

Separate provider-view from customer-view roles when defining a role. When a role is associated with
a provider, choose only the resources for which an access scope can be constrained by a provider view.
Do the same for a customer-view role.

To access the User Roles window, choose Administration > Security > User Roles and follow these
steps:

The window in Figure 9-9, “User Roles Window,” appears.

Figure 9-9

User Roles Window
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The predefined roles shown in Figure 9-9 are provided with associated permissions that cannot be edited
or deleted. They are intended to cover most of the needed use cases to facilitate a rapid assignment of
roles to users and groups with minimum manual configuration. They can also be used as examples to
create new roles.

Step2  The explanations of the buttons is as follows:
e C(Create, page 9-11 Create a new user role
e Copy, page 9-14 Copy selected user role
e Edit, page 9-14 Edit selected user role
e Delete, page 9-15 Delete selected user role(s)

Create

The Create button, located at the bottom of Figure 9-9, allows a user with the required privileges to
create a new user role. Follow these steps:

Step1  Choose Administration > Security > User Roles.

Step2  Click the Create button and a window comprised of Figure 9-10, “Create/Copy/Edit User Roles Window
(Top),” and Figure 9-11, “Create/Copy/Edit User Roles Window (Bottom),” appears.

Figure 9-10 Create/Copy/Edit User Roles Window (Top)
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Figure 9-11 Create/Copy/Edit User Roles Window (Bottom)

143051

Step3  Enter the following information in Figure 9-10:

e Name (required) Enter the name of this new user role.
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Enable Object Group Association The default is that this check box is unchecked. In this case,
Parent Role, Customer, and Provider are enabled and Object Groups is not enabled. Figure 9-11
is complete as shown. If you check this check box, Parent Role, Customer, and Provider are not
enabled and Object Groups is enabled. Figure 9-11is reduced to just PE, CPE, and Named
Physical Circuit.

Parent Role (optional) Click Edit and a list of the existing roles appears, similar to Figure 9-9, from
which you can click the radio button for the parent role you choose. Then click Select. You can
repeat this procedure if you want to change your selection. Click the Clear button if you want no
parent selection.

Customer (optional) Click Edit and a list of the existing customers appears. You can filter this list.
From the selected customers, click the radio button for the customer you want to select to own this
role. Then click Select. You can repeat this procedure if you want to change your selection. Click
the Clear button if you want no customer selection.

Note A customer can only be associated with a logical device, such as CPE and PE. This is not possible with
a physical device, such as device.

Provider (optional) Click Edit and a list of the existing providers appears. You can filter this list.
From the selected providers, click the radio button for the provider you want to select to own this
role. Then click Select. You can repeat this procedure if you want to change your selection. Click
the Clear button if you want no provider selection.

Object Groups (optional) Click Edit and a list of the existing object groups appears. You can filter
this list. From the selected object groups, check the check box(es) for the object group(s) you want
to associate with this User Role. Then click OK. You can repeat this procedure if you want to change
your selection. Deselect the Enable Object Group Association button is you want no object group
selection.

Description (optional) Enter the descriptive information about permissions in this field, as shown
in the Description column of Figure 9-9.

Users (optional) Click Edit and a list of the existing users appears. You can filter this list. From the
selected users, check the check box(es) for the user(s) you want assigned to this role. Then click
OK. You can repeat this procedure if you want to change your selection.

Note A user who is associated with a specific role cannot see objects associated with other customers or with
other providers.

User Groups (optional) Click Edit and a list of the existing user groups appears. You can filter this
list. From the selected user groups, check the check box(es) for the user group(s) you want assigned
to this role. Then click OK. You can repeat this procedure if you want to change your selection.

Step 4 In Figure 9-11, click any combination of the following permissions: Create; View; Modify; Delete. If
you want all the permissions, click All.

Note  ISC Host refers to Administration > Control Center. Here, you can view host details, perform
configuration tasks, start and stop servers, activate a watchdog, and so on.

[ oL-10727-01
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~
Note  SAA Probe is intended for management of SLA under Monitoring > SLA. Any user who wants to
generate SLA reports must have View permission on ISC Host in addition to View permission on SAA
Probe.
~
Note  The Workflow object is currently not used.
Step5  Click Save. Figure 9-9 reappears with the new user role listed.
Copy
The Copy button, located at the bottom of Figure 9-9, provides a convenient way to copy the information
from an existing User Role and edit it to create a new User Role. Follow these steps:
~
Note  All fields in the existing role are copied to the new role, even including Users and User Groups. You
should edit the new role carefully to reflect your intention.
Step 1 Choose Administration > Security > User Roles.
Step2  Check one check box for the existing User Role you want to copy and edit to create a new User Role.
Step3  Click the Copy button and the window comprised of Figure 9-10, “Create/Copy/Edit User Roles
Window (Top),” and Figure 9-11, “Create/Copy/Edit User Roles Window (Bottom)” appears.
Step4  The required entry is a Name. A default name is given, Copy of and the name of the original User Role.
You cannot duplicate a Name.
Step5  Make all the other changes you want by following the instructions in the “Create” section on page 9-11.
Step6  Click Save and you will return to Figure 9-9. The newly created User is added to the list and a Status
Succeeded message appears in green.
Edit
The Edit button, located at the bottom of Figure 9-9, allows a user with the required privileges to edit
user role-specific information. Follow these steps:
Step1  Choose Administration > Security > User Roles.
Step2  Check the check box for the row of the user role you want to edit.
Step3  Click the Edit button and a window appears combining Figure 9-10 and Figure 9-11 for this user role.
Step4  Enter the desired information for the user role profile, as specified in Step 3 and Step 4 of the “Create”
section on page 9-11.
Step5  Click Save. Figure 9-9 reappears with the edited user roles listed.
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Delete

The Delete button, located at the bottom of Figure 9-9, allows a user with the required privileges to
delete user role-specific information. Follow these steps:

Step 1 Choose Administration > Security > User Roles.
Step 2 Check the check box(es) for the row(s) of the user role(s) you want to delete.

Step3  Click the Delete button and a window as shown in Figure 9-12, “User Roles Confirm Delete,” appears.

Figure 9-12 User Roles Confirm Delete
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Showing 1 -1 of 1 record
# Mame Description

Copy of ISC predefined role. It has the permission to manage Invertory and deploy L2YPN
Service Request.

ROwWs per page: I EITE | <] <] zoto page: |1 of1 [+ =1

1. nevnrale

Delete Cancel

1439052

Step4  Click Delete to continue with the process of deleting information for the specified user role(s).
Otherwise click Cancel.

Step5  Figure 9-9, “User Roles Window,” reappears. If this was successful, the newly updated information
appears and a Status box appears in the lower left corner of the window with a green check mark for
Succeeded.

Object Groups

An Object Group is a named aggregate entity comprised of a set of objects. The object types can be PE,
CE, Named Physical Circuit (NPC), and interfaces of PEs or CEs. An Object Group provides instance
level of access granularity for users.

An Object Group can be associated with different roles. A role can be associated with an Object Group
or it can be associated with a grouping of Customer and Provider, but it cannot be associated with both
of these. The association with a grouping of Customer and Provider is either with Customer(s), with
Provider(s), or with Customer(s) and Provider(s). When a role is associated with Object Group(s), you
can only define permissions for PE, CE, and NPC. Permissions on interfaces is implied PEs or CEs, that
is, PE Create or CE Create implies Interface Create. PE or CE Edit implies Interface Create, Edit, or
Delete. CE or PE Delete implies Interface Delete.

When instance level of access is desired for PE, CE, NPC, or interface of PEs and CEs, you can usually
define a role associated with Object Group(s) that contains a collection of PEs and CEs you are limited
to operate. Then define other roles to include permissions on other types of objects. See the “User Roles
Design Example” section on page 9-19.

If an Object Group contains PEs (or CEs) only, with no explicit interface as a group member, you can
access all interfaces of grouped PEs or CEs. If an Object Group contains any explicit interface as group
members, every single interface that you want to access you must manually choose to include as group
members.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Note  Permissions are the union of all roles that you occupy. If your intention is to limit access to a scope of
devices or Named Physical Circuits (NPCs), define a role to be associated with Object Group(s), Device,
CE, PE, and NPC.
To access the Object Groups window, choose Administration > Security > Object Groups and follow
these steps:
Step 1 The window in Figure 9-13, “Object Groups Window,” appears.
Figure 9-13 Object Groups Window
Object Groups
Show groups with | Mame =l matching | | Find |
Showing 0 of 0 records
L Hame D escription
Rows per page: I 10 = 1] <] Goto page: I1 of1 (= [0
| Creats || Edit || Delete | g
Step2  The explanations of the buttons is as follows:
e Create, page 9-11 Create a new object group
e Edit, page 9-14 Edit a selected object group
e Delete, page 9-15 Delete selected object group(s)
Create
The Create button, located at the bottom of Figure 9-13, allows a user with the required privileges to
create a new object group. Follow these steps:
Step1  Choose Administration > Security > Object Groups.
Step2  Click the Create button and the window Figure 9-14, “Create/Edit Object Group Window,” appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 9-14 Create/Edit Object Group Window

MName :

Descrigtion:

PE Group Members: # Marne Irterface Members IT
Rowe per page: Iﬂ <] €] Goto page: |1_|:|f1 =1

CE Group Members: # Marme Irterface Members |T|
Rows per page: Iﬂ |]<| <] Goto page: |1_|:|f1 [> [>|]

MPC Group Members:  # Marre |T|

Rows per page: I | 1<] €] o to page: |1 af 1 B =1

| Sawve || Cancel |

Mate: * - Required Field

149054

Enter the following information in Figure 9-14:

Name (required) Enter the name of this new object group.
Description (optional) Enter a description of this new object group.

PE Group Members (optional) Click Edit and a list of the existing PEs appears. You can filter this
list. From the selected PEs, check the check box(es) for the PE(s) you want to include in this group.
Then click OK. You can repeat this procedure if you want to change your selection(s). The Interface
Members column will be empty. All existing interfaces for each of the PE Groups in the Name
column will default to be members of the group unless you select only a subset. To limit the
interfaces and select a subset of interfaces, click a PE Group in the Name column. You receive a list
of all the interfaces for that PE from which you can individually select only the interfaces you want
to associate with that PE Group. Then click OK. You return to Figure 9-14, “Create/Edit Object
Group Window,” and the Name and selected Interface Members for each PE Group Member
appear. If no entries exist in the Interface Members column for both PE Group Members and CE
Group Members, the default is all existing interfaces for both (if any exist).

CE Group Members (optional) Click Edit and a list of the existing CEs appears. You can filter this
list. From the selected CEs, check the check box(es) for the CE(s) you want to include in this group.
Then click OK. You can repeat this procedure if you want to change your selection(s). The Interface
Members column is empty. All existing interfaces for each of the CE Groups in the Name column
default to be members of the group unless you select only a subset. To limit the interfaces and select
a subset of interfaces, click a CE Group in the Name column.You receive a list of all the interfaces
for that CE from which you can individually select only the interfaces you want to associate with
that CE Group. Then click OK. You return to Figure 9-14, “Create/Edit Object Group Window,” and
the Name, and selected Interface Members for each CE Group Member appear. If no entries exist
in the Interface Members column for both CE Group Members and PE Group Members, the
default is all existing interfaces for both (if any exist).

[ oL-10727-01
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e NPC Group Members (optional) Click Edit and a list of the existing NPCs appears. You can filter
this list. From the selected NPCs, check the check box(es) for the NPC(s) you want to select to own
this role. Then click OK. You can repeat this procedure if you want to change your selection(s). You
return to Figure 9-14, “Create/Edit Object Group Window,” and the Name for each NPC Group
Member appears.
Step4  Click Save. Figure 9-14 reappears with the new object group listed.
Edit
The Edit button, located at the bottom of Figure 9-14, allows a user with the required privileges to edit
object group-specific information. Follow these steps:
Step 1 Choose Administration > Security > Object Groups.
Step2  Check the check box for the row of the object group you want to edit.
Step3  Click the Edit button and a window appears as shown in Figure 9-13, with the object group chosen
specified in the Name field.
Step4  Enter the desired information for the object group, as specified in Step 3 of the “Create” section on
page 9-16.
Step5  Click Save. Figure 9-13 reappears with the edited object groups listed.
Delete
The Delete button, located at the bottom of Figure 9-13, allows a user with the required privileges to
delete object group-specific information. Follow these steps:
Step 1 Choose Administration > Security > Object Groups.
Step 2 Check the check box(es) for the row(s) of the object group(s) you want to delete.
Step3  Click the Delete button and a window as shown in Figure 9-15, “Delete Object Groups Confirm Delete,”

appears.

Figure 9-15 Delete Object Groups Confirm Delete

Delete Object Group{s)

Confirm Delete
Showing 1 - 2 of 2 records
# Marne Degcription
1. abjgp??
2. ohjgp3

Rone per page: I all j |]<] (] Goto page: |1 af [> [>|]

| Delete || Cance| |

11k 074
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Click Delete to continue with the process of deleting information for the specified object group(s).
Otherwise click Cancel.

Figure 9-13, “Object Groups Window,” reappears. If this was successful, the newly updated information
appears and a Status box appears in the lower left corner of the window with a green check mark for
Succeeded.

User Roles Design Example

Example

This section gives an example situation, an illustration that shows this setup, and steps on how to setup
this design:

e Example, page 9-19
e [llustration of Setup, page 9-19
e Steps to Set Up Example, page 9-21

This section explains an example data center for which the following sections, “Illustration of Setup”
section on page 9-19 and “Steps to Set Up Example” section on page 9-21 give an illustration setup and
steps, respectively.

Finance Customer XYZ built an MPLS network to connect its branch offices to its data center.
Subsidiaries of XYZ are running different parts of the MPLS network. Each subsidiary uses a different
BGP AS domain, which results in different Provider Administrative Domains (PADs) inside ISC.

Each subsidiary acts as a Provider and owns therefore its own Devices, like PE and CE devices, and
should also own logical attributes inside ISC, like Regions, Sites, Customers, and VPNs. Therefore, the
view of the devices for each subsidiary must be separated into PAD views. Thus, Provider A cannot
manipulate or view the configuration files for devices of Provider B. Devices are not shared between
PADs.

Inside a PAD, there are Customers with sites and VPNs with only local significance. Also, the IP
addressing should be defined per PAD.

But there are also Customers that have sites in different PADs. This means that there is a need for
Inter-AS VPNs. The Provider who owns the Customer should also have the right to share this Customer
with other Providers. In this case, the VPNs and CERCs should be shared between the providers.

lllustration of Setup

Figure 9-16, “Contents in Example,” shows the setup described in the “Example” section on page 9-19.

[ oL-10727-01
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Figure 9-16
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Steps to Set Up Example

This section explains the steps to create the example explained in the “Example” section on page 9-19
and shown in the “Illustration of Setup” section on page 9-19.

Step1  Create the following Object Groups (see the “Create” section on page 9-16, which is for the section
Object Groups):

e PIPEGroup that has members PE111 and PE112

e P2PEGroup that has members PE211 and PE212

e CICEGroup that has members CE111 and CE121

e C2CEGroup that has members CE211 and CE221

¢ (C3CEGroup that has the member CE311

e (C2DeviceGroup that has members PE112, CE211, PE211, and CE221
e (C3DeviceGroup that has members PE212 and CE311.

Step2  Create the following User Roles that are associated with one or more groups created in Step 1 (see the
“Create” section on page 9-11, which is for the section User Roles.

e PlDeviceGroupRole, associated with groups PIPEGroup, CICEGroup, and C2CEGroup, and have
the Modify and Delete permissions on for PE and Cpe.

e P2DeviceGroupRole, associated with groups P2PEGroup, C2CEGroup, and C3CEGroup, and have
the Modify and Delete permissions on for PE and Cpe.

e (ClDeviceGroupRole, associated with groups PIPEGroup, C1CEGroup, and have the Modify
permission on for PE and the Modify and Delete permissions on for Cpe.

e (2DeviceGroupRole, associated with group C2DeviceGroup, and have the Modify permission on
for PE and the Modify and Delete permissions on for Cpe.

e (C3DeviceGroupRole, associated with group C3DeviceGroup, and have the Modify permission on
for PE and the Modify and Delete permissions on for Cpe.

Step3  Create the following User Roles that have Customer View or Provider View, as explained in the “User
Roles” section on page 9-9.

e P1MplsRole, associated with Provider P1, and have permissions on Provider, Task, ISC Host, Mpls
SR, Mpls Policy, NPC, and Probe. (Add Service, Template, and ServiceOrder if needed.)

e P2MplsRole, associated with Provider P2, and have permissions on Provider, Task, ISC Host, Mpls
SR, Mpls Policy, NPC, and Probe. (Add Service, Template, and ServiceOrder if needed.)

¢ ClMplsRole, associated with Customer C1, and have permissions on Customer, Task, ISC Host,
Mpls SR, Mpls Policy, NPC, and Probe. (Add Service, Template, and ServiceOrder if needed.)

e (C2MplsRole, associated with Customer C2, and have permissions on Customer, Task, ISC Host,
Mpls SR, Mpls Policy, NPC, and Probe. (Add Service, Template, and ServiceOrder if needed.)

e (C3MplsRole, associated with Customer C3, and have permissions on Customer, Task, ISC Host,
Mpls SR, Mpls Policy, NPC, and Probe. (Add Service, Template, and ServiceOrder if needed.)

Step4  Assign the User Roles defined in Step 2 and Step 3 to Users, as explained in the “Users” section on
page 9-2.

e User P1 has User Roles: P1DeviceGroupRole, PIMplsRole, CI1MplsRole, and C2MplsRole.
e User P2 has User Roles: P2DeviceGroupRole, P2MplsRole, C2MplsRole, and C3MplsRole.
e User C1 has User Roles: C1DeviceGroupRole and C1MplsRole.

Cisco IP Solution Center Infrastructure Reference, 4.2
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e User C2 has User Roles: C2DeviceGroupRole and C2MplsRole.
e User C3 has User Roles: C3DeviceGroupRole and C3MplsRole.

Control Center

Hosts

Note

This section explains how to view and change the properties in the Dynamic Component Properties
Library (DCPL); how to view status information about a host, servers, the WatchDog, and logs; how to
remotely install and uninstall a Processing server, Collection server, or Interface server; how to define
collection zones; and how to install license keys.

Choose Administration > Control Center and you go to the default page of Hosts in the TOC, as shown
in Figure 9-17, “Control Center > Hosts.”

Figure 9-17 Control Center > Hosts
Hosts
el
nHosts _Refresh |
« Gollection Zones Showing 1 - 1 of 1 record
- Licensing # | Mame Role Start Time Stop Time Running
1. [ efgh-utra.cisco.com Master Oct 27 04:19:56 PM PDT LIMKM OV es
Rows per page: I 10 = <] <] Zoto page: Il of 1 Bl
[Te]
18]
| Details || Config || Servers || Watchdog || Im=tall || Unirstall || Logs | §
—

From Administration > Control Center, you have the following three choices in the TOC:
e Hosts, page 9-22 Hosts allows you to manage the various servers.

e Collection Zones, page 9-29 Collection Zones are the means of associating collection servers with
network devices.

e Licensing, page 9-31 Licensing is where you install license keys, which is the only way to access
services and APIs.

Choose Administration > Control Center > Hosts.

A window as shown in Figure 9-17 appears.

Only the Install and Logs buttons are enabled by default when there is no host selected. When one or
more hosts are selected by checking the check box(es), the Install and Logs buttons are disabled and the
other buttons are enabled.

Click any of the buttons and proceed as follows:
e Details, page 9-23 Available only when one host system is chosen.
e Config, page 9-24 Available only when one or more host systems are chosen.

e Servers, page 9-25 Available only when one or more host systems are chosen.

Cisco IP Solution Center Infrastructure Reference, 4.2
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e Watchdog, page 9-26 Available only when one or more host systems are chosen.
e Install, page 9-27 Available only when no host system selections are made.
e Uninstall, page 9-28 Available only when one host system is chosen.

e Logs, page 9-28 Available only when no host system selections are made.

Details
For details about a chosen host, follow these steps:
Step 1 Choose a host by checking the check box to the left of the host name and then click the Details button.
Step2  You receive a window as shown in Figure 9-18, “Host Details.” This shows the details about the chosen
host.
Figure 9-18 Host Details
Host Details
Host: efgh-ultralO.cisco.com
General el
Active: es
[mage: {53 0-20030406,00,Q
Registered Doate: May 21 02:29:10 PDT
UnRegistered Date:
Install Location: fdiskZfopt/iscad m/isc3
Install Time: 2005-03-19 16:52:07.
Locations
Server Logs: fdisk2foptyiscad myisc?
Task Logs: fdisk2/foptfiscadm/isc?
Temporary: fdisk2foptfiscadmyises
Disk Stats
Fath; fdisk2/opt/iscadm/isc:
Total Disk Space: 19146 MEB
Free Disk Epace: 12810 MB; 66% Free
Fath; fdisk2/opt/iscadm/isc:
Total Disk Space: 19146 MEB
Free Disk Epace: 12810 MB; 66% Free
Health Stats
L ast Heartbeat:
L ast Heartbeat Status:
L ast Heartbeat Duration: M
Collection Zones =l
N N
OK |
o
Step3  Click OK and you return to Figure 9-17.
Cisco IP Solution Center Infrastructure Reference, 4.2
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Config

To view or change the Dynamic Component Properties Library (DCPL) properties, which replaces the
csm.properties file for VPNSC, follow these steps:

Note  csm.properties in VPNSC cannot be migrated to DCPL settings in ISC.

Step1  From Figure 9-17 on page 9-22, check a check box next to a host name for which you want to know the
existing properties and then click the Config button.

Step2 A window as shown in Figure 9-19, “Properties,” appears. It is a list of all the folders with all the
properties. See Appendix C, “Property Settings” for a list of all the properties with explanations,
defaults, and ranges/rules. If you don’t know the property name, you can use a key word and do a Find
on the pdf version of this appendix.

Figure 9-19 Properties

Host Configuration

version: | Oct 27 041847 PDT v

E (] AutoDiscovery -
H (] Gleanup

EH_JDos

[ _ ] D eplovmentF lovw

(] Discovery

[ (] DistribwtionF ramewark

E [ Gsam

EHCIGTL

([ zul

(] JavawehStart

(] Logging

] Provisioning

[

E ] SYsTEM

(] Scheduler —
H ] Services

E (] SnmpService

H_]TE

(] TETopology

(] TaskManager

E (] vpninvServer

H (] aagent ﬂ

0 e

| Creste Verzion | | Set to Latest |

149056

Step3  Click the + sign to expand each folder. The result could be more subfolders and the final level is the
property name.

Step4  Position the mouse over the folder or property name and you see a description.

Step5  Click on an entry to get details and instructions on how to change the value, as shown in the example in
Figure 9-20, “Properties Detail Example.”

Cisco IP Solution Center Infrastructure Reference, 4.2
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Figure 9-20 Properties Detail Example

Host Configuration

Wersion: | Apr 22 04:56:03 FDT =

| Atodiscovery =
= A Cleanup

-J RurtimeTasks
|_]TaskLogs

Attribute Cleanup'ilogLevel Version Apr 22 04:56:09 PDT

S TempFies Description: ~ NOTE: This logLevel {5 used only if there is no logLevel defined
5] loglevel for a component.

ELDcs logl ewel is the level at which logging is done for this component.

(1D eploymentF low These levels are identical to the logging levels defined for IDE1 .4

) DistritutionF ram ewark logging package,

Ccsem The levels ir} descending order are:

et %ngﬁl(gghest value)

sl INEO

[HE Logging CONFIG

__Provisioning FINE

CasLa FINER

1SYSTEM FINE2T (lowest walue)

| =cheduler Current Value:

__l=nmpService

1 TaskManager o D SEVERE =

__|vpnlrvServer

__laagent

el d

[+11 Tlnek rananer

03842

Step6  For each property that can be modified, you can modify the value and click Set Property. If when
making your modifications, you want to return to the previous settings, click Reset Property.

Step7  After making all the changes you choose in each of the specific properties, you can click Create Version
to create a new version of these properties. This feature gives you the option of saving multiple property
sets for future use.

Step8  To view the values of previous versions of property sets, click the drop-down list in Version and select
any version you choose.

Step9  When you click Set to Latest after selecting a version in Step 8, this version is dated as the most current.

Step10  To return, click to the navigation path you want to use next.

Servers
To view the status information about the servers, follow these steps:

Step 1 From Figure 9-17 on page 9-22, check a check box next to a host name for which you want to know the
server statistics and then click the Servers button.

Step2 A window as shown in Figure 9-21, “Servers,” appears.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 3

Step 4

Step 5

Watchdog

Step 1

Step 2

Figure 9-21 Servers

Servers
Showing 1 - 9 of 9 recards
2N | Marme State  Generstion Start Time PID Successful Heartheats Mizsed Hearthests

1. [T warker started 1 Oct 27 04:20:03 PM PDT 23148 15994 0
2. [ dispatcher started 2 Oct 27 04:24:16 P PDT 23168 1B136 0
3. [ discovery started 1 Oct 27 04:20:04 P PDT 23150 16080 0
4, [ lockmanager  started 1 Oct 27 04:20:03 P PDT 23147 18131 0
5. [ nspoller started 1 Oct 27 04:19:55 PM PDT 0 19964 0
6. [ scheduler started 1 Oct 27 04:22:21 PM PDT 23165 16212 0
7. [ hitpd started 2 Oct 27 04:24:19 PM PDT 23167 1B173 0
8 [ dbpoler started 1 Oct 27 04:19:55 PM PDT 0 16000 0
9. [T cneserver started 1 Oct 27 04:20:04 PM PDT 23151 18225 o]

Rows per page: | 10 | [<] €] Goto page: |1—|:|f1 [ =1

| Start || Stop || Restart H Logs H oK |

143057

Check any one check box next to the server you want to address and you have access to Start, Stop,

Restart, and Logs. When you click on a specific server name or the Logs button, you get a list of server
logs. If you then click on the log name for which you want details, the log viewer appears. You can filter
this information in the log viewer. After you complete the task of your choice, you return to Figure 9-21.

You can click a different server and click the button for the process of your choice. Or you can unclick
the server choice and click OK.

After you click OK in Figure 9-21, you return to Figure 9-17 on page 9-22.

To view the log information about WatchDog, follow these steps:

From Figure 9-17 on page 9-22, check a check box next to a host name for which you want to know the
WatchDog logs and then click the Watchdog button.

A window as shown in Figure 9-22, “WatchDog Logs,” appears.

Figure 9-22 WatchDog Logs

Hame Size Last Modified

watchdog 0 300721 Thursday, October 27, 2005 4:26:26 P PDT

oK

1490353
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Click on a specific WatchDog log name in the Name column to get the contents of that log. You can filter
the information in this log. Click OK to return to Figure 9-22.

You can repeat the process in Step 3 or click OK to return to Figure 9-17 on page 9-22.

Install
To remotely install the Processing Server, Collection Server, or Interface Server, follow these steps:
~
Note  Telnet and ftp must be available on both the Master and remote server.
~
Note  In this remote install, you must accept the default values, similar to the express install. If you want to
do a custom install, it is only available through the installation procedure explained in the “Installing
ISC” section of Chapter 2 of the Cisco IP Solution Center Installation Guide, 4.2.
Step1  From Figure 9-17 on page 9-22, be sure that no check boxes are checked and then click the Install
button.
Step2 A window as shown in Figure 9-23, “Install ISC Host,” appears.
Figure 9-23 Install ISC Host
Install I3C Host
Device Host Name - I
150 User : I
ISC User Password : I xxxxx
Fole: |F'rc:c:essing Server x|
Install Location : I
Foot Password: |
In=tall | | Cancel E
g
Step3  Provide the following information in Figure 9-23.
e Device Host Name (required)
e ISC User (required) This same user must be created on the remote server.
~
Note  Be sure you have 1 GB of disk space available in the ISC User’s home directory.
e ISC User Password (required)
¢ Role Accept the default of Process Server or click the drop-down list and choose the Collection
Server or Interface Server option.
Cisco IP Solution Center Infrastructure Reference, 4.2
[ oL-10727-01 .m


http://www.cisco.com/en/US/products/sw/netmgtsw/ps4748/products_installation_guide_book09186a00806923f0.html

Chapter9  Administration |

I Control Center

Step 4
Step 5

Uninstall

Step 1

Step 2

Step 3

Step 4
Step 5

Logs

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

¢ Install Location (required)

¢ Root Password (optional) To auto start ISC on a remote server, the root password is required.
Click the Install button.
The result is an Install Log.

To remotely uninstall the Processing Server, Collection Server, or Interface Server, follow these steps:

From Figure 9-17 on page 9-22, check a check box next to a hostname for which you want to uninstall
and then click the Uninstall button.

A window as shown in Figure 9-24, “Remote Uninstall,” appears.

Figure 9-24 Remote Uninstall
ISC User :
ISC User Password @ [

93846

Provide the following information in Figure 9-24.
e ISC User (required)
e ISC User Password (required)

Click the Uninstall button.

The result is an Uninstall Log.

To view install and uninstall logs for the Master and remotely installed server, follow these steps:

From Figure 9-17 on page 9-22, be sure that no check boxes are checked.
Click the Logs drop-down list and select Install or Uninstall.

The window that appears is the log of installations or uninstallations, dependent on your selection in
Step 2.

Click the link in the Name column to view the detailed log information.
Click OK to return to the window in Step 3.

Click OK again to return to Figure 9-17 on page 9-22.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Collection Zones

Step 1

Step 2

Step 3
Step 4

Choose Administration > Control Center.

A collection zone is a geographical grouping of devices. Each collection zone is associated with exactly
one Collection server that collects data from its devices. However, a Collection server can service
multiple collection zones. For example, if you initially create several collection zones and have them all
serviced by the Master server, then as the number of devices in each zone grows, you can install
additional Collection servers and assign some of the zones to them.

When you install a new Collection server or Processing server, the system creates a new collection zone
with the same name as the server. This functionality is for your convenience. You can delete this
collection zone if this does not fit your distribution environment setup.

To define collection zones, follow these steps:

From the Control Center, choose Collection Zones from the TOC in the left column, and a window as
shown in Figure 9-25, “Choose Control Center > Collection Zones” appears.

Figure 9-25 Choose Control Center > Collection Zones
Collection Zones
s :
« Hosts ShowGallection Zones with | Collection Zone Mame x| matching | _Find |
" C.ollec.tion Zones Showing 0 of 0 records
« Licensing 5 N - "
# [ Collection Zone Hame Collection Host Description Devices
ROWs per page: I 10 = <] <] Zoto page: Il of1 [ [0
o
=
| Create || Edit || Delete || Devices | @
—

To Create a collection zone, proceed to Step 3. To Edit a collection zone, proceed to Step 6. To Delete
a collection zone, proceed to Step 8. To display the Devices, proceed to Step 11.

From Figure 9-25, without checking any check boxes, click the Create button.

A window as shown in Figure 9-26, “Create Collection Zone,” appears.

[ oL-10727-01
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Step 5

Step 6

Step 7
Step 8

Step 9

Step 10

Step 11

Step 12

Figure 9-26 Create Collection Zone

Create Cellection Zone

u
Mame :

Drescription: Created on Sat Now 19 00:11:15 PST 2005
EBy efgh-ultra. cisco. com

Colection Host: | efgh-ultra.cisco.com x|

149155

Mote: = - Reguired Field

Fill in the following information:
e Name (required)

¢ Description (optional) This is automatically filled in with the creation statistics: date, time, and
creator. You can overwrite this information, add to it, or delete it altogether.

¢ Collection Host (default host appears) Click the drop-down list if you want to select a different
collection host.

Click Save. Figure 9-25 reappears, the newly created collection zone is added, and a Status appears with
a green check mark for Succeeded. You can repeat Step 3 to Step 5 to create another collection zone.
For Edit, proceed to Step 6. For Delete, proceed to Step 8. To display the Devices, proceed to Step 11.

To edit a collection zone, in Figure 9-25, check the check box for the collection zone you want to edit
and then click the Edit button.

A window as shown in Figure 9-26 appears. Follow the instructions in Step 4 and Step 5.

To delete a collection zone, in Figure 9-25, check one or more check boxes for the collection zone(s) you
want to delete. Then click the Delete button.

A Confirm Delete window appears, to give you a chance to click Cancel and not delete, or to click OK
and delete.

Figure 9-25 reappears and the collection zone is removed. You can repeat Step 8 and Step 9 to delete
more collection zones, you can proceed to Step 3 to create a collection zone, you can proceed to Step 6
to edit a collection zone, or you can proceed to Step 11 to display and assign devices.

To display, add, or delete devices, in Figure 9-25, check a check box for the desired collection zone.
Then click the Devices button.

A window appears as shown in Figure 9-27, “Collection Zone Devices.” This window shows the current
devices assigned to the selected collection zone.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 13

Step 14

Step 15
Step 16

Licensing

Step 1

Step 2

Control Center W

Figure 9-27 Collection Zone Devices

Collection Zone Devices

Showr Devices with | Any - matching ©
Showring 1-1 of 1 records
it Device Name Collelt\:]tion o IF Address Role Type
ame
1. newdevicel null CE IE2100

Rows per page: |10 =

93849

To add a device, click Add; to delete devices, select the devices you want to delete from those shown
and click Delete (this happens automatically with no chance to reconsider, but you can add it back in
with another Add process); to accept what is listed, click OK; or to cancel, click Cancel.

If you click Add, you get a window with all the devices in the database. You can filter the list and from
the listed choices you can select one or more devices to add to the selected collection zone. Then click
Select.

Figure 9-27 reappears with the updated device information for the selected collection zone.

When Figure 9-27 has all the devices you want, click OK and Figure 9-25 reappears with the updated
information.

Choose Administration > Control Center.

To install license keys, follow these steps:

From Control Center, choose Licensing from the TOC in the left column, as shown in Figure 9-28,
“Choose Control Center > Licensing.”

Figure 9-28 Choose Control Center > Licensing
Hosts
el
nHosts _Refresh |
« Gollection Zones Showing 1 - 1 of 1 record
- Licensing # | Mame Role Start Time Stop Time Running
1. [ efgh-utra.cisco.com Master Oct 27 04:19:56 PM PDT LIMKM OV es
Rows per page: I 10 = <] <] Zoto page: Il of 1 Bl
n
13}
| Details || Config || Servers || Watchdog || || Unirstall || Logs | §
—

From the Installed Licenses table, click the Install button, as shown in Figure 9-29, “Installed
Licenses.” The Installed Licenses table explains the current statistics. The columns of information tell
the Type of license keys you have installed (which can include ACTIVATION, API-L2VPN,
API-L3MPLS, L2VPN, L3MPLS/VPN,MPLSDIAG, QOS, TE, TE/BRG, TE/RG, VPLS, VPN); the

[ oL-10727-01
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Note

Note

Step 3

Size, which is valid for the ACTIVATION (licensed maximum global count of services), TE (number
of TE-enabled nodes), or the VPN (maximum number of VPNs licensed); the Usage, which gives the
number currently used for the rows; and the Date Updated, which reflects the refresh of the license
usage (on an hourly basis, by default).

When you purchase Traffic Engineering Management (TEM), you automatically receive TE, TE/BRG,
and TE/RG licenses. All of these licenses must be installed to have access to all the Cisco ISC TEM
features, including Planning Tools for protection planning (backup tunnels). The TE license serves as
an activation license for the maximum number of TE-enabled nodes to be managed by TEM (you
purchase licenses and upgrade licenses based on a range of nodes); the TE/RG license enables primary
tunnel placement; and the TE/BRG license enables the Fast ReRoute (FRR) protection function.

Click Refresh to give the most current status.

Figure 9-29 Installed Licenses

Installed Licenses

Type Size  Usage Date Updated

AGTIVATION 25 2005-11-18 23:42
AP L2 2005-11-18 23:42
AP|-L3MPLS 2005-11-18 23:42
L2%Pr 2005-11-18 23:42
L3P LEAP N 2005-11-18 23:42
MPLSDI &G 2005-11-18 23:42
QoS 2005-11-18 23:42
TE 23 2005-11-18 23:42
TEBRG 2005-11-18 23:42
TERG 2005-11-18 23:42
WPLS 2005-11-18 23:42
WP a0 53 2005-11-18 23:42

| Refresh | | Install |

149156

In the resulting window, as shown in Figure 9-30, “Enter License Key,” enter a License Key that you
received on your Right to Use paperwork with your product.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 4

Step 5

Note

Active Users W

Figure 9-30 Enter License Key

Install a License Key

License Keyx:

Sanve Cancel

149157

Mote: * - Required Field

Click Save. Your newly installed license appears in an updated version o f the Installed License table, as
shown in Figure 9-29, “Installed Licenses.”

Repeat Step 2, Step 3, and Step 4 for each of the Right to Use documents shipped with your product.

When you receive multiple Right to Use documents to upgrade either the ACTIVATION License, which
activates and sets the maximum global count of the services, or VPN licenses, which activates and set

the maximum number of VPNs, be sure to enter the licenses in the correct order. For example, if you are
upgrading from 500 to 3000 global count of the services and there are two steps to get there, enter the

license to upgrade from 500 to 1500 and then the license key to upgrade from 1500 to 3000.

Active Users

Step 1

This section explains how to communicate with active users.

Choose Administration > Active Users and follow these steps:

After you choose Administration > Active Users, a window that shows the currently logged users
appears, as shown in Figure 9-31, “Active Users.”

Figure 9-31 Active Users

Active Users

Show Sctive Users with | User 1D ] matching | | Fird |
Showving 1 - 1 of 1 record
LA User ID Device Host Hame Login Time Last Access Tine
1. [ admin efgh-ultra.cisco.com §:41:53 PM PST 1171805 12:33:52 &AM PST 1171905
Rows per page: | 10 =] N] ﬂ Goto page: II of1 b bl

Autc Refresh: IT Dizconnect

149158
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Step 2

A

In Figure 9-31, if you have the privileges of SysAdmin or UserAdmin, you can disconnect one or more
users. Check the check box next to each user you want to disconnect. Then click the Disconnect button
at the bottom of the window.

Caution

Step 3

The current login sessions for the disconnected users are terminated and their work is lost.

To exit this list of all active users, choose another feature from the main product tabs.

User Access Log

This section shows a detailed report of every activity by every user.

Step 1

~

Note

Choose Administration > User Access Log and follow these steps:

After you choose Administration > User Access Log, a window appears as shown in Figure 9-31,

“Active Users.”

Figure 9-32

User Access Log Viewer with Simple Filter

User Access Log Viewer

* SimpleFitter ¢ Advanced Filter

Find

Filter By: Date j Matches: I"
Showing 1 - 10 of 246 records
# Date Time U=er Name Crigin Host Action Ohject Severity Activity Wessage
1. 20051118 233449 backendadm Logon User INF O Security Activity Login successfully.
2.2005M1M8 23:30:56  hackendadm Logon User IMFC Securitydctivity Login successfully.
Fole newroled
3.2005M1M8 225343 admin efgh-ultra.cisco.com  Delete Role IMF SecuritySctivity (id=265810285) is
deleted.
Fole newroled
4. 20051118 22:49:15  admin efgh-ultra.cisco.com  Create Rale IMFC SecuritySctivity (id=265810285) is
created.
Group nemgroupd
5.2005M1M8 2210:38  admin efgh-ultra.cisco.com  Create Group IMF Securitydctivity (id=1203533294) is
created.
Role SysAdminRole
B.2005M1M8 21:46:26  admin efgh-ultra.cisco.com  Modify Rale IMFC Security&ctivity (id=-1234592039) is
modified.
User newd
F.2005M1M8 21:46:25  admin efgh-ultra.cisco.com  Create User IMF Securitydctivity (id=1734273524) is
created.
User newd
5. 2005M1M8 21:45:22  admin efgh-ultra.cisco.com  Delete User IMFC Securitydctivity (id=1734273524) is
deleted.
Role SysAdminRole
9.2005M1M8 21:44:59  admin efgh-ultra.cisco.com  Modify Role IMF SecuritySctivity (id=-1234592039) is
modified.
User newd
10,2005 1M8 21:44:58  admin efgh-ultra.cisco.com  Create User IMFC Securitydctivity (id=1734273524) is
created.
Rows per page: [ 10 x| <] <] Zoto page: Il of 25 (Ga) [» [p]

All the log information about user actions appears.

149159

The types of activities or objects to be logged can be configured. This can be done directly through SQL.
By default, security-related activities and activities on objects listed in the Role editor are logged.
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User Access Log W

Step2  The default Simple Filter radio button is selected. To filter using the Simple Filter, continue with
Step 3. To filter using Advanced Filter, proceed to Step 5.

Step3  To filter the information with Simple Filter, keep the Simple Filter radio button selected and from
Filter By, choose: Date, User Name, Origin Host, Action, Severity, or Activity (also column names).
For Matches, enter the beginning characters of what you want to match followed by *. Then click Find.
The result is that only the log information matching the entered filter appears.

Step4d  To exit this log report, choose another feature from the main product tabs.

Step 5 To filter the information with Advanced Filter, click the Advanced Filter radio button. A window as
shown in Figure 9-33, “User Access Log Viewer with Advanced Filter,” appears.

Figure 9-33 User Access Log Viewer with Advanced Filter

User Access Log Viewer

¢ simpleFilter % Advanced Filter Find
Date: l— Action: I—j

User Name: I"— Severity: Iﬁ

Device Host Mame: I"— Activity: Iﬁ

Service Reqguests Select/Deselect
Showing 1 - 10 of 246 records
# Date Time User Marme Crigin Host Action Ohject Severity Activity Message
1.2005M1M8 23:34:49  backendadm Logon User IMF Securitydctivity Login successfully.
2.2005M1M8 23:30:56  backendadm Logon User IMFC Securitydctivity Login successfully.
Fole newroled
3.2005M1M8 225343 admin efgh-ultra.cisco.com n Delete Role IMF SecuritySctivity (id=265810285) is
deleted.
Fole newroled
4. 2005M1M8 22:49:15  admin efgh-ultra.cisco.com n Creste Rale IMFC SecuritySctivity (id=265810285) is
created.
Group nemgroupd
5.2005M1M8 2210:35  admin efgh-ultra.cisco.com n Create Group IMF Securitydctivity (id=1203533294) is
created.
Role SysAdminRole
B.2005M1M8 21:46:26  admin efgh-ultra.cisco.com n Modify Rale IMFC Security&ctivity (id=-1234592039) is
modified.
User newd
F.2005M1M8 21:46:25  admin efgh-ultra.cisco.com n Create User IMF Securitydctivity (id=1734273524) is
created.
User newd
5. 20051118 21:45:22  admin efgh-ultra.cisco.com n Delete User IMFC Securitydctivity (id=1734273524) is
deleted.
Role SysAdminRole
9.2005M1M8 21:44:59  admin efgh-ultra.cisco.com n Modify Role IMF SecuritySctivity (id=-1234592039) is
modified.
User newd
10, 20054118 21:44:58  admin efgh-ultra.cisco.com n Creste User IMFC Securitydctivity (id=1734273524) is
created.
a
—
Rows per page: [ 10 x| 1<] ] Goto page: Il of 25 Bl @
) —

All the log information about user actions appears.

Step6  Enter filter information you want to match in one or more of the following categories and then click
Find.

Note  When you choose multiple filters, the log results that appear are only the ones that match all the specified
filter information.

¢ Date Enter the beginning characters of the date you want to view followed by a *, in the format given
in the Date column.

e User Name Enter the beginning characters of the specific User Name you want to view followed
by a *.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 7

Step 8

¢ Device Host Name Enter the beginning characters of the specific Host Name you want to view
followed by a *.

e Action Click the drop-down list and choose from: UNKNOWN; View; Create; Modify; Delete;
Logon; Logoff; Session Timeout. If you decide not to use this filter, just keep *.

e Severity Click the drop-down list and choose from: UNKNOWN; INFO; WARNING; ERROR. If
you decide not to use this filter, just keep *.

e Activity Click the drop-down list and choose from: UNKNOWN; SecurityActivity; or
UserActivity. The result is that only the log information matching the entered filter appears.

Service Requests has a selection of Select/Deselect. Click this and you receive a list of Service Requests
in the system from which you can check check box(es) for the User Access Log to handle. Then click
the Select button. These Service Requests then appear on Figure 9-33.

To exit this log report, choose another feature from the main product tabs.

Manage TIBCO Rendezvous

Step 1

Step 2

Step 3

The only reason you would ever use this functionality is if you change the TIBCO ports for TIBCO
Rendezvous Agent (rva) or TIBCO Rendezvous Routing Daemon (rvrd) after installation. The changes
being made here only affect the topology tool, a Java WebStart application.

Choose Administration > Manage TIBCO Rendezvous and follow these steps:

After you choose Administration > Manage TIBCO Rendezvous, a window appears as shown in
Figure 9-34, “TIBCO Rendezvous.”

Figure 9-34 TIBCO Rendezvous

TIB/Rendezvous

Agent for Java -7.13

lefgh-ultra]

20023-06-18 22:50:05

State: Component Information
information ;
- corrponent: ra
" N vErsion: 713
Configuration: | |)ionse ticket: 65509
host narme: efgh-ultra
change state | ||p agdress: 128.107.128.130
security client port: 7600
connection htt tunnel: enabled on main port
subjects state: running
htip tunnel | [total clients:
certificates direct clients: i)
tunnel clients: 1}
Miscellaneous:
copyright
web home

95362

From Figure 9-34, click connection, as described in Step 3; and click change state, as described in
Step 4. These are choices in the left column of Figure 9-34.

In Figure 9-34, when you click connection, a window such as Figure 9-35, “Connection Configuration,”
appears.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 4
Step 5
Step 6

Step 7
Step 8

Manage TIBCO Rendezvous I

Figure 9-35 Connection Configuration

Connection Configuration

| Accepl Client Connections on Listen Port: [7500 |

TIB/Rendezvous Daemon Connection:
service: 7a30

network:

daemon:

Subrnit | Hesetl

95261

If you must change the rva port number from the existing value, change the Accept Client Connections
on Listen Port: field to your new rva port number for ISC. If you must change the rvrd port number
from the existing value, change the service field to your new rvrd port number for ISC. Then click
Submit. Then Figure 9-35 returns with the new value and a note that says “Configuration change will
take effect after RVA is re-activated. To re-activate RVA set it into idle state and then back to active
state.”

In Figure 9-34, click change state, follow the instructions, and you complete this functionality.
From a terminal window, change to the bin directory of your ISC installation, such as /opt/isc-4.2/bin.
Source the ISC environment:
e C Shell - use the command source ./vpnenv.csh
e K Shell or Bash - use the command . ./vpnenv.sh
To start the script, at the command line type updateWebStartJars.

The next time you start a Java WebStart, such as the topology tool, these changes are in effect.

[ oL-10727-01
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APPENDIX A

Cisco CNS IE2100 Appliances

Cisco IP Solution Center (ISC) supports the Cisco CNS IE2100 Device Access Protocol for
communication with any Cisco IOS device, such as uploading a configuration file from a device,
downloading a configlet to a device, or executing a command on a device and obtaining a result. ISC
also supports CNS Plug-and-Play.

To use the Cisco CNS IE2100 functionality on ISC, you must first set up the Cisco CNS IE2100
appliance and the ISC workstation as explained in an appendix in the Cisco IP Solution Center
Installation Guide, 4.2.

This appendix includes the following sections. Implement these sections in sequence:

The “Using Plug-and-Play” section on page A-7 is optional.

1. Creating a Cisco CNS IE2100 Appliance, page A-1
2. Creating a Cisco IOS Device Using the Cisco CNS Device Access Protocol, page A-3
3. Using Plug-and-Play, page A-7

Creating a Cisco CNS IE2100 Appliance

~

Note

Step 1
Step 2

ISC supports multiple Cisco CNS IE2100 appliances. To create a Cisco CNS IE2100 appliance, follow
these steps:

For more information, see the Devices section of Chapter 3, “Service Inventory — Inventory and
Connection Manager.”

Choose Service Inventory > Inventory and Connection Manager > Devices.

A window appears as shown in Figure A-1, “Devices Window.”

[ oL-10727-01
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Creating a Cisco CNS IE2100 Appliance

Step 3
Step 4

Step 5

Figure A-1 Devices Window
Devices
ShowDevices with | Device Mame =l matching | | Find |
Showing 1 - § of 3 records
# Device Hame Management IP Address Type Parent Device Hame
1.7 & r=t Cisco 10S Device
2 & pen Cisco [0S Device
3. & = Cisco 103 Device
. & = Cisco 10 Davice
s & = Cisco 105 Device
B & c=3 Cisco 10S Device
. & cen Cisco |08 Device
8. & cels Cisco 103 Device
Rows perpage: | 10 7| [4] ] Goto page: ll_nﬂ b= 0

Create ‘.ll Edit || Delete || Config || E-rnzil || Copy |

128045

Click the Create button.
From the Create menu, click IE2100.

A window appears as shown in Figure A-2, “Create IE2100 Device Window”.

Figure A-2 Create IE2100 Device Window

General

Device Host Namex:

Device Dommain Marne:

|
|
D escrifption: |
IP Address: I

Sawe Cancel

25322

Mate: * - Reguired Field

Enter the Device Host Name and if applicable, the IE2100 Device Domain Name. The Description
field is optional. If the Cisco CNS IE2100 appliance is not registered with DNS, then you must enter the

IP Address of the Cisco CNS IE2100 appliance. Click Save.
Figure A-1 reappears with the IE2100 listed as a device.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Creating a Cisco 10S Device Using the Cisco CNS Device Access Protocol W

Creating a Cisco 10S Device Using the Cisco CNS Device
Access Protocol

Note

Step 1
Step 2
Step 3
Step 4

Each Cisco CNS IE2100 appliance can serve multiple Cisco IOS devices. A Cisco I0S device can only
be served by one Cisco CNS IE2100 appliance.To create a Cisco I0S device using the Cisco CNS Device
Access Protocol, follow these steps:

For more information, see the Devices section of Chapter 3, “Service Inventory — Inventory and
Connection Manager.”

Choose Service Inventory > Inventory and Connection Manager > Devices.
A window appears as shown in Figure A-1, “Devices Window.”

Click the Create button.

From the Create menu, click Cisco Device.

A window appears as shown in Figure A-3, “Create Cisco Device Window.”

[ oL-10727-01
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W Creating a Cisco 10S Device Using the Cisco CNS Device Access Protocol

Step 5

Figure A-3 Create Cisco Device Window

Device Host Name“:

Device Daomain Marne:

Description:

Collection Fone: I Mone j

Management IP &ddress: I

Irterfaces: Edit

8] 8]

Aezocisted Groups Edit

Login U=er;

Login Password;

“erify Login Password:

Enable User:

Enable Password:

Wierify Enable Password:

Terminal Session Protocal; I Default (Telnet) j

Config Access Protocol: I Default (Terminal) j
05 105 hd|
SMMP *ersion: IDEfEluIt (SNMP w1fvie) =]

Camrnunity String RoO: I

Camrnunity String Ry

| Sawve || Cancel |

149195

In the General section, enter the Device Host Name and Device Domain Name.

For CNS Device Access Protocol, you do not need to define the parameters in the Login User and Login

Password sections.

For the Device and Configuration Access Information section, you must choose CNS for the Terminal

Session Protocol.

For the Device and Configuration Access Information section, the only valid OS selection is 10S.
IOS_XR is not supported for Cisco CNS IE2100 appliances with ISC.

] Cisco IP Solution Center Infrastructure Reference, 4.2
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Step 6

Creating a Cisco 10S Device Using the Cisco CNS Device Access Protocol

Click the Show button for Additional Properties at the bottom of the window and this window expands
to add the additional information that is shown in Figure A-4, “Cisco Device Additional Properties,”
appears.

Figure A-4 Cisco Device Additional Properties

SMMP Security Level | Default (Mo Authentication/Mo Encryption) j

Authertication User Mame:

Authertication Password:

“erify Authentication Password:

|
|
|
A thentication Algorithira: Im
|
|
I—

Encryption Password:

“erify Encryption P assword:

Encryption Algorithm: MHane j

Terminal Server: I Hone j

Port: IEI

Fully Managed:

-
Device State; I ACTIVE j

CM = Identification:

Device Event [dentification: I CHE_ID j
Most recent GMS event: I Mone j
IE2100: Mone |
CMS Sotware Yersion: 1.4 j

2HS Device Transport: I HTTP j

Plattarmm:

Software Mersion:

Serial Mumber:

|
|
Image Mame: I
|
Dewvice Owwner's Email Address: I

| Sawe | | Cancel

Mote: * - Eeguired Field

149195
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I Creating a Cisco 10S Device Using the Cisco CNS Device Access Protocol

Step 7
Step 8

Note

Note

Step 9

Step 10

Note

Step 11

Step 12

Step 13

Step 14

The following steps pertain to the Terminal Server and CNS Options section.

Check the Fully Managed check box if you want the device to become a fully managed device. For fully
managed devices, ISC sends e-mail notifications upon receipt of device configuration changes originated
outside ISC and schedules enforcement audit tasks upon detection of possible intrusion.

Be sure to set the DCPL parameters for e-mail and Fully Managed, as explained in the “Config” section
on page 9-24. Choose Administration > Control Center. Choose a Host and then click Config. Then
in the TOC in the left column, be sure to enter appropriate information in the following fields: SYSTEM
> email > from; SYSTEM > email > smtpHost; SYSTEM > fullyManaged >
auditableCommandsFileLocation (if information is not given here, all commands are audited);
SYSTEM > fullyManaged > enforcementAuditScript; and SYSTEM > fullyManaged >
externalEventsEmailRecipients.

Verify that the cns config notify command is configured for the IOS device. This command ensures that
configuration change events, which are the basis of the fully-managed feature, are sent out on the event
bus. If this command is not configured on the device, the fully-managed feature will not work, because
there will be no config-changed events reaching ISC.

Specify the Device State, as follows:
¢ Choose ACTIVE (the default) if the router is physically present on the network.
e Choose INACTIVE if the router is not yet physically present on the network.
Specify the Device Event Identification, as follows:

¢ Choose HOST_NAME if the Device Host Name as defined in Step 5 is to be used as the CNS
Identification for this device.

e Choose CNS_ID if the device CNS Identification string is other than the Device Host Name.

e If you have selected CNS_ID as the Device Event Identification, you must enter the CNS
Identification parameter in the field labeled CNS Identification. This must be a unique argument.
It is used to create the device in the corresponding Cisco CNS IE2100 repository and to listen to
events pertaining to this device.

Verify that the cns id string {CNS_ID} event command is configured for the IOS device. If this
command is not present on the device, the IE2100 will not send out any events on the bus using this CNS
ID, and hence communication with the device will fail.

Select the Cisco CNS IE2100 appliance that serves this Cisco IOS device. Select one entry from the
drop-down list of IE2100 devices already defined in the repository.

Use the drop-down list for CNS Software Version to choose the version of Cisco CNS Configuration
Engine that manages the 10S device (1.3, 1.3.1, 1.3.2, 1.4, or 1.5).

Use the drop-down list for CNS Device Transport to choose HTTP or HTTPS as the transport
mechanism used by ISC to create, delete, or edit devices in the IE2100 repository. If HTTPS is used, the
Cisco CNS Configuration Engine must be running in secure mode.

Click Save. Figure A-1 reappears with the Cisco I0S device listed.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Using Plug-and-Play W

Using Plug-and-Play

Step 1

Step 2

Step 3

Step 1

ISC supports the Plug-and-Play device configuration through a Cisco CNS IE2100 appliance. ISC
supports devices not physically present on the network.

The procedures for using Plug-and-Play when the Cisco IOS device is not physically present on the
network vary depending on whether there is an initial configuration file for the device.

Follow these steps if the Cisco IOS device does not have an initial configuration file:

Create a Cisco IOS Device as described in the “Creating a Cisco IOS Device Using the Cisco CNS
Device Access Protocol” section.

Define the Cisco I0S device properties as shown in Figure A-4.

Be sure to specify the Device State as INACTIVE because the device is not physically present on the
network

Click Save.

A Cisco I0OS Device entry is created in the ISC repository and in the corresponding Cisco CNS IE2100
appliance repository.

Follow this step if the Cisco IOS device does have an initial configuration file:

Import the initial configuration file into ISC using the Inventory Manager functionality, explained in
Chapter 3, “Service Inventory — Inventory and Connection Manager” in this manual.

Be sure to specify the Device State as INACTIVE because the device is not physically present on the
network.

The Inventory Manager create a Cisco IOS Device entry in the ISC repository. Also, it creates an entry
in the corresponding Cisco CNS IE2100 repository, and associates the specified initial configuration file
with this new device in the Cisco CNS IE2100 repository.

You can provision the newly created inactive Cisco IOS Device for different services. Because the device
is not physically present on the network, ISC saves the configlets associated with these services in its
repository and tries to download them to the device only after the device has come up. Until the device
is physically present on the network, the service request goes into the WAIT_DEPLOY state. The
service requests are explained in the user guides for each of the services.

After the device comes up and connects to its corresponding Cisco CNS IE2100 appliance, the device
retrieves and applies its initial configuration if there is one waiting for it in the Cisco CNS IE2100
repository.

ISC detects that the device has come onto the network and performs the following actions:
¢ Changes the Cisco IOS Device state from INACTIVE to ACTIVE.
ISC performs a collect config of the IOS device and stores it in the ISC repository.

e Verifies whether any ISC service has been waiting for this device to come up and tries to download
the corresponding configlets to the device to complete the service request.
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W Using Plug-and-Play
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APPENDIX

ISC XML Reference

This appendix contains an alphabetical listing of the XML rules, tags, and attributes that are used in the
XML files used for ISC Discovery.

For a detailed description of the XML files and XML examples, see Chapter 4, “Service
Inventory—Discovery.”

Table B-1 ISC XML Rules, Tags, and Attributes
Tag Description
<as-number> Specifies the autonomous system (AS) number

for the provider. The AS number can be an integer
between 1 and 65535.

<CDP> Starts a <CDP> tag. The <CDP> tag specifies an
seed IP address and a hop count.

The <CDP> tag must contain the following
attributes:

e ipaddress

e hop

<connection> Starts a <connection> tag. The <connection> tag
must specify the following attributes:

e discovery-protocol
e fromDevice

e FromIP

e Fromlnterface

e toDevice

e toIP

e tolF

<create-customer> Starts a create-customer rule. The
create-customer rule creates a region object. the
create-customer rule must contain the following
tags:

e <customer-name>

* <create-site>

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table B-1 ISC XML Rules, Tags, and Attributes (continued)
Tag Description
<create-provider> Starts a create-provider rule. The create-provider

rule creates a service provider object.

The create-provider rule must contain the
following tags:

e <provider-name>
e <as-number>

e <create-region>

<create-region> Starts a create-region rule. The create-region
rule creates a region object. The create-region
rule must contain a region-name tag.

<create-site> Starts a create-site rule. The create-site rule must
contain a <site-name> tag.

<customer-name> Specifies a customer name. Required within the
create-customer rule.

<device> Starts a <device> tag. The <device> tag must
contain the following tags:

e <device-name>
e <ip-address>

The following tags are optional within the
<device> tag:

e <system-object-id>

e <snmp-info>

<device-name> Specifies the name of the device. Required within
the <device> tag.

<DISCOVERY_METHOD> Starts a <DISCOVERY_METHOD> tag. The
<DISCOVERY_METHOD> tag must contain a
<CDP> tag.

discovery-protocol Specifies the Discovery protocol used to discover

the network topology. Normally, this is “CDP.”

fromDevice Specifies the name of the device from which the
Named Physical Circuit starts. Required attribute
for the <connection> tag.

FromInterface Specifies the name of the device interface from
which the Named Physical Circuit starts.
Required attribute for the <connection> tag.

FromIP Specifies the management IP address of the
device from which the Named Physical Circuit
starts. Required attribute for the <connection>
tag.
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Table B-1 ISC XML Rules, Tags, and Attributes (continued)
Tag Description
hop Specifies the number of hops from the device

identified by the ipaddress attribute to go in
discovering devices. Required attribute for the

<CDP> tag.
ipaddress Specifies the IP address of a seed device.
Required attribute for the <CDP> tag.
<ip-address> Specifies the IP address of the device. Required
within the <device> tag.
<provider-name> Specifies the name of the provider.
<region-name> Specifies the name of a region.
<ro-community> Specifies the level of SNMP access for the device.

Normally, this should be “public.” Required
within the <snmp-info> tag.

<site-name> Specifies a site name.

<snmp-info> Specifies SNMP information for the device. The
<snmp-info> tag must contain a
<ro-community> tag. Optional within the
<device> tag.

<system-object-id> (optional) Can be included to specify the SNMP
Object ID (OID) for the device. If this is provided,
it is specified within the <device> tag.

toDevice Specifies the name of the device to which the
Named Physical Circuit connects. Required
attribute for the <connection> tag.

toIF Specifies the device interface on the device to
which the Named Physical Circuit connects.
Required attribute for the <connection> tag.

toIP Specifies the management IP address of the
device from which the Named Physical Circuit
connects Required attribute for the <connection>
tag.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Property Settings

To navigate to the properties, known as Dynamic Component Properties Library (DCPL), navigate to the
tab Administration > Control Center > Hosts. Then select a check box for a specific host and click the
Config button.

Note  More details about this are explained in the “Config” section on page 9-24.

When you click on the folder or subfolder, it expands to more subfolders or eventually to the property
itself. Then you receive an explanation, default values, and in some cases range and rules. This table can
help you understand all the properties available at a glance. The properties are listed alphabetically.
When a / ends an entry, this means it can be expanded further. Also, if you are searching for a property
and do not know the name, you can use some key words and do a Find on the pdf version.

Table C-1 DCPL Properties

Property Default Value Range/Rules |Explanation
AutoDiscovery Properties: Controls the operation of Autodiscovery.
/DiscoveryTemplateFolder /Discovery string Template folder under which the

templates to be discovered for MPLS
VPN Discovery will reside.

/TopologyHandler Default string This property points to the topology
handler for the discovery run.
/createVpnAndCustomerFromVRFName |true The valid This property controls whether the VPN
values are and Customer objects can be created from

true and false. |the VRF names. This is valid only in
certain scenarios when Service Providers
have maintained such a mapping.

/performTemplateDiscovery false The valid With this flag, the user can control the
values are template discovery. For performance
true and false. |reasons, if the template discovery is not
desired this should be set to false.

Cleanup Properties: Cleans up various system resources such
as log files and temporary files.

/Cleanup/TaskLogs/ This component cleans up old TaskLogs.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1 DCPL Properties (continued)

maxAgelnHours

168

integer

Maximum age of the TaskL.ogs in hours.
TaskLogs older than this age will be
deleted during the next cleanup cycle. Set
to 0 to disable this feature.

sleepIntervallnHours

24

integer,
1-1000 hours

Time in hours for taskLog cleanup
service to sleep between clean up cycles.

/Cleanup/Tasks/

This component cleans up old TaskLogs.

maxAgelnHours

integer

Maximum age of the Tasks in hours.
Tasks that have not been modified in over
maxAge hours and that have no Active
schedules will be deleted during the next
cleanup cycle. Set to 0 to disable this
feature.

sleepIntervallnHours

24

integer,
1-1000 hours

Time in hours for task cleanup service to
wait between clean up cycles. Changing
this value initiates an immediate cleanup
cycle.

/Cleanup/TempFiles/

This component cleans up old temporary
files.

maxAgelnHours

168

integer

Maximum age of the temporary files in
hours. Temporary files older than this age
will be deleted during the next cleanup
cycle. Set to O to disable this feature.

sleepIntervallnHours

24

integer,
1-1000 hours

Time in hours for tempFile cleanup
service to sleep between clean up cycles.

/Cleanup/logLevel

CONFIG

selection

This log Level is used only if there is no
log Level defined for a component. The
log Level is the level at which logging is
done for this component. These levels are
identical to the logging levels defined for
JDK1.4 logging package. The levels in
descending order are: SEVERE (highest
value) WARNING INFO CONFIG FINE
FINER FINEST (lowest value).

DCS Properties:

Device Configuration Service. This
component corresponds to a library thatis
used by ISC to communicate with
network devices using protocols such as
telnet, ssh, tftp, and so forth.

/DCS/FTP/

FTP Settings.

ftpPassword

string

Password for FTP server login, used by
DCS and GTL.

ftpRootDirectory

string

FTP root directory, used by DCS and
GTL.

ftpServer

string

FTP Server host name or IP address, used
by DCS and GTL.
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||
Table C-1 DCPL Properties (continued)
ftpSubDirectory string FTP sub directory, used by DCS and
GTL.
ftpUsername string Username for FTP server login, used by
DCS and GTL.
DCS/10SUsePrimaryWarningExprOnly false The valid If true, DCS uses only the primary
values are warning expression list, specified in

true and false. | DCS/IOSWarningExpressions. If false,
DCS uses the primary list specified in
DCS/I0SWarningExpressions for add
and modify operations and uses the list
specified in DCS/
I0SWarningExpressionsRemoveCfg
during delete (decommissioning)
operations.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1 DCPL Properties (continued)
/DCS/IOSWarningExpressions string I0S warning expressions that can be

safely ignored; case insensitive; . matches
any char except newline, * means zero or
more, + means one or more, ? means zero
or one.

All regular expressions except the last
one should have a $ at the end of the
regular expression.

%Aborting Save. Compress the config$
*Access Rules Download Complete$

% Access VLAN does not exist.$
Address aliases with.*$

% All RSA Keys will be removed.$

% All router certs issued using these keys
will also be removed.*$

% Already found same .* statement in
this profile$

% A profile is deemed incomplete until it
has match identity statements$
Jkcertificate accepted$

Certificate request sent$

.?Changes to the System MTU will not
take effect until the next reload.*$

CNS config partial agent is running
already$

% Configuration buffer full, can't add
command.*$

#Crypto EzVPN does not exist.*$

Enter configuration commands, one per
line$ Explicit Path name .*$

% Generating .* bit RSA keys$

Global .* will be Port Address
Translated.*$ Global Ethernet MTU is set
to.*$

If the interface doesn't support baby giant
frames.*$

Increasing .* burst size to$

% Interface .* IP address .* removed due
to enabling VRF$

% Interface .* IP address .* removed due
to disabling VRF$

% IP addresses from all interfaces in VRF
*have been removed$

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1 DCPL Properties (continued)

/DCS/IOSWarningExpressions (Continued) string % 1P routing table V.* does not exist.
Create first$

% IP routing table g.*does not exist.
Create first$

% No CEF interface information$

%No matching route to delete$
%Translation not found$

.*Not all config may be removed and may
reappear after reactivating$

"% .INOTE:$

OSPF: Unrecognized virtual interface .*
Treat it as loopback stub route$

outside interface address added$

% Profile already contains this keyring$
%PVC is already defined$

Restarting RADIUS authentication
service on port .*

$ Restarting RADIUS accounting service
on port .*$

Redundant .* statement$

security level for .* changed to$
#Service policy .* is already attached$
% Signature RSA Keys not found in
configuration.$

Jfsuccess$

The .*command will also show the
fingerprint$ %The static routes in .* with
outgoing interface .* will be removed$
Unable to disable parser cache$

% Unknown VPN$ .*

Unknown VREF specified$

% VRF .* does not exist or does not have
a RD$

.?warning.*

DCS/1I0SWarningExpressionsExitCfgMode string I0S warning expressions that can be
safely ignored when exiting config term
mode; regular expression must match
whole warning message; for messages
that wrap more than one line replace line
terminations (CR and/or LF chars) with a
single space character; replace each
variable field with the meta-character
sequence \\S+ that will match a single
group of non-whitespace chars; literals
are case insensitive; use $ to separate
entries.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1 DCPL Properties (continued)

DCS/I0SWarningExpressionsRemoveCfg

string

I0S warning expressions that can be
safely ignored during decommissioning;
case insensitive; . matches any char
except newline, * means zero or more, +
means one or more, ? means zero or one.

/DCS/RCP/

RCP Settings.

rcpDirectory

/tmp

string

Directory to use for
uploaded/downloaded config files.

/DCS/SSH/

SSH Client Settings.

overWriteSSHKeys

true

The valid
values are

true and false.

Overwrite SSH Keys: If true, will allow
new keys to overwrite existing keys in the
key file for a given host. If false, an error
will be displayed if host sent key does not
match the server sent key.

sshEncryptionCipher

3DES->DES

selection

Cipher to use for SSH
Encryption/Decryption; requires restart
on change. Values: 3DES->DES first tries
3DES then if not available falls back to
DES; 3DES, only tries 3DES; DES, only
tries DES.

/DCS/TFTP/

TFTP Settings.

tftpCreateFileOnServerBeforeUpload

true

The valid
values are

true and false.

Some TFTP servers require a file to exist
on the server with write access before a
TFTP client can upload it. This is
sometimes called write-replace or
overwrite mode. Other TFTP servers
require a that a file NOT exist, this is
sometimes called write-create or no
overwrite mode. When true, DCS will
create the file on the TFTP server before
uploading device configuration.

tftpRootDirectory

/tftpboot

string

TFTP Root Directory used by DCS and
GTL.

tftpServerIPAddress

string

TFEFTP Server host name or IP Address
used by DCS and GTL.

tftpSubDirectory

string

TFTP Sub Directory used by DCS and
GTL.

/DCS/XR

I0S-XR properties.

WarningExpressions

I0S-XR warning expressions that can be
safely ignored; case insensitive; . matches
any character except newline, * means
Zero or more, + means one or more, ?
means zero or one.

commitConfigTimeout

120

integer,
30-600

Maximum time in seconds to commit
config target buffer to running config.
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Table C-1 DCPL Properties (continued)
maxRetriesEnterCfgExcIMode 3 integer, 0-10 |Maximum number of times to retry
entering configure exclusive mode. 0 =no
retries. Retry delay interval is fixed at 30
seconds.

/DCS/allowCommandDownloadOnError false The valid Continue command download on error.
values are
true and false.

/DCS/cnsEventTimeout 120 integer, 0-120 |CNS event wait time in seconds
seconds

/DCS/configUploadTimeout 300 integer, Maximum time in seconds to wait for a
60-900 device configuration to be uploaded.

/DCS/logLevel CONFIG selection The log Level is the level at which

logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/DCS/maxDeviceConnectCompleteTime 60 integer, Maximum time in seconds to wait for a
15-600 terminal session connection to a device.
seconds

/DCS/maxDeviceConnectRetryCount 3 integer, 0-5 Maximum number of times to retry

connecting to a device when the
maxDeviceConnectCompleteTime
expires. 0= no retries.

/DCS/maxOperationTimeout 30 integer, 5-300 |Maximum time in minutes to wait for a
minutes device operation to complete.

/DCS/maxPromptTimeout 60 integer, Maximum time in seconds to wait for a
15-300 prompt during a terminal session with a
seconds device.

/DCS/maxSocketReadTimeout 30 integer, Maximum time in seconds to wait for data
10-300 on a socket connection read operation.
seconds

/DCS/misc Miscellaneous settings.

allowPromptCharsInBanner false The valid Controls if prompt characters, such as #
values are and >, are allowed in banners. If true, a

true and false.

minimum of 2 seconds (default of
loginSocketReadTimeout) is added to
each login. Note that selecting this option
requires “aaa authentication attempts
login n” to be set to a minimum of 2.
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Table C-1 DCPL Properties (continued)

loginSocketReadTimeout 2 integer, 1-45  |Number of seconds to WAIT for a login
authentication username or password
prompt. Applicable if
DCS\misc\allowPromptCharsInBanner is
true. Increasing this value slows down
device logins and counts against
DCS\maxDeviceConnectCompleteTime
who’s default is 60 seconds.

readBufferSize 32 integer, 4-96 |Size in KBytes of the buffers used while
reading device input streams with telnet
and SSH. Increasing size might improve
performance. Decrease size if there are
memory issues.

DeploymentFlow Property: Deployment flow Component: Used to
create a flow of different types of steps
such as mpls and qos.

/DeploymentFlow/logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

Discovery Properties: ISC auto discovery framework.

/Discovery/DeviceDiscovery
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Table C-1 DCPL Properties (continued)

continueOnError false The valid A Boolean flag indicating whether device
values are discovery should try to continue on an
true and false. |error. When the value is true, device
discovery ignores the device and attempts
to create other devices discovered. In this
case, the device discovery is marked as
SUCCESS, but indicates there were
errors. The default behavior is device
discovery is marked FAILED at the first
error encountered. This property applies
only to errors encountered during the
device creation phase of device discovery
like duplicate or missing hostnames in
case of CDP and file based discovery
options and invalid device configurations
or insufficient read permissions for
configurations files and so on, for the
configuration file based discovery option.
Any errors encountered during CDP
discovery itself or while parsing XML
files still result in the device discovery
step being marked as FAILED.
WARNING: If this property is set to true,
discovery continues if there are any
device creation errors, ignoring the
device that caused the error, but only
partial NPCs and services are discovered.

logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1 DCPL Properties (continued)

mgmtlpAddressLoopkupPattern string A comma separated list of interface name
patterns to look for to determine the
management IP address of the device
discovered using the import configuration
option. The configuration is parsed for
the interface information, and the first
available IP address of the interface from
the given list is used as the management
IP address of the device. For example, if
the IP address of the loopback O interface
should be used as the management IP
address, the value of the property should
be set to “loopback(”. If the first
available loopback should be used, set the
value of the property to “loopback”. A
comma separated list can be specified as
“Loopback0,Ethernet0”. In this case, the
first available IP address among the list of
interfaces specified in that order is used
as the management IP address.

/Discovery/DataCollection

continueOnError false The valid A Boolean flag indicating whether data
values are collection should try to continue on an
true and false. |error. When the value is true, the data
collection step does not collect discovery
data for the failed device, but attempts to
collect configuration for other devices
discovered. In this case, the configuration
collection step is marked as SUCCESS,
but indicates there were errors. The
default behavior is discovery data
collection step is marked FAILED at the
first error encountered. WARNING: If
this property is set to true, discovery
continues if there are any collection or
parsing errors, ignoring the device that
caused the error, but only partial NPCs
and services are discovered.

logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
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Table C-1 DCPL Properties (continued)

reuseConfigsIfAvailable false The valid If the Boolean flag is true, the discovery
values are data collection step uses the config from
true and false. |the repository if available. If the configs
are not in the repository, an attempt is
made to contact the device to collect the
current running configuration. The
default behavior is discovery tries to
collect the current running configs from
the device.

/Discovery/MPLSService MPLS services discovery.

logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/Discovery/MetroEService Metro Ethernet services discovery.

logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

meConfigParsingRegistry string List of handlers to be invoked at collect
config time for Metro Ethernet services.

meDiscoverIntraPopVPWS false The valid Set this to true if local switched VPWS
values are services are to be discovered. Do this only
true and false. |if you wish to discover VPWS services
switched at NPE. If not, set this to false
for performance reasons.

/Discovery/NPCDiscovery NPC discovery.

logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/Discovery/RoleAssignment
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Table C-1 DCPL Properties (continued)

logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/Discovery/Workflow

ISC auto discovery workflow.

logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/Discovery/configs.location

<vpnsc_tmp>/
Discovery/
configs

The directory name where the temporary
device configurations are stored during
the collect config process.

/Discovery/logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/Discovery/logLocation

vpnsc_tmp>/
Discovery/
logs

string

The directory name where discovery logs
files are kept.

/Discovery/restart

false

The valid
values are

true and false.

With this property, you can clear out all

network objects from the repository that
was created by the Discovery process and
you can restart the Discovery process. Be
very cautious in setting this value to true.

/Discovery/tmpdir

<vpnsc_tmp>
/Discovery

string

A directory to store the temporary results
of the discovery process.

DistributionFramework Properties:

Distribution Framework. This component
handles the distribution of work (jobs)
between different servers in a ISC
distributed installation.

/DistributionFramework/Dispatcher/

Service that dispatches jobs to workers.

DefaultUnitDuration

1000

integer

The unit duration (in milliseconds) used
to estimate jobs without a profile.

Pinglnterval

1000

integer

The interval (in ms) dispatcher pings the
workers to get the load.
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Table C-1 DCPL Properties (continued)

ProcessorEpsilon 10 integer If two proccessors differ in usage by an
amount less than this, they are considered
identical from the point of view of the
load balancer.

ProfileUpdateThreshold 10 integer The percent change of a profile that
triggers an update of the dispatcher.

logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/DistributionFramework/NamingHost <master_server> |string The hostname or ip address of the name
server.

/DistributionFramework/NamingPort <naming_port> |string The port of the name server.

/DistributionFramework/RemoteUtil/ Layer abstracting the remote call
functionality.

logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/DistributionFramework/ServiceLauncher/ Manages the execution of multiple
services in the same VM.

logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/DistributionFramework/ThreadPool/ Thread pool component used by the
worker to execute jobs.

logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

Cisco IP Solution Center Infrastructure Reference, 4.2
[ oL-10727-m .m



Appendix C  Property Settings |

Table C-1 DCPL Properties (continued)

/DistributionFramework/Worker/ Worker.

Groups string The groups this worker belongs to. This
property is deprecated because groups are
stored in the database rather than being
provided by the worker.

ThreadPoolSize 100 integer, The maximum number of threads. Set it
25-250 to 0 to allow the pool to use as many
thread as necessary.

logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

GSAM Property: Generic Service Access Model to get an
XML dump from the repository for the
provisioning driver.

/GSAM/logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

GTL Properties: Generic Transport Layer. This library
provides an API to different jobs (such as
provisioning, collection etc.) to access
Device Configuration Service (DCS).
The jobs do not interface with DCS
directly (to access the devices), but work
with the API provided by GTL.

/GTL/CSL/ Configuration Services Layer
ios/ I0OS related properties.
cmdsRequiringDelay string List of the IOS commands that execute

asynchronously and require time to be
processed before they are reflected in the
running configuration. Matching rules:
case insensitive, .matches any char except
newline, * means zero or more, + means
one or more, ? means zZero or one.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1 DCPL Properties (continued)

delayAfterDownloadingCmd

command
name: integer,
0-1800
seconds

List of the IOS commands that require a
delay after they are downloaded using a
terminal session protocol, such as Telnet.
The character ; delimits the list elements.
The IOS command in each list element
must be followed by the character :
followed by a maximum integer of 1800,
which indicates the number of seconds to
delay, thus indicating 0-1800 seconds
(0-30 minutes). The command matching
rules: case insensitive, .matches any char
except newline, * means zero or more, +
means one or more, 7 means Zero or one.
The default is a blank field.

delayBeforeDownloadingCmd

List of the IOS commands that require a
delay before they are downloaded using a
terminal session protocol, such as Telnet.
The character ; delimits the list elements.
The I0S command in each list element
must be followed by the character :
followed by a maximum integer of 1800,
which indicates the number of seconds to
delay, thus indicating 0-1800 seconds
(0-30 minutes). The command matching
rules: case insensitive, .matches any char
except newline, * means zero or more, +
means one or more, ? means zero or one.

delayBeforeUpload integer, 0-30 | The delay in seconds to wait after
seconds downloading a configlet that contains
asynchronous commands before
uploading the new configuration.
delayBeforeWriteMem 0 integer, 0-300 |The delay in seconds to wait after
seconds downloading a configlet before
performing a write memory command.
/GTL/PAM/
args string Invocation argument to be used.
className string PAM Class name.
usePAM false The valid When the value is true, the selected PAM
values are is used for device authentication. When
true and false. |the value is false, the standard
authentication credentials are used in the
ISC repository for each device.
/GTL/device-config-access-protocol 1 integer, 1-3 Protocol to use for device configuration

uploads and downloads. 1= TERMINAL
(Use the
device-terminal-session-protocol for
config access) 2= TFTP 3= FTP.

[ oL-10727-01
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Table C-1 DCPL Properties (continued)

/GTL/device-terminal-session-protocol

integer, 1-2

Protocol to use for device terminal
sessions. 1= TELNET 2= SSH.

/GTL/echo-mode

false

The valid
values are

true and false.

Flag indicating whether to run GTL in
ECHO mode or DCS mode.

/GTL/ios/

I0S related GTL properties.

copy-running-to-startup

true

The valid
values are

true and false.

Flag indicating whether to copy running
config to startup config when
downloading configlets. Write Mem flag.

/GTL/logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/GTL/pix/

PIX related properties.

copy-running-to-startup

true

The valid
values are

true and false.

Flag indicating whether to copy running
config to startup config when
downloading configlets. Write Mem flag.

GUI Properties:

The component for GUI-based
properties.

/GUI/Common/

Generic GUI component. Use it if you do
not have any specific component
requirements, such as security or L2ZVPN.

logFileViewThreshold

10000000

integer

The maximum log file size in bytes that
can be viewed in the GUI Log Viewer.

logLevel

FINE

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/GUI/L2VPN/

L2VPN related GUI component. Use it
with L2VPN related operations only.

logLevel

SEVERE

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
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Table C-1 DCPL Properties (continued)

/GUI/MPLSOAM/ The MPLS OAM component.

logLevel FINEST selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/GUI/MplsVPN/ MPLS VPN related GUI component. Use
it with MPLS VPN related operations
only.

logLevel SEVERE selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/GUI/Performance/ For monitoring GUI performance.

logLevel INFO selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

GUI/Ping Ping related GUI component. Use it with
Ping related operations only.

logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/GUI/QoS/ QoS related GUI component. Use it with
QoS related operations only.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1

DCPL Properties (continued)

logLevel

SEVERE

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

sendAuditEvent

true

The valid
values are
true and false.

Set true to enable sending audit event for
this service.

/GUI/Security/

Security related component. This is to be
used for security purposes only.

logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/GUI/Topology/

Component related to the web start
topology application.

logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/GUI/VPLS/

VPLS related GUI component. Use it
with VPLS related operations only.

logLevel

SEVERE

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/GUI/srRefreshRate

30000

integer

The refresh rate (in milliseconds) for the
SR List screen.

/GUl/workflowSteps

<vpnsc_home>/
etc/
workflowSteps.
csv

string

The pre-defined workflow steps.
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Table C-1

DCPL Properties (continued)

/GUI/workflows

<vpnsc_home>/
etc/workflows.
csv

string

The pre-defined workflows.

JavaWebStart Properties

Java Web Start components.

/JavaWebStart/InventoryManager/

Component to create and manage
Devices.

MaxDevicesPerSaveTransaction

25

integer, 1-500

Specifies the maximum number of
devices per transaction when performing
save operation.

/JavaWebStart/TaskManager/

Component to create and monitor
scheduled tasks.

MaxDevicesPerCollectionTask

25

integer, 1-500

Specifies the maximum number of
devices per Collect Config task. More
devices can be specified for a single task
and they will be managed as such from a
user perspective. However, there may be
more than on Collect Config task created
and executed in the repository.

Logging Properties:

This contains different properties needed
by the logging framework. There are a set
of default values for logging parameters.
These values can be overridden for a
specific server.

/Logging/Defaults/

This contains the default values for the
logging framework.

logFileNumber

integer, 1-10

Maximum number of log files for a
process. Each of these files can be of size
logFileSize. When the maximum number
for log files is reached for a process, the
log files are rotated by deleting the oldest
log file for that process.

logFileSize

2000000

integer,
1000000-
10000000
bytes

Size in bytes of a single log file for a
process. Each process will have a number
of log files (see logFileNumber
property), where each of these files can
grow to this size.

logFormatter

java.util.logging.

XMLFormatter

string

Class name for the default formatter of
log records.

[ oL-10727-01
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Table C-1 DCPL Properties (continued)

logLevel

CONFIG

selection

NOTE: This log Level is used only if
there is no log Level defined for a
component. The log Level is the level at
which logging is done for this
component. These levels are identical to
the logging levels defined for JDK1.4
logging package. The levels in
descending order are: SEVERE (highest
value) WARNING INFO CONFIG FINE
FINER FINEST (lowest value).

logLocation

<vpnsc_tmp>

string

The directory name where log files are
kept.

/Logging/TaskLogs/

This contains logging properties for task
logs.

logLocation

<vpnsc_tmp>/
TaskLogs

string

The directory name where all the task
logs are kept.

Provisioning Properties:

Contains properties and components for
service provisioning like MPLS VPNs.

/Provisioning/Engine/

Contains properties for the XML driven
provisioning engine.

logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

serviceSchema

service.xsd

string

Specifies the XML schema definition file
for defining new services.

/Provisioning/NOM/

Network Object Model for parsing and
delta generation of configs.

DocumentBuilderFactory/

This contains the properties for the DOM
builder factory.

ignoreComments

true

The valid
values are

true and false.

Flag.

ignoreWhiteSpace

false

The valid
values are

true and false.

Flag for DOM builder factory.

validation

false

The valid
values are

true and false.

Flag for validation of xml files.

catSyntaxFile

catSyntax.xml

string

Contains the XML for Catalyst command
syntax.
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Table C-1 DCPL Properties (continued)

explicitlyRemoveRouteTargets

false

The valid
values are

true and false.

Normally (false), the “no ip vrfname”
automatically cleans up all its
subcommands in IOS. There is no need to
clean up each one of the subcommands
before taking away the parent command.
By setting this value to true, ISC
explicitly cleans up all router target
cubcommands before removing the “ip
vrfname”.

iosSyntaxFile

iosSyntax.xml

string

Contains the xml syntax for IOS
command.

logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/Provisioning/PasswordManagement/

User generated Password generation

PasswordFormula/

User generated Password formula
generation class

class

string

User generated class file

/Provisioning/ProvDrv/

Contains properties for the XML driven
provisioning ProvDrv.

AuditJITUpload

true

The valid
values are

true and false.

If the value of this property is set to false,
the provisioning server does NOT upload
a copy of the configuration file from the
routers when it processes the Service
Request for auditing purpose. Instead, it
uses copies of the configuration files that
were collected and stored in the
Repository earlier. If the value of this
property is set to true, the provisioning
server uploads a copy of the configuration
file from the routers when it processes the
Service Request for auditing purpose.
The default value of this property is true.

CleanStagedConfigletWhenForceDeploy

false

The valid
values are

true and false.

If this value is true, when a service
request is force deployed, the staged
configlet is removed before provisioning.
If this value is the default of false, the
staged configlet is considered as part of
the base configuration during
provisioning.

[ oL-10727-01
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Table C-1 DCPL Properties (continued)

DownloadTemplateToUnmanagedDevice

false

The valid
values are

true and false.

If this value is true, for an unmanaged
device, ISC attempts to download just the
template. The configlet generated by the
provision is not part of the download. By
default, this value is false and then there
is no attempt to download to an
unmanaged device.

MaxNumberOfDevicesPerDownload

100

integer

ISC will try to bundle as much devices as
possible during a download attempt. This
value set the max number of devices
allowed during such an attempt. If the
number of devices exceeds this limit,
multiple download attempts will take
place. You should decrease this limit if
the download involves many devices with
huge configlets in order to conserve
memory usage.

ProvisionJITUpload

true

The valid
values are

true and false.

If the value of this property is set to false,
the provisioning server does NOT upload
a copy of the configuration file from the
routers when it processes the Service
Request for provisioning purpose.
Instead, it uses copies of the
configuration files that were collected
and stored in the Repository earlier. If the
value of this property is set to true, the
provisioning server uploads a copy of the
configuration file from the routers when it
processes the Service Request for
provisioning purpose.

SaveConfigletsFromAlISRs

true

The valid
values are

true and false.

If the value of this property is set to true,
for each device in a SR, the provisioning
server will save the configlet contributed
from all SRs that are processed in the
same provisioning run. If the value is set
to false, only the configlet contributed by
the current SR is saved for this device in
this SR even though this same device may
be in multiple SRs that are processed by
the same provisioning run.

logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
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Table C-1

DCPL Properties (continued)

/Provisioning/Service/

Contains different services and their
properties.

QoS/ QoS Provisioning Service related
properties section.
enableLogging true The valid When the value is the default of true,
values are debugging of logging is enabled for this
true and false. |service.
When the value is false, debugging of
logging is not enabled for this service.
managementLanAddress 0.0.0.0/0 string Management LAN address in the format
of a.b.c.d/x. This will become the default
value in QoS Policy’s
TrafficClassification’s
Mgmt_lan_addr_mask field.
platform/ Used by ProvDrv.
CISCO_ROUTER/ Used by ProvDrv.
serviceBladeClass com.cisco.vpnsc. |string Identifies ServiceBlade class name for
prov.qos. ProvDrv.
ServiceBlade.
QosServiceBlade
sendAuditEvent true The valid Set true to enable sending audit event for
values are this service.
true and false.
TE/ Traffic Engineering Provisioning Service
related properties section.
enableLogging true The valid When the value is the default of true,
values are debugging of logging is enabled for this
true and false. |service.
When the value is false, debugging of
logging is not enabled for this service.
platform/ Used by ProvDrv
CISCO_ROUTER/ Used by ProvDrv
serviceBladeClass com.cisco.vpnsc. |string Identifies ServiceBlade class name for
prov.te. ProvDrv.
ServiceBlade.
TeServiceBlade
sendAuditEvent true The valid Set true to enable sending audit event for
values are this service.
true and false.
Uds/ User defined services.
platform/ Service platform

CISCO_ROUTER/

Cisco router

[ oL-10727-01
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Table C-1 DCPL Properties (continued)

serviceBladeClass

com.cisco.vpnsc.
prov.uds.Uds
ServiceBlade

string

Uds Service Blade.

12vpn/

MPLS Layer 2 VPN Provisioning.

DownloadWeights/

Specifies the download weights for
different devices in an L2VPN service
request. The higher the weight, the sooner
we download to that device. By default
the weights are set to 0, so that all devices
get downloaded at the same time during
service deployment.

weightForCE

integer

Download weight for CE devices.

weightForPE

integer

Download weight assigned to PE devices.

weightForPE_CLE

integer

download weight for PE_CLE devices.

platform/

Contains properties for L2ZVPN for
different platforms.

CATOS/

Service blade parameters for CATOS.

serviceBladeClass

com.cisco.vpnsc.
prov.12vpn.L2VP
NServiceBlade

string

ServiceBladeClass location.

CISCO_ROUTER/

IOS.

serviceBladeClass

com.cisco.vpnsc.
prov.2vpn.L2VP
NServiceBlade

string

ServiceBladeClass location.

dataFileSchema

12vpnData.xsd

string

Layer 2 VPN Data File schema.

logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

parseConfigAfterProvisioning

false

The valid
values are

true and false.

This property controls the parsing of the
configuration file after the provisioning is
completed in order to make sure that

device inventory is in sync with network.

saveDebugData

true

The valid
values are

true and false.

If this property is set to true, whenever an
SR is provisioned, the uploaded config
files and input XML data are saved to a
temporary directory for debugging
purposes.

sendAuditEvent

true

The valid
values are

true and false.

Set true to enable sending audit event for
this service.
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Table C-1 DCPL Properties (continued)

serviceFile 12vpnService.xml |string Layer 2 VPN Service definition file.

logLevel/ SEVERE selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

mpls/ Contains properties for MPLS/BGP
Layer 3 VPN service.

DownloadWeights/ Specifies the download weights for
different devices in an MPLS-VPN
service request. The higher the weight,
the sooner we download to that device.
By default the weights are set to 0, so that
all devices get downloaded at the same
time during service deployment.

weightForCE 0 integer Download weight for CE devices.

weightForMVRFCE 0 integer Download weight for MVRFCE. The
higher the weight the sooner we
download to this device while deploying a
service request.

weightForPE 0 integer Download weight assigned to PE devices.

weightForPE_CLE 0 integer Download weight for PE_CLE devices.
platform/ Platform related classes.

CATOS/ Service blade parameters for CATOS.

serviceBladeClass com.cisco.vpnsc. |string ServiceBladeClass location.
prov.mpls.MplsS
erviceBlade

CISCO_ROUTER IOS.

serviceBladeClass com.cisco.vpnsc. |string ServiceBladeClass location
prov.mpls.MplsS
erviceBlade

allowDuplicateIpAddressForPPPo false The valid Provision PPPOATM by allowing
ATM values are duplicate IP addresses for MPLS Service
true and false. |Requests. Ignore duplicate IP address on
Loopback and Multilink interfaces.

Cisco IP Solution Center Infrastructure Reference, 4.2
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true and false.

|
Table C-1 DCPL Properties (continued)
allowOverwriteManualAssigned false The valid Allow manually-assigned IP address in
Address values are Service Request overwrite the
true and false. |pre-existing interface IP address. False
means if an MPLS service request tries to
provision a manually-assigned IP address
to an interface that already has a different
IP address on it, ISC detects that and
reports the error. True means ISC allows
the new IP address to overwrite the
existing IP address.
allowShared VLAN Modification false The valid For residential services, if the flag is on,
values are true, shared VLAN attributes are
true and false. |available for modify in edit mode. If the
flag is off, false, attributes are in read
only mode.
auditlpAddressViaUnnumbered false The valid When the value is the default of false, the
values are auditor only looks for the IP address of a
true and false. |provisioned interface. When the value is
true, the auditor tries to match the IP
address of the unnumbered interface, if
one exists.
auditMaxrouteThreshold true The valid This property controls whether an audit
values are will be run on the Max Route Threshold
true and false. |for a Service Request. This is needed to
maintain backward compatibility.
auditPartial Commands false The valid This property is set for the
values are autodiscovered systems containing a
true and false. |superset of the commands that ISC
supports.
dataFileSchema 13vpnData.xsd string Specifies the schema for the data XML
file for MPLS/BGP layer3 VPNs.
forceRemoveNonBroadcastStatic false The valid The default value is false.
RouteOnPE values are When the value is set to true, ISC
true and false. .
removes the non-broadcast type static
route command that has a pre-existing
long syntax, even if the command was not
provisioned by ISC. The non-broadcast
type static route command is removed
from a PE router prior to provisioning.
Long syntax contains both an outgoing
interface name and a next hop IP address.
ignoreLoopbackWhileRemovingVRF |false The valid Remove a VRF, even when some
values are Loopback interfaces are still pointing to

it.
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Table C-1 DCPL Properties (continued)
logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
parseConfigAfterProvisioning false The valid This property controls the parsing of the
values are configuration file after the provisioning is
true and false. [completed in order to make sure that
device inventory is in sync with network.
passAuditForNonBroadcastStatic false The valid When this property is set to true, the ISC
RouteOnPE values are auditor does not generate an error
true and false. |message if the static route was found with
a different format (such as, a PE interface
name instead of a CE IP address).
passIpAddressAuditWhenNoAddress |false The valid Pass the IP address command auditing if
Detected values are uploaded router config does not contain
true and false. |an IP address. This is to prevent the audit
failure from appended template blob
overwriting the provisioned IP address
command.
reapplylpAddress false The valid Re-apply the same IP address to the
values are interface when decommission a service
true and false. |request. This option is only applicable to
manually-assigned IP addresses. It does
not work for automatically-assigned IP
addresses. When this property is in effect,
the interface negate command will not be
generated.
removeSublnterface true The valid Removing the ISC generated subinterface
values are commands in decommission service
true and false. |requests.
saveDebugData true The valid If this property is set to true, whenever an
values are SR is provisioned, the uploaded config
true and false. |files and input XML data are saved to a
temporary directory for debugging
purposes.
sendAuditEvent true The valid Set true to enable sending audit event for
values are this service.
true and false.
serviceFile 13vpnService.xml |string Specifies the XML file containing the
service definition for MPLS/BGP layer3
VPNs. The schema for this file is
specified by
Provisioning.Engine.serviceSchema
Cisco IP Solution Center Infrastructure Reference, 4.2
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skipIpAddressValidationOn false The valid When the value is false, the IP addresses
UnmanagedCE values are between a PE and an unmanaged CE are
true and false. |validated to ensure they are in the same
subnetwork and valid host addresses.
When the value is true, this validation is
bypassed.
useNextHopAddressForStaticRoutes  |false The valid For Static Routes, use local router
values are outbound interface or IP address of the
true and false. |next hop to reach the destination network.
useOnlyExtraCEloopbackForGrey false The valid With Extra CE loopback, the user can
AccessList values are select this option to add only the loopback
true and false. |address instead of the interface ip address
and extra CE loopback.
shared/ Properties shared by MPLS VPN, L2VPN
and VPLS.

FeatureQuery/ ISC components that check if certain
features are available for certain devices
based on their software version and
platform information.

enableValidation true The valid If enabled, FeatureQuery will check if the
values are features are available based on the feature
true and false. |matrix and device OS version (I0S
Version or PIX Version). If disable it will
assume that all features are available on
all platforms (should be used for testing
only).

actionTakenOnUNIVlanList prune string Action taken when switch port allowed
vlan cmd is absent for ERS service.

overwriteInterfaceDescription true The valid By default, ISC generates a description

values are subcommand for all the physical
true and false. |interfaces it provisioned. Set this property
to false if this behavior is not desirable.
This property does not apply to logical
interfaces or other CLI objects that have a
description subcommand (Ex. crypto
map entries, gre Interfaces, etc.)
transferUNIDescToVIlanName false The valid Controls provisioning of the VLAN name
values are on the PE-POP. If set to true, the VLAN
true and false. |name is assigned from the description for
the UNI. If set to the default of false, no
VLAN name is assigned.
useSRDescriptionToGenerateDebug | false The valid This property is used to generate more
Data values are intuitive debug data for easy fixing of

true and false.

issues.

vpls/

Contains properties for Virtual Private
LAN Service.
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Table C-1

DCPL Properties (continued)

DownloadWeights/

Specifies the download weights for
different devices in an MPLS VPN
service request. The higher the weight,
the sooner we download to that device.
By default the weights are set to 0, so that
all devices get downloaded at the same
time during service deployment.

weightForCE

0

integer

Download weight for CE devices.

weightForPE

0

integer

Download weight assigned to PE devices.

weightForPE_CLE

0

integer

Download weight for PE_CLE devices.

dataFileSchema

vplsData.xsd

string

Specifies the schema for the data XML
file for VPLS.

logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

parseConfigAfterProvisioning

false

The valid
values are

true and false.

This property controls the parsing of the
configuration file after the provisioning is
completed to make sure that device
inventory is in sync with network.

platform/ Platform related classes.
CATOS/ Service blade parameters for CATOS.
serviceBladeClass com.cisco.vpnsc. |string ServiceBladeClass location.
prov.vpls.
VplsService
Blade
CISCO_ROUTER/ IOS.
serviceBladeClass com.cisco.vpnsc. |string ServiceBladeClass location.
prov.vpls.
VplsService
Blade
saveDebugData true The valid If this property is set to true, whenever an
values are SR is provisioned, the uploaded config
true and false. |files and input XML data are saved to a
temporary directory for debugging
purposes.
sendAuditEvent true The valid Set true to enable sending audit event for
values are this service.

true and false.

[ oL-10727-01

Cisco IP Solution Center Infrastructure Reference, 4.2 B



Appendix C  Property Settings |

Table C-1 DCPL Properties (continued)

serviceFile

vplsService.xml

string

Specifies the XML file containing the
service definition for VPLS. The schema
for this file is specified by
Provisioning.Engine.serviceSchema.

SLA Properties:

Service Level Agreement. This
component deals with creating SAA
probes between different devices and to
collect/aggregate the data corresponding
to those probes, in order to provide
different SLA reports.

/SLA/copyRunningToStartup

true

The valid
values are

true and false.

If true and if showInRunningConfig is
true - the running configuration will be
copied to startup after the router SA
Agent configuration has been changed.

/SLA/daysToKeepDailyStats

365

integer,
30-3650 days

Specifies how many days should the SLA
database keep the daily statistics.
Specifying a low number keeps the
database small but you will not be able to
access daily reports beyond this period.

/SLA/daysToKeepHourlyStats

60

integer,
7-1000 days

Specifies how many days should the SLA
database keep the hourly statistics.
Specifying a low number keeps the
database small but you will not be able to
access hourly reports beyond this period.

/SLA/logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/SLA/rowAgeOut

3600

integer,
0-2073600
seconds

The time after which a probe is
completely removed after its life is over.
In seconds.

/SLA/showInRunningConfig

true

The valid
values are

true and false.

If true, the configured SLAs appear in the
router’s running configuration.

SYSTEM Properties:

The properties common to all
sub-systems in ISC can be found under
this component. Most of the values here
are set at the time of installation.

/SYSTEM/app_dir <vpnsc_home> string Location of the ISC installation.
/SYSTEM/ciscoURL http://www.cisco. |string The Cisco URL.

com
/SYSTEM/databaseServer <db_server> string The database server fully qualified name.
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Table C-1 DCPL Properties (continued)
/SYSTEM/email/ Properties related to e-mails sent out by
ISC.
from <mailfrom> string The from field in the e-mail header of the
mails sent out by ISC.
smtpHost <mailhost> string The server using which e-mail messages
from ISC should be sent out.
/SYSTEM/fullyManaged/ Properties related to e-mails sent out by
ISC in case of fully managed devices.
auditableCommandsFileLocation string This property specifies the full path to the
file containing the list of prefixes of
auditable commands used in the Fully
Managed feature.
enforcementAuditScript string Script to be invoked when failure of
enforcement audit is detected.
externalEventsEmailRecipients <mailto> string The comma or space separated list of
email addresses to which notification
should be sent out when receiving a
config-change event originated outside
ISC.
/SYSTEM/license/ Properties related to ISC Licensing.
emailRecipients <mailto> string The comma separated list of e-mail
addresses to which the License Threshold
e-mails should be sent out.
refreshlnterval 1 integer, 1-24  |License refresh interval in hours.
hours
threshold 90 integer, VPN and ACTIVATION Threshold in
1-100% percent for e-mail notification.
/SYSTEM/masterServer <master_server> |string The master server fully qualified name.
/SYSTEM/maxTaskLimit 500 integer max TaskLimit.
/SYSTEM/role master string Identifies the role in the distribution
system. Possible values are: master ps
(processing server) cs (collection server)
is (interface server).
/SYSTEM/tibco/ TIBCO related properties.
port <tibco_port> integer The port on which TIBCO Rendezvous
listens for events.
prefix cisco.vpnsc. string Prefix for all TIBCO messages
originating from ISC.
rva-http-port <rva_http_port> |integer The http port for TIBCO Rendezvous
agent web interface.
rva-port <rva_port> integer The port on which TIBCO Rendezvous
agent listens for events.
/SYSTEM/tmpdir <vpnsc_tmp> string Location for temporary files.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1 DCPL Properties (continued)

Scheduler Properties:

Scheduler reads the task repository and
schedules tasks on every minute
boundary. Each scheduled task is passed
to Task manager for execution.

/Scheduler/logLevel

CONFIG

selection

The log Level indicates the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/Scheduler/syncInterval

integer, 0-10
minutes

When scheduler starts up for the first
time, it reads all the scheduling
information from the task repository.
After that, it depends on the events
generated by task repository for receiving
changes to the scheduling information. It
can also periodically synchronize with
the task repository by re-reading it at
regular intervals. This property specifies,
in minutes, that interval. If the value for
the interval is 0, scheduler will not
synchronize with the task repository and
only depends on the events.

Services Property

Common services.

/Services/Common/allowForcePurge

true

The valid
values are

true and false.

With the default value of true, you can
force purge a Service Request. If the
value is false, you cannot force purge a
Service Request.

SnmpService Properties:

The Snmp Service package provides APIs
to perform SNMP get() and set()
operations.

/SnmpService/misc

Advanced settings.

enableDebug

false

The valid
values are

true and false.

Enables the AdventNet SNMP stack
debug messages. Messages are written to
the TaskLogs directory in files stdout and
stderr. Warning: These log files grow
quickly and are NOT managed by the ISC
logger. Requires WatchDog restart.

rcvPktBuffSize

96

integer,
64-512

Buffer size in K bytes, for SNMP stack
receive buffer.

/SnmpService/default SNMPVersion

integer, 1-2

The default SNMP version used to
connect to Cisco router. Used if the
SNMP version is not specified per router.
Valid Values: SNMPv1/SNMPv2c - 1
SNMPv3 - 2.
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Table C-1 DCPL Properties (continued)

/SnmpService/defaultSecurityLevel

integer, 1-3

The default security level used to connect
to Cisco router. Used if the security level
is not specified per router. Values:
authentication no encryption - 1
authentication encryption - 2 no
authentication no encryption - 3.

/SnmpService/logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/SnmpService/maxTaskLimit

500

integer

maxTaskLimit

/SnmpService/retries

integer, 0-10

The number of retries to be used by the
SNMP protocol.

/SnmpService/timeout

integer, 0-300
seconds

Timeout value to be used by the SNMP
protocol. Unit: seconds

TE Properties:

Traffic Engineering Management (TEM)
Properties

/TE/Deployment

Control the operation of TEM
Provisioning

maxCacheSize

60

integer, >0

Maximum cache size.

oneDeviceEachTimeThreshold

500

integer, >0

When the total number of tunnels to be
provisioned exceeds this threshold
number, provision one device at a time.

partialConfigAudit

false

The valid
values are
true and false.

When the value is the default of false, the
config audit is not limited. When the
value is set to true, only a partial config
audit (audit of only the PENDING
tunnels) occurs for primary and backup
tunnel deployment.

tunnelMplslp

true

The valid
values are
true and false.

When the value is the default of true, this
indicates to deploy the mpls ip command
when provisioning TE primary tunnels,
which enables MPLS IP switching on the
router. When the value is set to false, this
indicates not to deploy the mpls ip
command when provisioning TE primary
tunnels.

/TE/repository

TEM Repository-related Properties

[ oL-10727-01
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Table C-1 DCPL Properties (continued)

checkPermissionEnabled

false

The valid
values are
true and false.

This property enables or disables
Role-Based Access Control (RBAC)
checking during particular TEM
operations, such as topology population,
discovery, and service deployment. When
the value is the default of false, RBAC
permission checking is not enabled.
When the values is set to true, RBAC
permission checking is enabled and
performance degrades.

TE Topology Properties:

TEM Topology-related Properties

/TE Topology/TrafficData

Color Control for Traffic Data Displays

Green

0-25

integer, 0-100
(percentage)

Topology representations for a link
performance utilization range, specified
as a percentage (default: 0-25), are
displayed in the color green.

Orange

51-75

integer, 0-100
(percentage)

Topology representations for a link
performance utilization range, specified
as a percentage (default: 51-75), are
displayed in the color orange.

Red

76-100

integer, 0-100
(percentage)

Topology representations for a link
performance utilization range, specified
as a percentage (default: 76-100), are
displayed in the color red. Greater than
100% is also displayed in red.

Yellow

26-50

integer, 0-100
(percentage)

Topology representations for a link
performance utilization range, specified
as a percentage (default: 26-50), are
displayed in the color yellow.

TaskManager Properties:

Task manager executes tasks that are
scheduled by scheduler. Task execution
consists of executing different actions
that comprise the task. Task manager
manages the dependencies between these
actions.

/TaskManager/CollectConfig

The Collect Config task uploads the
running configuration.

logLevel

CONFIG

selection

The log Level indicates the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
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Table C-1 DCPL Properties (continued)

/TaskManager/logLevel CONFIG selection The log Level indicates the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

VpnlnvServer Properties: Corba Server for VpnlnvServer IDL
backward compatibility.

/VpnlnvServer/logLevel SEVERE selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

aagent Properties: AAgent component related defines.

/aagent/defaultVersion 3.63 string The default 3k firmware version for
AAgent.

/aagent/directories/ Various directories for aagent.

dmd <vpnsc_home>/r |string File path and name.
esources/AAgent
/DMDFiles

input <vpnsc_home>/ |string File path and name.
resources/java/
classes/common/
AAgent/com/
cisco/vpnscagent

working <vpnsc_home>/r |string File path and name.
esources/java/arc
hives

cfr Properties:

The Command Flow Runner component.
This currently runs within the Tomcat
server (in the ISC web application) and is
responsible for running MPLSOAM
troubleshooting workflows.

/cfr/LogHandler

com.cisco.mgmt.
workflow.util.
IscLogHandler

Set the CFR to use a custom handler for
logging. The handler should log to a
separate file and format the log messages
using the
java.util.logging.SimpleFormatter
instead of the ISC default XML
formatting.

[ oL-10727-01
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Table C-1 DCPL Properties (continued)

/ctfr/logLevel

INFO

The level of logging information the
Command Flow Runner will log (it will
log from the set level upwards). The
logging levels are as defined in the
java.util.logging package.

lockmanager Properties:

Component that handles device locking.
When different jobs (such as
provisioning) try to update the config on
the device, they obtain software locks so
that two different jobs do not update the
config at the same time. LockManager
provides a way to obtain and later release
such software locks.

/lockmanager/collectConfiglock

false

The valid
values are
true and false.

Determines if a software lock is to be
applied to the devices in the
CollectConfig task. If true, a software
lock is applied to all devices prior to
executing the CollectConfig operation,
and is released upon completion of the
CollectConfig operation. Note that a
software lock is not applied to the
optional device attributes and interfaces
operations. This flag is read by the
CollectConfig task upon execution.

/lockmanager/lockTimeoutInHours

integer, 1-168
hours

Timeout in hours for a lock held by a lock
holder. If the lock holder does not free a
lock within this time the lockmanager
will automatically release the device
lock.

/lockmanager/logLevel

SEVERE

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/lockmanager/queueServicingInterval

100

integer,
10-2000
milliseconds

How often in milliseconds to service
pending lock requests. A lower value
decreases the average time it takes to get
a lock at the expense of CPU processing
overhead.

nbi Properties:

Northbound API (Nbi) component related
defines.

/nbi/BackwardCompatible

Path for execQuery requests.
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Table C-1 DCPL Properties (continued)

RecordNumber false The valid For execQuery requests, the number
values are embedded in the output class name
true and false. |include Record for the default, false, or

Record#1 for true.

/nbi/CompositeDir <vpnsc_home>/ |string Path to composite XML files. Do not
resources/java/ change it or the composite meta XML
xml/com/cisco/ files will not be backed up.
vpnsc/repository/
meta/xml/
composite

/nbi/CustomerReportMetaDir <vpnsc_home>/ |string Path to user defined report meta XML
resources/java/ files. Do not change it or the report meta
xml/com/cisco/ XML files will not be backed up.
vpnsc/repository/
meta/xml

/nbi/Formatter com.cisco.vpnsc. |string File path and name.
nbi.io.NbiSimple
Formatter

/nbi/Logger com.cisco.vpnsc. |string File path and name.
nbi.util.NbiVpns
cLogger

/nbi/MetaChecklInterval 300000 string Set the time for next meta check to

happen.

/nbi/MetaDir <vpnsc_home>/ |string Path to meta XML files. Do not change it
resources/java/ or the meta XML will not be backed up.
xml/com/cisco/
vpnsc/repository/
meta/xml

/nbi/ProvidedReportMetaDir <vpnsc_home>/ |string Path to ISC provided report meta XML
resources/java/ files. Do not change it or the report meta
xml/com/cisco/ xml files will not be backed up.
vpnsc/repository/
meta/xml

/nbi/Reader com.cisco.vpnsc. |string File path and name.
nbi.io.NbiSoapR
eader

/nbi/RequestParserMgr com.cisco.vpnsc. |string File path and name.
nbi.parser.NbiRe
questParserMgr

/nbi/SSLfilepath <vpnsc_home>/ |string Path to client.keystore file for NBI SSL
bin/client. connections.
keystore

/nbi/SessionTimeout 1200000 string Amount of time the session is valid.

/nbi/TransactionParser com.cisco.vpnsc. |string File path and name.
nbi.parser.NbiWs
dlParser
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/nbi/Validation true The valid Variable to enable validation of incoming
values are Nbi API XML attributes.
true and false.
/nbi/WaitTimeout 1200 integer The time in seconds to wait for a Service
Request to deploy.
/nbi/Writer/
SoapEncapsulation false The valid SoapEncapsulation.
values are
true and false.
/nbi/Writer com.cisco.vpnsc. |string File path and name.
nbi.io.NbiSoapW
riter
/nbi/logHandler com.cisco.vpnsc. |string Custom log handler for nbi. This handler
nbi.util. VpnscLo allows NBI to use alternate formatter
gHandler from default one used by rest of ISC. In
this case, NBI defaults to using
SimpleFormatter which dumps simple
output as opposed to XML output.
/nbi/logLevel WARNING selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging pack age. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
notification Properties: Event notification related defines.
/notification/Logger com.cisco.vpnsc. |string File path and name.
nbi.util.NbiVpns
cLogger
/notification/clientEnabled false The valid Set to true for enabling the example event
values are receiving servlet.

true and false.

/notification/clientHost <master_server> |string TIBCO event client host.
/notification/clientMethod /notification/ string TIBCO event client method.
servlet
eventListener
/notification/clientPort <http_port> string TIBCO event client port.
/notification/clientRegFile <vpnsc_home>/ |string Client TIBCO event registration file
resources/nbi name.
/notification
clientReg.txt
/notification/logFormatter java.util.logging. |string File path and name.

SimpleFormatter
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/notification/logHandler com.cisco.vpnsc. |string Custom log handler.
nbi.util.VpnscLo
gHandler

/notification/logLevel WARNING selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/notification/password cisco string Both user name and password are same as
the ones used for GUI login.

/notification/remotePassword string User password for remote system
authentication, if required, for example,
when LDAP is in use.

/notification/remoteUsername string User name for remote system
authentication, if required, for example,
when LDAP is in use.

/notification/username admin string Both user name and password are s same

as the ones used for GUI login.

pal Properties:

The PAL Device interaction component.
This runs within the Tomcat server and is
responsible for running device interaction
for the CFR to run the OAM
troubleshooting workflows.

/pal/failureScenario

The system parameter that represents the
current failure scenario. For use with the
Canned Response mechanism for testing.

/pal/logHandler

com.cisco.mgmt.

workflow.util.
IscLogHandler

Set the PAL to use a custom handler for
logging. The handler should log to a
separate file and will format the log
messages using the
java.util.logging.SimpleFormatter
instead of the ISC default XML
formatting.

/pal/logLevel

INFO

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
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Table C-1 DCPL Properties (continued)

/pal/responseDir

/vob/ntg/dev/reso
urces/pal/
testnetwork

The base directory where the failure
scenarios are held. Used by the canned
response mechanism and transport for
failure scenario testing.

repository Properties:

The component for Database related
properties.

/repository/Concurrency/

To setup properties for re-try loop to
avoid deadlock

NOICE_FACTOR

500

integer

Add random noise to each process that is
being retried.

NO_OF_RETRIES

integer

Number of retries before throwing
deadlock exception.

TIME_BASE

integer

The base number to calculate the wait
time. For example, a value of 2 for this
property and 3 retries means, the process
will be retried every 20, 2! and 2?2
seconds.

/repository/IPAddressPool/

IP Address Pool Constants.

AGE_TIME

1440

integer

The Aging interval for released IP
Address, in minutes. The default is 24
hours (1440 minutes).

RecoverIPAddrSleepInterval

60

integer, 10 -
144000
minutes

The time in minutes for recovering Aged
IP addresses recovery service to wait
between recovery cycles. The default is
60 minutes. Changing this value initiates
the recovery process.

releaseAndReuseAgedAddresses

true

The valid
values are

true and false.

The default value is false. When the value
is set to true, the user wants a manual
allocation of the address in the aged
address to succeed. When the value is set
to true, the address is released from the
Aged Pool and moved to the Allocated
pool when manually allocated.

/repository/common

Repository common constants.

MCAST_SUBSUME_ALL_SRS

true

The valid
values are

true and false.

This property set at true indicates that the
user wants all the MPLS VPN links of a
VPN to be subsumed when Multicast is
enabled for that VPN.

releaseAndReuseAgedAddresses

true

The valid
values are

true and false.

The default value is false. When the value
is set to true, the address will be released
from the Aged Pool and moved to the

Allocated pool when manually allocated.

/repository/deviceConfig/

null

Configuration file related properties.
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max Versions 10 integer, 1-50 |Maximum number of configuration files
to be stored per device in the repository
before older versions automatically get
purged.
/repository/mlshare/ Share directory for both MPLS and
L2VPN.
logLevel SEVERE selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
/repository/persistence/ Properties for database.
Versions 5 integer The number of maximum versions for a
Versioning Persistent Objects.
catalog directory string Catalog.
driver <db_driver> string The class name for the driver.
initialConnections 1 integer, 1-20 | Number of initial connections.
location <repository_ string The directory containing the
home> repository.db and repository.log files.
password sql string Password for opening a DB connection.
schema DBA string Schema.
slaurl jdbc:sybase:Tds: |string The url for opening a JDBC connection to
<local_db_server the SLA database.
>:<db_port_sla>/
2JCONNECT_
VERSION=5&
serviceName=sla
url <db_url> string The url for opening a JDBC connection.
username dba string User id to open a db connection.
/repository/rbac/ The component for RBAC User Access
Model, user Authentication.
checkCreatorPermissionEnabled true The valid The creator of objects can give the
values are permissions of Modify or Delete to
true and false. |others. If this flag is false, enable RBAC
permission checkin.
checkPermissionEnabled true The valid The creator of objects can give the
values are permissions of Modify or Delete to
true and false. |others. If this flag is false, enable RBAC
permission checkin.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1 DCPL Properties (continued)

enableAutologin

true

The valid
values are
true and false.

The property controls whether user may
store login information in form of cookies
on the computer from which the user
connects. If enabled, automatic login,
based on the cookie information is
permitted. Also user is presented with a
screen in which he or she can elect to
store login information on the local user’s
computer. With this property set to false
no autologin or options associated with it
are available.

logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

partialQueryResultExpected

true

The valid
values are
true and false.

When checking Permission on a list of
Persistent Objects, and the current user
does not the specified permission to all
the objects in the result list, partial results
will be returned if this flag is true;
Insufficient Permission exception will be
generated if the flag is false.

webSessionTimeoutSec

1800

integer, 1 -
2,147,483,647

Timeout of inactive web client session in
seconds. Default is 30 minutes.

/repository/ual/

User Access/Audit Log

cleanUALogs

true

The valid
values are
true and false.

whether to let system automatically clean
up UAL log entries based on
ual.maxAgelnDays.

maxAgelnDays

30

integer

Maximum age of the User Access/Audit
Logs in days after which the UALog
Cleanup Service will delete them. if 0
then UALogs deletion is disabled even if
cleanUALogs is set to true.

watchdog Properties:

All the servers in ISC are launched and
managed by the Watchdog.

/watchdog/byRole/

This component contains the watchdog
properties that based on the role of the
host.

cs/

Watchdog properties for machine playing
the role of a cs (Collection Server/Agent).

servers

httpd nspoller
worker dbpoller

string

Names of the servers to be run.
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Table C-1 DCPL Properties (continued)
db/ Watchdog properties for a machine
playing the role of a db (DB server).
servers dbpoller string The servers to be run on a installation
with the role db.
is/ Watchdog properties for a machine
playing the role of a Interface Server.
servers httpd dbpoller string Names of servers to be run on an
installation with role is.
master/ Watchdog properties of a machine
playing the role of a master.
servers httpd nspoller string The servers to be run.
dbpoller
dispatcher
worker scheduler
lockmanager
cornerstonebridg
e cnsserver
ps/ Watchdog properties for a machine
playing the role of a ps (Processing
Server/Agent).
servers httpd nspoller string Names of servers to be run.
worker dbpoller
/watchdog/criticalServers string If any of these servers enters the disabled

state, then it would mean that the system
is NOT healthy. If this value is null/empty
then every single server is critical.

/watchdog/diskspace/ Contains properties related to disk space
monitoring.
dirsToMonitor string The directories (and ultimately the disks
that contain them) to be monitored.
disksToMonitor string The disks to be monitored for space
constraints.
emailRecipients <mailto> string The comma separated list of e-mail

addresses to which the disk space related
e-mails should be sent out.

highWatermark <highwater> string High watermark for the directories
(disks) being monitored. The value
should be a number followed by a < (for
percent) or m or M (for Mbytes). These
values should correspond to the
available/free space on the disk. If the
available disk space stabilizes above this
value (after falling below the low
watermark), an e-mail is sent to the
addresses specified in the property
watchdog.diskspace.emailRecipients.

Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1 DCPL Properties (continued)
lowWatermark <lowwater> string Low watermark for the directories (disks)
being monitored. The value should be be
anumber followed by a % (for percent) or
m or M (for Mbytes). These values should
correspond to the available/free space on
the disk. If the available disk space falls
below this value, an e-mail is sent to the
addresses specified in the property
watchdog.diskspace.emailRecipients.
sleepInterval 60000 integer, Time between two status checks for disk
30000-300000 |space limits in milliseconds.
milliseconds
/watchdog/group/ Group.
database_users scheduler httpd  |string The servers that access database.
/watchdog/groups database_users string The space separated list of different
groups in the system.
/watchdog/heartbeat/ Properties related to watchdog heartbeat
mechanism are specified here.
period 120000 integer, The minimum time between each
30000- heartbeat request in milliseconds.
86400000
milliseconds
period_poller 60000 integer, The minimum time between each
30000- heartbeat request for dbpoller and
86400000 nspoller in milliseconds.
milliseconds
sendEvents false The valid If set to true, watchdog sends out TIBCO
values are events every time a heartbeat succeeds or
true and false. |fails. If set to false, no such events will be
sent.
startDelay 5000 integer, Time to wait before making the first
0-60000 heartbeat request in milliseconds.
milliseconds
timeout 3000 integer, The period of time before which response
1000-600000 |for heartbeat request should be received
milliseconds  |by the watchdog, in milliseconds.
wds/ Heartbeat properties for intra-watchdog
communication.
delay 5000 integer, The period in between heartbeats. (from
1000-60000 master watchdog to slave watchdog and
milliseconds |vice-versa) in milliseconds.
initDelay 1000 integer, The initial period of time for which the
1000-5000 heartbeat thread waits before trying for a
milliseconds |heartbeat after a watchdog registers with

the MasterWatchdog, in milliseconds.
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Table C-1

DCPL Properties (continued)

masterReconnectAttemptDelay

2000

integer,
100-60000
milliseconds

The sleep time between two successive
attempts by a slave watchdog to reconnect
to master watchdog, in milliseconds.

maxAllowedMisses

integer

The maximum number of consecutive
misses that a watchdog should miss for
the master to consider it inactive or
unregistered.

maxAttemptsForMasterReconnect

500

integer

Once the slave watchdog loses
connection with the master, it will try this
many times to try and establish the
connection. If it cannot re-establish a
connection with the master even after
making these many attempts, it shuts
itself down. Between attempts, it sleeps
watchdog.heartbeat.wds.masterRecon
nectAttemptDelay time. The value for
this property should be specified in
milliseconds. A value of 0 indicates that
the slave watchdog has no upper limit on
the number of reconnect attempts.

/watchdog/java/

Java.

flags

-XX:+UseAltSig
s

string

Any other flags to be passed on to java.

vmtype

-server

string

The flag to be passed on to java (-server
or -client).

/watchdog/logLevel

FINEST

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/watchdog/server/

httpd nspoller
dbpoller
dispatcher
worker scheduler
lockmanager
cornerstonebridg
e

string

Server.

cnsserver/

Monitors CNS events from IE2100 boxes.
Communication between client and
server is completely handled using
TIBCO events.

heartbeat/

Heartbeat related properties.
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Table C-1 DCPL Properties (continued)

startDelay

10000

integer,
0-60000
milliseconds

Time to wait before making the first
heartbeat request in milliseconds.

timeout

3000

integer,
1000-600000
milliseconds

The period of time before which response
for heartbeat request should be received
by the watchdog, in milliseconds.

java/

Java attributes for this server.

flags

string

Any additional java flags specific to this
server. If the value is changed, watchdog
restart is required for the new value to
take effect.

class

com.cisco.vpnsc.
watchdog.servers
.WDCnsServer

string

Heartbeat Handler - Checks for valid
TIBCO Connection.

cmd

java
com.cisco.vpnsc.
cns.CnsServer

string

Implementation to monitor CNS events
from IE2100 boxes.

dependencies

dbpoller

string

Dependencies.

logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

dbpoller/

This server keeps polling the database to
see if it is functional.

class

com.cisco.vpnsc.
watchdog.servers
.WDDatabase

string

Name of class responsible for getting
heartbeats.

logLevel

CONFIG

selection

The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

select

select id from
vpnsc_host

string

SQL select statement to issue when
pinging the database.

discovery/

Handles various ISC Discovery workflow
related tasks.
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Table C-1 DCPL Properties (continued)
class com.cisco.vpnsc. |string Heartbeat Handler.
discovery.engine.
server.Discovery
Server
cmd java string Implementation of the Discovery work
com.cisco.vpnsc. interface.
discovery.engine.
server.
Discoverylmpl
dependencies dbpoller string dependencies
heartbeat/ Heartbeat related properties.
startDelay 10000 integer, Time to wait before making the first
0-60000 heartbeat request in milliseconds.
milliseconds
timeout 3000 integer, The period of time before which response
1000-60000 for heartbeat request should be received
milliseconds  |by the watchdog, in milliseconds. To
discover large networks with a complex
topology, we recommend you reset this
property to 180000 milliseconds (3
minutes).
java/ Java attributes for this server
flags string Any additional java flags specific to this
server. If the value is changed, watchdog
restart is required for the new value to
take effect. To discover large networks
with a complex topology, we recommend
you reset this property to
-Xmx3072m -XX:PermSize=256m
-XX:MaxPermSize=512m.
logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
dispatcher/ Dispatcher service of the Distribution
framework.
app_args Dispatcher string Args to the class that starts this service.
com.cisco.vpnsc.
dist.vpnsc.Vpnsc
DispatcherImpl
class com.cisco.vpnsc. |string The class that proxies this service for the
watchdog.servers watchdog.
.WDDispatcher
Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1 DCPL Properties (continued)
cmd java string Command to start the server.
com.cisco.vpnsc.
watchdog.ext.Ser
viceLauncherImp
1
dependencies dbpoller nspoller |string The other services that this service
depends on Heartbeat related properties.
heartbeat/
startDelay 45000 integer, Time to wait before making the first
0-60000 heartbeat request in milliseconds.
milliseconds
timeout 3000 integer, The period of time before which response
1000-60000 for heartbeat request should be received
milliseconds  |by the watchdog, in milliseconds.
java/ Java attributes for this server
flags string Any additional java flags specific to this
server. If the value is changed, watchdog
restart is required for the new value to
take effect.
logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
httpd/ httpd httpd
class com.cisco.vpnsc. |string Class.
watchdog.servers
.WDHttpd
cmd <vpnsc_home>/ |string The command to start httpd on this host.
bin/tomcat.
sh start fg
dependencies dbpoller string Dependencies.
dependenciesByRole/ Dependencies of httpd based on the role
of installation (higher priority than
normal dependencies)
cs string Dependencies on a CS.
ps string Dependencies on a PS.
heartbeat/ Heartbeat.
port <http_port> integer The port on which httpd should run.

] Cisco IP Solution Center Infrastructure Reference, 4.2

0L-10727-01 |



| AppendixC  Property Settings

Table C-1 DCPL Properties (continued)
startDelay 45000 integer, Time to wait before making the first
0-60000 heartbeat request in milliseconds.
milliseconds
timeout 10000 integer, The period of time before which response
1000-600000 |for heartbeat request should be received
milliseconds  |by the watchdog, in milliseconds.
url http://localhost:  |string url
<http_port>/isc/
about.htm
logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
lockmanager/ Component that handles locking.
class com.cisco.vpnsc. |string Class that keeps track of lockmanager
watchdog.servers heartbeats.
.WDLockManag
er
cmd java string Command that starts up the lockmanager.
com.cisco.vpnsc.
lockmanager.Loc
kManagerImpl
dependencies nspoller string Lock Manager depends on the NS.
heartbeat/ Heartbeat related properties.
startDelay 10000 integer, Time to wait before making the first
0-60000 heartbeat request in milliseconds.
milliseconds
timeout 3000 integer, The period of time before which response
1000-600000 |for heartbeat request should be received
seconds by the watchdog, in milliseconds.
java/ Java attributes for this server.
flags string Any additional java flags specific to this
server. If the value is changed, watchdog
restart is required for the new value to
take effect.
Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1 DCPL Properties (continued)
logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
maxQuickDieCount 3 integer The maximum number of times a server
can die consecutively without having a
successful heartbeat. If this number is
exceeded, the server is marked as
disabled.
nspoller/ This server polls the NameServer to see if
it is running.
class com.cisco.vpnsc. |string Class.
watchdog.servers
.WDNameServer
logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
scheduler/ Scheduler.
class com.cisco.vpnsc. |string Class.
watchdog.servers
.WDScheduler
cmd java string Command to start the scheduler.
com.cisco.vpnsc.
scheduler.Schedu
ler
dependencies dbpoller worker |string Dependencies.
heartbeat/ Heartbeat related properties.
startDelay 30000 integer, Time to wait before making the first
0-60000 heartbeat request in milliseconds.
milliseconds
timeout 3000 integer, The period of time before which response
1000-600000 |for heartbeat request should be received
milliseconds  |by the watchdog, in milliseconds.
java/ Java attributes for this server.
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Table C-1 DCPL Properties (continued)
flags string Any additional java flags specific to this
server. If the value is changed, watchdog
restart is required for the new value to
take effect.
logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).
startTimeout 240000 integer, The timeout for the initial heartbeat
5000-600000 |response. The first heartbeat should
happen within this time.
worker/ Worker service of the distribution
framework.
app_args Worker string Arguments to the class specified in the
COm.CiSCO.vpnsc. cmd property.
dist.WorkerImpl,
com.cisco.vpnsc.
sla.sql.SlaMainte
nanceService,
com.cisco.vpnsc.
repository.ual.U
ALCleanupServi
celmpl,
com.cisco.vpnsc.
license.LicenseS
ynchronize,
com.cisco.vpnsc.
cleanup.TaskLog
CleanupService,
com.cisco.vpnsc.
cleanup.TempFil
eCleanupService,
com.cisco.vpnsc.
cleanup.Runtime
TaskCleanupServ
ice”
class com.cisco.vpnsc. |string The server class that proxies Worker
watchdog.servers service for the watchdog.
.WDWorker
cmd java string Command to start the worker.
com.cisco.vpnsc.
watchdog.ext.Ser
viceLauncherImp
1
Cisco IP Solution Center Infrastructure Reference, 4.2
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Table C-1 DCPL Properties (continued)
dependencies nspoller string Servers that have to be functioning for
this server to function normally.
dependenciesByRole/ Dependencies of httpd based on the role
of installation (higher priority than
normal dependencies)
cs string Dependencies on a CS.
ps string Dependencies on a PS.
heartbeat/ Heartbeat related properties.
startDelay 45000 integer, Time to wait before making the first
0-60000 heartbeat request in milliseconds.
milliseconds
timeout 3000 integer, The period of time before which response
1000-600000 |for heartbeat request should be received
milliseconds  |by the watchdog, in milliseconds.
java/ Java attributes for this server.
flags -Xmx512m string Any additional java flags specific to this
-Xbootclasspath/ server. If the value is changed, watchdog
p:<vpnsc_home> restart is required for the new value to
/thirdparty/jar/ take effect.
AdventNetSnmp
3_3.2jar:
<vpnsc_home>/
thirdparty/jar/
cryptix32.jar
-Dcom.cisco.
insmbu.template
mgr.backend.
PropFile=
<vpnsc_home>/
resources/
templatesystem/
Template.
properties
logLevel CONFIG selection The log Level is the level at which
logging is done for this component. These
levels are identical to the logging levels
defined for JDK1.4 logging package. The
levels in descending order are: SEVERE
(highest value) WARNING INFO
CONFIG FINE FINER FINEST (lowest
value).

/watchdog/serverStatus/ The properties related to the server status
monitoring function provided by the
watchdog are specified here.

emailRecipients <mailtoRestart> |string Comma separated list of e-mail addresses

to which notices about server state
changes should be e-mailed
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Table C-1 DCPL Properties (continued)
stableTime 60000 integer, Time in milliseconds that has to pass
20000-300000 |before a server’s status can be considered
milliseconds |stable (for the purpose of sending out a
server status e-mail notification).
/watchdog/servers httpd nspoller string Server.
dbpoller
dispatcher
worker scheduler
lockmanager
cornerstonebridg
e
/watchdog/waitDelay 3000 integer, The time period for which the wait() calls
20000-300000 |in watchdog wait, before checking the
milliseconds |wait condition, in milliseconds.
xml Properties: The component for XML-based
properties.
/xml/queries/ Properties for RepQueryLoader.
filepath <vpnsc_home>/ |string File path and name.
resources/java/
xml/com/cisco/
vpnsc/repository/
Queries.xml

Cisco IP Solution Center Infrastructure Reference, 4.2
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A

access control list
ACL

antialiasing

API

Application
Programming
Interface

area

AS

ASN

ATM

ATMoMPLS

AToM

audit SR (TE)

auto bandwidth /
auto-bw

GLOSSARY

See ACL.
access control list. A list kept by routers to control access to or from the router for a number of services.
Algorithm used to smooth lines in a topology layout.

application programming interface. APIs are supplied as XML schema and CORBA IDL files to
customers with Cisco VPN Solutions Center products. After compiling these IDL files to produce
language-specific implementation files for the target language of your choosing, you can use these
APIs to incorporate MPLS-VPN features in third-party client-application source code. The CORBA
version is being deprecated form the product and will not be supported in subsequent versions.

See API.

Segments and their attached devices. Areas are usually connected to other areas through routers,
making up a single autonomous system. See also AS. See also region.

Collection of networks under a common administration sharing a common routing strategy.
Autonomous systems are subdivided by areas or regions. An autonomous system must be assigned a
unique 16-bit number by the IJANA. Specific to BGP for MPLS VPN Solutions.

autonomous system number.

Asynchronous Transfer Mode. The international standard for cell relay in which multiple service types
(such as voice, video, or data) are conveyed in fixed-length (53-byte) cells. Fixed-length cells allow
cell processing to occur in hardware, thereby reducing transit delays. ATM is designed to take
advantage of high-speed transmission media, such as E3, SONET, and T3.

Asynchronous Transfer Mode over Multi-Protocol Label Switching. A type of Layer 2 point-to-point
connection running over an MPLS core.

Any Transport over MPLS.

Tool for auditing the protection of protected TE elements using all existing backup tunnels and
proposed changes.

A way to configure a tunnel for automatic bandwidth adjustment and to control the manner in which
the bandwidth for a tunnel is adjusted.
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A

autonomous
system

autonomous
system number

backing store

baseline

BECN

BGP

Border Gateway
Protocol

border router

CAR

CcDP

CE

CEF

See AS.

See ASN.

Function that stores graphics content when moved to the background and regenerates it when moved
to the foreground. This helps avoid superfluous refreshing.

A set of data collected from targets. For example, the latest configuration files for a list of Cisco
Routers, or the latest configuration files, IP unnumbered information, and PVC information for a list
of Cisco Routers. MPLS VPN Solution software automatically maintains baselines that correspond to:
1) the latest PE configuration files in the Provider Administrative Domain (with one baseline per PAD);
2) the latest configuration files of the customer edge routers (CEs) and provider edge routers (PEs) in
the virtual private networks (VPNs) that the customer has defined. MPLS VPN Solution uses these
baselines to create audit and topology reports.

backwards explicit congestion notification. This is a concept in Frame Relay networking.

Border Gateway Protocol. An interdomain routing protocol designed for the global Internet. Exterior
border gateway protocols (EBGPs) communicate among different autonomous systems. Interior border
gateway protocols (IBGPs) communicate among routers within a single autonomous system.

See BGP.

A router at the edge of a provider network that interfaces to another provider’s border router using the
EBGP protocol.

Committed Access Rate. CAR is Cisco’s traffic policing tool for instituting a QoS policy at the edge
of a network. CAR allows you to identify packets of interest for classification with or without rate
limiting. CAR allows you to define a traffic contract in routed networks.

Cisco Discovery Protocol. A protocol that is used to discover IOS devices in a network. One of the
choices of method for performing device discovery in the ISC Discovery process.

customer edge router. A CE is part of a customer network and interfaces to a provider edge router (PE).
A CE can join any set of virtual private networks (VPNs). Each CE connects a customer site to a PE,
obtaining the VPN service for that customer site, and belongs to exactly one customer. Each CE may
have many configlets and may be configured by multiple service requests.

Cisco express forwarding. A layer 3 switching technology inside a router. It defines the fastest method
by which a Cisco router uses to forward packets from ingress to egress interfaces.
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CERC customer edge routing community. A component of a VPN that is configured for either full mesh or
hub-and-spoke connectivity. A method (using route-target attributes) of describing how CEs in a VPN
communicate with each other. CERCs organize a complex VPN into simpler subgroups. Each CERC
belongs to one and only one VPN. CERCs can be used to describe the logical topology of the VPN
itself.

CERC membership Relationship between a VRF definition and a CERC. It dictates which CERC a VRF definition is
joining and whether it is joining the CERC as either a hub or a spoke.

CiM Common Information Model from the DMTF. Describes components of a managed environment using
an object-oriented modeling approach.

CIM-CX Common Information Model - Cisco eXtensions. A DMTF CIM-based model.
CIR committed information rate. This is a concept in Frame Relay networking.
Cisco Service See CSM.

Management

committed access See CAR.
rate

configlet A configuration fragment that can be downloaded to a CE or PE to modify its current IOS command-set
configuration.

conformant tunnel A well-behaved tunnel that meets the TE management paradigm of ISC. A conformant primary tunnel
with zero hold and setup priorities is a managed tunnel.

CORBA Common Object Request Broker Architecture.

CSM Cisco Service Management System. The name of Cisco’s large-picture project for service management.
Many interdependent products fall within this project.

customer Requests VPN service from a provider. Each customer may own many customer sites.
customer edge See CE.

router

customer edge See CERC.

routing community

customer network A network under the control of an end customer. The VPN connects the single customer network by
connecting the isolated sites.

customer site A set of IP systems with mutual IP connectivity between them without the use of a VPN. Each customer
site belongs to exactly one customer. A customer site can contain any number of CEs.

Cisco IP Solution Center Infrastructure Reference, 4.2
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D

data-link
connection
identifier

data model

dCEF

Device/Topology
Based Discovery

DHCP

DLCI

DMTF

DNS

document type
definition

Domain Naming
System

double buffer

DRAM

DSCP

DTD

Dynamic Host
Configuration
Protocol

dynamic path
dynamic

random-access
memory

See DLCI.

A concrete representation of an information model in terms appropriate to a specific data store and
access technology.

Distributed Cisco expressed forwarding routing. Enables distributed forwarding on versatile interface
processors (VIPs).

One of the methods available for performing ISC device discovery. The Device/Toplogy Discovery
method uses an XML file that provides device names and IP addresses and another XML file that
provides information on the interface connections between devices in the network topology.

Dynamic Host Configuration Protocol.

data-link connection identifier. A value that specifies a private virtual circuit (PVC) or a switched
virtual circuit (SVC) in a Frame Relay network.

Distributed Management Task Force.

Domain Naming System. System used in the Internet for translating names of network nodes into
addresses.

See DTD.

See DNS.

Smooths the lines in the topology display when dragging elements.

dynamic random-access memory. RAM that stores information in capacitors that must be periodically
refreshed.

Differentiated services code point. A field in the IPv4 ToS byte of the packet header that allows you
classify packets into any of 64 classes.

document type definition.

See DHCP.

A dynamic path is provisioned by allowing the head router to find a path. The dynamic keyword is then
provisioned to the routers.

See DRAM.
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E

EBGP exterior border gateway protocol. EBGPs (see BGP) communicate among different network domains.

egress Traffic leaving the network or device.

E-LAN An Ethernet LAN Service Type representing a multipoint-to-multipoint Ethernet service in a Metro
Ethernet network.

E-Line An Ethernet Line Service Type representing a point-to-point Ethernet service in a Metro Ethernet
network.

EMS Ethernet Multipoint Service is a port-based multipoint-to-multipoint E-LAN service that is used for
transparent LAN applications.

EPL Ethernet Private Line is a port-based point-to-point E-Line service that maps Layer 2 traffic directly on
to a TDM circuit.

ERMS Ethernet Relay Multipoint Service is a multipoint-to-multipoint VLAN-based E-LAN service that is
used primarily for establishing a multipoint-to-multipoint connection between customer routers.

ERS Ethernet Relay Service is a point-to-point LAN-based E-Line service that is used primarily for
establishing a point-to-point connection between customer routers.

Ethernet LAN See E-LAN.

Service Type

Ethernet Line See E-Line.

Service Type

Ethernet Multipoint See EMS.
Service

Ethernet Private See EPL.

Line

Ethernet Relay See ERMS.
Multipoint Service

Ethernet Relay See ERS.
Service

Ethernet Virtual See EVC.

Connection

Ethernet Wire See EWS.

Service

EVC An Ethernet Virtual Connection in Metro Ethernet with an association of two or more UNIs that limits
the exchange of service frames to UNIs within the EVC.

EWS Ethernet Wire Service is a point-to-point port-based E-Line service that is used primarily to connect

geographically remote LANs over a service provider network.

Cisco IP Solution Center Infrastructure Reference, 4.2
[ oL-10727-m .m



M Glossary

E

Extensible Markup See XML.

Language

EWS An Ethernet Wire Service is a point-to-point-based E-Line service that is used primarily to connect
geographically remote LANs over a Service Provider network.

exterior border See EBGP.

gateway protocol

F

Fast Re-Route Provides link protection to Label-Switched Paths (LSPs). This enables all traffic carried by LSPs that

(FRR) protection traverse a failed link to be rerouted around the failure.

FRoMPLS Frame Relay over Multi-Protocol Label Switching. A type of Layer 2 point-to-point connection
running over an MPLS core.

G

Gigabit Switch See GSR.

Router

global pool The bandwidth of TE enabled interfaces is assigned a number of nested bandwidth pools. The global
pool represents the total bandwidth that can be reserved out of the total link bandwidth.

grooming Grooming is a TE tool that works on the whole network to optimize the placement of existing managed
tunnels. It is only available when no tunnel attributes have been changed.

GSR Gigabit Switch Router.

H

hold priority Priority associated with a Label-Switched Path (LSP) for the tunnel to determine if it should be

preempted by other LSPs that are being signaled.

Hyper text Transfer See HTTP.

Protocol
HTTP Hyper text Transfer Protocol. An application protocol running on TCP/IP and the World Wide Web
HTTPS Secure HTTP. Secure HTTP (HTTPS) provides the capability to connect to the Cisco IOS HTTPS

server securely. It uses Secure Sockets Layer (SSL) and Transport Layer Security (TLS) to provide
device authentication and data encryption.

Cisco IP Solution Center Infrastructure Reference, 4.2
m. oL-10727-01 |



Glossary W

IANA Internet Assigned Numbers Authority. Organization operated under the auspices of the ISOC as a part
of the IAB. IANA delegates authority for IP address-space allocation and domain-name assignment to
the InterNIC and other organizations. IANA also maintains a database of assigned protocol identifiers
used in the TCP/IP stack, including BGP autonomous system numbers.

IBGP interior border gateway protocol. IBGPs (see BGP) communicate among routers within a single
network domain.

ICMP Internet Control Message Protocol. Network layer Internet protocol that reports errors and provides
other information relevant to IP packet processing.

IDL Interface Definition Language. Generic language for describing APIs for API servers. IDL API files
must be compiled using an IDL compiler from an approved CORBA vendor to produce
language-specific API files in a CORBA-supported target language. Using the generated
target-language files you can add API-supported features to third-party client-application source code.

information model An abstraction and representation of the entities in a managed environment - their properties,
operations, and relationships. It is independent of any specific repository, application, protocol, or
platform.

ingress Traffic entering the network or device.

Interface Definition See IDL.
Language

interior border See IBGP.
gateway protocol

Internet Control See ICMP.
Message Protocol

internet-service See ISP.
provider

inter-switch link See ISL.

IPv4 Internet Protocol, version 4. A version of IP that support a 32-bit address space.

IPv6 Internet Protocol, version 6. A version of IP that support a 128-bit address space.

ISC Cisco IP Solution Center.

ISC Discovery An automated process that allows ISC to discover the devices in a MPLS VPN network or a L2ZVPN

Metro Ethernet network.

ISL Inter-Switch Link. Provider of internet access and services through single BGP autonomous system.
ISP internet-service provider. Provider of internet access and services through single BGP autonomous
system.

Cisco IP Solution Center Infrastructure Reference, 4.2
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L
L2VPN

L2TPv3

label-switched path

link speed factor

LSP

managed tunnel

manage lock

management
information base

MCE

Metro Ethernet

MiB

MLPPP

MPE

MPLS

MPLS TE tunnel

Layer 2 Virtual Private Network.
Layer 2 Tunnel Protocol Version 3.
See LSP.

TE multiplication factor to be applied to the link speed to determine the amount of bandwidth that must
be protected.

Sequence of routers that cooperatively perform MPLS operations for a packet stream. The first router
in an LSP is called the ingress router, and the last router in the path is called the egress router. An LSP
is a point-to-point, half-duplex connection from the ingress router to the egress router. (The ingress and
egress routers cannot be the same router.)

The concept of managed tunnels is at the center of TE planning activities. A managed tunnel is a
primary TE tunnel characterized by having a setup/hold priority of zero, a non-zero bandwidth, and a
valid explicit path. A non-zero bandwidth is defined to be non-zero Resource Reservation Protocol
(RSVP) bandwidth or non-zero maximum auto bandwidth if auto bandwidth is enabled.

Whenever a task updates the TE database and it might affect the resource and hence the result of a
tunnel computation, it locks the system before the update and releases it at completion of the update.
Manage lock is a capability provided in the GUI to release the lock under error conditions.

See MIB.

Management Customer Edge Router. The MCE is a required element in some MPLS VPN topologies.
The network management subnet, which consists of the MPLS VPN Solution and Cisco IP Manager
workstations on a single local area network (LAN), connects directly to an MCE.

Metro Ethernet services use Ethernet technology to deliver cost-effective, high-speed connectivity for
metropolitan-area network (MAN) and wide-area network (WAN) applications.

management information base.

Multilink Point-to-Point Protocol. Method of splitting, recombining, and sequencing datagrams across
multiple, logical data links.

Management Provider Edge Router. The MPE is an element in some MPLS VPN topologies. The
network management subnet connect directly to an MCE, which in turn is connected to an MPE.

multi protocol label switching. An emerging standard based on a Cisco Tag Switching technology.

multiprotocol label switching traffic engineering (MPLS TE) tunnel. Can be a primary or a backup
tunnel.
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MPLS VPN

multilink
point-to-point
protocol

multipoint-to-multi

point

multi protocol label

switching

multi protocol label

switching virtual
private network

Multi-VRF CE

network

Network-facing
Provider Edge

network
management

subnet

non-conformant
tunnel

N-PE

Glossary W

multi protocol label switching virtual private network. For MPLS VPN Solution, it is a set of PEs that
are connected via a common “backbone” network to supply private IP interconnectivity between two
or more customer sites for a given customer. Each VPN has a set of provisioning templates/policies
(CERC) and can span multiple Provider Administrative Domains but has a default provider
administrative domain for RD and RT auto-allocation purposes. CERCs in a VPN break down complex
topology into multiple subgroups.

See MLPP.

In Metro Ethernet, a connection type consisting of single multipoint-to-multipoint Ethernet circuits
provisioned between two or more UNIs.

See MPLS.

See MPLS VPN.

multi-VPN routing and forwarding tables CE (MVRFCE) is a feature that provides for Layer 3
aggregation. Multiple CEs can connect to a single Multi-VRF CE (typically in an enterprise network);
then the Multi-VRF CE connects directly to a PE.

In MPLS VPN Solution, a collection of targets with unique names.

See N-PE.

Consists of the MPLS VPN Solution and Cisco IP Manager workstations on a single LAN. The network
management subnet connects directly to an MCE.

A TE tunnel, which might impact ISC TEM's ability to meet bandwidth guarantees. This could be due
to unknown bandwidth requirements such as no max bandwidth configured for auto-bandwidth,
potential for pre-emption, dynamic paths, etc. A zero priority unmanaged tunnel would also be a non-
conformant tunnel.

Network-facing Provider Edge within the Edge layer in a Metro Ethernet network.

[ oL-10727-01
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o

0ss

operations support
system

PAD

PE

PE-AGG

permanent virtual
circuit.

Point-to-Point
Ethernet

projection
(topology map)

propagation delay
provider

Provider
Administrative

Domain

Provider edge
aggregation

provider edge
router

Operations Support System. Network management system supporting a specific management function,
such as alarm surveillance and provisioning, in a carrier network.

See OSS.

Provider Administrative Domain. Set of all PE devices in one BGP autonomous system. An
administrative domain defined by an Internet Service Provider. The network owned by the PAD is
called a backbone network. Each PAD includes a route distinguisher and route target and IP address
pools. Each PAD can have any number of regions within it. If an ISP requires two AS numbers, it must
consist of two provider administrative domains. Each provider administrative domain has regions that
have a route distinguisher (RD), a route target (RT), and an IP address pool from which to
automatically generate IP values during provisioning. Each provider administrative domain can have
many regions.

provider edge router. A router at the edge of a provider network that interfaces to CE routers. Each PE
belongs to exactly one region of a Provider Adminisirative Domain and connects to one or more
customer sites. Each PE can have many VRF definitions and configlets, and each can be configured by
many service requests.

Provider edge aggregation (PE-AGG) within the Aggregation layer in a Metro Ethernet network.
See PVC.

A network architecture delivered with the Cisco Metro Ethernet offering. It supports both EWS and
ERS services.

A map projection is a topology function, which maps a sphere onto a plane.

The time it takes for traffic to travel along a link from the head interface to the tail interface.

A party supplying internet service for its customer. See also ISP.

See PAD.

See PE-AGG.

See PE.
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provider network

PVC

QoS

quality of Service

RD

region

Residual
Bandwidth
Reservation

response time

Glossary W

A backbone network under the control of a service provider that provides transport services between
customer sites.

permanent virtual circuit. This is applicable to Frame Relay and Asynchronous Transfer Mode.

Quality of Service. The mechanisms that give network managers the ability to control the mix of
bandwidth, delay, jitter, and packet loss in the network. QoS is not a device feature, it is an end-to-end
system architecture.

See QoS.

Route Distinguisher. A 64-bit value that is added to an IPv4 prefix to create a unique VPN prefix. Each
VRF has an RD.

A group of provider edge routers (PEs) within a single BGP autonomous system. Provider
Administrative Domains are divided into regions just as customers are divided into sites. Each region
belongs to exactly one provider administrative domain and can have many PEs. Regions allow a
provider to employ unique IP address pools in large geographical regions. Each region is represented
in the VPN Inventory Repository by a Region object.

The discrepancy between bandwidth reservations discovered for each link and bandwidth reserved by
tunnels that ISC is aware of.

Renamed to service assurance agent (SA Agent).

reporter

RG The Route Generator is a placement tool used in ISC Traffic Engineering Management to achieve
optimization and bandwidth protection in the network.

RIP Routing Information Protocol. The simplest Interior Gateway Protocol (IGP) in the Internet.

round-trip time See RTT.

route distinguisher See RD.

Route Generator See RG.

route target See RT.

Routing See RIP.

Information

Protocol

RT Route Target. A 64-bit value by which the IOS discriminates routes for route updates in VRFs.

Cisco IP Solution Center Infrastructure Reference, 4.2
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RTR

RTT

S

SA Agent

schema

seed router
Service Assurance
Agent

service level
agreement

setup priority
Shared-Risk Link
Group

site

SLA

SOAP

SNMP
SP

SRLG

Static route

storm control

Renamed to Service Assurance Agent (SA Agent).

Round-trip time. The total time required for a packet to traverse a network to its destination and back
again.

Service Assurance Agent. SA Agent provides Round-Trip Time for various protocols: DHCP, DNS,
HTTP, ICMP Echo, Jitter, TCP Connect, and UDP Echo.

A set of data models that describe a set of objects to be managed.

The TE network discovery process uses a seed router as an initial communication point to discover the
MPLS TE network topology.

See SA Agent.

See SLA.

Priority used when signaling a Label-Switched Path (LSP) for the tunnel to determine which of the
existing tunnels can be preempted.

See SRLG.

A component of a customer. A collection of one or more customer edge routers (CEs).

Service Level Agreement. Service-Level Agreements (SLAs) are negotiated contracts between VPN
providers and their subscribers. An SLA defines the criteria for the specific services that the subscriber
expects the provider to deliver. The SLA is the only binding mechanism at the subscriber's disposal to
ensure that the VPN provider delivers the services as agreed.

A lightweight protocol for exchange of information in a decentralized, distributed environment. It is an
XML based protocol that consists of three parts: an envelope that defines a framework for describing
what is in a message and how to process it, a set of encoding rules for expressing instances of

application-defined datatypes, and a convention for representing remote procedure calls and responses.

Simple Network Management Protocol.
Service Provider.

In Traffic Engineering, a Shared-Risk Link Group (SRLG) identifies links with common physical
characteristics that could fail as a group during a single failure event.

Route that is explicitly configured and entered into the routing table. Static routes take precedence over
routes chosen by dynamic routing protocols.

Interface configuration settings to help prevent a UNI port from being disrupted by a broadcast,
multicast, or unicast storm.

Cisco IP Solution Center Infrastructure Reference, 4.2
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S

sub pool The bandwidth of TE enabled interfaces is assigned a number of nested bandwidth pools. A sub pool
is a bandwidth pool nested inside a global pool. Thus, if for example a primary tunnel reserves
bandwidth from the sub pool, it will also reserve the same bandwidth from the global pool.

system path An ISC system generated explicit path (immovable unless the tunnel is set to be reroutable). The first
path has to be an explicit path.

T

target Single device from which information may be collected. A target may be a router. Any device

(customer edge router, provider edge router, or RMON probe) from which the MPLS VPN Solution
software can collect information.

target language CORBA-supported programming language to be generated by the IDL compiler based on the IDL API
files. The generated target-language files can then be used to incorporate API-supported features in
third-party client-application source code. For a complete list of CORBA-supported target languages,
see the Object Modeling Group web site.

TCP Transmission Control Protocol. Connection-oriented transport layer protocol that provides reliable
full-duplex data transmission.

TE traffic engineering.
TE discovery An ISC task used to populate the repository with the TE network element and data.
TE explicit path A fixed path from a specific head to a specific destination device. Paths are defined between source and

destination routers, possibly with one or more hops in between.

TE functional audit A task that checks the Label-Switched Path (LSP) used on a router at a given moment against the LSP
stored in the repository.

TE link A link between two TE enabled interfaces.

TEM Traffic Engineering Management is an ISC implementation of the Traffic Engineering (TE) technology.
TE metric Metric used to override the Interior Gateway Protocol (IGP) administrative weight (cost) of a TE link.
TE node A TE enabled node.

TE policy A set of rules established for a tunnel to carry TE traffic.

TE provider The TE provider is a concept designed to allow the network management application to manage many

different operators simultaneously, each working on different networks.

TE topology A TE topology provides a graphical representation of the various network elements in a TE network,
such as devices, links, and tunnels.

TE traffic admission Also referred to as tunnel admission. It is the first step towards enabling services on TE tunnels by
assigning traffic to traffic-engineered tunnels.

TE tunnel See MPLS TE tunnel.

Cisco IP Solution Center Infrastructure Reference, 4.2
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T

Transmission See TCP.
Control Protocol

tunnel audit When any type of change to the TE network is required, whether tunnel or resource modifications, a
tunnel audit is run to determine what inconsistencies the change might cause, if any.

tunnel placement  Tunnel placement is a TE tool for calculating optimal paths for new or changed tunnels in the existing
network.

tunnel repair As changes are made to bandwidth requirements or delay parameters of existing TE tunnels, tunnel
placement can create inconsistencies. Tunnel repair is designed to address such inconsistencies. The
objective of tunnel repair is to try to move as few existing tunnels as possible to accommodate the
changes.

UDP User Datagram Protocol. Connectionless transport layer protocol in the TCP/IP protocol stack. UDP is
a simple protocol that exchanges datagrams without acknowledgments or guaranteed delivery,
requiring that error processing and retransmission be handled by other protocols.

unmanaged tunnel An unmanaged tunnel is any tunnel that is not managed. See managed tunnel.

U-PE The User-facing Provider Edge within the Access layer in a Metro Ethernet network.
User Datagram See UDP.

Protocol

User-facing See U-PE.

Provider Edge

user role A user role is a predefined or a user-specified role defining a set of permissions.

\"/

vcl virtual channel identifier. Used in ATM networking concept.

virtual channel See VCI.

identifier

virtual LAN See VLAN.

virtual path See VPI.

identifier

virtual private See VPN.

network

VLAN virtual LAN. Group of devices on a LAN that are configured so they can communicate as if they were

attached to the same wire, when in fact they are located on a number of different LAN segments.

Cisco IP Solution Center Infrastructure Reference, 4.2
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\"/

VLAN Translation A technique used to pass frames between subinterfaces with different VLAN IDs. This allows frames
entering a device with one VLAN ID to exit with a different VLAN ID. VLAN translation provides
flexibility in managing VLANSs, as well as Metro Ethernet-related services. There are two types of
VLAN translation—1 to 1 (1:1) and 2 to 1 (2:1).

VolP voice over internet protocol.

VPI virtual path identifier.The VPI, together with the VCI, is used to identify the next destination of a cell
as it passes through a series of ATM switches on its way to its destination.

VPIM VPN Provisioning and Inventory Manager.
VPLS Virtual Private LAN Service.
VPN Virtual Private Network. A framework that provides private IP networking over a public infrastructure

such as the Internet. In MPLS VPN Solution, a VPN is a set of customer sites that are configured to
communicate through a VPN service. A VPN is a network in which two sites can communicate over
the provider’s network in a private manner; that is, no site outside the VPN can intercept their packets
or inject new packets. The provider network is configured such that only one VPN’s packets can be
transmitted through that VPN—that is, no data can come in or out of the VPN unless it is specifically
configured to allow it. There is a physical connection from the provider edge network to the customer
edge network, so authentication in the conventional sense is not required. A VPN is a private network
constructed within a public network infrastructure, such as the Internet. A VPN is a communications
environment in which access is controlled to permit peer connections only within a defined community
of interest, and is constructed through some form of partitioning of a common underlying
communications medium, where this communications medium provides services to the network on a
nonexclusive basis.

VPN customer Owner of VPN.

VPN See VRF.

routing/forwarding

instance

VRF definition The configuration information for a VPN routing/forwarding instance (VRF) table for PEs that share a

common route-target (RT) signature. In the VPN inventory repository, a VRF definition is a template
by which to define a VRF table in a PE.

VRF VPN routing/forwarding instance. A routing table that is populated with VPN routes. A VRF is an IOS
route table instance for connecting a set of sites to a VPN service.

WSDL Web Services Definition Language

Cisco IP Solution Center Infrastructure Reference, 4.2
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X

XML Extensible Markup Language.

XML API A programmatic interface to ISC used by OSS systems. The XML API is implement in a SOAP over
HTTP format and provides full ISC functionality.

XML Schema A specific format (.xsd) to describe XML structures (for example, metadata).

Cisco IP Solution Center Infrastructure Reference, 4.2
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aagent properties C-35

about 1-6

access domain

create 3-121, 4-48

accessing reports  7-43
account 1-5

active users 1-16,9-1, 9-33

admin 1-2

Administration  1-2, 1-3, 1-15, 9-1
advanced filter 9-35

advanced operation method 5-2
advanced task configuration method 7-3
append 5-6

as-number tag B-1

assigning 3-35

audience  xvii

AutoDiscovery property C-1
autonomous system number B-1

auto refresh 1-8

background daemon 2-1
bootstrapping  2-1
Broken state  3-3
buckets 7-15

C

CDP button 4-26

INDEX

CDP Discovery
verifying CDP is running 4-16
CDP tag 4-18
CERC 1-11,3-2,3-132
access 3-133
delete 3-135
CE roles
assigning  4-41

DIRECT-CONNECTED-MGMT-HOST role

DIRECT-CONNECTED-REGULAR role
edit 4-43
MANAGED-MGMT-LAN role 4-43
MANAGED-REGULAR role 4-43
MULTI-VRF role 4-43
UNMANAGED 4-43
UNMANAGED-MGMT-LAN role 4-43
UNMANAGED-MULTI-VRF role 4-43

CE routing community 1-11, 3-2, 3-132
access 3-133
delete 3-135

cfr properties €-35

Cisco MPLS Diagnostics Expert 1-3,1-14

Cleanup properties C-1

closed state  3-3

CNS attributes
edit 4-33

CNS device access protocol  A-3

CNS IE2100 appliance A-1
create A-1

cnsserver server  2-10

collect config 7-3

Collect Config Task

creating and running 4-76
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collection zones 1-16, 9-29

color coding 1-8

commands
startdb  2-1
startns  2-2
startwd  2-2
stopall 2-3
stopdb  2-3
stopns 2-4
stopwd 2-4

watchdog  2-1

wdclient 2-5
components, GUI 1-6
config audit 7-5
configuration files 3-6
configurations

view 6-3
configuration to display 5-8
connection tag  4-22
control center 1-16, 9-1, 9-22
copy

users  9-5
cornerstone bridge server 2-10
CPE devices

configuring SSH connectivity 3-71
create  3-102

template 6-5

user groups  9-7

user role  9-11, 9-16
create-customer tag  B-1
create data file 6-3,6-15
create-provider rule B-2
create-region rule B-2
create-site rule B-2
create template  6-3
customer 1-11, 3-2, 3-107

access 3-108

associating with devices 9-13

create 3-108

definition 9-9
delete 3-110

edit 3-109
customer context 1-6
customer-name tag B-2
customer site

create 3-111

custom reports  7-47

D

data file
delete 6-21
edit 6-20

data file name 6-17
dbpoller server 2-10
DCPL properties C-1
aagent C-35
AutoDiscovery C-1
cfr C-35

Cleanup C-1

DCS ¢-2
DeploymentFlow C-8
Discovery C-8

DistributionFramework C-12

GSAM C-14
GTL C-14
GUI C-16

JavaWebStart C-19
lockmanager C-36
Logging C-19
nbi C-36
notification C-38
pal C-39
Provisioning C-20
repository  C-40
Scheduler C-32
Services €-32
SLA C-30
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SYSTEM C-30
TaskManager C-34
TE C-33

TE Topology C-34
VpnlnvServer C-35
watchdog C-42

xml C-53

DCS properties C-2

delete

template 6-3

user groups 9-9

user roles  9-15, 9-18

users  9-6

deployed state  3-3
DeploymentFlow property C-8
detailed reports 7-42

device 1-11,3-2,3-70

copy 3-100

creation 3-76

delete 3-96

deleting 4-53

edit 3-93

e-mail 3-106

inserting into an NPC topology 4-53
device.xml file

description 4-19

editing 4-20

sample file 4-19
Device/Topology button 4-26
device access protocol 5-9
device assignment display
changing 4-36

device configuration, edit 3-97
device configuration manager 1-12,5-7
device configurations

editing 4-28

device console 1-12, 5-1

device configuration manager 5-7

Index W

download commands  5-2
download template  5-3
EXEC commands 5-9
reload 5-13
device discovery 4-23
device group 1-11, 3-2, 3-101, 3-102
access 3-102
delete 3-105
edit 3-105
device-name tag B-2
XML tags
device-name tag 4-20
device owner, e-mail  3-99
device roles
general description 4-38
Devices File field 4-26
device tag B-2
DHCP protocol 7-29
DIA-channelization template folder 6-23
Diagnostics Expert 1-3,1-14
diagnostic tools 2-5
DIRECT-CONNECTED-MGMT-HOST role 4-43
DIRECT-CONNECTED-REGULAR role 4-43
disabled_dependent state 2-10
disabled state 2-11
Discovery 1-12
data collection 4-34
description of workflow
for ISC L2VPN Management 4-9
for ISC MPLS VPN Management 4-9
for MPLS Diagnostics expert 4-13

device discovery 4-23

L2VPN (Metro Ethernet) service discovery phase 4-63

launching Discovery 4-23

logs 4-5

MPLS VPN service discovery phase 4-54
NPC discovery phase 4-47

overview 4-1

preliminary steps  4-14
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process illustrated 4-3
properties C-8
required XML files 4-16
role assignment  4-34
summary
for ISC L2ZVPN Management 4-7

for ISC MPLS VPN Management 4-7

for MPLS Diagnostics Expert 4-11
summary of methods 4-2
technical notes  4-4

using Restart button 4-5

using with Cisco ISC MPLS VPN Management

using with ISC L2VPN Management

using with ISC Traffic Engineering Management

using with MPLS Diagnostics Expert
DISCOVERY_METHOD tag 4-18,B-2

XML tags

DISCOVERY_METHOD B-2

discovery-protocol tag  4-22, B-2
dispatcher server 2-10
DistributionFramework properties C-12
DNS protocol 7-28
documentation xv
download commands 1-12, 5-2
download template 1-12, 5-3
download to running 5-9
download to startup 5-9
dynamic Java class type 6-14

dynamic URL type 6-14

4-6

4-6

4-5

4-7

edit

device configurations 4-28
user groups 9-8

user roles  9-14, 9-18
users  9-6

editing 3-25

edit template  6-3

e-mail, device group 3-106
e-mail device owner 3-99
e-mailing reports  7-46
enable traps 7-15
end-to-end wire

editing VPN associated with  4-69
examples template folder 6-23
EXEC commands 1-12,5-9
exec time column  2-11

exporting reports  7-45

F

failed audit state  3-3
failed deploy state 3-3
falling threshold 7-15
filter 1-7

advanced 9-35

simple 9-35
float type 6-11
frequency 7-14
fromDevice tag 4-22, B-2
FromlInterface tag 4-22, B-2
FromIP tag 4-22, B-2
ftp 59
FTP protocol 7-27
Full Mesh topology  4-56

Functional state 3-3

G

gen column  2-11

general device attributes
edit 4-32

getting started 1-1

glossary 1

go to page 1-7

GSAM property C-14

GTL properties C-14
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GUI components 1-6
GUI properties C-16
GUI reports  7-43

header check box 1-7
header row 1-7
help 1-5
Home screen 1-2,1-3,7-1, 8-1,9-1
hop tag 4-18,B-3
hosts  1-16, 9-22
config 9-24
details 9-23
servers 9-25
Watchdog 9-26
HTTP CoS report 7-40
httpd server 2-10
HTTP protocol 7-28
HTTP report 7-39
Hub and Spoke topology 4-56

ICMP Echo protocol 7-25
icons 1-10
IE2100 appliance
create  A-1
M
accessing IM  3-5
assigning devices 3-35
importing devices with configuration files 3-6
launching IM  3-38
opening customers 3-25
opening devices 3-7
opening providers 3-15
importing devices with configuration files 3-6

index 1-5

installation
remote 9-27
integer type 6-10
inter-N-PE interfaces
edit 4-48
introduction  1-1
invalid state 3-3
inventory.xml file
editing  4-17
Inventory and Connection Manager 1-11, 3-1
Inventory Manager 1-11, 3-1, 3-2, 3-5
I0S 371
IP address
create 3-124
IP address pool 3-122
ip-address tag  4-20, B-3
ipaddress tag 4-18, B-3
IPv4 type 6-12
ISC L2VPN Management
Discovery process for 4-6
ISC Traffic Engineering Management

using Discovery with 4-7

Index W

J

JavaWebStart properties C-19
jitter CoS report  7-41

jitter protocol 7-26

jitter report  7-39

K

keep history 7-15
keys 3-1

L

L2TPv3 functional audit 7-5
L2VPN (Metro Ethernet) service discovery 4-63
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L2VPN (Metro Ethernet Discovery) button
L2VPN functional audit 7-5
L2VPN repository variables 6-24
Layer 2 end-to-end wires

deleting 4-71

joining 4N

splitting  4-70
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